
Konfigurations- und Bedienungsanleitung
MMI-20018293, Rev AB

Juni 2012

Micro Motion® Masse Abfüll-
Auswerteelektronik mit Modbus

Konfigurations- und Bedienungsanleitung



Micro Motion Kundenservice

E-Mail

• Weltweit: flow.support@emerson.com

• Asien/Pazifik: APflow.support@emerson.com

Nord- und Südamerika Europa und Naher Osten Asien/Pazifik

Vereinigte Staaten 800-522-6277 Großbritannien 0870 240 1978 Australien 800 158 727

Kanada +1 303-527-5200 Niederlande +31 (0) 318 495 555 Neuseeland 099 128 804

Mexiko +41 (0) 41 7686 111 Frankreich 0800 917 901 Indien 800 440 1468

Argentinien +54 11 4837 7000 Deutschland 0800 182 5347 Pakistan 888 550 2682

Brasilien +55 15 3238 3677 Italien 8008 77334 China +86 21 2892 9000

Venezuela +58 26 1731 3446 Zentral- und Osteur-

opa

+41 (0) 41 7686 111 Japan +81 3 5769 6803

Russland/GUS +7 495 981 9811 Südkorea +82 2 3438 4600

Ägypten 0800 000 0015 Singapur +65 6 777 8211

Oman 800 70101 Thailand 001 800 441 6426

Qatar 431 0044 Malaysia 800 814 008

Kuwait 663 299 01

Südafrika 800 991 390

Saudi-Arabien 800 844 9564

VAE 800 0444 0684



Inhalt

Teil I Erste Schritte
Kapitel 1 Einführung in die Abfüllung mit der Füllmassen-Auswerteelektronik .............................. 2

1.1 Die Füllmassen-Auswerteelektronik von .......................................................................................2
1.2 Befüllungsart mit Fülloptionen ......................................................................................................2

1.2.1 E/A-Anforderungen ........................................................................................................ 4
1.3 Optionen für Bedieninterface ........................................................................................................4

Kapitel 2 Schnellstart mittels ProLink II ..........................................................................................6
2.1 Einschalten der Auswerteelektronik .............................................................................................. 6
2.2 Status des Durchfluss-Messsystems prüfen ...................................................................................7
2.3 Herstellen einer Verbindung von ProLink II zur Auswerteelektronik ...............................................7
2.4 Abschluss der Konfiguration und Inbetriebnahme ........................................................................ 8

2.4.1 Testen oder Anpassen des Systems mittels Sensorsimulation .........................................9
2.4.2 Backup der Auswerteelektronik Konfiguration ............................................................. 10
2.4.3 Werkskonfiguration wiederherstellen .......................................................................... 11

Kapitel 3 Schnellstart mittels Modbus ..........................................................................................12
3.1 Einschalten der Auswerteelektronik ............................................................................................ 12
3.2 Status des Durchfluss-Messsystems prüfen .................................................................................13
3.3 Einrichten des Modbus Interface Tool (MIT) ................................................................................ 13
3.4 Herstellen einer Modbus Verbindung mit der Auswerteelektronik .............................................. 13
3.5 Abschluss der Konfiguration und Inbetriebnahme ...................................................................... 14

3.5.1 Testen oder Anpassen des Systems mittels Modbus und Sensorsimulation .................. 15
3.5.2 Wiederherstellen der Werkskonfiguration mittels Modbus .......................................... 16

Teil II Konfigurieren und Durchführen von Abfüllungen
mit integrierter Ventilsteuerung

Kapitel 4 Vorbereiten der Konfiguration einer integrierten Abfüll-Ventilsteuerung ..................... 18
4.1 Allgemeines Verfahren zur Konfiguration und Durchführung einer Abfüllung mit integrierter

Ventilsteuerung ..........................................................................................................................19
4.2 Tipps und Tricks zum Konfigurieren der Abfüllung mit integrierter Ventilsteuerung ................... 19

4.2.1 Werkseinstellungen für grundlegende Befüllungsparameter ........................................20

Kapitel 5 Konfigurieren einer Abfüllung mit integrierter Ventilsteuerung mittels ........................21
5.1 Konfigurieren einer Abfüllung mit integrierter Ventilsteuerung mittels ProLink II ....................... 21

5.1.1 Konfigurieren einer einstufigen Abfüllung mittels ProLink II ......................................... 21
5.1.2 Konfigurieren einer zweistufigen Abfüllung mittels ProLink II ....................................... 24
5.1.3 Konfigurieren einer zeitgesteuerten Abfüllung mittels ProLink II .................................. 30
5.1.4 Konfigurieren einer Abfüllung mit doppeltem Füllkopf mittels ProLink II ...................... 32
5.1.5 Konfigurieren einer zeitgesteuerten Abfüllung mit doppeltem Füllkopf mittels

ProLink II ...................................................................................................................... 35
5.2 Konfigurieren von Abfülloptionen mittels ProLink II .................................................................... 38

5.2.1 Konfigurieren und Implementieren der automatischen Überfüllkompensation (AOC)
mittels ProLink II ...........................................................................................................38

5.2.2 Konfigurieren der Spülfunktion mittels ProLink II ..........................................................42
5.2.3 Konfigurieren der Pumpenfunktion mittels ProLink II ................................................... 44

5.3 Konfigurieren einer Abfüllsteuerung mittels ProLink II (optional) ................................................ 45
5.3.1 Konfigurieren des Binäreingangs für die Abfüllsteuerung mittels ProLink II ...................45

Inhalt

Konfigurations- und Bedienungsanleitung i



5.3.2 Einrichten eines Ereignisses zur Durchführung einer Abfüllsteuerung mittels
ProLink II ...................................................................................................................... 47

5.3.3 Mehrere Maßnahmen, die einem Binäreingang oder Ereignis zugewiesen sind ............ 49
5.4 Konfigurieren der Abfüllprotokollierung mittels ProLink II (optional) .......................................... 50

5.4.1 Konfigurieren von Kanal B als Binärausgang und Übertragen des Abfüllstatus ON/OFF
mittels ProLink II ...........................................................................................................51

5.4.2 Konfigurieren des mA-Ausgangs, um die prozentuale Abfüllung auszugeben mittels
ProLink II ...................................................................................................................... 52

Kapitel 6 Abfüllvorgang mittels .................................................................................................. 53
6.1 Abfüllung mit integrierter Ventilsteuerung mittels ProLink II ...................................................... 53

6.1.1 Wenn die Abfüllung nicht startet ..................................................................................55
6.1.2 Wenn die Abfüllung nicht vollständig durchgeführt wurde ...........................................55
6.1.3 Auswirkungen von Pause und Fortfahren bei zweistufigen diskreten Abfüllungen ........... 56

6.2 Durchführen einer manuellen Spülung mittels ProLink II ............................................................. 62
6.3 Durchführen eines Cleaning-in-Place-Verfahrens (CIP) mittels ProLink II ..................................... 63
6.4 Überwachen und Analysieren der Abfüllleistung mittels ProLink II ...............................................63

6.4.1 Sammeln detaillierter Abfülldaten für eine einzelne Abfüllung mittels ProLink II ...........63
6.4.2 Analyse der Abfüllleistung mittels Abfüllstatistiken und ProLink II ................................ 64

Kapitel 7 Konfigurieren einer integrierten Abfüll-Ventilsteuerung mittels Modbus ...................... 66
7.1 Konfigurieren einer integrierten Abfüll Ventilsteuerung mittels Modbus .................................... 66

7.1.1 Konfigurieren einer einstufigen Abfüllung mittels Modbus ...........................................66
7.1.2 Konfigurieren einer zweistufigen Abfüllung mittels Modbus ........................................ 70
7.1.3 Konfigurieren einer zeitgesteuerten Abfüllung mittels Modbus ....................................77
7.1.4 Konfigurieren einer Doppelfüllkopf Abfüllung mittels Modbus ..................................... 79
7.1.5 Konfigurieren einer zeitgesteuerten Doppelfüllkopf Abfüllung mittels Modbus ........... 83

7.2 Konfigurieren von Abfülloptionen mittels Modbus ......................................................................86
7.2.1 Konfigurieren und Implementieren der automatischen Überfüllkompensation (AOC)

mittels Modbus ............................................................................................................ 86
7.2.2 Konfigurieren der Spülfunktion mittels Modbus ........................................................... 91
7.2.3 Konfigurieren der Pumpenfunktion mittels Modbus .....................................................93

7.3 Configure fill control using Modbus (optional) ............................................................................ 94
7.3.1 Konfigurieren des Binäreingangs für die Abfüllsteuerung mittels Modbus .................... 94
7.3.2 Einrichten eines Ereignisses zur Durchführung einer Abfüllsteuerung mit Modbus ....... 96
7.3.3 Mehrere Maßnahmen, die einem Binäreingang oder Ereignis zugewiesen sind ............ 99

7.4 Konfigurieren von Abfüllberichten mittels Modbus (optional) ...................................................100
7.4.1 Kanal B als Binärausgang konfigurieren und den Abfüllstatus ON/OFF mittels Modbus

übertragen .................................................................................................................101
7.4.2 Konfigurieren des mA Ausgangs, um die prozentuale Abfüllung mittels Modbus

auszugeben ................................................................................................................102

Kapitel 8 Abfüllvorgang mittels Modus ......................................................................................103
8.1 Abfüllung mit integrierter Ventilsteuerung mittels Modbus ausführen. .................................... 103

8.1.1 Wenn die Abfüllung nicht startet ................................................................................105
8.1.2 Wenn die Abfüllung nicht vollständig durchgeführt wurde .........................................106
8.1.3 Auswirkungen von Pause und Fortfahren bei zweistufigen diskreten Abfüllungen ......... 107

8.2 Durchführen einer manuellen Spülung mittels Modbus ............................................................ 113
8.3 Durchführen eines Cleaning-in-Place-Verfahrens (CIP) mit Modbus .......................................... 114
8.4 Überwachen und Analysieren der Abfüll Leistungsmerkmale mittels Modbus ........................... 114

8.4.1 Sammeln detaillierter Abfülldaten für eine einzelne Abfüllung mit Modbus ................114
8.4.2 Analysieren der Abfüll Leistungsmerkmale mittels Abfüllstatistiken und Modbus .......115

Teil III Konfigurieren und Durchführen von Abfüllungen
mit externer Ventilsteuerung

Inhalt

ii  Micro Motion® Masse Abfüll-Auswerteelektronik mit Modbus



Kapitel 9 Konfigurieren und Einrichten einer externen Abfüll-Ventilsteuerung mittels
ProLink II .....................................................................................................................118
9.1 Konfigurieren einer mit einem externen Ventil gesteuerten Abfüllung mit Modbus

ProLink II ................................................................................................................................... 118
9.2 Einrichten und Ausführen einer mit einem externen Ventil gesteuerten Abfüllung ................... 119

Kapitel 10 Konfigurieren und Einrichten einer externen Abfüll-Ventilsteuerung mittels
Modbus .......................................................................................................................120
10.1 Konfigurieren einer externen Ventilsteuerungs-Abfüllung mitels Modbus ................................ 120
10.2 Einrichten und Ausführen einer mit einem externen Ventil gesteuerten Abfüllung ................... 122

Teil IV Allgemeine Konfiguration der
Auswerteelektronik

Kapitel 11 Prozessmessung konfigurieren ................................................................................... 124
11.1 Charakterisieren des Durchfluss-Messsystems (falls erforderlich) ..............................................124

11.1.1 Beispiel Sensor Typenschilder .....................................................................................125
11.1.2 Durchflusskalibrierparameter (FCF, FT) ...................................................................... 125
11.1.3 Dichtekalibrierparameter (D1, D2, K1, K2, FD, DT, TC) .................................................. 126

11.2 Massedurchflussmessung konfigurieren ................................................................................... 126
11.2.1 Massedurchfluss Messeinheit konfigurieren ..................................................................... 127
11.2.2 Konfigurieren der Durchflussdämpfung ...........................................................................128
11.2.3 Massedurchfluss Abschaltung für Abfüllanwendungen konfigurieren ............................... 129
11.2.4 Massedurchfluss Abschaltung konfigurieren .....................................................................130

11.3 Konfigurieren von Volumendurchflussmessungen für Flüssigkeitsanwendungen ..................... 131
11.3.1 Konfigurieren von Volumendurchfluss-Messeinheit für Flüssigkeitsanwendungen .............132
11.3.2 Konfigurieren der Volumendurchflussabschaltung in Befüllanwendungen ......................... 133
11.3.3 Konfigurieren der Volumendurchflussabschaltung .............................................................134

11.4 Konfigurieren von Durchflussrichtung ............................................................................................136
11.4.1 Optionen der Durchflussrichtung .................................................................................... 136

11.5 Konfigurieren der Dichtemessung ............................................................................................ 140
11.5.1 Konfigurieren der Dichte Messeinheit ............................................................................. 140
11.5.2 Schwallstrom Parameter konfigurieren ...................................................................... 141
11.5.3 Konfigurieren der Dichtedämpfung ................................................................................ 143
11.5.4 Konfigurieren der Dichteabschaltung ..............................................................................144

11.6 Konfigurieren einer Temperaturmessung ................................................................................. 144
11.6.1 Konfigurieren einer Temperatur Messeinheit ................................................................... 145
11.6.2 Konfigurieren der Temperaturdämpfung ..........................................................................145

11.7 Druckkompensation konfigurieren ........................................................................................... 146
11.7.1 Druckkompensation konfigurieren mittels ProLink II .................................................. 146
11.7.2 Druckkompensation konfigurieren mittels ProLink III ................................................. 148
11.7.3 Optionen für Druckmesseinheit ...................................................................................... 149

Kapitel 12 Geräteoptionen und Präferenzen konfigurieren .......................................................... 151
12.1 Konfigurieren der Alarmverwaltung ..........................................................................................151

12.1.1 Konfigurieren von Störung-Timeout ............................................................................... 151
12.1.2 Konfigurieren von Status Alarmstufe .............................................................................. 152

12.2 Informationsparameter konfigurieren ...................................................................................... 155
12.2.1 Konfigurieren der Beschreibung .................................................................................... 155
12.2.2 Nachricht konfigurieren ................................................................................................ 156
12.2.3 Konfigurieren des Datums ............................................................................................156
12.2.4 Sensor Seriennummer konfigurieren ...............................................................................156
12.2.5 Sensor Werkstoff konfigurieren ......................................................................................157
12.2.6 Sensor Auskleidungswerkstoff konfigurieren .................................................................... 157
12.2.7 Sensor Flanschtyp konfigurieren ....................................................................................158

Inhalt

Konfigurations- und Bedienungsanleitung iii



Kapitel 13 Integrieren des Messgerätes mit dem Netzwerk ..........................................................159
13.1 Konfigurieren der Auswerteelektronikkanäle ............................................................................ 159
13.2 mA Ausgang konfigurieren ....................................................................................................... 160

13.2.1 mA Ausgang Prozessvariable konfigurieren ..................................................................... 160
13.2.2 Messanfang (LRV) und Messende (URV) konfigurieren ....................................................161
13.2.3 Analogausgang Abschaltung konfigurieren ...................................................................... 162
13.2.4 Zusätzliche Dämpfung konfigurieren ...............................................................................163
13.2.5 mA Ausgang Störaktion und mA Ausgang Störwert konfigurieren ........................................ 165

13.3 Frequenzausgang konfigurieren ............................................................................................... 166
13.3.1 Frequenzausgang Polarität konfigurieren .........................................................................166
13.3.2 Frequenzausgang Skaliermethode konfigurieren ...............................................................167
13.3.3 Frequenzausgang max. Impulsbreite konfigurieren ............................................................ 169
13.3.4 Frequenzausgang Störaktion und Frequenzausgang Störwert konfigurieren .......................... 170

13.4 Konfigurieren des Binärausgangs ..............................................................................................171
13.4.1 Konfigurieren der Binärausgangsquelle .......................................................................... 171
13.4.2 Konfigurieren derPolarität des Binärausgangs ..................................................................172
13.4.3 Konfigurieren von Binärausgang Störaktion ..................................................................... 173

13.5 Binäreingang konfigurieren ...................................................................................................... 174
13.5.1 Binäreingang Aktion konfigurieren ..................................................................................175
13.5.2 Binäreingang Polarität konfigurieren ............................................................................... 176

13.6 Konfigurieren eines erweiterten Ereignisses ..............................................................................177
13.6.1 Optionen für Erweitertes Ereignisaktion ........................................................................... 178

13.7 Konfigurieren der digitalen Kommunikation ............................................................................. 179
13.7.1 Modbus/RS-485 Kommunikation konfigurieren ......................................................... 179
13.7.2 Digitale Kommunikation Störaktion konfigurieren ...............................................................180

Teil V Geschäftstätigkeit, Wartung sowie Fehlersuche
und -beseitigung

Kapitel 14 Auswerteelektronikbetrieb .........................................................................................183
14.1 Notieren der Prozessvariablen .................................................................................................. 183
14.2 Anzeigen von Prozessvariablen ................................................................................................. 184

14.2.1 Anzeigen von Prozessvariablen mittels ProLink III ....................................................... 184
14.3 Anzeigen und Bestätigen von Statusalarmen ............................................................................ 184

14.3.1 Anzeigen und Bestätigen von Alarmen mittels ProLink II ............................................ 184
14.3.2 Anzeigen und Bestätigen von Alarmen mittels ProLink III ........................................... 185
14.3.3 Prüfen des Alarmstatus und Bestätigen von Alarmen mittels Modbus ........................ 186
14.3.4 Alarmdaten im Auswerteelektronik-Speicher ............................................................. 186

14.4 Lesen von Gesamt- und Summenzählerwerten ......................................................................... 187
14.5 Starten und Stoppen von Gesamt- und Summenzählern ...........................................................188
14.6 Zähler zurücksetzen ..................................................................................................................188
14.7 Gesamtzähler zurücksetzen ...................................................................................................... 189

Kapitel 15 Messunterstützung .....................................................................................................190
15.1 Nullpunktkalibrierung des Durchflussmesssystems .................................................................. 190

15.1.1 Nullpunktkalibrierung des Durchflussmesssystems mittels ProLink II ......................... 190
15.1.2 Nullpunktkalibrierung des Durchflussmesssystems mittels ProLink III ........................ 192
15.1.3 Nullpunktkalibrierung des Durchflussmesssystems mittels Modbus ...........................193

15.2 Messsystem validieren .............................................................................................................. 195
15.2.1 Alternative Methode für die Berechnung des Gerätefaktors für

Volumendurchfluss .................................................................................................... 196
15.3 (Standard) D1 und D2 Dichtekalibrierung durchführen .............................................................197

15.3.1 Durchführen einer D1- und D2-Dichtekalibrierung mittels ProLink II .......................... 198

Inhalt

iv  Micro Motion® Masse Abfüll-Auswerteelektronik mit Modbus



15.3.2 Durchführen einer D1- und D2-Dichtekalibrierung mittels ProLink III ......................... 199
15.3.3 Durchführen einer D1- und D2-Dichtekalibrierung mittels Modbus ............................200

15.4 Durchführen einer Temperaturkalibrierung .............................................................................. 200
15.4.1 Durchführen einer Temperaturkalibrierung mit ProLink II ...........................................201
15.4.2 Durchführen einer Temperaturkalibrierung mit ProLink III ..........................................202

Kapitel 16 Störungsanalyse und -behebung ................................................................................. 203
16.1 Status Alarme ........................................................................................................................... 203
16.2 Probleme bei Durchflussmessungen .........................................................................................208
16.3 Probleme bei Dichtemessungen ............................................................................................... 210
16.4 Probleme bei der Temperaturmessung .....................................................................................211
16.5 Probleme bei mA-Ausgängen ................................................................................................... 212
16.6 Probleme beim Frequenzausgang .............................................................................................214
16.7 Verwenden der Sensorsimulation zur Störungsanalyse und -beseitigung ..................................214
16.8 Verdrahtung der Spannungsversorgung prüfen ........................................................................ 215
16.9 Erdung überprüfen ................................................................................................................... 216
16.10 Messkreistests durchführen ...................................................................................................... 216

16.10.1 Messkreistests durchführen mittels ProLink II .............................................................216
16.10.2 Messkreistests durchführen mittels ProLink III ............................................................ 217
16.10.3 Messkreistests mittels Modus durchführen ................................................................ 219

16.11 mA Ausgänge abgleichen ......................................................................................................... 221
16.11.1 Abgleichen der mA Ausgänge mittels ProLink II ..........................................................221
16.11.2 Abgleichen der mA Ausgänge mittels ProLink III .........................................................222
16.11.3 Abgleichen der mA Ausgänge mittels Modbus ........................................................... 222

16.12 Prüfen von Messanfang und Messende ..........................................................................................223
16.13 mA Ausgang Störaktion prüfen ...................................................................................................... 224
16.14 Prüfung auf hochfrequente Störungen (RFI) ..............................................................................224
16.15 Frequenzausgang max. Impulsbreite prüfen ..................................................................................... 224
16.16 Frequenzausgang Skaliermethode prüfen ........................................................................................ 225
16.17 Frequenzausgang Störaktion prüfen ............................................................................................... 225
16.18 Prüfen der Durchflussrichtung ....................................................................................................... 225
16.19 Prüfen der Abschaltungen ........................................................................................................ 225
16.20 Prüfen auf Schwallströmung (Zweiphasenströmung) ............................................................... 226
16.21 Antriebsverstärkung prüfen ...................................................................................................... 226

16.21.1 Daten der Antriebsverstärkung sammeln ................................................................... 228
16.22 Aufnehmerspannung prüfen .....................................................................................................228

16.22.1 Aufnehmer Spannungsdaten sammeln ..................................................................... 229
16.23 Prüfen auf elektrische Kurzschlüsse .......................................................................................... 229

Anhänge und Referenz
Anhang A Voreingestellte Werte und Bereiche ............................................................................231

A.1 Voreingestellte Werte und Bereiche ......................................................................................... 231

Anhang B Verwendung mit der Auswerteelektronik ................................................................... 235
B.1 Grundlegende Informationen über das ProLink II ...................................................................... 235
B.2 Menüstruktur für ProLink II ....................................................................................................... 236

Index ................................................................................................................................................241

Inhalt

Konfigurations- und Bedienungsanleitung v



Inhalt

vi  Micro Motion® Masse Abfüll-Auswerteelektronik mit Modbus



Teil I
Erste Schritte

In diesem Teil enthaltene Kapitel:

• Einführung in die Abfüllung mit der Füllmassen-Auswerteelektronik

• Schnellstart mittels ProLink II

• Schnellstart mittels Modbus

Erste Schritte
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1 Einführung in die Abfüllung mit der
Füllmassen-Auswerteelektronik
In diesem Kapitel behandelte Themen:

• Die Füllmassen-Auswerteelektronik von

• Befüllungsart mit Fülloptionen

• Optionen für Bedieninterface

1.1 Die Füllmassen-Auswerteelektronik von
Die Füllmassen-Auswerteelektronik eignet sich für jedes Verfahren, das bei der Abfüllung
oder der Dosierung höchste Genauigkeit erfordert.

Zusammen mit einem Coriolis-Sensor von kann die Füllmassen-Auswerteelektronik für
massenbasierte Messungen eingesetzt werden, die durch Veränderungen des
Prozessmediums, der Temperatur oder des Drucks unbeeinflusst bleiben. Abfüllungen mit
integrierter Ventilsteuerung werden mittels hochpräzisen Binärausgängen realisiert, um
so schnellstmögliche Ansprechzeiten des Ventils zu erhalten. Die automatische
Überfüllkompensation passt das System so an, dass Verarbeitungsverzögerungen bei der
Ventilsteuerung minimiert werden. Volumenbasierte Abfüllungen sind ebenfalls möglich.

Die Füllmassen-Auswerteelektronik vereint alle erweiterten digitalen
Singalverarbeitungsalgorithmen, Diagnose und Merkmale der Produktfamilie von
Auswerteelektroniken.

1.2 Befüllungsart mit Fülloptionen
Je nach Bestelloption unterstützt die Füllmassen-Auswerteelektronik entweder
Befüllungen mit integrierter oder mit externer Ventilsteuerung. Bei Installationen mit
integrierter Ventilsteuerung gibt es fünf Arten von Befüllungen mit integrierter
Ventilsteuerung und drei Befüllungsoptionen. Jede Befüllungsart und Kombination verfügt
über unterschiedliche Ausgangsanforderungen und wird unterschiedlich konfiguriert.

Abfüllarten und BeschreibungenTabelle 1-1:   

Modellcode der Auswer-
teelektronik Unterstützte Abfüllarten Beschreibung

FMT*P

FMT*Q

Externe Ventilsteuerung Die Auswerteelektronik misst den Durchfluss und sendet die
Durchflussdaten über den Frequenz-/Impulsausgang an einen
Host. Der Host öffnet und schließt die Ventile und führt eine
Messung der Abfüllmengen durch. Die Auswerteelektronik er-
kennt keine Abfüllanwendung.

FMT*R

FMT*S

FMT*T

FMT*U

Integrierte Ventilsteuer-
ung

Der Host leitet die Abfüllung ein. Die Auswerteelektronik setzt
den Abfüll-Gesamtzähler zurück, öffnet die Ventile, führt Mes-
sungen der Abfüllmenge durch und schließt die Ventile.

Einführung in die Abfüllung mit der Füllmassen-Auswerteelektronik

2  Micro Motion® Masse Abfüll-Auswerteelektronik mit Modbus



Abfüllarten und Beschreibungen (Fortsetzung)Tabelle 1-1:   

Modellcode der Auswer-
teelektronik Unterstützte Abfüllarten Beschreibung

FMT*V Einstufig diskret Die Abfüllung wird von einem einzelnen diskreten Ventil (EIN/
AUS) gesteuert. Das Ventil öffnet vollständig, wenn die Abfül-
lung beginnt, und schließt vollständig, wenn Fill Target erreicht
ist bzw. die Abfüllung angehalten oder beendet wird.

Zweistufig diskret Die Abfüllung wird von zwei diskreten Ventilen gesteuert: ei-
nem primären und einem sekundären Ventil. Ein Ventil muss
beim Beginn der Abfüllung öffnen und das andere öffnet bei ei-
nem vom Anwender definierten Punkt. Ein Ventil muss bis zum
Ende der Abfüllung geöffnet bleiben und das andere schließt
bei einem vom Anwender definierten Punkt.

Zeitgesteuert Der Ventil ist für eine bestimmte Anzahl von Sekunden geöf-
fnet.

Doppelter Füllkopf Abfüllsequenz:
1. Behälter Nr. 1 wird in Position gebracht.
2. Füllkopf Nr. 1 beginnt mit der Abfüllung von Behälter Nr. 1,

und Behälter Nr. 2 wird in Position gebracht.
3. Abfüllung Nr. 1 wird beendet. Füllkopf Nr. 2 beginnt mit

der Abfüllung von Behälter Nr. 2. Behälter Nr. 1 wird durch
einen neuen Behälter ersetzt.

Einstufige Standard-Abfüllsteuerung wird auf beide Abfüllun-
gen angewendet: Das Ventil öffnet vollständig, wenn die Ab-
füllung beginnt, und schließt vollständig, wenn Fill Target er-
reicht ist bzw. die Abfüllung angehalten oder beendet wird.

Doppelter Füllkopf,
zeitgesteuert

Abfüllsequenz:
1. Behälter Nr. 1 wird in Position gebracht.
2. Füllkopf Nr. 1 beginnt mit der Abfüllung von Behälter Nr. 1,

und Behälter Nr. 2 wird in Position gebracht.
3. Abfüllung Nr. 1 wird beendet. Füllkopf Nr. 2 beginnt mit

der Abfüllung von Behälter Nr. 2. Behälter Nr. 1 wird durch
einen neuen Behälter ersetzt.

Zeitsteuerung wird auf beide Abfüllungen angewendet: Jedes
Ventil wird für eine bestimmte Anzahl von Sekunden geöffnet.

Abfüllarten und BeschreibungenTabelle 1-2:   

Option Beschreibung Kompatibilität

Spülen Die Spülfunktion wird verwendet, um ein Hilfsventil zu
steuern, das nicht für die Abfüllung eingesetzt wird. Beis-
pielsweise kann damit ein Behälter mit Wasser oder Gas
aufgefüllt werden, nachdem der Füllvorgang abgeschlos-
sen ist, oder sie kann als “ Dämpfung dienen.” Der Durch-
fluss durch das Hilfsventil wird von der Auswerteelektronik
nicht gemessen.

Kompatibel mit:

• Einstufigen diskreten Abfüllungen
• Zweistufigen diskreten Abfüllun-

gen
• Zeitgesteuerten Abfüllungen

Pumpe Die Pumpfunktion wird verwendet, um den Druck während
der Abfüllung zu erhöhen, indem eine in Flussrichtung
liegende Pumpe kurz vor dem Beginn der Abfüllung ges-
tartet wird.

Kompatibel mit:

• Einstufigen diskreten Abfüllungen

Einführung in die Abfüllung mit der Füllmassen-Auswerteelektronik
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Abfüllarten und Beschreibungen (Fortsetzung)Tabelle 1-2:   

Option Beschreibung Kompatibilität

Automatische
Überfüllkompen-
sation (AOC)

Die automatische Überfüllkompensation (AOC) wird ver-
wendet, um die Abfüllzeit anzupassen und um für die Zeit
zu kompensieren, die benötigt wird, den Befehl zum
Schließen des Ventils zu übertragen bzw. damit das Ventil
vollständig schließt.

Kompatibel mit:

• Einstufigen diskreten Abfüllungen
• Zweistufigen diskreten Abfüllun-

gen
• Abfüllungen mit doppeltem Füll-

kopf

1.2.1 E/A-Anforderungen
Um eine bestimmte Befüllungsart und -option zu implementieren, müssen die binären
Ausgänge der Auswerteelektronik mit den entsprechenden Ventilen oder Geräten
verdrahtet und konfiguriert werden.

E/A-Anforderungen für Befüllungsarten und -optionenTabelle 1-3:   

Befüllart
Präzisions-
BA1

Präzisions-
BA2

Kanal B wird
als BA betrie-
ben mA-Ausgang

Frequen-
zausgang

Externe Ventilsteuerung – – Nach Wunsch – Zum Host

Integrierte
Ventilsteuer-
ung

Einstufig diskret Primärventil – – Nach Wunsch –

Einstufig binär mit
Spülzyklus

Primärventil – Spülventil Nach Wunsch –

Einstufig binär mit
Pumpe

Primärventil Pumpe Nach Wunsch Nach Wunsch –

Zweistufig binär Primärventil Sekundärven-
til

Nach Wunsch Nach Wunsch –

Zweistufig binär mit
Spülzyklus

Primärventil Sekundärven-
til

Spülventil Nach Wunsch –

Zeitgesteuert Primärventil – Nach Wunsch Nach Wunsch –

Zeitgesteuert mit
Spülung

Primärventil – Spülventil Nach Wunsch –

Doppelter Füllkopf Ventil in
Füllkopf 1

Ventil in
Füllkopf 2

Nach Wunsch Nach Wunsch –

Zeitgesteuerter dop-
pelter Füllkopf

Ventil in
Füllkopf 1

Ventil in
Füllkopf 2

Nach Wunsch Nach Wunsch –

1.3 Optionen für Bedieninterface
Die Optionen für das Bedieninterface und den Abfüllvorgang richten sich nach dem von
der Auswerteelektronik unterstützten Protokoll. Das Protokoll ergibt sich aus dem
Modellcode der Auswerteelektronik.
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Optionen für Auswerteelektronik-Protokoll und BedieninterfaceTabelle 1-4:   

Modellcode der Aus-
werteelektronik

Unterstütztes Proto-
koll

Bedieninterface-Optionen

Konfiguration, Wartung und
Fehlersuche- und beseitigung Abfüllvorgang

FMT*P

FMT*R

FMT*S

FMT*T

Modbus • ProLink II
• Modbus-Hilfsprogramm

• ProLink II
• Modbus-Host

FMT*Q

FMT*U

FMT*V

PROFIBUS-DP • ProLink II
• EDD
• Busparameter

• ProLink II
• EDD
• GSD
• Busparameter

Einführung in die Abfüllung mit der Füllmassen-Auswerteelektronik
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2 Schnellstart mittels ProLink II
In diesem Kapitel behandelte Themen:

• Einschalten der Auswerteelektronik

• Status des Durchfluss-Messsystems prüfen

• Herstellen einer Verbindung von ProLink II zur Auswerteelektronik

• Abschluss der Konfiguration und Inbetriebnahme

2.1 Einschalten der Auswerteelektronik
Die Auswerteelektronik muss für alle Konfigurations- und Inbetriebnahmeaufgaben sowie
für Prozessmessungen eingeschaltet sein.

1. Den entsprechenden Verfahren folgen, um sicherzustellen, dass ein neues im
Netzwerk befindliches Gerät nicht die bestehenden Messungen und Messkreise
stört.

2. Sicherstellen, dass die Kabel an die Auswerteelektronik, wie in Micro Motion FMT
Auswerteelektronik für Masseabfüllung: Installationsanleitung beschrieben,
angeschlossen sind.

3. Stellen Sie sicher, dass alle Auswerteelektronik und Sensor Gehäusedeckel sowie
Verschlüsse geschlossen sind.

VORSICHT!

Sicherstellen, dass alle Gehäusedeckel und Dichtungen dicht verschlossen sind, um eine
Entzündung in einer brennbaren Umgebung zu vermeiden. Bei Installationen in
explosionsgefährdeten Bereichen und mit geöffneten Gehäusedeckeln kann das
Einschalten der Stromversorgung zu einer Explosion führen.

4. Schalten Sie die Spannungsversorgung ein.

Die Auswerteelektronik führt automatisch Diagnoseroutinen durch. In dieser
Zeitspanne ist Alarm 009 aktiv. Die Diagnoseroutinen sind in ungefähr 30 Sekunden
abgeschlossen.

Nachbereitungsverfahren

Obwohl der Sensor bereits kurz nach dem Startvorgang das Prozessmedium verarbeiten
kann, kann die Elektronik bis zu 10 Minuten benötigen, um ein thermisches Gleichgewicht
zu erreichen. Aus diesem Grund kann es bei dem erstmaligen Startvorgang bzw. bei einer
Abschaltung, die so lange gedauert hat, dass die Komponenten die
Umgebungstemperatur annehmen konnten, ungefähr 10 Minuten dauern, bis sich die
Elektronik erwärmt hat und zuverlässige Prozessmessungen liefert. Während dieser
Warmlaufphase kann es sein, dass Sie geringfügige Instabilitäten oder Ungenauigkeiten
der Messung feststellen.

Schnellstart mittels ProLink II
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2.2 Status des Durchfluss-Messsystems prüfen
Das Durchfluss-Messsystem auf jegliche Störbedingungen prüfen, die eine Aktion des
Anwenders erforderlich machen oder die die Messgenauigkeit beeinflussen.

1. Ca. 10 Sekunden warten, bis der Startvorgang abgeschlossen ist.

Sofort nach dem Startvorgang durchläuft die Auswerteelektronik Diagnoseroutinen
und prüft auf Störbedingungen. Während des Startvorgangs ist Alarm A009 aktiv.
Dieser Alarm sollte nach dem Startvorgang automatisch gelöscht werden.

2. Eine Verbindung mit der Auswerteelektronik herstellen und auf aktive Alarme
prüfen.

Nachbereitungsverfahren

Weitere Informationen bzgl. der Anzeige der Liste aktiver Alarme sind unter Abschnitt 14.3
zu finden.

Weitere Informationen bzgl. der einzelnen Alarme und empfohlener Maßnahmen sind
unter Abschnitt 16.1 zu finden.

2.3 Herstellen einer Verbindung von ProLink II zur
Auswerteelektronik
Durch das Herstellen einer Verbindung mittels ProLink II können Sie Prozessdaten
anzeigen, ProLink II verwenden, um die Auswerteelektronik zu konfigurieren,
wartungstechnische und fehlerbehebende Aufgaben durchführen oder einen
Abfüllvorgang ausführen.

Vorbereitungsverfahren

Folgende Systeme müssen installiert und einsatzbereit sein:

• ProLink II v2.91 oder höher

• ProLink II Installationskit für Modbus/RS-485-Verbindungen

Verfahren

1. Schließen Sie die Kabel des Signalwandlers an die Kabel an, die an den RS-485
angeschlossen sind, oder an die Serviceport-Pins an der Auswerteelektronik.
Weitere Informationen finden Sie im Micro Motion FMT Auswerteelektronik für
Masseabfüllung: Installationsanleitung .

2. Starten Sie ProLink II und wählen Connect > Connect to Device.

3. Geben Sie im Dialogfeld Connection die hier dargestellten Parameter ein und klicken
dann auf Connect.

Verbindungsparameter

Protokoll der Auswerteelektronik

Modbus PROFIBUS-DP

Protocol Modbus RTU Service Port

COM Port Der Port an Ihrem PC, den Sie
für diese Verbindung ver-
wenden

Der Port an Ihrem PC, den Sie
für diese Verbindung ver-
wenden

Schnellstart mittels ProLink II
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Verbindungsparameter

Protokoll der Auswerteelektronik

Modbus PROFIBUS-DP

Address Konfigurierte Modbus-
Adresse der Auswerteelek-
tronik (Voreinstellung = 1)

–

Anmerkung
Die Auswerteelektronik analysiert automatisch die eingehende Verbindungsanfrage und
beantwortet alle Verbindungsanfragen mit einer beliebigen Einstellung für Parität und
Stoppbits und allen Netzwerkgeschwindigkeiten zwischen 1200 und 38.400 Baud. Sie
brauchen keine Werte für diese Verbindungsparameter einrichten.

Zeigt ProLink II den Bildschirm Process Variables bei erfolgreicher Verbindung an.

Benötigen Sie Hilfe?  Falls eine Fehlermeldung angezeigt wird:

• Stellen Sie sicher, dass Sie den korrekten COM-Port angegeben haben.

• Prüfen Sie die gesamte Verkabelung zwischen PC und Auswerteelektronik.

• Setzen Sie an beiden Enden des Segments 1/2-Watt-Abschlusswiderstände mit 120 Ω ein.

2.4 Abschluss der Konfiguration und
Inbetriebnahme
Verwenden Sie das folgende Verfahren als allgemeine Richtlinien, um die Konfiguration
und Inbetriebnahme der Auswerteelektronik abzuschließen.

1. Konfigurieren Sie die Abfüllung.

• Siehe Kapitel 7 bzgl. Abfüllung mit integrierter Ventilsteuerung.

• Siehe Kapitel 10 bzgl. Abfüllung mit externer Ventilsteuerung.

2. Führen Sie alle erforderlichen Konfigurationen der Auswerteelektronik durch, die
sich nicht speziell auf die Abfüllung beziehen.

Siehe Kapitel 11, Kapitel 12 und Kapitel 13.

3. Führen Sie Tests oder Anpassungen Ihres Systems mittels Sensorsimulation durch.

Siehe Abschnitt 3.5.1.

4. Erstellen Sie eine Sicherungskopie der Konfiguration Ihrer Auswerteelektronik in
einer Datei auf Ihrem PC.

Siehe Abschnitt 2.4.2.

Benötigen Sie Hilfe?  Sie können jederzeit die Werkskonfiguration wiederherstellen, um die
Auswerteelektronik in eine bekannte Betriebskonfiguration zu versetzen. Siehe Abschnitt 3.5.2.
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2.4.1 Testen oder Anpassen des Systems mittels
Sensorsimulation
Verwenden Sie Sensor Simulation, um die Reaktion des Systems auf eine Vielzahl von
Prozessbedingungen zu testen. Dazu gehören Grenz-, Problem- und Alarmbedingungen
sowie die Abstimmung des Messkreises.

Vorbereitungsverfahren

Bevor Sie die Sensor Simulation aktivieren, stellen Sie sicher, dass der Prozess die
Auswirkungen der simulierten Prozesswerte tolerieren kann.

Verfahren

1. Navigieren Sie zum Sensorsimulationsmenü.

Kommunikations-Hilfsmittel Menüpfad

ProLink II ProLink > Configuration > Sensor Simulation

ProLink III Device Tools > Diagnostics > Testing > Sensor Simulation

2. Aktivieren Sie die Sensor Simulation.

3. Für Massedurchfluss setzen Sie Wellenform wie gewünscht und geben Sie die
erforderlichen Werte ein.

Option Erforderliche Werte

Fixed Fester Wert

Sawtooth Periode

Minimum

Maximum

Sine Periode

Minimum

Maximum

4. Für Dichte setzen Sie Wellenform wie gewünscht und geben Sie die erforderlichen
Werte ein.

Option Erforderliche Werte

Fixed Fester Wert

Sawtooth Periode

Minimum

Maximum

Sine Periode

Minimum

Maximum

5. Für Temperatur setzen Sie Wellenform wie gewünscht und geben Sie die
erforderlichen Werte ein.

Schnellstart mittels ProLink II

Konfigurations- und Bedienungsanleitung 9



Option Erforderliche Werte

Fixed Fester Wert

Sawtooth Periode

Minimum

Maximum

Sine Periode

Minimum

Maximum

6. Beobachten Sie die Reaktion des Systems auf die simulierten Werte und nehmen Sie
nach Bedarf entsprechende Änderungen an der Konfiguration der
Auswerteelektronik oder am System vor.

7. Modifizieren Sie die simulierten Werte und wiederholen Sie die
Simulationsverfahren.

8. Nachdem Sie alle Test- oder Simulationsverfahren abgeschlossen haben,
deaktivieren Sie die Sensor Simulation.

Sensorsimulation
Mit der Sensorsimulation können Sie das System testen oder den Messkreis einstellen,
ohne die Testbedingungen in Ihrem Prozess erstellen zu müssen. Bei aktivierter
Sensorsimulation gibt die Auswerteelektronik die simulierten Werte für Massedurchfluss,
Dichte und Temperatur aus und ergreift alle erforderlichen Maßnahmen. Beispielsweise
kann die Auswerteelektronik eine Abschaltung durchführen, ein Ereignis aktivieren oder
einen Alarm setzen.

Ist der Simulationsmodus aktiv, werden die simulierten Werte im gleichen Speicher wie die
Prozessdaten vom Sensor abgelegt. Dann werden die simulierten Werte während des
Betriebs der Auswerteelektronik verwendet. Zum Beispie beeinflusst die Simulation:

• Alle Werte wie Massedurchfluss, Temperatur oder Dichte, die auf dem Display
angezeigt oder mittels Ausgängen oder digitaler Kommunikation ausgegeben
werden

• Die Summen- und Gesamtzähler für Masse

• Alle Volumenberechnungen und Daten, inkl. ausgegebener Werte, Volumen-
Summenzähler und Volumen-Gesamtzähler

• Alle im Datenlogger gespeicherten Werte für Masse, Dichte oder Volumen

Die Sensorsimulation ändert keine Diagnosewerte.

Im Gegensatz zu tatsächlichen Massedurchfluss- und Dichtewerten sind die simulierten
Werte nicht temperaturkompensiert (d. h. angepasst an den Temperatureinfluss auf die
Sensormessrohre).

2.4.2 Backup der Auswerteelektronik Konfiguration
ProLink II und ProLink III bieten Upload- und Download-Funktionen für die Konfiguration,
um Konfigurationssätze auf Ihrem PC zu speichern. Dies ermöglicht ein Sichern und
Wiederherstellen der Auswerteelektronik Konfiguration. Außerdem ist dies eine bequeme
Methode, um eine Konfiguration über mehrere Geräte hinweg zu zu reproduzieren.
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Vorbereitungsverfahren

Eine der folgenden Versionen:

• Eine aktive Verbindung von ProLink II

• Eine aktive Verbindung von ProLink III

Einschränkung
Diese Funktion ist mit keinem anderen Kommunikations-Hilfsmittel verfügbar.

Verfahren

• Sichern der Auswerteelektronik Konfiguration mittels ProLink II:

1. File > Load from Xmtr to File auswählen.

2. Einen Namen und einen Speicherort für die Sicherungsdatei auswählen und auf
Save klicken.

3. Die Optionen auswählen, die die Sicherungsdatei enthalten soll, und auf Download
Configuration klicken.

• Backup der Auswerteelektronik Konfiguration mittels ProLink III:

1. Device Tools > Configuration Transfer > Save or Load Configuration Data auswählen.

2. Im Gruppenfeld Configuration die Konfigurationsdaten auswählen, die gesichert
werden sollen.

3. Auf Save klicken und den Dateinamen und den Speicherort auf Ihrem Computer
auswählen.

4. Klicken Sie auf Start Save.

Die Sicherungsdatei wird mit dem ausgewählten Namen und an dem ausgewählten
Speicherort gespeichert. Sie wird als Textdatei gespeichert und kann mittels beliebigem
Text-Editor geöffnet werden.

2.4.3 Werkskonfiguration wiederherstellen

ProLink II ProLink > Configuration > Device > Werkskonfiguration wiederherstellen

ProLink III Geräte Extras > Konfigurationsübertragung > Restore Factory Configuration

Überblick

Das Wiederherstellen der Werkskonfiguration versetzt die Auswerteelektronik in eine
bekannte Betriebskonfiguration. Dies kann hilfreich sein, wenn während der Konfiguration
Probleme auftreten.

Hinweis
Die Wiederherstellung der Werkskonfiguration ist keine Aktion, die häufig durchgeführt werden
sollte. Wenn Sie einen diesbezüglichen Bedarf erkennen, sollten Sie sich an Micro Motion wenden,
um in Erfahrung zu bringen, ob für die Lösung bestimmter Probleme eine bevorzugte Methode
existiert.
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3 Schnellstart mittels Modbus
In diesem Kapitel behandelte Themen:

• Einschalten der Auswerteelektronik

• Status des Durchfluss-Messsystems prüfen

• Einrichten des Modbus Interface Tool (MIT)

• Herstellen einer Modbus Verbindung mit der Auswerteelektronik

• Abschluss der Konfiguration und Inbetriebnahme

3.1 Einschalten der Auswerteelektronik
Die Auswerteelektronik muss für alle Konfigurations- und Inbetriebnahmeaufgaben sowie
für Prozessmessungen eingeschaltet sein.

1. Den entsprechenden Verfahren folgen, um sicherzustellen, dass ein neues im
Netzwerk befindliches Gerät nicht die bestehenden Messungen und Messkreise
stört.

2. Sicherstellen, dass die Kabel an die Auswerteelektronik, wie in Micro Motion FMT
Auswerteelektronik für Masseabfüllung: Installationsanleitung beschrieben,
angeschlossen sind.

3. Stellen Sie sicher, dass alle Auswerteelektronik und Sensor Gehäusedeckel sowie
Verschlüsse geschlossen sind.

VORSICHT!

Sicherstellen, dass alle Gehäusedeckel und Dichtungen dicht verschlossen sind, um eine
Entzündung in einer brennbaren Umgebung zu vermeiden. Bei Installationen in
explosionsgefährdeten Bereichen und mit geöffneten Gehäusedeckeln kann das
Einschalten der Stromversorgung zu einer Explosion führen.

4. Schalten Sie die Spannungsversorgung ein.

Die Auswerteelektronik führt automatisch Diagnoseroutinen durch. In dieser
Zeitspanne ist Alarm 009 aktiv. Die Diagnoseroutinen sind in ungefähr 30 Sekunden
abgeschlossen.

Nachbereitungsverfahren

Obwohl der Sensor bereits kurz nach dem Startvorgang das Prozessmedium verarbeiten
kann, kann die Elektronik bis zu 10 Minuten benötigen, um ein thermisches Gleichgewicht
zu erreichen. Aus diesem Grund kann es bei dem erstmaligen Startvorgang bzw. bei einer
Abschaltung, die so lange gedauert hat, dass die Komponenten die
Umgebungstemperatur annehmen konnten, ungefähr 10 Minuten dauern, bis sich die
Elektronik erwärmt hat und zuverlässige Prozessmessungen liefert. Während dieser
Warmlaufphase kann es sein, dass Sie geringfügige Instabilitäten oder Ungenauigkeiten
der Messung feststellen.
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3.2 Status des Durchfluss-Messsystems prüfen
Das Durchfluss-Messsystem auf jegliche Störbedingungen prüfen, die eine Aktion des
Anwenders erforderlich machen oder die die Messgenauigkeit beeinflussen.

1. Ca. 10 Sekunden warten, bis der Startvorgang abgeschlossen ist.

Sofort nach dem Startvorgang durchläuft die Auswerteelektronik Diagnoseroutinen
und prüft auf Störbedingungen. Während des Startvorgangs ist Alarm A009 aktiv.
Dieser Alarm sollte nach dem Startvorgang automatisch gelöscht werden.

2. Eine Verbindung mit der Auswerteelektronik herstellen und auf aktive Alarme
prüfen.

Nachbereitungsverfahren

Weitere Informationen bzgl. der Anzeige der Liste aktiver Alarme sind unter Abschnitt 14.3
zu finden.

Weitere Informationen bzgl. der einzelnen Alarme und empfohlener Maßnahmen sind
unter Abschnitt 16.1 zu finden.

3.3 Einrichten des Modbus Interface Tool (MIT)
Das Micro Motion Modbus Interface Tool (MIT) ist ein Hilfsmittel, das alle Modbus Speicher
und Register der Auswerteelektronik dokumentiert. Das MIT liefert alle notwendigen
Informationen über Modbus Adressen, Datentypen, Integercodes usw. Zusätzliche
Merkmale ermöglichen die Suche von Speicher und Registern nach Schlüsselwörtern und
bereiten auswerteelektronikspezifische oder merkmalspezifische Listen vor und drucken
diese aus.

Vorbereitungsverfahren

Für MIT ist Microsoft Excel 2007 oder höher erforderlich.

Version 4 oder höher des MIT ist erforderlich, um die Masse Abfüll-Auswerteelektronik zu
unterstützen.

Verfahren

1. Download das Installationspaket für das Modbus Installation Tool von der
Micro Motion Website herunter (www.micromotion.com) oder kopieren Sie es
Micro Motion von der Dokumentations CD.

2. Entpacken Sie das Installationspaket und starten Sie Setup.

3. Starten Sie MIT, weitere Informationen finden Sie in der MIT Betriebsanleitung (die
zusammen mit dem Hilfsmittel installiert wird).

3.4 Herstellen einer Modbus Verbindung mit der
Auswerteelektronik
Durch die Herstellung einer Modbus Verbindung kann ein Modbus Hilfsmittel oder
Programm verwendet werden, um Prozessdaten anzuzeigen, die Auswerteelektronik zu
konfigurieren oder wartungstechnische und fehlerbehebende Aufgaben bzw. einen
Befüllvorgang auszuführen.
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Vorbereitungsverfahren

• Jedes standardmäßige Modbus Programm oder Hilfsmittel

• Eine tatsächliche RS-485 Verbindung an die RS-485 Anschlussklemmen der
Auswerteelektronik

Verfahren

1. Im Modbus Programm die konfigurierte Modbus Adresse eingeben.

Die Standard Modbus Adresse ist 1. Der Bereich geht von 1 bis 127, mit Ausnahme
von 111.

2. Im Modbus Programm andere erforderliche Verbindungsparamater eingeben.

Die Auswerteelektronik akzeptiert alle Modbus Verbindungsanfragen innerhalb der
folgenden Parameterbereiche:

Parameter Bereich

Protokoll Modbus RTU (8 Bit)

Baud Alle Standardraten zwischen 1200 und
38.400

Parität Gerade, ungerade, keine

Stoppbits 1 oder 2

3.5 Abschluss der Konfiguration und
Inbetriebnahme
Verwenden Sie das folgende Verfahren als allgemeine Richtlinien, um die Konfiguration
und Inbetriebnahme der Auswerteelektronik abzuschließen.

1. Konfigurieren Sie die Abfüllung.

• Siehe Kapitel 7 bzgl. Abfüllung mit integrierter Ventilsteuerung.

• Siehe Kapitel 10 bzgl. Abfüllung mit externer Ventilsteuerung.

2. Führen Sie alle erforderlichen Konfigurationen der Auswerteelektronik durch, die
sich nicht speziell auf die Abfüllung beziehen.

Siehe Kapitel 11, Kapitel 12 und Kapitel 13.

3. Führen Sie Tests oder Anpassungen Ihres Systems mittels Sensorsimulation durch.

Siehe Abschnitt 3.5.1.

Benötigen Sie Hilfe?  Sie können jederzeit die Werkskonfiguration wiederherstellen, um die
Auswerteelektronik in eine bekannte Betriebskonfiguration zu versetzen. Siehe Abschnitt 3.5.2.
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3.5.1 Testen oder Anpassen des Systems mittels Modbus und
Sensorsimulation
Verwenden Sie Sensor Simulation, um die Reaktion des Systems auf eine Vielzahl von
Prozessbedingungen zu testen. Dazu gehören Grenz-, Problem- und Alarmbedingungen
sowie die Abstimmung des Messkreises.

Vorbereitungsverfahren

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Auf dem PC muss das Modbus Interface Tool (MIT) installiert sein.

Bevor Sie die Sensor Simulation aktivieren, stellen Sie sicher, dass der Prozess die
Auswirkungen der simulierten Prozesswerte tolerieren kann.

Verfahren

1. Konfigurieren Sie die Simulation für Massedurchfluss.

a. Schreiben Sie den Code für die Wellenform in Register 3171.

b. Wenn Sie Fixed gewählt haben, schreiben Sie den Festwert in die Register
3175–3176.

c. Wenn Sie Sawtooth oder Sine gewählt haben, schreiben Sie die Mindestamplitude
in die Register 3177–3178, die Maximalamplitude in die Register 3179–3180
und die Wellenperiode in die Register 3181–3182.

2. Konfigurieren Sie die Simulation für Temperatur.

a. Schreiben Sie den Code für die Wellenform in Register 3172.

b. Wenn Sie Fixed gewählt haben, schreiben Sie den Festwert in die Register
3183–3184.

c. Wenn Sie Sawtooth oder Sine gewählt haben, schreiben Sie die Mindestamplitude
in die Register 3185–3186, die Maximalamplitude in die Register 3187–3188
und die Wellenperiode in die Register 3189–3190.

3. Konfigurieren Sie die Simulation für Dichte.

a. Schreiben Sie den Code für die Wellenform in Register 3173.

b. Wenn Sie Fixed gewählt haben, schreiben Sie den Festwert in die Register
3191–3192.

c. Wenn Sie Sawtooth oder Sine gewählt haben, schreiben Sie die Mindestamplitude
in die Register 3193–3194, die Maximalamplitude in die Register 3195–3196
und die Wellenperiode in die Register 3197–3198.

4. Schreiben Sie 1 in die Spule 255, um die Sensorsimulation zu aktivieren.

5. Beobachten Sie die Reaktion des Systems auf die simulierten Werte und nehmen Sie
nach Bedarf entsprechende Änderungen an der Konfiguration der
Auswerteelektronik oder am System vor.

6. Modifizieren Sie die simulierten Werte und wiederholen Sie die
Simulationsverfahren.

7. Nachdem Sie alle Test- oder Simulationsverfahren abgeschlossen haben, schreiben
Sie 0 in Speicher 255, um die Sensor Simulation zu deaktivieren

Schnellstart mittels Modbus

Konfigurations- und Bedienungsanleitung 15



Sensorsimulation
Mit der Sensorsimulation können Sie das System testen oder den Messkreis einstellen,
ohne die Testbedingungen in Ihrem Prozess erstellen zu müssen. Bei aktivierter
Sensorsimulation gibt die Auswerteelektronik die simulierten Werte für Massedurchfluss,
Dichte und Temperatur aus und ergreift alle erforderlichen Maßnahmen. Beispielsweise
kann die Auswerteelektronik eine Abschaltung durchführen, ein Ereignis aktivieren oder
einen Alarm setzen.

Ist der Simulationsmodus aktiv, werden die simulierten Werte im gleichen Speicher wie die
Prozessdaten vom Sensor abgelegt. Dann werden die simulierten Werte während des
Betriebs der Auswerteelektronik verwendet. Zum Beispie beeinflusst die Simulation:

• Alle Werte wie Massedurchfluss, Temperatur oder Dichte, die auf dem Display
angezeigt oder mittels Ausgängen oder digitaler Kommunikation ausgegeben
werden

• Die Summen- und Gesamtzähler für Masse

• Alle Volumenberechnungen und Daten, inkl. ausgegebener Werte, Volumen-
Summenzähler und Volumen-Gesamtzähler

• Alle im Datenlogger gespeicherten Werte für Masse, Dichte oder Volumen

Die Sensorsimulation ändert keine Diagnosewerte.

Im Gegensatz zu tatsächlichen Massedurchfluss- und Dichtewerten sind die simulierten
Werte nicht temperaturkompensiert (d. h. angepasst an den Temperatureinfluss auf die
Sensormessrohre).

3.5.2 Wiederherstellen der Werkskonfiguration mittels
Modbus
Das Wiederherstellen der Werkskonfiguration versetzt die Auswerteelektronik in eine
bekannte Betriebskonfiguration. Dies kann hilfreich sein, wenn während der Konfiguration
Probleme auftreten.

Vorbereitungsverfahren

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Verfahren

Schreiben Sie 1 in Spule 247.

Schnellstart mittels Modbus
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Teil II
Konfigurieren und Durchführen von
Abfüllungen mit integrierter
Ventilsteuerung

In diesem Teil enthaltene Kapitel:

• Vorbereiten der Konfiguration einer integrierten Abfüll-Ventilsteuerung

• Konfigurieren einer Abfüllung mit integrierter Ventilsteuerung mittels

• Abfüllvorgang mittels

• Konfigurieren einer integrierten Abfüll-Ventilsteuerung mittels Modbus

• Abfüllvorgang mittels Modus

Konfigurieren und Durchführen von Abfüllungen mit integrierter Ventilsteuerung
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4 Vorbereiten der Konfiguration einer
integrierten Abfüll-Ventilsteuerung
In diesem Kapitel behandelte Themen:

• Allgemeines Verfahren zur Konfiguration und Durchführung einer Abfüllung mit
integrierter Ventilsteuerung

• Tipps und Tricks zum Konfigurieren der Abfüllung mit integrierter
Ventilsteuerung

Vorbereiten der Konfiguration einer integrierten Abfüll-Ventilsteuerung
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4.1 Allgemeines Verfahren zur Konfiguration und
Durchführung einer Abfüllung mit integrierter
Ventilsteuerung

Konfigurieren und Durchführen einer Abfüllung mit integrierter VentilsteuerungAbbildung 4-1:   

Configure fill

Configure fill options

Configure fill control methods

Configure fill reporting methods

Choose fill type

Fill operation methodManual Automatic

Choose operation tool

Run fill

Set up and program host

Run fill

Choose configuration tool

4.2 Tipps und Tricks zum Konfigurieren der
Abfüllung mit integrierter Ventilsteuerung
Folgende Einstellungen überprüfen, bevor mit der Füllkonfiguration begonnen wird:

Vorbereiten der Konfiguration einer integrierten Abfüll-Ventilsteuerung
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• Zur Konfiguration einer Abfüllung mit den werksseitigen Standardeinstellungen
beginnen. Andernfalls können bestimmte Parameterkombinationen von der
Auswerteelektronik abgelehnt werden. Siehe Abschnitt 4.2.1.

• Die Einstellungen für Mass Flow Cutoff oder Volume Flow Cutoff sind für die
Abfüllgenauigkeit wichtig. Sicherstellen, dass die entsprechende Abschaltung vor
dem Beginn einer Abfüllung oder vor dem Durchführen einer AOC-Kalibrierung
eingestellt ist. Siehe Abschnitt 11.2.3, wenn Masse zur Messung der Abfüllung
verwendet wird. Siehe Abschnitt 11.3.2, wenn Volumen zur Messung der Abfüllung
verwendet wird.

• Die Einstellung von Flow Direction regelt, wie die Gesamt-Abfüllmenge gemessen
wird. Siehe Auswirkung der Durchflussrichtung auf die Gesamtbefüllung bzgl. der
Abfüllung mit integrierter Ventilsteuerung.

• Die Messung der Abfüllmenge und der Betrieb können durch andere Parameter der
Auswerteelektronik beeinflusst werden. Allgemeine Informationen zur
Konfiguration können unter Kapitel 11, Kapitel 12 und Kapitel 13 eingesehen werden.

• Die Konfiguration der Abfüllung oder die allgemeine Konfiguration der
Auswerteelektronik kann während einer Abfüllung verändert werden. Die Änderung
der Konfiguration wird aktiv, sobald die Abfüllung beendet ist.

4.2.1 Werkseinstellungen für grundlegende
Befüllungsparameter
Zur Konfiguration einer Befüllung beginnen Sie mit den hier aufgeführten
Werkseinstellungen. Andernfalls können bestimmte Parameterkombinationen von der
Auswerteelektronik abgelehnt werden.

Grundlegende Befüllungsparameter und WerkseinstellungenTabelle 4-1:   

Parameter Werkseinstellung

Option Befüllung aktiv Aktiviert

Doppelbefüllung aktiv Deaktiviert

AOC aktiv Aktiviert

Spülung aktiv Deaktiviert

Enable Timed Fill Deaktiviert

Befüllart Einstufig binär

Hochzählen Aktiviert

Konfiguration % Sollwert

Vorbereiten der Konfiguration einer integrierten Abfüll-Ventilsteuerung
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5 Konfigurieren einer Abfüllung mit
integrierter Ventilsteuerung mittels
In diesem Kapitel behandelte Themen:

• Konfigurieren einer Abfüllung mit integrierter Ventilsteuerung mittels ProLink II

• Konfigurieren von Abfülloptionen mittels ProLink II

• Konfigurieren einer Abfüllsteuerung mittels ProLink II (optional)

• Konfigurieren der Abfüllprotokollierung mittels ProLink II (optional)

5.1 Konfigurieren einer Abfüllung mit integrierter
Ventilsteuerung mittels ProLink II
Die Befüllungsart entsprechend der Anwendung konfigurieren.

Hinweis
Eine einstufige Binärbefüllung eignet sich für die meisten Anwendungen. Diese Befüllungsart
verwenden, soweit keine speziellen Anforderungen für andere Befüllungsarten bestehen. In den
meisten Fällen ist die Auswerteelektronik werksseitig für einstufige Binärbefüllungen konfiguriert
und mit einem Minimum an Konfigurationsanpassungen vor Ort einsatzbereit.

5.1.1 Konfigurieren einer einstufigen Abfüllung mittels
ProLink II
Eine einstufige Binärbefüllung konfigurieren, wenn ein einzelner Behälter von einem
einzelnen Ventil befüllt werden soll. Das Ventil ist solange geöffnet, bis der Befüllungssollwert
erreicht ist.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Wählen Sie ProLink > Configuration (Konfiguration) > Discrete Output (Binärausgang).
b. Setzen Sie Precision DO1 auf Primary Valve.

c. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Konfigurieren einer Abfüllung mit integrierter Ventilsteuerung mittels
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Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Öffnen Sie das Fenster Flow (Durchfluss).

b. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

c. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

d. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

e. Die anderen Durchflussoptionen wie gewünscht einstellen.

Konfigurieren einer Abfüllung mit integrierter Ventilsteuerung mittels
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Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

3. Öffnen Sie das Fenster Filling (Abfüllung).

4. Flow Source (Durchflussquelle) auf die Prozessvariable einstellen, die zur
Befüllungsmessung verwendet werden soll.

Option Beschreibung

Massedurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Massedurchfluss

Volumendurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Volumendurchfluss

5. Folgende Parameter einstellen oder überprüfen:

Parameter Einstellung

Befüllungsoption aktivieren Aktiviert

Doppelbefüllung aktiv Deaktiviert

AOC aktiv Aktiviert

Spülung aktiv Deaktiviert

Enable Timed Fill Deaktiviert

Befüllart Einstufig binär

Hinweis
Micro Motion empfiehlt dringendst die Verwendung der automatischen
Überfüllkompensation (AOC). AOC verbessert, sofern aktiviert und kalibriert, die
Befüllgenauigkeit und Reproduzierbarkeit.

6. Count Up (Hochzählen) wie gewünscht einstellen.

Count Up (Hochzählen) steuert, wie der Befüllzähler rechnet und angezeigt wird.

Option Beschreibung

Enabled (Aktiviert) Der Abfüllzähler beginnt bei 0 und zählt bis zu Fill Target (Befüllungssoll)
hoch.

Disabled (Deaktiviert) Der Abfüllzähler beginnt bei Fill Target und zählt bis 0 herunter.

7. Fill Target (Befüllungssoll) auf die Menge einstellen, bei der der Befüllungsvorgang
abgeschlossen ist.

Den Wert in den Messeinheiten für Flow Source (Durchflussquelle) konfigurierten
Wert eingeben.

8. Max Fill Time (Maximale Befüllungszeit) auf die Anzahl von Sekunden einstellen, bei
der die Befüllungszeit überschritten wird.

Konfigurieren einer Abfüllung mit integrierter Ventilsteuerung mittels
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Kann die Befüllung vor Ablauf dieser Zeit nicht abgeschlossen werden, wird die
Befüllung verworfen und Fehlernachrichten werden wegen
Befüllungszeitüberschreitung angezeigt.

Max Fill Time (Maximale Befüllungszeit) auf 0 einstellen, um die
Befüllungszeitüberschreitungsfunktion zu deaktivieren.

Der Standardwert für Max Fill Time (Maximale Befüllungszeit) ist 0 (deaktiviert). Der
Bereich liegt bei 0 Sekunden bis 800 Sekunden.

9. Measured Fill Time (Gemessene Befüllungszeit) wie gewünscht einstellen.

Measured Fill Time (Gemessene Befüllungszeit) steuert, wie die Befüllungszeit
gemessen wird.

Option Beschreibung

Durchfluss stoppt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik erkennt, dass
der Durchfluss nach dem Schließen des Ventils stoppt.

Ventil schließt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik den Binäraus-
gang nach Bedarf einstellt, um das Ventil zu schließen.

Nachbereitungsverfahren

Optionen für einstufige Abfüllungen sind:

• Automatische Überfüllkompensation (AOC) konfigurieren. Wenn die automatische
Überfüllkompensation aktiviert ist, sicherstellen, dass AOC für die entsprechende
Anwendung ordnungsgemäß konfiguriert und kalibriert ist.

• Implementieren der Spülfunktion.

• Implementieren der Pumpfunktion.

5.1.2 Konfigurieren einer zweistufigen Abfüllung mittels
ProLink II
Eine zweistufige Binärbefüllung konfigurieren, wenn ein einzelner Behälter von zwei
Ventilen befüllt werden soll.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Öffnen Sie das Fenster Discrete Output (Binärausgang).

b. Setzen Sie Precision DO1 auf Primary Valve.

c. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Konfigurieren einer Abfüllung mit integrierter Ventilsteuerung mittels
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Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

d. Setzen Sie Precision DO2 auf Secondary Valve.

e. Stellen Sie Precision DO2 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Öffnen Sie das Fenster Flow (Durchfluss).

b. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.
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Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

c. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

d. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

e. Die anderen Durchflussoptionen wie gewünscht einstellen.

Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

3. Öffnen Sie das Fenster Filling (Abfüllung).

4. Flow Source (Durchflussquelle) auf die Prozessvariable einstellen, die zur
Befüllungsmessung verwendet werden soll.

Option Beschreibung

Massedurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Massedurchfluss

Volumendurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Volumendurchfluss

5. Folgende Parameter einstellen oder überprüfen:

Parameter Einstellung

Befüllungsoption aktivieren Aktiviert

Doppelbefüllung aktiv Deaktiviert

AOC aktivieren Aktiviert

Spülung aktiv Deaktiviert

Enable Timed Fill Deaktiviert

Befüllungsart Zweistufig binär

Hinweis
Micro Motion empfiehlt dringendst die Verwendung der automatischen
Überfüllkompensation (AOC). AOC verbessert, sofern aktiviert und kalibriert, die
Befüllgenauigkeit und Reproduzierbarkeit.

6. Count Up (Hochzählen) wie gewünscht einstellen.

Count Up (Hochzählen) steuert, wie der Befüllzähler rechnet und angezeigt wird.
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Option Beschreibung

Enabled (Aktiviert) Der Abfüllzähler beginnt bei 0 und zählt bis zu Fill Target (Befüllungssoll)
hoch.

Disabled (Deaktiviert) Der Abfüllzähler beginnt bei Fill Target und zählt bis 0 herunter.

7. Configure By (Konfigurieren von) wie gewünscht einstellen.

Configure By (Konfigurieren von) steuert, wie die Ventilsteuerzeit konfiguriert ist.

Option Beschreibung

% Sol-
lwert

Die Ventilöffnungs- und schließzeit wird als Prozentsatz von Fill Target (Befüllungs-
soll) konfiguriert. Zum Beispiel:
• Ventil öffnet = 0 %: Das Ventil öffnet, wenn die aktuelle Befüllunssumme 0 %

von Fill Target (Befüllungssoll) beträgt.
• Ventil schließt = 90 %: Das Ventil schließt, wenn die aktuelle Befüllungs-

summe 90 % von Fill Target (Befüllungssoll) beträgt.

Menge Die Ventilöffnungs- und schließzeiten werden zusammen mit der konfigurierten
Messeinheit konfiguriert. Zum Beispiel:
• Ventil öffnet = 0 g: Das Ventil öffnet, wenn die aktuelle Befüllungssumme 0 g

beträgt.
• Ventil schließt = 50 g: Das Ventil schließt, wenn die aktuelle Befüllungs-

summe 50 g weniger als Fill Target (Befüllungssoll) beträgt.

8. Fill Target (Befüllungssoll) auf die Menge einstellen, bei der der Befüllungsvorgang
abgeschlossen ist.

Den Wert in den Messeinheiten für Flow Source (Durchflussquelle) konfigurierten
Wert eingeben.

9. Max Fill Time (Maximale Befüllungszeit) auf die Anzahl von Sekunden einstellen, bei
der die Befüllungszeit überschritten wird.

Kann die Befüllung vor Ablauf dieser Zeit nicht abgeschlossen werden, wird die
Befüllung verworfen und Fehlernachrichten werden wegen
Befüllungszeitüberschreitung angezeigt.

Max Fill Time (Maximale Befüllungszeit) auf 0 einstellen, um die
Befüllungszeitüberschreitungsfunktion zu deaktivieren.

Der Standardwert für Max Fill Time (Maximale Befüllungszeit) ist 0 (deaktiviert). Der
Bereich liegt bei 0 Sekunden bis 800 Sekunden.

10. Measured Fill Time (Gemessene Befüllungszeit) wie gewünscht einstellen.

Measured Fill Time (Gemessene Befüllungszeit) steuert, wie die Befüllungszeit
gemessen wird.

Option Beschreibung

Durchfluss stoppt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik erkennt, dass
der Durchfluss nach dem Schließen des Ventils stoppt.

Ventil schließt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik den Binäraus-
gang nach Bedarf einstellt, um das Ventil zu schließen.

11. Open Primary (Primär öffnen), Open Secondary (Sekundär öffnen), Close Primary (Primär
schließen) und Close Secondary (Sekundär schließen) wie gewünscht einstellen.

Konfigurieren einer Abfüllung mit integrierter Ventilsteuerung mittels
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Diese Werte steuern den Zeitpunkt in der Befüllung, bei dem die primären und
sekundären Ventile öffnen und schließen. Entweder werden sie durch die Menge
oder den Prozentsatz des Sollwertes, wie durch den Configure By (Konfiguriert durch)
Parameter gesteuert, konfiguriert.

Entweder muss Open Primary (Primär öffnen) oder Open Secondary (Sekundär öffnen)
so eingestellt werden, dass sie zu Befüllungsbeginn öffnen. Sofern dies gewünscht
wird, können beide zu Befüllungsbeginn öffnen. Wird ein Wert so eingestellt, dass er
später öffnet, wird der andere automatisch so eingestellt, dass er zu
Befüllungsbeginn öffnet.

Entweder muss Close Primary (Primär schließen) oder Close Secondary (Sekundär
schließen) auf Schließen bei Befüllungsende eingestellt werden. Sofern dies
gewünscht wird, können beide bei Befüllungsende schließen. Wird ein Wert so
eingestellt, dass er früher schließt, wird der andere automatisch so eingestellt, dass
er bei Befüllungsende schließt.

Nachbereitungsverfahren

Optionen für zweistufige Abfüllungen sind:

• Automatische Überfüllkompensation (AOC) konfigurieren. Wenn die automatische
Überfüllkompensation aktiviert ist, sicherstellen, dass AOC für die entsprechende
Anwendung ordnungsgemäß konfiguriert und kalibriert ist.

• Implementieren der Spülfunktion.

Ventilöffnungs- und Schließsequenzen für zweistufige
diskrete Abfüllungen
Die folgenden Abbildungen zeigen das Öffnen und Schließen der Sekundärventile,
gesteuert durch die Konfiguration von Primär öffnen, Sekundär öffnen, Primär schließen und
Sekundär schließen.

Diese Abbildungen setzen voraus, dass die Abfüllung von Anfang bis Ende ohne
Unterbrechungen läuft.

Zuerst Primär öffnen, zuerst Primär schließenAbbildung 7-1:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Primary

Target 
(AOC adjusted)

T1 T2
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Zuerst Primär öffnen, zuerst Sekundär schließenAbbildung 7-2:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

T1 T2

Zuerst Sekundär öffnen, zuerst Primär schließenAbbildung 7-3:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Primary

Target 
(AOC adjusted)

T1 T2

Zuerst Sekundär öffnen, zuerst Sekundär schließenAbbildung 7-4:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Secondary

Target 
(AOC adjusted)

T1 T2

Einfluss von Configure By (Konfigurieren durch) auf das Öffnen
und Schließen des Ventils
Configure By (Konfigurieren durch) steuert, wie die Werte für Open Primary (Primär öffnen),
Open Secondary Sekundär öffnen), Close Primary (Primär schließen) und Close Secondary
(Sekundär schließen) konfiguriert und angewendet werden.

• Wenn Configure By(Konfiguriert durch) = % Target (Sollwert), addiert die
Auswerteelektronik die konfigurierten Werte für „Valve Open“ (Ventil geöffnet) und
„Valve Close“ (Ventil geschlossen) zu 0 %.

• Wenn Configure By (Konfiguriert durch) = Quantity (Menge), addiert die
Auswerteelektronik die konfigurierten Werte für „Valve Open“ (Ventil geöffnet) zu
0, und subtrahiert die konfigurierten Werte für „Valve Close“ (Ventil geschlossen)
von Fill Target (Befüllungssollwert).
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Beispiel: Configure By (Konfiguriert durch) und Befehle zum Öffnen/Schließen des
Ventils

Fill Target (Befüllungssollwert) = 200 g. Das Primärventil soll zu Beginn des
Befüllungsvorgangs öffnen und am Ende des Befüllungsvorgangs schließen. Das
Sekundärventil soll öffnen, nachdem 10 g abgefüllt wurden und wieder schließen,
nachdem 190 g abgefüllt wurden. Siehe Tabelle 7-1 bzgl. der erforderlichen Einstellungen,
die dieses Ergebnis bewirken.

Configure By (Konfiguriert durch) und Ventilkonfiguration Tabelle 7-1:   

Configure By (Konfiguriert durch)
Werte für „Valve Open“ (Ventil geöffnet) und „Valve
Close“ (Ventil geschlossen)

% Sollwert • Open Primary (Primär öffnen) = 0 %
• Open Secondary (Sekundär öffnen) = 5 %
• Close Secondary (Sekundär schließen) = 95 %
• Close Primary (Primär schließen) = 100 %

Menge • Open Primary (Primär öffnen) = 0 g
• Open Secondary (Sekundär öffnen) = 10 g
• Close Secondary (Sekundär schließen) = 10 g
• Close Primary (Primär schließen) = 0 g

5.1.3 Konfigurieren einer zeitgesteuerten Abfüllung mittels
ProLink II
Eine zeitgesteuerte Befüllung konfigurieren, wenn ein einzelner Behälter von einem
einzelnen Ventil befüllt werden soll. Der Ventil ist für eine bestimmte Anzahl von Sekunden
geöffnet.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Wählen Sie ProLink > Configuration (Konfiguration) > Discrete Output (Binärausgang).
b. Setzen Sie Precision DO1 auf Primary Valve.

c. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC
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Option
Signal von der Auswertee-
lektronik Spannung

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Öffnen Sie das Fenster Flow (Durchfluss).

b. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

c. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

d. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

e. Die anderen Durchflussoptionen wie gewünscht einstellen.

Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

3. Folgende Parameter einstellen oder überprüfen:
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Parameter Einstellung

Befüllungsoption aktivieren Aktiviert

Hochzählen Aktiviert

Doppelbefüllung aktiv Deaktiviert

AOC aktivieren Deaktiviert

Spülung aktivieren Deaktiviert

Zeitgesteuerte Befüllung aktivieren Aktiviert

Befüllungsart Einstufig binär

4. Target Time (Sollwertzeit) auf die Anzahl von Sekunden einstellen, die der
Befüllungsvorgang dauern wird.

Nachbereitungsverfahren

Die folgende Option ist für zeitgesteuerte Abfüllungen verfügbar:

• Implementieren der Spülfunktion.

5.1.4 Konfigurieren einer Abfüllung mit doppeltem Füllkopf
mittels ProLink II
Eine Befüllung mit doppeltem Füllkopf konfigurieren, wenn zwei Behälter abwechselnd
von doppelten Füllköpfen befüllt werden sollen. Jedes Ventil ist solange geöffnet, bis der
Befüllungssollwert erreicht ist.

Wichtig
Das konfigurierte Fill Target (Befüllungssoll) wird auf beide Befüllungsköpfe angewendet.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Wählen Sie ProLink > Configuration (Konfiguration) > Discrete Output (Binärausgang).
b. Setzen Sie Precision DO1 auf Primary Valve.

c. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Konfigurieren einer Abfüllung mit integrierter Ventilsteuerung mittels

32  Micro Motion® Masse Abfüll-Auswerteelektronik mit Modbus



Option
Signal von der Auswertee-
lektronik Spannung

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

d. Setzen Sie Precision DO2 auf Secondary Valve.

e. Stellen Sie Precision DO2 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Öffnen Sie das Fenster Flow (Durchfluss).

b. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.
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c. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

d. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

e. Die anderen Durchflussoptionen wie gewünscht einstellen.

Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

3. Öffnen Sie das Fenster Filling (Abfüllung).

4. Flow Source (Durchflussquelle) auf die Prozessvariable einstellen, die zur
Befüllungsmessung verwendet werden soll.

Option Beschreibung

Massedurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Massedurchfluss

Volumendurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Volumendurchfluss

5. Folgende Parameter einstellen oder überprüfen:

Parameter Einstellung

Befüllungsoption aktivieren Aktiviert

Hochzählen Aktiviert

Doppelbefüllung aktivieren Aktiviert

AOC aktivieren Aktiviert

Spülung aktiv Deaktiviert

Enable Timed Fill Deaktiviert

Befüllart Einstufig binär

Hinweis
Micro Motion empfiehlt dringendst die Verwendung der automatischen
Überfüllkompensation (AOC). AOC verbessert, sofern aktiviert und kalibriert, die
Befüllgenauigkeit und Reproduzierbarkeit.

6. Fill Target (Befüllungssoll) auf die Menge einstellen, bei der der Befüllungsvorgang
abgeschlossen ist.

Anmerkung
Das konfigurierte Fill Target (Befüllungssoll) wird auf beide Befüllungsköpfe angewendet.
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7. Max Fill Time (Maximale Befüllungszeit) auf die Anzahl von Sekunden einstellen, bei
der die Befüllungszeit überschritten wird.

Kann die Befüllung vor Ablauf dieser Zeit nicht abgeschlossen werden, wird die
Befüllung verworfen und Fehlernachrichten werden wegen
Befüllungszeitüberschreitung angezeigt.

Max Fill Time (Maximale Befüllungszeit) auf 0 einstellen, um die
Befüllungszeitüberschreitungsfunktion zu deaktivieren.

Der Standardwert für Max Fill Time (Maximale Befüllungszeit) ist 0 (deaktiviert). Der
Bereich liegt bei 0 Sekunden bis 800 Sekunden.

8. Measured Fill Time (Gemessene Befüllungszeit) wie gewünscht einstellen.

Measured Fill Time (Gemessene Befüllungszeit) steuert, wie die Befüllungszeit
gemessen wird.

Option Beschreibung

Durchfluss stoppt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik erkennt, dass
der Durchfluss nach dem Schließen des Ventils stoppt.

Ventil schließt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik den Binäraus-
gang nach Bedarf einstellt, um das Ventil zu schließen.

Nachbereitungsverfahren

Optionen für Abfüllungen mit doppeltem Füllkopf sind:

• Automatische Überfüllkompensation (AOC) konfigurieren. Wenn die automatische
Überfüllkompensation aktiviert ist, sicherstellen, dass AOC für die entsprechende
Anwendung ordnungsgemäß konfiguriert und kalibriert ist.

5.1.5 Konfigurieren einer zeitgesteuerten Abfüllung mit
doppeltem Füllkopf mittels ProLink II
Eine zeitgesteuerte Befüllung mit doppeltem Füllkopf konfigurieren, wenn zwei Behälter
abwechselnd von doppelten Füllköpfen befüllt werden sollen. Jedes Ventil ist für eine
bestimmte Anzahl von Sekunden geöffnet.

Wichtig
Die konfigurierte Target Time (Sollwertzeit) wird auf beide Befüllungsköpfe angewendet.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Wählen Sie ProLink > Configuration (Konfiguration) > Discrete Output (Binärausgang).
b. Setzen Sie Precision DO1 auf Primary Valve.

c. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.
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Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

d. Setzen Sie Precision DO2 auf Secondary Valve.

e. Stellen Sie Precision DO2 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Öffnen Sie das Fenster Flow (Durchfluss).

b. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.
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Option Beschreibung

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

c. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

d. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

e. Die anderen Durchflussoptionen wie gewünscht einstellen.

Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

3. Öffnen Sie das Fenster Filling (Abfüllung).

4. Flow Source (Durchflussquelle) auf die Prozessvariable einstellen, die zur
Befüllungsmessung verwendet werden soll.

Option Beschreibung

Massedurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Massedurchfluss

Volumendurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Volumendurchfluss

5. Folgende Parameter einstellen oder überprüfen:

Parameter Einstellung

Befüllungsoption aktivieren Aktiviert

Hochzählen Aktiviert

Doppelbefüllung aktivieren Aktiviert

AOC aktivieren Deaktiviert

Spülung aktivieren Deaktiviert

Zeitgesteuerte Befüllung aktivieren Aktiviert
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Parameter Einstellung

Befüllungsart Einstufig binär

6. Target Time (Sollwertzeit) auf die Anzahl von Sekunden einstellen, die der
Befüllungsvorgang dauern wird.

Anmerkung
Die konfigurierte Target Time (Sollwertzeit) wird auf beide Befüllungsköpfe angewendet.

5.2 Konfigurieren von Abfülloptionen mittels
ProLink II
Je nach Befüllungsart kann die automatische Überfüllkompensation (AOC), die Spül- oder
die Pumpenfunktion konfiguriert und angewendet werden.

5.2.1 Konfigurieren und Implementieren der automatischen
Überfüllkompensation (AOC) mittels ProLink II
Die automatische Überfüllkompensation (AOC) wird verwendet, um die Abfüllzeit
anzupassen und um für die Zeit zu kompensieren, die benötigt wird, den Befehl zum
Schließen des Ventils zu übertragen bzw. damit das Ventil vollständig schließt.

Vorbereitungsverfahren

Vor Einrichtung der AOC stellen Sie sicher, dass alle anderen Abfüllparameter richtig
konfiguriert sind.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Wählen Sie ProLink > Configuration (Konfiguration) > Temperature (Temperatur).
2. Wählen Sie die Art der zu implementierenden AOC.

Option Beschreibung

Fixed Das Ventil schließt an dem Punkt, der durch Fill Target minus der Menge, die in Fixed
Overshoot Comp eingegeben ist, definiert wird. Verwenden Sie diese Option nur
dann, wenn der Wert für die „Frühwarnung“ bereits bekannt ist.

Overfill Definiert die Richtung, aus der der AOC-Algorithmus sich der Sollmenge nähert.
Der AOC-Algorithmus beginnt mit der Schätzung eines Überfüllungswerts und re-
duziert dann die Überfüllung in aufeinanderfolgenden Kalibrierabfüllungen.

Underfill Definiert die Richtung, aus der der AOC-Algorithmus sich der Sollmenge nähert.
Der AOC-Algorithmus beginnt mit der Schätzung eines Unterfüllungswerts und re-
duziert dann die Unterfüllung in aufeinanderfolgenden Kalibrierabfüllungen.
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Hinweis
Die Option Fixed wird normalerweise nicht verwendet. Wenn Sie Fixed wählen, funktioniert die
Auswerteelektronik als Legacy-Batchsteuerung. In typischen Einsatzbereichen bieten die
anderen AOC-Optionen bessere Genauigkeit und Wiederholbarkeit.

Einschränkung
Die Optionen Fixed und Overfill werden für Abfüllungen mit doppeltem Füllkopf nicht
unterstützt.

3. Implementierung der Fixed AOC:

a. Deaktivieren Sie Enable AOC.

b. Setzen Sie AOC Algorithm auf Fixed.

c. Stellen Sie Fixed Overshoot Comp nach Wunsch ein.

Die Voreinstellung ist 0 und wird in Prozesseinheiten gemessen.

Die Auswerteelektronik schließt das Ventil, wenn der aktuelle Abfüllzähler gleich
dem Fill Target minus dem angegebenen Wert (in Prozesseinheiten) ist.

4. So implementieren Sie Overfill oder Underfill:

a. Stellen Sie sicher, dass Enable AOC aktiviert ist.

b. Setzen Sie AOC Algorithm auf Underfill oder Overfill.
c. Stellen Sie AOC Window Length auf die Anzahl der Abfüllungen ein, die zur AOC-

Kalibrierung verwendet wird.

Die Voreinstellung ist 10. Der Auswahlbereich ist 2 bis 32.

Hinweis
Micro Motion empfiehlt die Verwendung des Standardwerts, es sei denn, Sie haben
besondere Anwendungsanforderungen.

Wichtig
Ändern Sie die Werte für AOC Change Limit oder AOC Convergence Rate nur auf Anweisung des
Kundendienstes von Micro Motion. Diese Parameter werden verwendet, um die Funktion des
AOC-Algorithmus für besondere Anwendungsanforderungen einzustellen.

Nachbereitungsverfahren

Wenn Sie AOC Algorithm auf Overfill oder Underfill setzen, müssen Sie eine AOC-Kalibrierung
durchführen.

Durchführen einer AOC-Kalibrierung mittels ProLink II
Die AOC-Kalibrierung wird verwendet, um den Wert für die automatische
Überfüllkompensation (Automatic Overshoot Compensation, AOC) anhand der Ist-
Abfülldaten zu berechnen. Wenn Sie AOC Algorithm auf Overfill oder Underfill setzen, müssen
Sie eine AOC-Kalibrierung durchführen.

Es gibt zwei Arten der AOC-Kalibrierung:
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• Standard: Die Kalibrierung wird manuell durchgeführt. Der AOC-Koeffizient wird
anhand von Abfülldaten berechnet, die bei dieser Kalibrierung eingeholt werden,
und derselbe AOC-Koeffizient wird solange angewandt, bis die Kalibrierung
wiederholt wird.

• Rolling: Die Kalibrierung wird kontinuierlich und automatisch durchgeführt, und der
AOC-Koeffizient wird kontinuierlich - auf Basis von Abfülldaten des letzten
Abfüllvorgangs - aktualisiert.

Hinweis
Für stabile Prozesse empfiehlt Micro Motion die AOC-Standardkalibrierung. Testen Sie nach Bedarf
beide Methoden und wählen Sie die Methode, mit der Sie die besten Ergebnisse erzielen.

Durchführen einer AOC-Standardkalibrierung

Standard AOC Calibration wird verwendet, um einen konstanten AOC-Koeffizienten zu
erzeugen.

Vorbereitungsverfahren

AOC Window Length muss entsprechend gesetzt werden. Micro Motion empfiehlt die
Verwendung des Standardwerts (10), es sei denn, Sie haben besondere
Anwendungsanforderungen.

Mass Flow Cutoff bzw. Volume Flow Cutoff müssen entsprechend der Betriebsumgebung
gesetzt werden.

• Wenn Flow Source auf Mass Flow Rate gesetzt ist, siehe Abschnitt 11.2.3.

• Wenn Flow Source auf Volume Flow Rate gesetzt ist, siehe Abschnitt 11.3.2.

Ihr System muss zum Abfüllen bereit sein, und Sie müssen wissen, wie Abfüllvorgänge
ausgeführt werden.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Wählen Sie ProLink > Run Filler.
2. Kalibrierung des Primärventils (alle Befüllarten):

a. Klicken Sie auf Start AOC Cal.
b. Führen Sie zwischen zwei und der in AOC Window Length angegebenen Anzahl von

Kalibrierabfüllungen aus.

Anmerkung
Sie können nach Wahl auch mehr Kalibrierabfüllungen durchführen. Der AOC-Koeffizient
wird anhand der letzten Abfüllungen berechnet.

Hinweis
Normalerweise werden, aufgrund der werksseitigen Standardeinstellungen, die ersten
Abfüllungen leicht über- oder unterfüllt. Im Laufe der Kalibrierung werden diese
Abfüllungen auf dem Fill Target konvergieren.

c. Wenn die Abfüllzähler kontinuierlich zufriedenstellend sind, klicken Sie auf Save
AOC Cal.
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3. Kalibrierung des Sekundärventils (Abfüllungen mit doppeltem Füllkopf):

a. Klicken Sie auf Start Secondary AOC Cal.
b. Führen Sie zwischen zwei und der in AOC Window Length angegebenen Anzahl von

Kalibrierabfüllungen aus.

Die Auswerteelektronik führt die Abfüllungen automatisch durch das
Sekundärventil durch.

Anmerkung
Sie können nach Wahl auch mehr Kalibrierabfüllungen durchführen. Der AOC-Koeffizient
wird anhand der letzten Abfüllungen berechnet.

Hinweis
Normalerweise werden, aufgrund der werksseitigen Standardeinstellungen, die ersten
Abfüllungen leicht über- oder unterfüllt. Im Laufe der Kalibrierung werden diese
Abfüllungen auf dem Fill Target konvergieren.

c. Wenn die Abfüllzähler kontinuierlich zufriedenstellend sind, klicken Sie auf Save
Secondary AOC Cal.

Der aktuelle AOC-Koeffizient wird im Fenster Run Filler angezeigt. Falls Sie eine Abfüllung
mit doppeltem Füllkopf durchführen, zeigt das Fenster Run Filler den AOC-Koeffizienten
für das Primär- und für das Sekundärventil an. Diese Koeffizienten werden solange auf die
Abfüllvorgänge angewandt, wie AOC aktiviert ist.

Anmerkung
Bei zweistufigen Abfüllungen wird der AOC-Wert auf das Ventil angewandt, das sich schließt,
nachdem die Sollmenge erreicht ist. Falls die Abfüllparameter so eingestellt sind, dass sich beide
Ventile nach Erreichen der Sollmenge schließen, wird der AOC-Koeffizient auf beide Ventile
angewandt.

Hinweis
Micro Motion empfiehlt eine Wiederholung der AOC-Kalibierung, falls einer der folgenden Zustände
eintritt:

• Wenn Geräte ausgetauscht oder eingestellt wurden.

• Wenn sich die Durchflussmenge bedeutend geändert hat.

• Wenn die Abfüllgenauigkeit niedriger als erwartet ist.

• Wenn Mass Flow Cutoff oder Volume Flow Cutoff geändert wurden.

Einrichten einer kontinuierlichen AOC-Kalibrierung

Rolling AOC Calibration wird verwendet, um den AOC-Koeffizienten kontinuierlich - auf
Basis von Abfülldaten des letzten Abfüllvorgangs - zu aktualisieren.

Vorbereitungsverfahren

AOC Window Length muss entsprechend gesetzt werden. Micro Motion empfiehlt die
Verwendung des Standardwerts (10), es sei denn, Sie haben besondere
Anwendungsanforderungen.

Ihr System muss zum Abfüllen bereit sein, und Sie müssen wissen, wie Abfüllvorgänge
ausgeführt werden.
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ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Wählen Sie ProLink > Run Filler.
2. Zur Kalibrierung des Primärventils (alle Abfüllarten) klicken Sie auf Start AOC Cal: Zur

Kalibrierung des Sekundärventils (Abfüllungen mit doppeltem Füllkopf) klicken Sie
auf Start Secondary AOC Cal.

Sie können die kontinuierliche AOC-Kalibrierung für ein oder beide Ventile
einrichten.

3. Starten Sie die Serienabfüllung.

Die Auswerteelektronik berechnet den/die AOC-Koeffizienten nach jeder Abfüllung
anhand der letzten xAbfüllungen neu, wobei x die in AOC Window Length festgelegte Anzahl
ist. Die aktuellen Werte werden im Fenster Run Filler angezeigt. Falls sich die Konfiguration
oder die Prozessbedingungen geändert haben, gleicht die kontinuierliche AOC-
Kalibrierung diese Änderungen aus. Diese Einstellung findet jedoch über mehrere
Abfüllungen hinweg statt, das heißt, dass es einige Abfüllvorgänge dauern wird, ehe AOC
die Werte angepasst hat.

Hinweis
Während die AOC-Kalibrierung läuft, auf Save AOC Cal (AOC-Kal. speichern) oder Save Secondary AOC
Cal (Sekundär-AOC-Kal. speichern) klicken. Der aktuelle AOC-Koeffizient wird gespeichert und auf
alle nachfolgenden Abfüllungen durch das entsprechende Ventil angewandt. Mit anderen Worten
ändert diese Aktion die AOC-Kalibriermethode für dieses Ventil von Rolling auf Standard.

5.2.2 Konfigurieren der Spülfunktion mittels ProLink II
Die Spülfunktion wird verwendet, um ein Hilfsventil zu steuern, das nicht für die Abfüllung
eingesetzt wird. Beispielsweise kann damit ein Behälter mit Wasser oder Gas aufgefüllt
werden, nachdem der Füllvorgang abgeschlossen ist, oder sie kann als “ Dämpfung
dienen.” Der Durchfluss durch das Hilfsventil wird von der Auswerteelektronik nicht
gemessen. Eine Konfiguration der Spülfunktion zur automatischen oder manuellen
Spülsteuerung ist möglich. Bei der Auswahl der automatischen Steuerung wird das
Hilfsventil nach jeder Befüllung geöffnet und nach dem Ablauf der konfigurierten Spülzeit
geschlossen.

Einschränkung
Die Spülfunktion wird nicht für Befüllungen mit doppeltem Füllkopf oder zeitgesteuerte Befüllungen
mit doppeltem Füllkopf unterstützt.

Vorbereitungsverfahren

Die Binärausgänge müssen entsprechend Ihrer Abfüllart und Abfülloptionen geschaltet
sein.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Konfigurieren von Kanal B als Binärausgang:

a. Wählen Sie ProLink > Configuration > Channel.
b. Setzen Sie Channel B Type Assignment auf Discrete Output.
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c. Öffnen Sie das Fenster Discrete Output (Binärausgang).

d. Setzen Sie DO1 Assignment auf Discrete Batch: Purge Valve.

e. Stellen Sie DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

f. Stellen Sie DO1 Fault Action entsprechend Ihrer Installation ein.

Option Beschreibung

Upscale Der Binäreingang wird auf EIN geschaltet (Ventil geöf-
fnet), wenn eine Störung auftritt.

Downscale Der Binäreingang wird auf AUS geschaltet (Ventil ges-
chlossen), wenn eine Störung auftritt.

None Bei Auftreten einer Störung werden keine Maßnahmen er-
griffen. Der Binärausgang bleibt in dem Zustand, in dem
er vor Auftreten der Störung war.

2. Spülung konfigurieren:

a. Wählen Sie ProLink > Configuration (Konfiguration) > Temperature (Temperatur).
b. Enable Purge (Spülung aktivieren) aktivieren.

c. Purge Mode (Spülmodus) wie gewünscht einstellen.

Option Beschreibung

Auto (Automatisch) Eine Spülung wird nach jeder Befüllung automatisch
durchgeführt.

Manual (Manuell) Spülvorgänge müssen manuell gestartet und ges-
toppt werden.

Hinweis
Wenn Purge Mode (Spülmodus) auf Auto (Automatisch) eingestellt ist, ist eine manuelle
Steuerung des Spülventils weiterhin möglich. Eine Spülung kann manuell gestartet oder
gestoppt werden oder sie kann durch die Auswerteelektronik nach der abgelaufenen
Purge Time (Spülzeit) gestoppt werden. Wird eine Spülung automatisch gestartet, kann sie
manuell gestoppt werden.
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d. Wenn Purge Mode (Spülmodus) auf Auto (Automatisch) eingestellt ist, Purge Delay
(Spülverzögerung) auf die Anzahl von Sekunden einstellen, die die
Auswerteelektronik nach der Befüllung warten soll, umd das Spülventil zu
öffnen.

Der Standardwert für Purge Delay (Spülverzögerung) beträgt 2 Sekunden.

e. Wenn Purge Mode (Spülmodus) auf Auto (Automatisch) eingestellt wird, Purge Time
(Spülzeit) auf die Anzahl von Sekunden einstellen, die die Auswerteelektronik das
Ventil offen halten soll.

Der Standardwert für Purge Time (Spülzeit) beträgt 1 Sekunde. Der Bereich liegt
bei 0 Sekunden bis 800 Sekunden.

Hinweis
Die nächste Befüllung kann erst beginnen, wenn das Spülventil geschlossen ist.

5.2.3 Konfigurieren der Pumpenfunktion mittels ProLink II
Die Pumpfunktion wird verwendet, um den Druck während der Abfüllung zu erhöhen,
indem eine in Flussrichtung liegende Pumpe kurz vor dem Beginn der Abfüllung gestartet
wird.

Einschränkung
Die Pumpenfunktion wird nicht für zweistufige Binärbefüllungen, Befüllungen mit doppeltem
Füllkopf, zeitgesteuerte Befüllungen oder zeitgesteuerte Befüllungen mit doppeltem Füllkopf
unterstützt.

Vorbereitungsverfahren

Die Binärausgänge müssen entsprechend Ihrer Abfüllart und Abfülloptionen geschaltet
sein.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Öffnen Sie das Fenster Discrete Output (Binärausgang).

b. Setzen Sie Precision DO2 auf Pump.

c. Stellen Sie Precision DO2 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC
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Option
Signal von der Auswertee-
lektronik Spannung

OFF Standortspezifisch bis zu
30 VDC

2. Wählen Sie ProLink > Configuration (Konfiguration) > Temperature (Temperatur).
3. Pump to Valve Delay (Pumpe-zu-Ventilverzögerung) auf die Anzahl von Sekunden

einstellen, die die Pumpe laufen soll, bevor das Ventil geöffnet wird.

Der Standardwert beträgt 10 Sekunden. Der Bereich liegt bei 0 Sekunden bis
30 Sekunden.

Wenn der Befehl Begin Filling (Befüllung beginnen) empfangen wird, startet die
Auswerteelektronik die Pumpe, wartet die unter Pump to Valve Delay (Pumpe-zu-
Ventilverzögerung) spezifizierte Anzahl von Sekunden und öffnet dann das Ventil. Die
Pumpe läuft, bis die Befüllung abgeschlossen ist.

5.3 Konfigurieren einer Abfüllsteuerung mittels
ProLink II (optional)
Bei einer typischen Serienfertigung erfolgt die Abfüllsteuerung (Starten und Stoppen der
Abfüllung) durch den Host oder die SPS. Sie können auf Wunsch das System auch so
einrichten, dass die Abfüllung über den Binäreingang (falls verfügbar) begonnen, beendet,
angehalten und fortgesetzt wird. Außerdem können Sie ein Ereignis definieren, bei dem
die Abfüllung beginnt, endet, angehalten oder fortgesetzt wird.

5.3.1 Konfigurieren des Binäreingangs für die Abfüllsteuerung
mittels ProLink II
Wenn Kanal B verfügbar ist, können Sie diesen als Binäreingang konfigurieren und
verwenden, um eine Abfüllung zu beginnen oder zu beenden oder um eine laufende
Abfüllung anzuhalten und fortzusetzen. Außerdem können Sie den Kanal zum
Zurücksetzen des Masse Summenzählers, des Volumen Summenzählers oder aller
Summenzähler konfigurieren. Wenn der Binäreingang aktiviert ist, werden alle
zugewiesenen Aktionen durchgeführt.

Vorbereitungsverfahren

Kanal B muss als Binärausgang geschaltet sein.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Konfigurieren von Kanal B als Binäreingang:

a. Wählen Sie ProLink > Configuration > Channel.
b. Setzen Sie Type Assignment für Kanal B auf Discrete Input.

2. Weisen Sie dem Binäreingang Steuerungsaktionen zur Abfüllung zu.

a. Öffnen Sie das Fenster Discrete Input (Binäreingang).
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b. Wählen Sie die Aktion oder Aktionen, die bei Aktivierung des Binäreingangs
ausgeführt werden sollen.

Aktion Beschreibung Bemerkungen

Begin Filling Beginnt die Abfüllung mit der aktuellen Abfüll-
konfiguration. Der Abfüllzähler wird automa-
tisch zurückgesetzt, bevor die Abfüllung be-
ginnt.

Falls eine Abfüllung läuft, wird der Befehl ig-
noriert.

Wenn ein automatischer Spülvorgang läuft,
werden die Funktionen zum Start der Abfül-
lung ausgeführt, sobald der Spülvorgang ab-
geschlossen ist.

End Filling Beendet die aktuelle Abfüllung und führt Funk-
tionen zum Ende der Abfüllung aus. Die Abfül-
lung kann nicht fortgesetzt werden.

Wird ausgeführt, während eine Abfüllung läuft
oder angehalten ist und während eines Spül-
vorgangs oder einer Spülverzögerung.

Für Abfüllungen mit doppeltem Füllkopf und
zeitgesteuerte Abfüllungen mit doppeltem
Füllkopf beendet der Befehl immer die zurzeit
aktive Abfüllung.

Pause Filling Zeitgesteuerte Abfüllungen, Abfüllungen mit
doppeltem Füllkopf und zeitgesteuerte Abfül-
lungen mit doppeltem Füllkopf: Identisch mit
End Filling.

Einstufige Abfüllungen und zweistufige Abfül-
lungen: Hält die Abfüllung vorläufig an. Die
Abfüllung kann fortgesetzt werden, wenn die
Abfüllmenge kleiner als die Sollmenge ist.

Falls ein Spülvorgang oder eine Spülverzöger-
ung läuft, wird der Befehl ignoriert.

Resume Filling Startet die Abfüllung wieder, nachdem sie un-
terbrochen wurde. Die Zählung wird an der
Stelle oder an dem Zeitpunkt wieder fortge-
setzt, an der/dem sie unterbrochen wurde.

Wird nur ausgeführt, wenn eine einstufige Ab-
füllung oder eine zweistufige Abfüllung ange-
halten wurden. Wird alle anderen Male ignor-
iert.

Reset Mass Total Setzt den Wert des Masse Summenzählers auf
0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

Reset Volume Total Setzt den Wert des Volumen Summenzählers
auf 0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

Reset All Totals Setzt den Wert des Masse Summenzählers und
des Volumen Summenzählers auf 0 zurück,
und setzt den Abfüllzähler auf 0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

c. Öffnen Sie für jede ausgewählte Aktion die Dropdown-Liste und wählen Sie
Discrete Input 1.

3. Stellen Sie DI1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das vom Binäreingang gesendete EIN-Signal auch als EIN
gelesen wird, und umgekehrt.
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Option
Angelegte Spannung über
Anschlussklemmen Auswerteelektronik liest

Active High 3 bis 30 VDC ON

<0,8 VDC OFF

Active Low <0,8 VDC ON

3 bis 30 VDC OFF

5.3.2 Einrichten eines Ereignisses zur Durchführung einer
Abfüllsteuerung mittels ProLink II
Sie können ein Ereignis zuweisen, um eine Abfüllung zu starten, zu stoppen, anzuhalten
oder fortzusetzen. Außerdem können Sie das Ereignis zum Zurücksetzen des Masse
Summenzählers, des Volumen Summenzählers oder aller Summenzähler zuweisen. Beim
Schalten des Ereignisses auf ON (EIN) werden alle zugewiesenen Aktionen durchgeführt.

Vorbereitungsverfahren

Sie müssen alle gewünschten Ereignisse konfigurieren. Sie können diese Ereignisse sowohl
vor als auch nach dem Zuweisen von Aktionen konfigurieren.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Weisen Sie dem Ereignis Steuerungsaktionen zur Abfüllung zu.

a. Wählen Sie ProLink > Configuration (Konfiguration) > Discrete Events (Binärereignisse).
b. Identifizieren Sie die Aktion oder Aktionen, die bei Auftreten des Discrete Event 1

ausgeführt werden soll bzw. sollen.

Aktion Beschreibung Bemerkungen

Begin Filling Beginnt die Abfüllung mit der aktuellen Abfüll-
konfiguration. Der Abfüllzähler wird automa-
tisch zurückgesetzt, bevor die Abfüllung be-
ginnt.

Falls eine Abfüllung läuft, wird der Befehl ig-
noriert.

Wenn ein automatischer Spülvorgang läuft,
werden die Funktionen zum Start der Abfül-
lung ausgeführt, sobald der Spülvorgang ab-
geschlossen ist.

End Filling Beendet die aktuelle Abfüllung und führt Funk-
tionen zum Ende der Abfüllung aus. Die Abfül-
lung kann nicht fortgesetzt werden.

Wird ausgeführt, während eine Abfüllung läuft
oder angehalten ist und während eines Spül-
vorgangs oder einer Spülverzögerung.

Für Abfüllungen mit doppeltem Füllkopf und
zeitgesteuerte Abfüllungen mit doppeltem
Füllkopf beendet der Befehl immer die zurzeit
aktive Abfüllung.

Pause Filling Zeitgesteuerte Abfüllungen, Abfüllungen mit
doppeltem Füllkopf und zeitgesteuerte Abfül-
lungen mit doppeltem Füllkopf: Identisch mit
End Filling.
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Aktion Beschreibung Bemerkungen

Einstufige Abfüllungen und zweistufige Abfül-
lungen: Hält die Abfüllung vorläufig an. Die
Abfüllung kann fortgesetzt werden, wenn die
Abfüllmenge kleiner als die Sollmenge ist.

Falls ein Spülvorgang oder eine Spülverzöger-
ung läuft, wird der Befehl ignoriert.

Resume Filling Startet die Abfüllung wieder, nachdem sie un-
terbrochen wurde. Die Zählung wird an der
Stelle oder an dem Zeitpunkt wieder fortge-
setzt, an der/dem sie unterbrochen wurde.

Wird nur ausgeführt, wenn eine einstufige Ab-
füllung oder eine zweistufige Abfüllung ange-
halten wurden. Wird alle anderen Male ignor-
iert.

Reset Mass Total Setzt den Wert des Masse Summenzählers auf
0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

Reset Volume Total Setzt den Wert des Volumen Summenzählers
auf 0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

Reset All Totals Setzt den Wert des Masse Summenzählers und
des Volumen Summenzählers auf 0 zurück,
und setzt den Abfüllzähler auf 0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

2. Wiederholen Sie das Verfahren für Discrete Event 2–5.

Beispiel: Ereignisse überwachen den Prozess und pausieren oder beenden die
Abfüllung

Der akzeptable Dichtebereich für Ihren Prozess ist 1,1 g/cm3 bis 1,12 g/cm3. Der
akzeptable Temperaturbereich ist 20 °C bis 25 °C. Wenn die Dichte den Messbereich
überschreitet, möchten Sie die Abfüllung anhalten. Wenn die Temperatur den
Messbereich überschreitet, möchten Sie die Abfüllung beenden.

Konfiguration der Ereignisse:

• Discrete Event 1:

- Event Type: Out of Range
- Process Variable: Density
- Low Setpoint (A): 1,1 g/cm3

- High Setpoint (B): 1,12 g/cm3

• Discrete Event 2:

- Event Type: Out of Range
- Process Variable: Temperature
- Low Setpoint (A): 20 °C

- High Setpoint (B): 25 °C

Aktionszuordnungen:

• Pause Fill: Discrete Event 1
• End Fill: Discrete Event 2
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Nachbereitungsverfahren

Wenn Sie Ereignissen Aktionen zugeordnet haben, die nicht konfiguriert sind, müssen Sie
diese Ereignisse konfigurieren, bevor Sie diese Methode der Abfüllsteuerung
implementieren können.

5.3.3 Mehrere Maßnahmen, die einem Binäreingang oder
Ereignis zugewiesen sind
Wenn mehrere Maßnahmen einem Binäreingang oder Ereignis zugewiesen sind, führt die
Auswerteelektronik nur die Maßnahmen durch, die jeweils für die aktuelle Situation von
Bedeutung sind. Wenn zwei oder mehr der Maßnahmen sich gegenseitig ausschließen,
führt die Auswerteelektronik Maßnahmen gemäß einem Prioritätenschema durch, das in
der Firmware der Auswerteelektronik definiert ist.

Die folgenden Beispiele zeigen drei Konfigurationen, die Micro Motion empfiehlt, und zwei
Konfigurationen, die nicht empfohlen werden.

Beispiel: Verwenden des Binäreingangs oder des Ereignisses, um eine Abfüllung zu
beginnen und zu beenden (empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Beginn
• Abfüllung-Ende
• Masse Summenzähler zurücksetzen
• Volumen Summenzähler zurücksetzen

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, werden der Masse Summenzähler und der Volumen
Summenzähler zurückgesetzt und eine Abfüllung beginnt.

• Wenn eine Abfüllung läuft, wird diese beendet und der Masse Summenzähler und
der Volumen Summenzähler werden zurückgesetzt.

Beispiel: Verwenden des Binäreingangs oder des Ereignisses, um die Abfüllung zu
beginnen, anzuhalten und sie fortzusetzen (empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Beginn
• Abfüllung-Pause
• Abfüllung-Fortsetzung

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, wird diese gestartet.

• Wenn eine Abfüllung läuft und nicht angehalten wurde, wird diese angehalten.

• Wenn eine Abfüllung angehalten wurde, wird diese fortgesetzt.

Beispiel: Verwenden des Binäreingangs, um die Abfüllung zu starten und den
Volumenzähler zurückzusetzen (empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Beginn
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• Volumen Summenzähler zurücksetzen

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, wird der Volumen Summenzähler zurückgesetzt und
eine Abfüllung beginnt.

• Wenn eine Abfüllung läuft, wird der Volumen Summenzähler zurückgesetzt.

Hinweis
Diese Konfiguration ist nützlich, wenn die Abfüllung hinsichtlich der Masse konfiguriert wird, das
Gesamtvolumen für die Abfüllung aber ebenfalls ermittelt werden soll. In diesem Fall nicht den
Binäreingang aktivieren, während die Abfüllung läuft. Am Ende der Abfüllung kann das
Gesamtvolumen abgelesen werden. Danach mit der nächsten Abfüllung fortfahren.

Beispiel: Inkompatible Zuordnungen (nicht empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Beginn
• Abfüllung-Ende
• Abfüllung-Pause
• Abfüllung-Fortsetzung

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, wird diese gestartet.

• Wenn eine Abfüllung läuft, wird diese beendet.

In diesem Beispiel wird die Abfüllung durch den Binäreingang oder das Ereignis nicht
angehalten, weil die Maßnahme End Fill Priorität hat.

Beispiel: Inkompatible Zuordnungen (nicht empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Ende
• Alle Zähler zurücksetzen

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, werden alle Zähler, einschließlich dem Abfüll-
Summenzähler, zurückgesetzt.

• Wenn eine Abfüllung läuft, wird diese beendet und alle Zähler, einschließlich dem
Abfüll-Summenzähler, werden zurückgesetzt.

Das Ergebnis dieser Kombination ist, dass der Abfüll-Summenzähler vor dem Abrufen der
Daten zurückgesetzt wird.

5.4 Konfigurieren der Abfüllprotokollierung
mittels ProLink II (optional)
Sie können die Auswerteelektronik so konfigurieren, dass der ON/OFF-Status über Kanal B
(falls verfügbar) und der Prozentsatz der Abfüllung über den mA-Ausgang ausgegeben
wird.
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5.4.1 Konfigurieren von Kanal B als Binärausgang und
Übertragen des Abfüllstatus ON/OFF mittels ProLink II
Falls Kanal B verfügbar ist, können Sie diesen verwenden, um auszugeben, ob ein
Abfüllvorgang läuft.

Vorbereitungsverfahren

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Kanal B muss als Binärausgang geschaltet sein.

Verfahren

1. Wählen Sie ProLink > Configuration > Channel.
2. Setzen Sie Channel B Type Assignment auf Discrete Output.
3. Öffnen Sie das Fenster Discrete Output (Binärausgang).

4. Setzen Sie DO1 Assignment auf Discrete Batch: Batching/Filling In Progress.

5. Stellen Sie DO1 Polarity entsprechend Ihrer Installation ein.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

6. Stellen Sie DO1 Fault Action entsprechend Ihrer Installation ein.

Option Beschreibung

Upscale Der Binäreingang wird auf EIN geschaltet (Ventil geöffnet),
wenn eine Störung auftritt.

Downscale Der Binäreingang wird auf AUS geschaltet (Ventil geschlos-
sen), wenn eine Störung auftritt.

None Bei Auftreten einer Störung werden keine Maßnahmen er-
griffen. Der Binärausgang bleibt in dem Zustand, in dem er
vor Auftreten der Störung war.

Hinweis
Wenn der Binärausgang zur Ausgabe von Abfüllberichten verwendet wird, empfiehlt Micro
Motion die Einstellung von DO1 Fault Action auf None.
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5.4.2 Konfigurieren des mA-Ausgangs, um die prozentuale
Abfüllung auszugeben mittels ProLink II
Sie können den mA-Ausgang so konfigurieren, dass er den Prozentsatz der abgebenenen
Sollmenge ausgibt. In einer typischen Konfiguration steigt der Strom von 4 mA auf 20 mA,
wenn der Abfüllzähler von 0 % auf 100 % geht.

Vorbereitungsverfahren

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Wählen Sie ProLink > Configuration (Konfiguration) > Analog Output (Analogausgang).
2. Setzen Sie Secondary Variable Is auf Discrete Batch: Percent Fill.
3. Setzen Sie Lower Range Value auf den durch 4 mA dargestellten Abfüllprozentwert.

4. Setzen Sie Upper Range Value auf den durch 20 mA dargestellten Abfüllprozentwert.

5. Stellen Sie AO Fault Action wie gewünscht ein.

Wenn Lower Range Value auf 0 % eingestellt ist und Upper Range Value auf 100 % eingestellt
ist: Wenn die Abfüllung beginnt, erzeugt der mA-Ausgang 4 mA (0 % von Fill Target). Der
Strom wird proportional zum Abfüllzähler bis auf 20 mA (100 % von Fill Target) steigen.

Anmerkung
Wenn Flow Direction auf Bidirectional oder Negate Bidirectional eingestellt ist, kann der Abfüllzähler unter
bestimmten Durchflussbedingungen sinken. In diesem Fall wird der vom mA-Ausgang erzeugte
Strom proportional reduziert.
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6 Abfüllvorgang mittels
In diesem Kapitel behandelte Themen:

• Abfüllung mit integrierter Ventilsteuerung mittels ProLink II

• Durchführen einer manuellen Spülung mittels ProLink II

• Durchführen eines Cleaning-in-Place-Verfahrens (CIP) mittels ProLink II

• Überwachen und Analysieren der Abfüllleistung mittels ProLink II

6.1 Abfüllung mit integrierter Ventilsteuerung
mittels ProLink II
Mit ProLink II können Sie eine Abfüllung starten, überwachen, anhalten, fortsetzen und
beenden.

Vorbereitungsverfahren

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Wählen Sie ProLink > Run Filler.
2. (Optional) Auf Wunsch wählen Sie einen anderen Wert für Fill Target (einstufige

Abfüllungen, zweistufige Abfüllungen oder Abfüllungen mit doppeltem Füllkopf)
oder für Target Time (zeitgesteuerte Abfüllungen oder zeitgesteuerte Abfüllungen
mit doppeltem Füllkopf).

3. (Optional) Falls die automatische Überfüllkompensation (Automatic Overshoot
Compensation, AOC) aktiviert ist, können Sie einen anderen Wert für AOC Coeff
eingeben.

Hinweis
Während der Produktion empfiehlt Micro Motion, AOC Coeff auf dem während der AOC-
Kalibrierung festgelegten Wert zu belassen. Falls Sie AOC-Kalibrierabfüllungen ausführen und
über einen AOC Coeff Wert von einem ähnlichen Gerät verfügen, können Sie diesen Wert als
„ersten Näherungswert“ im aktuellen Gerät verwenden. Dies kann nützlich sein, wenn Sie
Auslaufen verhindern oder auf ein Minimum reduzieren möchten.

4. Klicken Sie auf Begin Filling.

Der Abfüllzähler wird automatisch zurückgesetzt und das/die Ventil(e) wird/werden
geöffnet. Die Anzeige für Filling in Progress sollte On sein. Ist dies nicht der Fall und
stattdessen die Anzeige Start Not Okay oder die Anzeige AOC Flow Rate Too High Ein
sind, führen Sie eine Fehlersuche der Abfüllkonfiguration durch und wiederholen Sie
das Verfahren.

5. Überwachen Sie die Abfüllung anhand der Werte unter Current Total und Percent Fill
der Anzeige Fill Status.
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Werte des Abfüllforts-
chritts Beschreibung

Current Total Abfüllmenge zum aktuellen Zeitpunkt. Dieser Wert wird von
Count Up beeinflusst:
• Wenn Count Up aktiviert ist, beginnt Current Total bei 0 und

zählt bis zu Fill Target hoch.
• Wenn Count Up deaktiviert ist, beginnt Current Total bei Fill

Target und zähl bis auf 0 herunter.

Percent Fill Prozentwert des Fill Target, der bis zum aktuellen Zeitpunkt
gemessen wurde. Dieser Wert wird nicht von Count Up beein-
flusst.

Fill Status Anzeige Beschreibung

Filling in Progress Zurzeit wird eine Abfüllung durch das Primärventil durchge-
führt. Diese Anzeige ist auch dann aktiv, wenn die Abfüllung
angehalten wird.

Secondary Fill in Progress Zurzeit wird eine Abfüllung durch das Sekundärventil durch-
geführt. Diese Anzeige ist auch dann aktiv, wenn die Abfül-
lung angehalten wird. Dies gilt nur für Abfüllungen mit dop-
peltem Füllkopf.

Max Fill Time Exceeded Die aktuelle Abfüllung hat die derzeitige Einstellung für Max
Fill Time überschritten. Die Abfüllung wird abgebrochen.

Primary Valve Das Primärventil ist offen.

Secondary Valve Das Sekundärventil ist offen.

Pump Die Pumpe läuft.

Purge In Progress Ein Spülvorgang wurde, entweder automatisch oder man-
uell, gestartet.

Purge Delay Phase Ein automatischer Spülzyklus läuft und ist aktuell in der Ver-
zögerungsperiode zwischen Beendigung der Abfüllung und
Start des Spülvorgangs.

Purge Valve Das Spülventil ist offen.

6. (Optional) Halten Sie die Abfüllung nach Wunsch an.

Während die Abfüllung angehalten ist, können Sie den Wert für Current Target
ändern, die Abfüllung manuell mit End Filling beenden oder mit Resume Filling
fortsetzen. Die Abfüllung wird mit dem aktuellen Wert für Current Total und Percent Fill
fortgesetzt.

Einschränkung
Eine zeitgesteuerte Abfüllung oder eine zeitgesteuerte Abfüllung mit doppeltem Füllkopf
kann nicht angehalten werden.

Wichtig
Für zweistufige Abfüllungen hängt die Auswirkung eines Anhaltens und Fortsetzens der
Abfüllung von der Zeitsteuerung der Befehle zum Öffnen und Schließen des Ventils und von
dem Punkt, an welchem die Abfüllung angehalten wird, ab.
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7. (Optional) Verwenden Sie End Filling, um die Abfüllung nach Wunsch manuell zu
beenden.

Nachdem die Abfüllung beendet wurde, kann sie nicht wieder gestartet werden.

Hinweis
In den meisten Fällen sollten Sie den Abfüllvorgang automatisch beenden lassen. Beenden Sie
den Abfüllvorgang nur dann manuell, wenn Sie die Füllung entsorgen möchten.

6.1.1 Wenn die Abfüllung nicht startet
Falls die Abfüllung nicht beginnt, die Anzeigen für Start Not Okay und AOC Flow Rate Too High
prüfen.

Wenn die Anzeige Start Not Okay aufleuchtet, Folgendes prüfen:

• Sicherstellen, dass die Abfüllung aktiviert ist.

• Darauf achten, dass die vorherige Abfüllung bereits beendet ist.

• Sicherstellen, dass Fill Target oder Target Time auf positive Werte eingestellt sind.

• Sicherstellen, dass alle Ausgänge dem Ventil oder der Pumpe zugeordnet sind, das
bzw. die der Abfüllart und der Abfülloption entsprechen.

• Sicherstellen, dass keine aktiven Fehlerbedingungen an der Auswerteelektronik
vorherrschen.

• Bei Abfüllungen mit doppelten Füllköpfen sicherstellen, dass auf keinem der
Füllköpfe eine Abfüllung läuft.

Wenn die Anzeige AOC Flow Rate Too High leuchtet, ist die zuletzt gemessene
Durchflussgeschwindigkeit zu hoch, und die Abfüllung kann nicht gestartet werden.
Anders ausgedrückt bedeutet dies, dass der AOC Koeffizient, kompensiert für die
Durchflussgeschwindigkeit, angibt, dass der Befehl zum Schließen des Ventils vor dem
Beginn der Abfüllung gegeben werden müsste. Dies kann vorkommen, wenn die
Durchflussgeschwindigkeit signifikant höher liegt, seit der AOC-Koeffizient berechnet
wurde. Micro Motion empfiehlt das folgende Wiederherstellungsverfahren:

1. Jede Einrichtung durchführen, die erforderlich ist, um die AOC-Kalibrierung
durchzuführen.

2. Im Fenster Run Filler auf Override Blocked Start klicken.

3. AOC-Kalibrierung durchführen.

4. Die Produktionsabfüllung des Systems unter Verwendung des neuen AOC-
Koeffizienten wieder aufnehmen.

6.1.2 Wenn die Abfüllung nicht vollständig durchgeführt
wurde
Falls die Abfüllung anormal beendet wurde, die Auswerteelektronik und die AnzeigeMax Fill
Time Exceeded prüfen.

Wenn ein Fehler während einer Abfüllung auftritt, wird diese von der Auswerteelektronik
automatisch abgebrochen.
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Wenn die Anzeige Max Fill Time Exceeded leuchtet, konnte die Abfüllung nicht ihren Zielwert
vor der konfigurierten Max Fill Time erreichen. Folgende Möglichkeiten oder Maßnahmen
sind in Betracht zu ziehen:

• Die Durchflussgeschwindigkeit des Prozesses erhöhen.

• Auf Gaseinschlüsse (Schwallströmung) im Prozessmedium prüfen.

• Auf Verstopfungen des Durchflusses prüfen.

• Sicherstellen, dass die Ventile mit der erwarteten Geschwindigkeit schließen.

• Max Fill Time auf einen höheren Wert einstellen.

• Max Fill Time durch eine Einstellung auf 0 deaktivieren.

6.1.3 Auswirkungen von Pause und Fortfahren bei zweistufigen
diskreten Abfüllungen
Bei zweistufigen diskreten Abfüllungen hängt es davon ab, wo Pause und Fortfahren in
Zusammenhang mit dem Öffnen und Schließen der primären und sekundären Ventile
auftreten.

Zuerst Primär öffnen, zuerst Primär schließen

In den folgenden Abbildungen:

• Das Primärventil öffnet zum Beginn der Abfüllung.

• Das Sekundärventil öffnet während der Abfüllung an dem vom Anwender
konfigurierten Punkt. T stellt die Zeit oder Anzahl dar, die für Sekundär öffnen
konfiguriert ist.

• Das Primärventil schließt, bevor die Abfüllung abgeschlossen ist.

• Das Sekundärventil schließt, wenn die Abfüllung abgeschlossen ist.

Fall AAbbildung 8-1:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Primary

Target 
(AOC adjusted)

Pause Resume

TT

Open Secondary 
not performed
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Fall BAbbildung 8-2:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Primary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Secondary

Fall CAbbildung 8-3:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Primary

Target 
(AOC adjusted)

T T

Secondary valve 
opened early

Pause Resume

Open 
Secondary

Fall DAbbildung 8-4:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Primary

Target 
(AOC adjusted)

T T

Secondary valve 
opened early

Pause Resume

Open 
Secondary

Zuerst Primär öffnen, zuerst Sekundär schließen

In den folgenden Abbildungen:

• Das Primärventil öffnet zum Beginn der Abfüllung.
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• Das Sekundärventil öffnet während der Abfüllung an dem vom Anwender
konfigurierten Punkt. T stellt die Zeit oder Anzahl dar, die für Sekundär öffnen
konfiguriert ist.

• Das Sekundärventil schließt, bevor die Abfüllung abgeschlossen ist.

• Das Primärventil schließt, wenn die Abfüllung abgeschlossen ist.

Fall EAbbildung 8-5:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

Pause Resume

TT

Open Secondary 
not performed

Fall FAbbildung 8-6:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Secondary

Fall GAbbildung 8-7:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

T T

Secondary valve 
not reopened

Pause Resume

Open 
Secondary
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Fall HAbbildung 8-8:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Secondary

Secondary valve 
not reopened

Zuerst Sekundär öffnen, zuerst Primär schließen

In den folgenden Abbildungen:

• Das Sekundärventil öffnet zum Beginn der Abfüllung.

• Das Primärventil öffnet während der Abfüllung an dem vom Anwender
konfigurierten Punkt. T stellt die Zeit oder Anzahl dar, die für Primär öffnen
konfiguriert ist.

• Das Primärventil schließt, bevor die Abfüllung abgeschlossen ist.

• Das Sekundärventil schließt, wenn die Abfüllung abgeschlossen ist.

Fall IAbbildung 8-9:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Primary

Target 
(AOC adjusted)

Pause Resume

TT

Open Primary 
not performed

Abfüllvorgang mittels

Konfigurations- und Bedienungsanleitung 59



Fall JAbbildung 8-10:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Primary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Primary

Fall KAbbildung 8-11:   

Secondary valve

Primary valve

Start Open 
Primary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Primary not 
performed

Close 
Primary

Fall LAbbildung 8-12:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Primary

Target 
(AOC adjusted)

T T

Pause Resume

Open Primary 
not performed

Zuerst Sekundär öffnen, zuerst Sekundär schließen

In den folgenden Abbildungen:

• Das Sekundärventil öffnet zum Beginn der Abfüllung.

• Das Primärventil öffnet während der Abfüllung an dem vom Anwender
konfigurierten Punkt. T stellt die Zeit oder Anzahl dar, die für Primär öffnen
konfiguriert ist.
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• Das Sekundärventil schließt, bevor die Abfüllung abgeschlossen ist.

• Das Primärventil schließt, wenn die Abfüllung abgeschlossen ist.

Fall MAbbildung 8-13:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Secondary

Target 
(AOC adjusted)

Pause Resume

TT

Open Primary 
not performed

Fall NAbbildung 8-14:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Secondary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Primary

Fall OAbbildung 8-15:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Secondary

Target 
(AOC adjusted)

T T

Primary valve 
opened early

Pause Resume

Open 
Primary
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Fall PAbbildung 8-16:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Secondary

Target 
(AOC adjusted)

T T

Primary valve 
opened early

Pause Resume

Open 
Primary

6.2 Durchführen einer manuellen Spülung mittels
ProLink II
Die Spülfunktion wird verwendet, um ein Hilfsventil zu steuern, das nicht für die Abfüllung
eingesetzt wird. Beispielsweise kann damit ein Behälter mit Wasser oder Gas aufgefüllt
werden, nachdem der Füllvorgang abgeschlossen ist, oder sie kann als “ Dämpfung
dienen.” Der Durchfluss durch das Hilfsventil wird von der Auswerteelektronik nicht
gemessen.

Vorbereitungsverfahren

Die Spülfunktion muss in Ihrem System implementiert sein.

Die vorhergehende Abfüllung muss beendet worden sein.

Das Hilfsventil muss an das Medium, das Sie verwenden möchten (z. B. Luft, Wasser,
Stickstoff), angeschlossen sein.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Wählen Sie ProLink > Run Filler.
2. Klicken Sie auf Begin Purge.

Die Anzeigen Purge In Progress und Purge Valve werden eingeschaltet.

3. Lassen Sie das Spülmedium eine angemessene Zeit durch das System laufen.

4. Klicken Sie auf End Purge.

Die Anzeigen Purge In Progress und Purge Valve werden ausgeschaltet.
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6.3 Durchführen eines Cleaning-in-Place-
Verfahrens (CIP) mittels ProLink II
Die Clean-in-Place (CIP) Funktion wird verwendet, um ein Reinigungsmedium durch das
System zu leiten. Mit dem CIP-Verfahren können Sie die Innenflächen von Rohren,
Ventilen, Stutzen usw. reinigen, ohne das Gerät zerlegen zu müssen.

Vorbereitungsverfahren

Hierbei darf kein Abfüllvorgang laufen.

Das Reinigungsmedium muss zum Durchfluss durch das System bereit stehen.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Tauschen Sie das Prozessmedium gegen das Reinigungsmedium aus.

2. Wählen Sie ProLink > Run Filler.
3. Klicken Sie auf Begin Cleaning.

Die Auswerteelektronik öffnet das Primärventil und, falls dieses zum Abfüllen
verwendet wird, das Sekundärventil. Falls die Pumpenfunktion aktiviert ist, wird die
Pumpe gestartet, bevor das Ventil geöffnet wird. Die Anzeige Cleaning In Progress
wird eingeschaltet.

4. Lassen Sie das Reinigungsmedium eine angemessene Zeit durch das System laufen.

5. Klicken Sie auf End Cleaning.

Die Auswerteelektronik schließt alle offenen Ventile und stoppt die Pumpe (falls
zutreffend). Die Anzeige Cleaning In Progress wird ausgeschaltet.

6. Tauschen Sie das Reinigungsmedium gegen das Prozessmedium aus.

6.4 Überwachen und Analysieren der
Abfüllleistung mittels ProLink II
Für eine Einzelabfüllung können detaillierte Durchflussdaten gesammelt werden und diese
Daten können dann mit denen anderer Abfüllungen verglichen werden.

6.4.1 Sammeln detaillierter Abfülldaten für eine einzelne
Abfüllung mittels ProLink II
Detaillierte Daten der letzten Abfüllung werden in der Auswerteelektronik gespeichert,
sofern die Abfüllungsprotokollierung aktiviert ist. Die Daten können mittels digitaler
Kommunikation zu Analysezwecken ausgelesen werden. Die detaillierten Daten können
zur Optimierung oder Fehlersuche in der Produktionsumgebung verwendet werden.
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Einschränkung
Obwohl Sie ProLink II benutzen können, um die Abfüllprotokollierung zu aktivieren und zu
deaktivieren, können Sie das Abfüllprotokoll nicht mit ProLink II ansehen. Um das Abfüllprotokoll
ansehen zu können, müssen Sie eine Modbus- oder PROFIBUS-Verbindung wählen.

Vorbereitungsverfahren

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Wählen Sie ProLink > Configuration (Konfiguration) > Temperature (Temperatur).
2. Aktivieren Sie Enable Fill Logging.

3. Führen Sie einen Abfüllvorgang aus.

4. Deaktivieren Sie Enable Fill Logging, wenn Sie die Datensammlung beendet haben.

Das Abfüllprotokoll enthält Datensätze von einem einzigen Abfüllvorgang. Die
Aufzeichnung beginnt mit dem Start der Abfüllung und endet 50 Millisekunden nach
Beendigung der Abfüllung oder wenn die maximale Prokotollgröße erreicht wurde.
Datensätze werden alle 10 Millisekunden geschrieben. Jeder Datensatz enthält den
aktuellen Wert für Flow Source (die zum Messen der Abfüllung verwendete Prozessvariable).
Das Abfüllprotokoll ist auf 1000 Datensätze bzw. 10 Sekunden Abfülldauer begrenzt.
Nachdem die maximale Größe erreicht ist, stoppt die Protokollierung zwar, aber die Daten
sind in der Auswerteelektronik verfügbar, bis der nächste Abfüllvorgang beginnt. Das
Abfüllprotokoll wird zu Beginn eines neuen Abfüllvorgangs immer gelöscht.

6.4.2 Analyse der Abfüllleistung mittels Abfüllstatistiken und
ProLink II
Die Auswerteelektronik zeichnet automatisch eine Vielzahl von Daten über jeden
Abfüllungsvorgang auf. Diese Daten dienen zur Optimierung des Systems.

Vorbereitungsverfahren

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Wählen Sie ProLink > Run Filler.
2. (Optional) Klicken Sie auf Reset Fill Statistics, um die Analyse mit einem neuen Satz

Abfülldaten zu starten.

3. Führen Sie Abfüllvoränge aus und beobachten Sie die Abfülldaten.

Abfülldaten Abfüllart Beschreibung

Durchschnittliche Gesamtab-
füllung

Einstufige Abfüllungen,
zweistufige Abfüllungen
und zeitgesteuerte Ab-
füllungen

Berechneter Durchschnitt aller Abfüll-
summen seit Zurücksetzen der Abfüll-
statistik.

Abfüllungen mit doppel-
tem Füllkopf und zeit-
gesteuerte Abfüllungen
mit doppeltem Füllkopf

Berechneter Durchschnitt aller Abfüll-
summen durch den Füllkopf Nr. 1 seit
Zurücksetzen der Abfüllstatistik.
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Abfülldaten Abfüllart Beschreibung

Abweichung der Gesamtab-
füllung

Einstufige Abfüllungen,
zweistufige Abfüllungen
und zeitgesteuerte Ab-
füllungen

Berechnete Abweichung aller Füll-
summen seit Zurücksetzen der Abfüll-
statistik.

Abfüllungen mit doppel-
tem Füllkopf und zeit-
gesteuerte Abfüllungen
mit doppeltem Füllkopf

Berechnete Abweichung aller Abfüll-
summen durch den Füllkopf Nr. 1 seit
Zurücksetzen der Abfüllstatistik.

Durchschnittliche sekundäre
Gesamtabfüllung

Nur Abfüllungen mit
doppeltem Füllkopf und
zeitgesteuerte Abfüllun-
gen mit doppeltem Füll-
kopf

Berechneter Durchschnitt aller Abfüll-
summen durch den Füllkopf Nr. 2 seit
Zurücksetzen der Abfüllstatistik.

Abweichung der sekundären
Gesamtabfüllung

Nur Abfüllungen mit
doppeltem Füllkopf und
zeitgesteuerte Abfüllun-
gen mit doppeltem Füll-
kopf

Berechnete Abweichung aller Abfüll-
summen durch den Füllkopf Nr. 2 seit
Zurücksetzen der Abfüllstatistik.
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7 Konfigurieren einer integrierten
Abfüll-Ventilsteuerung mittels
Modbus
In diesem Kapitel behandelte Themen:

• Konfigurieren einer integrierten Abfüll Ventilsteuerung mittels Modbus

• Konfigurieren von Abfülloptionen mittels Modbus

• Configure fill control using Modbus (optional)

• Konfigurieren von Abfüllberichten mittels Modbus (optional)

7.1 Konfigurieren einer integrierten Abfüll
Ventilsteuerung mittels Modbus
Die Befüllungsart entsprechend der Anwendung konfigurieren.

Hinweis
Eine einstufige Binärbefüllung eignet sich für die meisten Anwendungen. Diese Befüllungsart
verwenden, soweit keine speziellen Anforderungen für andere Befüllungsarten bestehen. In den
meisten Fällen ist die Auswerteelektronik werksseitig für einstufige Binärbefüllungen konfiguriert
und mit einem Minimum an Konfigurationsanpassungen vor Ort einsatzbereit.

7.1.1 Konfigurieren einer einstufigen Abfüllung mittels
Modbus
Eine einstufige Binärbefüllung konfigurieren, wenn ein einzelner Behälter von einem
einzelnen Ventil befüllt werden soll. Das Ventil ist solange geöffnet, bis der Befüllungssollwert
erreicht ist.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Auf dem PC muss das Modbus Interface Tool (MIT) installiert sein.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Setzen Sie Precision DO1 auf Primary Valve.

b. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.
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Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

b. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

c. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

d. Die anderen Durchflussoptionen wie gewünscht einstellen.
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Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

3. Flow Source (Durchflussquelle) auf die Prozessvariable einstellen, die zur
Befüllungsmessung verwendet werden soll.

Option Beschreibung

Massedurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Massedurchfluss

Volumendurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Volumendurchfluss

4. Folgende Parameter einstellen oder überprüfen:

Parameter Einstellung

Befüllungsoption aktivieren Aktiviert

Doppelbefüllung aktiv Deaktiviert

AOC aktiv Aktiviert

Spülung aktiv Deaktiviert

Enable Timed Fill Deaktiviert

Befüllart Einstufig binär

Hinweis
Micro Motion empfiehlt dringendst die Verwendung der automatischen
Überfüllkompensation (AOC). AOC verbessert, sofern aktiviert und kalibriert, die
Befüllgenauigkeit und Reproduzierbarkeit.

5. Count Up (Hochzählen) wie gewünscht einstellen.

Count Up (Hochzählen) steuert, wie der Befüllzähler rechnet und angezeigt wird.

Option Beschreibung

Enabled (Aktiviert) Der Abfüllzähler beginnt bei 0 und zählt bis zu Fill Target (Befüllungssoll)
hoch.

Disabled (Deaktiviert) Der Abfüllzähler beginnt bei Fill Target und zählt bis 0 herunter.

6. Fill Target (Befüllungssoll) auf die Menge einstellen, bei der der Befüllungsvorgang
abgeschlossen ist.

Den Wert in den Messeinheiten für Flow Source (Durchflussquelle) konfigurierten
Wert eingeben.

7. Max Fill Time (Maximale Befüllungszeit) auf die Anzahl von Sekunden einstellen, bei
der die Befüllungszeit überschritten wird.
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Kann die Befüllung vor Ablauf dieser Zeit nicht abgeschlossen werden, wird die
Befüllung verworfen und Fehlernachrichten werden wegen
Befüllungszeitüberschreitung angezeigt.

Max Fill Time (Maximale Befüllungszeit) auf 0 einstellen, um die
Befüllungszeitüberschreitungsfunktion zu deaktivieren.

Der Standardwert für Max Fill Time (Maximale Befüllungszeit) ist 0 (deaktiviert). Der
Bereich liegt bei 0 Sekunden bis 800 Sekunden.

8. Measured Fill Time (Gemessene Befüllungszeit) wie gewünscht einstellen.

Measured Fill Time (Gemessene Befüllungszeit) steuert, wie die Befüllungszeit
gemessen wird.

Option Beschreibung

Durchfluss stoppt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik erkennt, dass
der Durchfluss nach dem Schließen des Ventils stoppt.

Ventil schließt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik den Binäraus-
gang nach Bedarf einstellt, um das Ventil zu schließen.

Beispiel: Konfigurieren einer einstufigen Abfüllung

Wichtig
In diesem Beispiel werden standardmäßige oder typische Einstellungen für die erforderlichen
Parameter verwendet. Für Ihre Anwendung sind möglicherweise andere Einstellungen erforderlich.
Weitere Informationen zu Datentypen und Integercodes finden Sie im MIT.

Position Wert Beschreibung

Register 2489 110 Setzt die Genauigkeit DO1 auf Primärventil

Register 2490 1 Setzt die DO1 Polarität Genauigkeit auf Aktiv hoch

Register 17 0 Setzt die Durchflussrichtung auf Vorwärts

Register 39 70 Setzt die Massedurchfluss Einheiten auf g/s

Register 42 28 Setzt die Volumendurchfluss Einheiten auf m3/s

Register 1251 0 Setzt die Durchflussquelle auf Massedurchfluss

Speicher 266 0 Setzt Doppelbefüllung aktivieren auf Deaktiviert

Speicher 267 0 Setzt die Zeitgesteuerte Abfüllung aktivieren auf Deaktiviert

Register 1253 1 Setzt die Abfüllart auf Einstufig

Speicher 203 1 Setzt Hochzählen auf Aktiviert

Register
1289-1290

100 Setzt den Abfüll Sollwert auf 100 g

Register 1305 1 Setzt die Max Abfüllzeit auf 1 s

Speicher 347 0 Setzt die Gemessene Abfüllzeit auf Durchfluss gestoppt

Nachbereitungsverfahren

Optionen für einstufige Abfüllungen sind:

• Automatische Überfüllkompensation (AOC) konfigurieren. Wenn die automatische
Überfüllkompensation aktiviert ist, sicherstellen, dass AOC für die entsprechende
Anwendung ordnungsgemäß konfiguriert und kalibriert ist.
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• Implementieren der Spülfunktion.

• Implementieren der Pumpfunktion.

7.1.2 Konfigurieren einer zweistufigen Abfüllung mittels
Modbus
Eine zweistufige Binärbefüllung konfigurieren, wenn ein einzelner Behälter von zwei
Ventilen befüllt werden soll.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Auf dem PC muss das Modbus Interface Tool (MIT) installiert sein.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Setzen Sie Precision DO1 auf Primary Valve.

b. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

c. Setzen Sie Precision DO2 auf Secondary Valve.

d. Stellen Sie Precision DO2 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC
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Option
Signal von der Auswertee-
lektronik Spannung

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

b. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

c. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

d. Die anderen Durchflussoptionen wie gewünscht einstellen.

Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

3. Flow Source (Durchflussquelle) auf die Prozessvariable einstellen, die zur
Befüllungsmessung verwendet werden soll.
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Option Beschreibung

Massedurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Massedurchfluss

Volumendurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Volumendurchfluss

4. Folgende Parameter einstellen oder überprüfen:

Parameter Einstellung

Befüllungsoption aktivieren Aktiviert

Doppelbefüllung aktiv Deaktiviert

AOC aktivieren Aktiviert

Spülung aktiv Deaktiviert

Enable Timed Fill Deaktiviert

Befüllungsart Zweistufig binär

Hinweis
Micro Motion empfiehlt dringendst die Verwendung der automatischen
Überfüllkompensation (AOC). AOC verbessert, sofern aktiviert und kalibriert, die
Befüllgenauigkeit und Reproduzierbarkeit.

5. Count Up (Hochzählen) wie gewünscht einstellen.

Count Up (Hochzählen) steuert, wie der Befüllzähler rechnet und angezeigt wird.

Option Beschreibung

Enabled (Aktiviert) Der Abfüllzähler beginnt bei 0 und zählt bis zu Fill Target (Befüllungssoll)
hoch.

Disabled (Deaktiviert) Der Abfüllzähler beginnt bei Fill Target und zählt bis 0 herunter.

6. Configure By (Konfigurieren von) wie gewünscht einstellen.

Configure By (Konfigurieren von) steuert, wie die Ventilsteuerzeit konfiguriert ist.

Option Beschreibung

% Sol-
lwert

Die Ventilöffnungs- und schließzeit wird als Prozentsatz von Fill Target (Befüllungs-
soll) konfiguriert. Zum Beispiel:
• Ventil öffnet = 0 %: Das Ventil öffnet, wenn die aktuelle Befüllunssumme 0 %

von Fill Target (Befüllungssoll) beträgt.
• Ventil schließt = 90 %: Das Ventil schließt, wenn die aktuelle Befüllungs-

summe 90 % von Fill Target (Befüllungssoll) beträgt.
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Option Beschreibung

Menge Die Ventilöffnungs- und schließzeiten werden zusammen mit der konfigurierten
Messeinheit konfiguriert. Zum Beispiel:
• Ventil öffnet = 0 g: Das Ventil öffnet, wenn die aktuelle Befüllungssumme 0 g

beträgt.
• Ventil schließt = 50 g: Das Ventil schließt, wenn die aktuelle Befüllungs-

summe 50 g weniger als Fill Target (Befüllungssoll) beträgt.

7. Fill Target (Befüllungssoll) auf die Menge einstellen, bei der der Befüllungsvorgang
abgeschlossen ist.

Den Wert in den Messeinheiten für Flow Source (Durchflussquelle) konfigurierten
Wert eingeben.

8. Max Fill Time (Maximale Befüllungszeit) auf die Anzahl von Sekunden einstellen, bei
der die Befüllungszeit überschritten wird.

Kann die Befüllung vor Ablauf dieser Zeit nicht abgeschlossen werden, wird die
Befüllung verworfen und Fehlernachrichten werden wegen
Befüllungszeitüberschreitung angezeigt.

Max Fill Time (Maximale Befüllungszeit) auf 0 einstellen, um die
Befüllungszeitüberschreitungsfunktion zu deaktivieren.

Der Standardwert für Max Fill Time (Maximale Befüllungszeit) ist 0 (deaktiviert). Der
Bereich liegt bei 0 Sekunden bis 800 Sekunden.

9. Measured Fill Time (Gemessene Befüllungszeit) wie gewünscht einstellen.

Measured Fill Time (Gemessene Befüllungszeit) steuert, wie die Befüllungszeit
gemessen wird.

Option Beschreibung

Durchfluss stoppt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik erkennt, dass
der Durchfluss nach dem Schließen des Ventils stoppt.

Ventil schließt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik den Binäraus-
gang nach Bedarf einstellt, um das Ventil zu schließen.

10. Open Primary (Primär öffnen), Open Secondary (Sekundär öffnen), Close Primary (Primär
schließen) und Close Secondary (Sekundär schließen) wie gewünscht einstellen.

Diese Werte steuern den Zeitpunkt in der Befüllung, bei dem die primären und
sekundären Ventile öffnen und schließen. Entweder werden sie durch die Menge
oder den Prozentsatz des Sollwertes, wie durch den Configure By (Konfiguriert durch)
Parameter gesteuert, konfiguriert.

Entweder muss Open Primary (Primär öffnen) oder Open Secondary (Sekundär öffnen)
so eingestellt werden, dass sie zu Befüllungsbeginn öffnen. Sofern dies gewünscht
wird, können beide zu Befüllungsbeginn öffnen. Wird ein Wert so eingestellt, dass er
später öffnet, wird der andere automatisch so eingestellt, dass er zu
Befüllungsbeginn öffnet.

Entweder muss Close Primary (Primär schließen) oder Close Secondary (Sekundär
schließen) auf Schließen bei Befüllungsende eingestellt werden. Sofern dies
gewünscht wird, können beide bei Befüllungsende schließen. Wird ein Wert so
eingestellt, dass er früher schließt, wird der andere automatisch so eingestellt, dass
er bei Befüllungsende schließt.
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Beispiel: Konfigurieren einer zweistufigen Abfüllung

Wichtig
In diesem Beispiel werden standardmäßige oder typische Einstellungen für die erforderlichen
Parameter verwendet. Für Ihre Anwendung sind möglicherweise andere Einstellungen erforderlich.
Weitere Informationen zu Datentypen und Integercodes finden Sie im MIT.

Position Wert Beschreibung

Register 2489 110 Setzt die DO1 Genauigkeit auf Primärventil

Register 2490 1 Setzt die DO1 Polarität Genauigkeit auf Aktiv hoch

Register 2491 111 Setzt die DO2 Genauigkeit auf Sekundärventil

Register 2492 1 Setzt die DO2 Polarität Genauigkeit auf Aktiv hoch

Register 17 0 Setzt die Durchflussrichtung auf Vorwärts

Register 39 70 Setzt die Massedurchfluss Einheiten auf g/s

Register 42 28 Setzt die Volumendurchfluss Einheiten auf m3/s

Register 1251 0 Setzt die Durchflussquelle auf Massedurchfluss

Speicher 266 0 Setzt Doppelabfüllung aktivieren auf Deaktiviert

Spule 267 0 Setzt die Zeitgesteuerte Abfüllung aktivieren auf Deaktiviert

Register 1253 2 Setzt die Abfüllart auf Zweistufig

Speicher 203 1 Setzt Hochzählen auf Aktiviert

Register 1255 0 Setzt Konfigurieren von auf % Sollwert

Register
1289-1290

100 Setzt den Abfüll Sollwert auf 100 g

Register 1305 1 Setzt die Max Abfüllzeit auf 1 s

Speicher 347 0 Setzt die Gemessene Abfüllzeit auf Durchfluss gestoppt

Register
1277-1278

0 Setzt Primär öffnen auf 0 % von Abfüll Sollwert

Register
1281-1282

80 Setzt Primär schließen auf 80 % von Abfüll Sollwert

Register
1279-1280

50 Setzt Sekundär öffnen auf 50 % von Abfüll Sollwert

Register
2517-2518

100 Setzt Sekundär schließen) auf 100 % von Abfüll Sollwert

Nachbereitungsverfahren

Optionen für zweistufige Abfüllungen sind:

• Automatische Überfüllkompensation (AOC) konfigurieren. Wenn die automatische
Überfüllkompensation aktiviert ist, sicherstellen, dass AOC für die entsprechende
Anwendung ordnungsgemäß konfiguriert und kalibriert ist.
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Ventilöffnungs- und Schließsequenzen für zweistufige
diskrete Abfüllungen
Die folgenden Abbildungen zeigen das Öffnen und Schließen der Sekundärventile,
gesteuert durch die Konfiguration von Primär öffnen, Sekundär öffnen, Primär schließen und
Sekundär schließen.

Diese Abbildungen setzen voraus, dass die Abfüllung von Anfang bis Ende ohne
Unterbrechungen läuft.

Zuerst Primär öffnen, zuerst Primär schließenAbbildung 7-1:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Primary

Target 
(AOC adjusted)

T1 T2

Zuerst Primär öffnen, zuerst Sekundär schließenAbbildung 7-2:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

T1 T2

Zuerst Sekundär öffnen, zuerst Primär schließenAbbildung 7-3:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Primary

Target 
(AOC adjusted)

T1 T2
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Zuerst Sekundär öffnen, zuerst Sekundär schließenAbbildung 7-4:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Secondary

Target 
(AOC adjusted)

T1 T2

Einfluss von Configure By (Konfigurieren durch) auf das Öffnen
und Schließen des Ventils
Configure By (Konfigurieren durch) steuert, wie die Werte für Open Primary (Primär öffnen),
Open Secondary Sekundär öffnen), Close Primary (Primär schließen) und Close Secondary
(Sekundär schließen) konfiguriert und angewendet werden.

• Wenn Configure By(Konfiguriert durch) = % Target (Sollwert), addiert die
Auswerteelektronik die konfigurierten Werte für „Valve Open“ (Ventil geöffnet) und
„Valve Close“ (Ventil geschlossen) zu 0 %.

• Wenn Configure By (Konfiguriert durch) = Quantity (Menge), addiert die
Auswerteelektronik die konfigurierten Werte für „Valve Open“ (Ventil geöffnet) zu
0, und subtrahiert die konfigurierten Werte für „Valve Close“ (Ventil geschlossen)
von Fill Target (Befüllungssollwert).

Beispiel: Configure By (Konfiguriert durch) und Befehle zum Öffnen/Schließen des
Ventils

Fill Target (Befüllungssollwert) = 200 g. Das Primärventil soll zu Beginn des
Befüllungsvorgangs öffnen und am Ende des Befüllungsvorgangs schließen. Das
Sekundärventil soll öffnen, nachdem 10 g abgefüllt wurden und wieder schließen,
nachdem 190 g abgefüllt wurden. Siehe Tabelle 7-1 bzgl. der erforderlichen Einstellungen,
die dieses Ergebnis bewirken.

Configure By (Konfiguriert durch) und Ventilkonfiguration Tabelle 7-1:   

Configure By (Konfiguriert durch)
Werte für „Valve Open“ (Ventil geöffnet) und „Valve
Close“ (Ventil geschlossen)

% Sollwert • Open Primary (Primär öffnen) = 0 %
• Open Secondary (Sekundär öffnen) = 5 %
• Close Secondary (Sekundär schließen) = 95 %
• Close Primary (Primär schließen) = 100 %

Menge • Open Primary (Primär öffnen) = 0 g
• Open Secondary (Sekundär öffnen) = 10 g
• Close Secondary (Sekundär schließen) = 10 g
• Close Primary (Primär schließen) = 0 g
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7.1.3 Konfigurieren einer zeitgesteuerten Abfüllung mittels
Modbus
Eine zeitgesteuerte Befüllung konfigurieren, wenn ein einzelner Behälter von einem
einzelnen Ventil befüllt werden soll. Der Ventil ist für eine bestimmte Anzahl von Sekunden
geöffnet.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Auf dem PC muss das Modbus Interface Tool (MIT) installiert sein.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Setzen Sie Precision DO1 auf Primary Valve.

b. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.
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Option Beschreibung

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

b. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

c. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

d. Die anderen Durchflussoptionen wie gewünscht einstellen.

Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

3. Folgende Parameter einstellen oder überprüfen:

Parameter Einstellung

Befüllungsoption aktivieren Aktiviert

Hochzählen Aktiviert

Doppelbefüllung aktiv Deaktiviert

AOC aktivieren Deaktiviert

Spülung aktivieren Deaktiviert

Zeitgesteuerte Befüllung aktivieren Aktiviert

Befüllungsart Einstufig binär

4. Target Time (Sollwertzeit) auf die Anzahl von Sekunden einstellen, die der
Befüllungsvorgang dauern wird.

Beispiel: Konfigurieren einer zeitgesteuerten Abfüllung

Wichtig
In diesem Beispiel werden standardmäßige oder typische Einstellungen für die erforderlichen
Parameter verwendet. Für Ihre Anwendung sind möglicherweise andere Einstellungen erforderlich.
Weitere Informationen zu Datentypen und Integercodes finden Sie im MIT.
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Position Wert Beschreibung

Register 2489 110 Setzt die DO1 Genauigkeit auf Primärventil

Register 2490 1 Setzt die DO1 Polarität Genauigkeit auf Aktiv hoch

Register 17 0 Setzt die Durchflussrichtung auf Vorwärts

Register 39 70 Setzt die Massedurchfluss Einheiten auf g/s

Register 42 28 Setzt die Volumendurchfluss Einheiten auf m3/s

Register 1251 0 Setzt die Durchflussquelle auf Massedurchfluss

Speicher 266 0 Setzt Doppelabfüllung aktivieren auf Deaktiviert

Spule 267 1 Setzt die Zeitgesteuerte Abfüllung aktiv auf Aktiviert

Register 1253 1 Setzt die Abfüllart auf Einstufig

Spule 203 1 Setzt Hochzählen auf Aktiviert

Register
1307-1308

15 Setzt die Sollwertzeit auf 15 s

Nachbereitungsverfahren

Die folgende Option ist für zeitgesteuerte Abfüllungen verfügbar:

• Implementieren der Spülfunktion.

7.1.4 Konfigurieren einer Doppelfüllkopf Abfüllung mittels
Modbus
Eine Befüllung mit doppeltem Füllkopf konfigurieren, wenn zwei Behälter abwechselnd
von doppelten Füllköpfen befüllt werden sollen. Jedes Ventil ist solange geöffnet, bis der
Befüllungssollwert erreicht ist.

Wichtig
Das konfigurierte Fill Target (Befüllungssoll) wird auf beide Befüllungsköpfe angewendet.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Auf dem PC muss das Modbus Interface Tool (MIT) installiert sein.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Setzen Sie Precision DO1 auf Primary Valve.

b. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.
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Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

c. Setzen Sie Precision DO2 auf Secondary Valve.

d. Stellen Sie Precision DO2 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.
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Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

b. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

c. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

d. Die anderen Durchflussoptionen wie gewünscht einstellen.

Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

3. Flow Source (Durchflussquelle) auf die Prozessvariable einstellen, die zur
Befüllungsmessung verwendet werden soll.

Option Beschreibung

Massedurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Massedurchfluss

Volumendurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Volumendurchfluss

4. Folgende Parameter einstellen oder überprüfen:

Parameter Einstellung

Befüllungsoption aktivieren Aktiviert

Hochzählen Aktiviert

Doppelbefüllung aktivieren Aktiviert

AOC aktivieren Aktiviert

Spülung aktiv Deaktiviert

Enable Timed Fill Deaktiviert

Befüllart Einstufig binär

Hinweis
Micro Motion empfiehlt dringendst die Verwendung der automatischen
Überfüllkompensation (AOC). AOC verbessert, sofern aktiviert und kalibriert, die
Befüllgenauigkeit und Reproduzierbarkeit.

5. Fill Target (Befüllungssoll) auf die Menge einstellen, bei der der Befüllungsvorgang
abgeschlossen ist.
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Anmerkung
Das konfigurierte Fill Target (Befüllungssoll) wird auf beide Befüllungsköpfe angewendet.

6. Max Fill Time (Maximale Befüllungszeit) auf die Anzahl von Sekunden einstellen, bei
der die Befüllungszeit überschritten wird.

Kann die Befüllung vor Ablauf dieser Zeit nicht abgeschlossen werden, wird die
Befüllung verworfen und Fehlernachrichten werden wegen
Befüllungszeitüberschreitung angezeigt.

Max Fill Time (Maximale Befüllungszeit) auf 0 einstellen, um die
Befüllungszeitüberschreitungsfunktion zu deaktivieren.

Der Standardwert für Max Fill Time (Maximale Befüllungszeit) ist 0 (deaktiviert). Der
Bereich liegt bei 0 Sekunden bis 800 Sekunden.

7. Measured Fill Time (Gemessene Befüllungszeit) wie gewünscht einstellen.

Measured Fill Time (Gemessene Befüllungszeit) steuert, wie die Befüllungszeit
gemessen wird.

Option Beschreibung

Durchfluss stoppt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik erkennt, dass
der Durchfluss nach dem Schließen des Ventils stoppt.

Ventil schließt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik den Binäraus-
gang nach Bedarf einstellt, um das Ventil zu schließen.

Beispiel: Konfigurieren einer Doppelfüllkopf Abfüllung

Wichtig
In diesem Beispiel werden standardmäßige oder typische Einstellungen für die erforderlichen
Parameter verwendet. Für Ihre Anwendung sind möglicherweise andere Einstellungen erforderlich.
Weitere Informationen zu Datentypen und Integercodes finden Sie im MIT.

Position Wert Beschreibung

Register 2489 110 Setzt die DO1 Genauigkeit auf Primärventil

Register 2490 1 Setzt die DO1 Polarität Genauigkeit auf Aktiv hoch

Register 2491 111 Setzt die DO2 Genauigkeit auf Sekundärventil

Register 2492 1 Setzt die DO2 Polarität Genauigkeit auf Aktiv hoch

Register 17 0 Setzt die Durchflussrichtung auf Vorwärts

Register 39 70 Setzt die Massedurchfluss Einheiten auf g/s

Register 42 28 Setzt die Volumendurchfluss Einheiten auf m3/s

Register 1251 0 Setzt die Durchflussquelle auf Massedurchfluss

Register 1253 1 Setzt die Abfüllart auf Einstufig

Speicher 266 1 Setzt die Doppelabfüllung aktivieren auf Aktiviert

Speicher 267 0 Setzt die Zeitgesteuerte Abfüllung aktivieren auf Deaktiviert

Speicher 203 1 Setzt Hochzählen auf Aktiviert

Register
1289-1290

100 Setzt den Abfüll Sollwert auf 100 g
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Position Wert Beschreibung

Register 1305 1 Setzt die Max Abfüllzeit auf 1 s

Speicher 347 0 Setzt die Gemessene Abfüllzeit auf Durchfluss gestoppt

Nachbereitungsverfahren

Optionen für Doppelfüllkopf Abfüllungen sind:

• Automatische Überfüllkompensation (AOC) konfigurieren. Wenn die automatische
Überfüllkompensation aktiviert ist, sicherstellen, dass AOC für die entsprechende
Anwendung ordnungsgemäß konfiguriert und kalibriert ist.

7.1.5 Konfigurieren einer zeitgesteuerten Doppelfüllkopf
Abfüllung mittels Modbus
Eine zeitgesteuerte Befüllung mit doppeltem Füllkopf konfigurieren, wenn zwei Behälter
abwechselnd von doppelten Füllköpfen befüllt werden sollen. Jedes Ventil ist für eine
bestimmte Anzahl von Sekunden geöffnet.

Wichtig
Die konfigurierte Target Time (Sollwertzeit) wird auf beide Befüllungsköpfe angewendet.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Auf dem PC muss das Modbus Interface Tool (MIT) installiert sein.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Setzen Sie Precision DO1 auf Primary Valve.

b. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

c. Setzen Sie Precision DO2 auf Secondary Valve.
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d. Stellen Sie Precision DO2 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

b. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

c. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.
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d. Die anderen Durchflussoptionen wie gewünscht einstellen.

Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

3. Flow Source (Durchflussquelle) auf die Prozessvariable einstellen, die zur
Befüllungsmessung verwendet werden soll.

Option Beschreibung

Massedurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Massedurchfluss

Volumendurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Volumendurchfluss

4. Folgende Parameter einstellen oder überprüfen:

Parameter Einstellung

Befüllungsoption aktivieren Aktiviert

Hochzählen Aktiviert

Doppelbefüllung aktivieren Aktiviert

AOC aktivieren Deaktiviert

Spülung aktivieren Deaktiviert

Zeitgesteuerte Befüllung aktivieren Aktiviert

Befüllungsart Einstufig binär

5. Target Time (Sollwertzeit) auf die Anzahl von Sekunden einstellen, die der
Befüllungsvorgang dauern wird.

Anmerkung
Die konfigurierte Target Time (Sollwertzeit) wird auf beide Befüllungsköpfe angewendet.

Beispiel: Konfigurieren einer zeitgesteuerten Doppelfüllkopf Abfüllung

Wichtig
In diesem Beispiel werden standardmäßige oder typische Einstellungen für die erforderlichen
Parameter verwendet. Für Ihre Anwendung sind möglicherweise andere Einstellungen erforderlich.
Weitere Informationen zu Datentypen und Integercodes finden Sie im MIT.

Position Wert Beschreibung

Register 2489 110 Setzt die Genauigkeit DO1 auf Primärventil

Register 2490 1 Setzt die Genauigkeit Poarität DO1 auf Aktiv hoch

Register 2491 111 Setzt die Genauigkeit DO2 auf Sekundärventil

Register 2492 1 Setzt die Genauigkeit Poarität DO2 auf Aktiv hoch

Register 17 0 Setzt die Durchflussrichtung auf Vorwärts
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Position Wert Beschreibung

Register 39 70 Setzt die Massedurchfluss Einheiten auf g/s

Register 42 28 Setzt die Volumendurchfluss Einheiten auf m3/s

Register 1251 0 Setzt die Durchflussquelle auf Massedurchfluss

Speicher 266 1 Setzt die Doppelabfüllung aktivieren auf Aktiviert

Speicher 267 1 Setzt die Zeitgesteuerte Befüllung aktiv auf Aktiviert

Register 1253 1 Setzt die Abfüllart auf Einstufig

Speicher 203 1 Setzt Hochzählen auf Aktiviert

Register
1307-1308

15 Setzt die Sollwertzeit auf 15 s

7.2 Konfigurieren von Abfülloptionen mittels
Modbus
Je nach Befüllungsart kann die automatische Überfüllkompensation (AOC), die Spül- oder
die Pumpenfunktion konfiguriert und angewendet werden.

7.2.1 Konfigurieren und Implementieren der automatischen
Überfüllkompensation (AOC) mittels Modbus
Die automatische Überfüllkompensation (AOC) wird verwendet, um die Abfüllzeit
anzupassen und um für die Zeit zu kompensieren, die benötigt wird, den Befehl zum
Schließen des Ventils zu übertragen bzw. damit das Ventil vollständig schließt.

Vorbereitungsverfahren

Vor Einrichtung der AOC stellen Sie sicher, dass alle anderen Abfüllparameter richtig
konfiguriert sind.

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Auf dem PC muss das Modbus Interface Tool (MIT) installiert sein.

Verfahren

1. Wählen Sie die Art der zu implementierenden AOC.

Option Beschreibung

Fixed Das Ventil schließt an dem Punkt, der durch Fill Target minus der Menge, die in Fixed
Overshoot Comp eingegeben ist, definiert wird. Verwenden Sie diese Option nur
dann, wenn der Wert für die „Frühwarnung“ bereits bekannt ist.

Overfill Definiert die Richtung, aus der der AOC-Algorithmus sich der Sollmenge nähert.
Der AOC-Algorithmus beginnt mit der Schätzung eines Überfüllungswerts und re-
duziert dann die Überfüllung in aufeinanderfolgenden Kalibrierabfüllungen.
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Option Beschreibung

Underfill Definiert die Richtung, aus der der AOC-Algorithmus sich der Sollmenge nähert.
Der AOC-Algorithmus beginnt mit der Schätzung eines Unterfüllungswerts und re-
duziert dann die Unterfüllung in aufeinanderfolgenden Kalibrierabfüllungen.

Hinweis
Die Option Fixed wird normalerweise nicht verwendet. Wenn Sie Fixed wählen, funktioniert die
Auswerteelektronik als Legacy-Batchsteuerung. In typischen Einsatzbereichen bieten die
anderen AOC-Optionen bessere Genauigkeit und Wiederholbarkeit.

Einschränkung
Die Optionen Fixed und Overfill werden für Abfüllungen mit doppeltem Füllkopf nicht
unterstützt.

2. Implementierung der Fixed AOC:

a. Deaktivieren Sie Enable AOC.

b. Setzen Sie AOC Algorithm auf Fixed.

c. Stellen Sie Fixed Overshoot Comp nach Wunsch ein.

Die Voreinstellung ist 0 und wird in Prozesseinheiten gemessen.

Die Auswerteelektronik schließt das Ventil, wenn der aktuelle Abfüllzähler gleich
dem Fill Target minus dem angegebenen Wert (in Prozesseinheiten) ist.

3. So implementieren Sie Overfill oder Underfill:

a. Stellen Sie sicher, dass Enable AOC aktiviert ist.

b. Setzen Sie AOC Algorithm auf Underfill oder Overfill.
c. Stellen Sie AOC Window Length auf die Anzahl der Abfüllungen ein, die zur AOC-

Kalibrierung verwendet wird.

Die Voreinstellung ist 10. Der Auswahlbereich ist 2 bis 32.

Hinweis
Micro Motion empfiehlt die Verwendung des Standardwerts, es sei denn, Sie haben
besondere Anwendungsanforderungen.

Wichtig
Ändern Sie die Werte für AOC Change Limit oder AOC Convergence Rate nur auf Anweisung des
Kundendienstes von Micro Motion. Diese Parameter werden verwendet, um die Funktion des
AOC-Algorithmus für besondere Anwendungsanforderungen einzustellen.

Beispiel: Konfigurieren von AOC

Wichtig
In diesem Beispiel werden standardmäßige oder typische Einstellungen für die erforderlichen
Parameter verwendet. Für Ihre Anwendung sind möglicherweise andere Einstellungen erforderlich.
Weitere Informationen zu Datentypen und Integercodes finden Sie im MIT.

• Feste AOC:
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Position Wert Beschreibung

Speicher 205 0 Setzt AOC aktiviert auf Deaktiviert

Register 1309 2 Setzt AOC Algorithmus auf Fest

Register
2515-2516

0 Setzt Feste Überfüllkompensation auf 0

• Überfüll- oder Unterfüll-AOC:

Position Wert Beschreibung

Speicher 205 1 Setzt AOC aktiviert auf Aktiviert

Register 1309 0 Setzt AOC Algorithmus auf Überfüllung

Register 1310 10 Setzt AOC Bereichsbreite auf 10 Abfüllungen

Nachbereitungsverfahren

Wenn Sie AOC Algorithm auf Overfill oder Underfill setzen, müssen Sie eine AOC-Kalibrierung
durchführen.

Durchführen einer AOC Kalibrierung mittels Modbus
Die AOC-Kalibrierung wird verwendet, um den Wert für die automatische
Überfüllkompensation (Automatic Overshoot Compensation, AOC) anhand der Ist-
Abfülldaten zu berechnen. Wenn Sie AOC Algorithm auf Overfill oder Underfill setzen, müssen
Sie eine AOC-Kalibrierung durchführen.

Es gibt zwei Arten der AOC-Kalibrierung:

• Standard: Die Kalibrierung wird manuell durchgeführt. Der AOC-Koeffizient wird
anhand von Abfülldaten berechnet, die bei dieser Kalibrierung eingeholt werden,
und derselbe AOC-Koeffizient wird solange angewandt, bis die Kalibrierung
wiederholt wird.

• Rolling: Die Kalibrierung wird kontinuierlich und automatisch durchgeführt, und der
AOC-Koeffizient wird kontinuierlich - auf Basis von Abfülldaten des letzten
Abfüllvorgangs - aktualisiert.

Hinweis
Für stabile Prozesse empfiehlt Micro Motion die AOC-Standardkalibrierung. Testen Sie nach Bedarf
beide Methoden und wählen Sie die Methode, mit der Sie die besten Ergebnisse erzielen.

Durchführen einer Standard AOC Kalibrierung

Standard AOC Calibration wird verwendet, um einen konstanten AOC-Koeffizienten zu
erzeugen.

Vorbereitungsverfahren

AOC Window Length muss entsprechend gesetzt werden. Micro Motion empfiehlt die
Verwendung des Standardwerts (10), es sei denn, Sie haben besondere
Anwendungsanforderungen.
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Mass Flow Cutoff bzw. Volume Flow Cutoff müssen entsprechend der Betriebsumgebung
gesetzt werden.

• Wenn Flow Source auf Mass Flow Rate gesetzt ist, siehe Abschnitt 11.2.3.

• Wenn Flow Source auf Volume Flow Rate gesetzt ist, siehe Abschnitt 11.3.2.

Ihr System muss zum Abfüllen bereit sein, und Sie müssen wissen, wie Abfüllvorgänge
ausgeführt werden.

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Auf dem PC muss das Modbus Interface Tool (MIT) installiert sein.

Verfahren

1. Kalibrierung des Primärventils (alle Befüllarten):

a. Schreiben von 1 zu Start AOC Kalibrierung (Speicher 209).

b. Führen Sie zwischen zwei und der in AOC Window Length angegebenen Anzahl von
Kalibrierabfüllungen aus.

Anmerkung
Sie können nach Wahl auch mehr Kalibrierabfüllungen durchführen. Der AOC-Koeffizient
wird anhand der letzten Abfüllungen berechnet.

Hinweis
Normalerweise werden, aufgrund der werksseitigen Standardeinstellungen, die ersten
Abfüllungen leicht über- oder unterfüllt. Im Laufe der Kalibrierung werden diese
Abfüllungen auf dem Fill Target konvergieren.

c. Wenn die Zähler kontinuierlich zufriedenstellend sind, schreibe 1 an AOC Kal
speichern (Speicher 210).

2. Kalibrierung des Sekundärventils (Abfüllungen mit doppeltem Füllkopf):

a. Schreibe 1 an Start Sekundäre AOC Kalibrierung (Speicher 342).

b. Führen Sie zwischen zwei und der in AOC Window Length angegebenen Anzahl von
Kalibrierabfüllungen aus.

Die Auswerteelektronik führt die Abfüllungen automatisch durch das
Sekundärventil durch.

Anmerkung
Sie können nach Wahl auch mehr Kalibrierabfüllungen durchführen. Der AOC-Koeffizient
wird anhand der letzten Abfüllungen berechnet.

Hinweis
Normalerweise werden, aufgrund der werksseitigen Standardeinstellungen, die ersten
Abfüllungen leicht über- oder unterfüllt. Im Laufe der Kalibrierung werden diese
Abfüllungen auf dem Fill Target konvergieren.

c. Wenn die Zähler kontinuierlich zufriedenstellend sind, schreibe 1 an Sekundäre
AOC Kal speichern (Speicher 343).
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Der aktuelle AOC-Koeffizient wird im Fenster Run Filler angezeigt. Falls Sie eine Abfüllung
mit doppeltem Füllkopf durchführen, zeigt das Fenster Run Filler den AOC-Koeffizienten
für das Primär- und für das Sekundärventil an. Diese Koeffizienten werden solange auf die
Abfüllvorgänge angewandt, wie AOC aktiviert ist.

Anmerkung
Bei zweistufigen Abfüllungen wird der AOC-Wert auf das Ventil angewandt, das sich schließt,
nachdem die Sollmenge erreicht ist. Falls die Abfüllparameter so eingestellt sind, dass sich beide
Ventile nach Erreichen der Sollmenge schließen, wird der AOC-Koeffizient auf beide Ventile
angewandt.

Hinweis
Micro Motion empfiehlt eine Wiederholung der AOC-Kalibierung, falls einer der folgenden Zustände
eintritt:

• Wenn Geräte ausgetauscht oder eingestellt wurden.

• Wenn sich die Durchflussmenge bedeutend geändert hat.

• Wenn die Abfüllgenauigkeit niedriger als erwartet ist.

• Wenn Mass Flow Cutoff oder Volume Flow Cutoff geändert wurden.

Einrichten einer kontinuierlichen AOC Kalibrierung

Rolling AOC Calibration wird verwendet, um den AOC-Koeffizienten kontinuierlich - auf
Basis von Abfülldaten des letzten Abfüllvorgangs - zu aktualisieren.

Vorbereitungsverfahren

AOC Window Length muss entsprechend gesetzt werden. Micro Motion empfiehlt die
Verwendung des Standardwerts (10), es sei denn, Sie haben besondere
Anwendungsanforderungen.

Ihr System muss zum Abfüllen bereit sein, und Sie müssen wissen, wie Abfüllvorgänge
ausgeführt werden.

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Auf dem PC muss das Modbus Interface Tool (MIT) installiert sein.

Verfahren

1. Schreibe 1 an Start AOC Kalibrierung (Speicher 209), um das Primärventil zu kalibrieren
(alle Abfüllarten). Schreibe 1 an Start Sekundäre AOC Kalibrierung (Speicher 342), um
das sekundäre Ventil zu kalibrieren (Abfüllungen mit doppeltem Füllkopf).

Sie können die kontinuierliche AOC-Kalibrierung für ein oder beide Ventile
einrichten.

2. Starten Sie die Serienabfüllung.

Die Auswerteelektronik berechnet den/die AOC-Koeffizienten nach jeder Abfüllung
anhand der letzten xAbfüllungen neu, wobei x die in AOC Window Length festgelegte Anzahl
ist. Die aktuellen Werte werden im Fenster Run Filler angezeigt. Falls sich die Konfiguration
oder die Prozessbedingungen geändert haben, gleicht die kontinuierliche AOC-
Kalibrierung diese Änderungen aus. Diese Einstellung findet jedoch über mehrere
Abfüllungen hinweg statt, das heißt, dass es einige Abfüllvorgänge dauern wird, ehe AOC
die Werte angepasst hat.
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Hinweis
Während der AOC Kalibrierung können Sie 1 an AOC Kalibrierung speichern (Speicher 210) oder 1 an
AOC Kalibrierung speichern (Speicher 343) schreiben. Der aktuelle AOC-Koeffizient wird gespeichert
und auf alle nachfolgenden Abfüllungen durch das entsprechende Ventil angewandt. Mit anderen
Worten ändert diese Aktion die AOC-Kalibriermethode für dieses Ventil von Rolling auf Standard.

7.2.2 Konfigurieren der Spülfunktion mittels Modbus
Die Spülfunktion wird verwendet, um ein Hilfsventil zu steuern, das nicht für die Abfüllung
eingesetzt wird. Beispielsweise kann damit ein Behälter mit Wasser oder Gas aufgefüllt
werden, nachdem der Füllvorgang abgeschlossen ist, oder sie kann als “ Dämpfung
dienen.” Der Durchfluss durch das Hilfsventil wird von der Auswerteelektronik nicht
gemessen. Eine Konfiguration der Spülfunktion zur automatischen oder manuellen
Spülsteuerung ist möglich. Bei der Auswahl der automatischen Steuerung wird das
Hilfsventil nach jeder Befüllung geöffnet und nach dem Ablauf der konfigurierten Spülzeit
geschlossen.

Einschränkung
Die Spülfunktion wird nicht für Befüllungen mit doppeltem Füllkopf oder zeitgesteuerte Befüllungen
mit doppeltem Füllkopf unterstützt.

Vorbereitungsverfahren

Die Binärausgänge müssen entsprechend Ihrer Abfüllart und Abfülloptionen geschaltet
sein.

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Auf dem PC muss das Modbus Interface Tool (MIT) installiert sein.

Verfahren

1. Konfigurieren von Kanal B als Binärausgang:

a. Setzen Sie Channel B Type Assignment auf Discrete Output.
b. Setzen Sie DO1 Assignment auf Discrete Batch: Purge Valve.

c. Stellen Sie DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

d. Stellen Sie DO1 Fault Action entsprechend Ihrer Installation ein.
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Option Beschreibung

Upscale Der Binäreingang wird auf EIN geschaltet (Ventil geöf-
fnet), wenn eine Störung auftritt.

Downscale Der Binäreingang wird auf AUS geschaltet (Ventil ges-
chlossen), wenn eine Störung auftritt.

None Bei Auftreten einer Störung werden keine Maßnahmen er-
griffen. Der Binärausgang bleibt in dem Zustand, in dem
er vor Auftreten der Störung war.

2. Spülung konfigurieren:

a. Enable Purge (Spülung aktivieren) aktivieren.

b. Purge Mode (Spülmodus) wie gewünscht einstellen.

Option Beschreibung

Auto (Automatisch) Eine Spülung wird nach jeder Befüllung automatisch
durchgeführt.

Manual (Manuell) Spülvorgänge müssen manuell gestartet und ges-
toppt werden.

Hinweis
Wenn Purge Mode (Spülmodus) auf Auto (Automatisch) eingestellt ist, ist eine manuelle
Steuerung des Spülventils weiterhin möglich. Eine Spülung kann manuell gestartet oder
gestoppt werden oder sie kann durch die Auswerteelektronik nach der abgelaufenen
Purge Time (Spülzeit) gestoppt werden. Wird eine Spülung automatisch gestartet, kann sie
manuell gestoppt werden.

c. Wenn Purge Mode (Spülmodus) auf Auto (Automatisch) eingestellt ist, Purge Delay
(Spülverzögerung) auf die Anzahl von Sekunden einstellen, die die
Auswerteelektronik nach der Befüllung warten soll, umd das Spülventil zu
öffnen.

Der Standardwert für Purge Delay (Spülverzögerung) beträgt 2 Sekunden.

d. Wenn Purge Mode (Spülmodus) auf Auto (Automatisch) eingestellt wird, Purge Time
(Spülzeit) auf die Anzahl von Sekunden einstellen, die die Auswerteelektronik das
Ventil offen halten soll.

Der Standardwert für Purge Time (Spülzeit) beträgt 1 Sekunde. Der Bereich liegt
bei 0 Sekunden bis 800 Sekunden.

Hinweis
Die nächste Befüllung kann erst beginnen, wenn das Spülventil geschlossen ist.

Beispiel: Konfigurieren der Spülfunktion

Wichtig
In diesem Beispiel werden standardmäßige oder typische Einstellungen für die erforderlichen
Parameter verwendet. Für Ihre Anwendung sind möglicherweise andere Einstellungen erforderlich.
Weitere Informationen zu Datentypen und Integercodes finden Sie im MIT.
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Position Wert Beschreibung

Register 1167 4 Setzt die Typzuweisung für Kanal B auf Binärausgang

Register 1151 110 Setzt die DO1 Zuweisung auf Primärventil

Register 1152 1 Setzt die DO1 Polarität auf Aktiv hoch

Register 2615 4 Setzt die DO1 Störaktion auf Keine

Speicher 111 1 Aktiviert Purge aktivieren

Speicher 200 0 Setzt den Spülmodus auf Auto

Register
1311-1312

3 Setzt die Spülverzögerung auf 3 s

Register
1313-1314

2 Setzt die Spülzeit auf 2 s

7.2.3 Konfigurieren der Pumpenfunktion mittels Modbus
Die Pumpfunktion wird verwendet, um den Druck während der Abfüllung zu erhöhen,
indem eine in Flussrichtung liegende Pumpe kurz vor dem Beginn der Abfüllung gestartet
wird.

Einschränkung
Die Pumpenfunktion wird nicht für zweistufige Binärbefüllungen, Befüllungen mit doppeltem
Füllkopf, zeitgesteuerte Befüllungen oder zeitgesteuerte Befüllungen mit doppeltem Füllkopf
unterstützt.

Vorbereitungsverfahren

Die Binärausgänge müssen entsprechend Ihrer Abfüllart und Abfülloptionen geschaltet
sein.

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Auf dem PC muss das Modbus Interface Tool (MIT) installiert sein.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Setzen Sie Precision DO2 auf Pump.

b. Stellen Sie Precision DO2 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC
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Option
Signal von der Auswertee-
lektronik Spannung

OFF Standortspezifisch bis zu
30 VDC

2. Pump to Valve Delay (Pumpe-zu-Ventilverzögerung) auf die Anzahl von Sekunden
einstellen, die die Pumpe laufen soll, bevor das Ventil geöffnet wird.

Der Standardwert beträgt 10 Sekunden. Der Bereich liegt bei 0 Sekunden bis
30 Sekunden.

Wenn der Befehl Begin Filling (Befüllung beginnen) empfangen wird, startet die
Auswerteelektronik die Pumpe, wartet die unter Pump to Valve Delay (Pumpe-zu-
Ventilverzögerung) spezifizierte Anzahl von Sekunden und öffnet dann das Ventil. Die
Pumpe läuft, bis die Befüllung abgeschlossen ist.

Beispiel: Konfigurieren der Pumpenfunktion

Wichtig
In diesem Beispiel werden standardmäßige oder typische Einstellungen für die erforderlichen
Parameter verwendet. Für Ihre Anwendung sind möglicherweise andere Einstellungen erforderlich.
Weitere Informationen zu Datentypen und Integercodes finden Sie im MIT.

Position Wert Beschreibung

Register 2491 109 Setzt die DO2 Genauigkeit auf Pumpe

Register 2492 1 Setzt die DO2 Polarität Genauigkeit auf Aktiv hoch

Register
2493-2494

15 Setzt die Pumpe zu Ventil Verzögerung auf 15 s

7.3 Configure fill control using Modbus (optional)
Bei einer typischen Serienfertigung erfolgt die Abfüllsteuerung (Starten und Stoppen der
Abfüllung) durch den Host oder die SPS. Sie können auf Wunsch das System auch so
einrichten, dass die Abfüllung über den Binäreingang (falls verfügbar) begonnen, beendet,
angehalten und fortgesetzt wird. Außerdem können Sie ein Ereignis definieren, bei dem
die Abfüllung beginnt, endet, angehalten oder fortgesetzt wird.

7.3.1 Konfigurieren des Binäreingangs für die Abfüllsteuerung
mittels Modbus
Wenn Kanal B verfügbar ist, können Sie diesen als Binäreingang konfigurieren und
verwenden, um eine Abfüllung zu beginnen oder zu beenden oder um eine laufende
Abfüllung anzuhalten und fortzusetzen. Außerdem können Sie den Kanal zum
Zurücksetzen des Masse Summenzählers, des Volumen Summenzählers oder aller
Summenzähler konfigurieren. Wenn der Binäreingang aktiviert ist, werden alle
zugewiesenen Aktionen durchgeführt.
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Vorbereitungsverfahren

Kanal B muss als Binärausgang geschaltet sein.

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Auf dem PC muss das Modbus Interface Tool (MIT) installiert sein.

Verfahren

1. Konfigurieren von Kanal B als Binäreingang:

a. Setzen Sie Type Assignment für Kanal B auf Discrete Input.
2. Weisen Sie dem Binäreingang Steuerungsaktionen zur Abfüllung zu.

a. Wählen Sie die Aktion oder Aktionen, die bei Aktivierung des Binäreingangs
ausgeführt werden sollen.

Aktion Beschreibung Bemerkungen

Begin Filling Beginnt die Abfüllung mit der aktuellen Abfüll-
konfiguration. Der Abfüllzähler wird automa-
tisch zurückgesetzt, bevor die Abfüllung be-
ginnt.

Falls eine Abfüllung läuft, wird der Befehl ig-
noriert.

Wenn ein automatischer Spülvorgang läuft,
werden die Funktionen zum Start der Abfül-
lung ausgeführt, sobald der Spülvorgang ab-
geschlossen ist.

End Filling Beendet die aktuelle Abfüllung und führt Funk-
tionen zum Ende der Abfüllung aus. Die Abfül-
lung kann nicht fortgesetzt werden.

Wird ausgeführt, während eine Abfüllung läuft
oder angehalten ist und während eines Spül-
vorgangs oder einer Spülverzögerung.

Für Abfüllungen mit doppeltem Füllkopf und
zeitgesteuerte Abfüllungen mit doppeltem
Füllkopf beendet der Befehl immer die zurzeit
aktive Abfüllung.

Pause Filling Zeitgesteuerte Abfüllungen, Abfüllungen mit
doppeltem Füllkopf und zeitgesteuerte Abfül-
lungen mit doppeltem Füllkopf: Identisch mit
End Filling.

Einstufige Abfüllungen und zweistufige Abfül-
lungen: Hält die Abfüllung vorläufig an. Die
Abfüllung kann fortgesetzt werden, wenn die
Abfüllmenge kleiner als die Sollmenge ist.

Falls ein Spülvorgang oder eine Spülverzöger-
ung läuft, wird der Befehl ignoriert.

Resume Filling Startet die Abfüllung wieder, nachdem sie un-
terbrochen wurde. Die Zählung wird an der
Stelle oder an dem Zeitpunkt wieder fortge-
setzt, an der/dem sie unterbrochen wurde.

Wird nur ausgeführt, wenn eine einstufige Ab-
füllung oder eine zweistufige Abfüllung ange-
halten wurden. Wird alle anderen Male ignor-
iert.

Reset Mass Total Setzt den Wert des Masse Summenzählers auf
0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

Reset Volume Total Setzt den Wert des Volumen Summenzählers
auf 0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.
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Aktion Beschreibung Bemerkungen

Reset All Totals Setzt den Wert des Masse Summenzählers und
des Volumen Summenzählers auf 0 zurück,
und setzt den Abfüllzähler auf 0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

3. Stellen Sie DI1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das vom Binäreingang gesendete EIN-Signal auch als EIN
gelesen wird, und umgekehrt.

Option
Angelegte Spannung über
Anschlussklemmen Auswerteelektronik liest

Active High 3 bis 30 VDC ON

<0,8 VDC OFF

Active Low <0,8 VDC ON

3 bis 30 VDC OFF

Beispiel: Konfigurieren des Binäreingangs für die Abfüllsteuerung

Wichtig
In diesem Beispiel werden standardmäßige oder typische Einstellungen für die erforderlichen
Parameter verwendet. Für Ihre Anwendung sind möglicherweise andere Einstellungen erforderlich.
Weitere Informationen zu Datentypen und Integercodes finden Sie im MIT.

Position Wert Beschreibung

Register 1167 5 Setzt die Typ Zuordnung für Kanal B auf Binäreingang

Register 1329 98 Weist Abfüllung starten dem Binäreingang zu

Register 1178 1 Setzt die DI1 Polarität auf Aktiv hoch

7.3.2 Einrichten eines Ereignisses zur Durchführung einer
Abfüllsteuerung mit Modbus
Sie können ein Ereignis zuweisen, um eine Abfüllung zu starten, zu stoppen, anzuhalten
oder fortzusetzen. Außerdem können Sie das Ereignis zum Zurücksetzen des Masse
Summenzählers, des Volumen Summenzählers oder aller Summenzähler zuweisen. Beim
Schalten des Ereignisses auf ON (EIN) werden alle zugewiesenen Aktionen durchgeführt.

Vorbereitungsverfahren

Sie müssen alle gewünschten Ereignisse konfigurieren. Sie können diese Ereignisse sowohl
vor als auch nach dem Zuweisen von Aktionen konfigurieren.

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Auf dem PC muss das Modbus Interface Tool (MIT) installiert sein.
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Verfahren

1. Weisen Sie dem Ereignis Steuerungsaktionen zur Abfüllung zu.

a. Identifizieren Sie die Aktion oder Aktionen, die bei Auftreten des Discrete Event 1
ausgeführt werden soll bzw. sollen.

Aktion Beschreibung Bemerkungen

Begin Filling Beginnt die Abfüllung mit der aktuellen Abfüll-
konfiguration. Der Abfüllzähler wird automa-
tisch zurückgesetzt, bevor die Abfüllung be-
ginnt.

Falls eine Abfüllung läuft, wird der Befehl ig-
noriert.

Wenn ein automatischer Spülvorgang läuft,
werden die Funktionen zum Start der Abfül-
lung ausgeführt, sobald der Spülvorgang ab-
geschlossen ist.

End Filling Beendet die aktuelle Abfüllung und führt Funk-
tionen zum Ende der Abfüllung aus. Die Abfül-
lung kann nicht fortgesetzt werden.

Wird ausgeführt, während eine Abfüllung läuft
oder angehalten ist und während eines Spül-
vorgangs oder einer Spülverzögerung.

Für Abfüllungen mit doppeltem Füllkopf und
zeitgesteuerte Abfüllungen mit doppeltem
Füllkopf beendet der Befehl immer die zurzeit
aktive Abfüllung.

Pause Filling Zeitgesteuerte Abfüllungen, Abfüllungen mit
doppeltem Füllkopf und zeitgesteuerte Abfül-
lungen mit doppeltem Füllkopf: Identisch mit
End Filling.

Einstufige Abfüllungen und zweistufige Abfül-
lungen: Hält die Abfüllung vorläufig an. Die
Abfüllung kann fortgesetzt werden, wenn die
Abfüllmenge kleiner als die Sollmenge ist.

Falls ein Spülvorgang oder eine Spülverzöger-
ung läuft, wird der Befehl ignoriert.

Resume Filling Startet die Abfüllung wieder, nachdem sie un-
terbrochen wurde. Die Zählung wird an der
Stelle oder an dem Zeitpunkt wieder fortge-
setzt, an der/dem sie unterbrochen wurde.

Wird nur ausgeführt, wenn eine einstufige Ab-
füllung oder eine zweistufige Abfüllung ange-
halten wurden. Wird alle anderen Male ignor-
iert.

Reset Mass Total Setzt den Wert des Masse Summenzählers auf
0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

Reset Volume Total Setzt den Wert des Volumen Summenzählers
auf 0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

Reset All Totals Setzt den Wert des Masse Summenzählers und
des Volumen Summenzählers auf 0 zurück,
und setzt den Abfüllzähler auf 0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

2. Wiederholen Sie das Verfahren für Discrete Event 2–5.
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Beispiel: Ereignisse überwachen den Prozess und pausieren oder beenden die
Abfüllung

Der akzeptable Dichtebereich für Ihren Prozess ist 1,1 g/cm3 bis 1,12 g/cm3. Der
akzeptable Temperaturbereich ist 20 °C bis 25 °C. Wenn die Dichte den Messbereich
überschreitet, möchten Sie die Abfüllung anhalten. Wenn die Temperatur den
Messbereich überschreitet, möchten Sie die Abfüllung beenden.

Konfiguration der Ereignisse:

• Discrete Event 1:

Einbauort Wert Beschreibung

Register 609 0 Wählt Binärereignis 1

Register 610 3 Stellt Ereignisart auf Außerhalb des Bereichs ein

Register 615 3 Stellt Prozessvariable auf Dichte ein

Register 611–
612

1.10 Stellt Niedriger Sollwert (A) auf 1,1 g/cm3

Register 613–
614

1.12 Stellt Hoher Sollwert (B) auf 1,12 g/cm3

• Discrete Event 2:

Einbauort Wert Beschreibung

Register 609 2 Wählt Binärereignis 2

Register 610 3 Stellt Ereignisart auf Außerhalb des Bereichs ein

Register 615 1 Stellt Prozessvariable auf Temperatur

Register 611–
612

20 Stellt Niedriger Sollwert (A) auf 20 °C

Register 613–
614

25 Stellt Hoher Sollwert (B) auf 25 °C

• Aktionszuordnungen:

Einbauort Wert Beschreibung

Register 1330 57 Weist Abfüllung Pause dem Binärereignis 1 zu

Register 1324 58 Weist Abfüllung Ende dem Binärereignis 2 zu

Nachbereitungsverfahren

Wenn Sie Ereignissen Aktionen zugeordnet haben, die nicht konfiguriert sind, müssen Sie
diese Ereignisse konfigurieren, bevor Sie diese Methode der Abfüllsteuerung
implementieren können.
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7.3.3 Mehrere Maßnahmen, die einem Binäreingang oder
Ereignis zugewiesen sind
Wenn mehrere Maßnahmen einem Binäreingang oder Ereignis zugewiesen sind, führt die
Auswerteelektronik nur die Maßnahmen durch, die jeweils für die aktuelle Situation von
Bedeutung sind. Wenn zwei oder mehr der Maßnahmen sich gegenseitig ausschließen,
führt die Auswerteelektronik Maßnahmen gemäß einem Prioritätenschema durch, das in
der Firmware der Auswerteelektronik definiert ist.

Die folgenden Beispiele zeigen drei Konfigurationen, die Micro Motion empfiehlt, und zwei
Konfigurationen, die nicht empfohlen werden.

Beispiel: Verwenden des Binäreingangs oder des Ereignisses, um eine Abfüllung zu
beginnen und zu beenden (empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Beginn
• Abfüllung-Ende
• Masse Summenzähler zurücksetzen
• Volumen Summenzähler zurücksetzen

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, werden der Masse Summenzähler und der Volumen
Summenzähler zurückgesetzt und eine Abfüllung beginnt.

• Wenn eine Abfüllung läuft, wird diese beendet und der Masse Summenzähler und
der Volumen Summenzähler werden zurückgesetzt.

Beispiel: Verwenden des Binäreingangs oder des Ereignisses, um die Abfüllung zu
beginnen, anzuhalten und sie fortzusetzen (empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Beginn
• Abfüllung-Pause
• Abfüllung-Fortsetzung

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, wird diese gestartet.

• Wenn eine Abfüllung läuft und nicht angehalten wurde, wird diese angehalten.

• Wenn eine Abfüllung angehalten wurde, wird diese fortgesetzt.

Beispiel: Verwenden des Binäreingangs, um die Abfüllung zu starten und den
Volumenzähler zurückzusetzen (empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Beginn
• Volumen Summenzähler zurücksetzen

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, wird der Volumen Summenzähler zurückgesetzt und
eine Abfüllung beginnt.
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• Wenn eine Abfüllung läuft, wird der Volumen Summenzähler zurückgesetzt.

Hinweis
Diese Konfiguration ist nützlich, wenn die Abfüllung hinsichtlich der Masse konfiguriert wird, das
Gesamtvolumen für die Abfüllung aber ebenfalls ermittelt werden soll. In diesem Fall nicht den
Binäreingang aktivieren, während die Abfüllung läuft. Am Ende der Abfüllung kann das
Gesamtvolumen abgelesen werden. Danach mit der nächsten Abfüllung fortfahren.

Beispiel: Inkompatible Zuordnungen (nicht empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Beginn
• Abfüllung-Ende
• Abfüllung-Pause
• Abfüllung-Fortsetzung

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, wird diese gestartet.

• Wenn eine Abfüllung läuft, wird diese beendet.

In diesem Beispiel wird die Abfüllung durch den Binäreingang oder das Ereignis nicht
angehalten, weil die Maßnahme End Fill Priorität hat.

Beispiel: Inkompatible Zuordnungen (nicht empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Ende
• Alle Zähler zurücksetzen

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, werden alle Zähler, einschließlich dem Abfüll-
Summenzähler, zurückgesetzt.

• Wenn eine Abfüllung läuft, wird diese beendet und alle Zähler, einschließlich dem
Abfüll-Summenzähler, werden zurückgesetzt.

Das Ergebnis dieser Kombination ist, dass der Abfüll-Summenzähler vor dem Abrufen der
Daten zurückgesetzt wird.

7.4 Konfigurieren von Abfüllberichten mittels
Modbus (optional)
Sie können die Auswerteelektronik so konfigurieren, dass der ON/OFF-Status über Kanal B
(falls verfügbar) und der Prozentsatz der Abfüllung über den mA-Ausgang ausgegeben
wird.
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7.4.1 Kanal B als Binärausgang konfigurieren und den
Abfüllstatus ON/OFF mittels Modbus übertragen
Falls Kanal B verfügbar ist, können Sie diesen verwenden, um auszugeben, ob ein
Abfüllvorgang läuft.

Vorbereitungsverfahren

Kanal B muss als Binärausgang geschaltet sein.

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Auf dem PC muss das Modbus Interface Tool (MIT) installiert sein.

Verfahren

1. Setzen Sie Channel B Type Assignment auf Discrete Output.
2. Setzen Sie DO1 Assignment auf Discrete Batch: Batching/Filling In Progress.

3. Stellen Sie DO1 Polarity entsprechend Ihrer Installation ein.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

4. Stellen Sie DO1 Fault Action entsprechend Ihrer Installation ein.

Option Beschreibung

Upscale Der Binäreingang wird auf EIN geschaltet (Ventil geöffnet),
wenn eine Störung auftritt.

Downscale Der Binäreingang wird auf AUS geschaltet (Ventil geschlos-
sen), wenn eine Störung auftritt.

None Bei Auftreten einer Störung werden keine Maßnahmen er-
griffen. Der Binärausgang bleibt in dem Zustand, in dem er
vor Auftreten der Störung war.

Hinweis
Wenn der Binärausgang zur Ausgabe von Abfüllberichten verwendet wird, empfiehlt Micro
Motion die Einstellung von DO1 Fault Action auf None.
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Beispiel: Konfigurieren des Binärausgangs, um den Abfüllungsstatus ON/OFF zu
übertragen

Position Wert Beschreibung

Register 1167 4 Setzt die Typzuweisung für Kanal B auf Binärausgang

Register 1151 106 Setzt die DO1 Zuweisung aufBatch: Batch/Abfüllung läuft

Register 1152 1 Setzt die DO1 Polarität auf Aktiv hoch

Register 2615 4 Setzt die DO1 Störaktion auf Keine ein

7.4.2 Konfigurieren des mA Ausgangs, um die prozentuale
Abfüllung mittels Modbus auszugeben
Sie können den mA-Ausgang so konfigurieren, dass er den Prozentsatz der abgebenenen
Sollmenge ausgibt. In einer typischen Konfiguration steigt der Strom von 4 mA auf 20 mA,
wenn der Abfüllzähler von 0 % auf 100 % geht.

Vorbereitungsverfahren

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Auf dem PC muss das Modbus Interface Tool (MIT) installiert sein.

Verfahren

1. Setzen Sie Secondary Variable Is auf Discrete Batch: Percent Fill.
2. Setzen Sie Lower Range Value auf den durch 4 mA dargestellten Abfüllprozentwert.

3. Setzen Sie Upper Range Value auf den durch 20 mA dargestellten Abfüllprozentwert.

4. Stellen Sie AO Fault Action wie gewünscht ein.

Wenn Lower Range Value auf 0 % eingestellt ist und Upper Range Value auf 100 % eingestellt
ist: Wenn die Abfüllung beginnt, erzeugt der mA-Ausgang 4 mA (0 % von Fill Target). Der
Strom wird proportional zum Abfüllzähler bis auf 20 mA (100 % von Fill Target) steigen.

Anmerkung
Wenn Flow Direction auf Bidirectional oder Negate Bidirectional eingestellt ist, kann der Abfüllzähler unter
bestimmten Durchflussbedingungen sinken. In diesem Fall wird der vom mA-Ausgang erzeugte
Strom proportional reduziert.

Beispiel: Konfigurieren des mA Ausgangs, um die prozentuale Abfüllung auszugeben

Position Wert Beschreibung

Register 13 207 Setzt die Sekundärvariable ist auf Batch: Abfüllung in Prozent)

Register 221-222 10,00 Setzt den Messanfang auf 10 Prozent

Register 219-220 80,00 Setzt das Messende auf 80 Prozent

Register 1114 4 Setzt die AO Störaktion auf Keine
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8 Abfüllvorgang mittels Modus
In diesem Kapitel behandelte Themen:

• Abfüllung mit integrierter Ventilsteuerung mittels Modbus ausführen.

• Durchführen einer manuellen Spülung mittels Modbus

• Durchführen eines Cleaning-in-Place-Verfahrens (CIP) mit Modbus

• Überwachen und Analysieren der Abfüll Leistungsmerkmale mittels Modbus

8.1 Abfüllung mit integrierter Ventilsteuerung
mittels Modbus ausführen.
Mit dem digitalen Kommunikationsprotokoll Modbus können Sie eine Abfüllung starten,
überwachen, anhalten, fortsetzen und beenden.

Vorbereitungsverfahren

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Auf dem PC muss das Modbus Interface Tool (MIT) installiert sein.

Verfahren

1. (Optional) Auf Wunsch wählen Sie einen anderen Wert für Fill Target (einstufige
Abfüllungen, zweistufige Abfüllungen oder Abfüllungen mit doppeltem Füllkopf)
oder für Target Time (zeitgesteuerte Abfüllungen oder zeitgesteuerte Abfüllungen
mit doppeltem Füllkopf).

2. (Optional) Falls die automatische Überfüllkompensation (Automatic Overshoot
Compensation, AOC) aktiviert ist, können Sie einen anderen Wert für AOC Coeff
eingeben.

Hinweis
Während der Produktion empfiehlt Micro Motion, AOC Coeff auf dem während der AOC-
Kalibrierung festgelegten Wert zu belassen. Falls Sie AOC-Kalibrierabfüllungen ausführen und
über einen AOC Coeff Wert von einem ähnlichen Gerät verfügen, können Sie diesen Wert als
„ersten Näherungswert“ im aktuellen Gerät verwenden. Dies kann nützlich sein, wenn Sie
Auslaufen verhindern oder auf ein Minimum reduzieren möchten.

3. Abfüllung starten.

Der Abfüllzähler wird automatisch zurückgesetzt und das/die Ventil(e) wird/werden
geöffnet. Die Anzeige für Filling in Progress sollte On sein. Ist dies nicht der Fall und
stattdessen die Anzeige Start Not Okay oder die Anzeige AOC Flow Rate Too High Ein
sind, führen Sie eine Fehlersuche der Abfüllkonfiguration durch und wiederholen Sie
das Verfahren.

4. Überwachen Sie die Abfüllung anhand der Werte unter Current Total und Percent Fill
der Anzeige Fill Status.
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Werte des Abfüllforts-
chritts Beschreibung

Current Total Abfüllmenge zum aktuellen Zeitpunkt. Dieser Wert wird von
Count Up beeinflusst:
• Wenn Count Up aktiviert ist, beginnt Current Total bei 0 und

zählt bis zu Fill Target hoch.
• Wenn Count Up deaktiviert ist, beginnt Current Total bei Fill

Target und zähl bis auf 0 herunter.

Percent Fill Prozentwert des Fill Target, der bis zum aktuellen Zeitpunkt
gemessen wurde. Dieser Wert wird nicht von Count Up beein-
flusst.

Fill Status Anzeige Beschreibung

Filling in Progress Zurzeit wird eine Abfüllung durch das Primärventil durchge-
führt. Diese Anzeige ist auch dann aktiv, wenn die Abfüllung
angehalten wird.

Secondary Fill in Progress Zurzeit wird eine Abfüllung durch das Sekundärventil durch-
geführt. Diese Anzeige ist auch dann aktiv, wenn die Abfül-
lung angehalten wird. Dies gilt nur für Abfüllungen mit dop-
peltem Füllkopf.

Max Fill Time Exceeded Die aktuelle Abfüllung hat die derzeitige Einstellung für Max
Fill Time überschritten. Die Abfüllung wird abgebrochen.

Primary Valve Das Primärventil ist offen.

Secondary Valve Das Sekundärventil ist offen.

Pump Die Pumpe läuft.

Purge In Progress Ein Spülvorgang wurde, entweder automatisch oder man-
uell, gestartet.

Purge Delay Phase Ein automatischer Spülzyklus läuft und ist aktuell in der Ver-
zögerungsperiode zwischen Beendigung der Abfüllung und
Start des Spülvorgangs.

Purge Valve Das Spülventil ist offen.

5. (Optional) Halten Sie die Abfüllung nach Wunsch an.

Während die Abfüllung angehalten ist, können Sie den Wert für Current Target
ändern, die Abfüllung manuell mit End Filling beenden oder mit Resume Filling
fortsetzen. Die Abfüllung wird mit dem aktuellen Wert für Current Total und Percent Fill
fortgesetzt.

Einschränkung
Eine zeitgesteuerte Abfüllung oder eine zeitgesteuerte Abfüllung mit doppeltem Füllkopf
kann nicht angehalten werden.

Wichtig
Für zweistufige Abfüllungen hängt die Auswirkung eines Anhaltens und Fortsetzens der
Abfüllung von der Zeitsteuerung der Befehle zum Öffnen und Schließen des Ventils und von
dem Punkt, an welchem die Abfüllung angehalten wird, ab.
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6. (Optional) Verwenden Sie End Filling, um die Abfüllung nach Wunsch manuell zu
beenden.

Nachdem die Abfüllung beendet wurde, kann sie nicht wieder gestartet werden.

Hinweis
In den meisten Fällen sollten Sie den Abfüllvorgang automatisch beenden lassen. Beenden Sie
den Abfüllvorgang nur dann manuell, wenn Sie die Füllung entsorgen möchten.

Beispiel: Abfüllung mit integrierter Ventilsteuerung ausführen.

Wichtig
In diesem Beispiel werden standardmäßige oder typische Einstellungen für die erforderlichen
Parameter verwendet. Für Ihre Anwendung sind möglicherweise andere Einstellungen erforderlich.
Weitere Informationen zu Datentypen und Integercodes finden Sie im MIT.

Position Wert Beschreibung

Register
1289-1290

100 Setzt Abfüll Sollwert auf 100 g (bei einstufigen Abfüllungen,
zweistufigen Abfüllungen oder Doppelfüllkopf Abfüllun-
gen)

Register
1307-1308

15 Setzt Sollwert Zeit auf 15 s (bei zeitlich begrenzten oder zeit-
gesteuerten Doppelfüllkopf Abfüllungen)

Speicher 100 1 Startet den Abfüllung

Speicher 222 1 Die Anzeige für Abfüllung läuft

Register 2496,
Bits 0 und 1

0 Die Anzeigen für Start nicht OK und AOC Durchfluss zu hoch

Register
1291-1292

70 Der Wert für Aktueller Zähler

Register 2505 70 Der Wert für Prozent der Abfüllung

Register 1256 3 Die Anzeige für Abfüll Status

Speicher 107 1 Unterbricht die Abfüllung

Speicher 101 1 Setzt die Abfüllung nach dem Status Unterbrechung fort

Speicher 100 0 Beendet die Abfüllung

8.1.1 Wenn die Abfüllung nicht startet
Falls die Abfüllung nicht beginnt, die Anzeigen für Start Not Okay und AOC Flow Rate Too High
prüfen.

Wenn die Anzeige Start Not Okay aufleuchtet, Folgendes prüfen:

• Sicherstellen, dass die Abfüllung aktiviert ist.

• Darauf achten, dass die vorherige Abfüllung bereits beendet ist.

• Sicherstellen, dass Fill Target oder Target Time auf positive Werte eingestellt sind.

• Sicherstellen, dass alle Ausgänge dem Ventil oder der Pumpe zugeordnet sind, das
bzw. die der Abfüllart und der Abfülloption entsprechen.

• Sicherstellen, dass keine aktiven Fehlerbedingungen an der Auswerteelektronik
vorherrschen.
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• Bei Abfüllungen mit doppelten Füllköpfen sicherstellen, dass auf keinem der
Füllköpfe eine Abfüllung läuft.

Wenn die Anzeige AOC Flow Rate Too High leuchtet, ist die zuletzt gemessene
Durchflussgeschwindigkeit zu hoch, und die Abfüllung kann nicht gestartet werden.
Anders ausgedrückt bedeutet dies, dass der AOC Koeffizient, kompensiert für die
Durchflussgeschwindigkeit, angibt, dass der Befehl zum Schließen des Ventils vor dem
Beginn der Abfüllung gegeben werden müsste. Dies kann vorkommen, wenn die
Durchflussgeschwindigkeit signifikant höher liegt, seit der AOC-Koeffizient berechnet
wurde. Micro Motion empfiehlt das folgende Wiederherstellungsverfahren:

1. Jede Einrichtung durchführen, die erforderlich ist, um die AOC-Kalibrierung
durchzuführen.

2. 1 in Spule 110 (Override Blocked Start) schreiben.

3. AOC-Kalibrierung durchführen.

4. Die Produktionsabfüllung des Systems unter Verwendung des neuen AOC-
Koeffizienten wieder aufnehmen.

Beispiel: Zu prüfende Werte, wenn die Abfüllung nicht startet

Wichtig
In diesem Beispiel werden standardmäßige oder typische Einstellungen für die erforderlichen
Parameter verwendet. Für Ihre Anwendung sind möglicherweise andere Einstellungen erforderlich.
Weitere Informationen zu Datentypen und Integercodes finden Sie im MIT.

Position Beschreibung

Register 1289-1290 Prüfen, ob der Abfüll-Sollwert eine nicht-negative Zahl ist

Register 1307-1308 Prüfen, ob der Abfüll-Sollwert eine nicht-negative Zahl ist

Register 2496, Bits 0
und 1

Die Anzeigen für Start nicht OK und AOC Durchfluss zu hoch prüfen

8.1.2 Wenn die Abfüllung nicht vollständig durchgeführt
wurde
Falls die Abfüllung anormal beendet wurde, die Auswerteelektronik und die AnzeigeMax Fill
Time Exceeded prüfen.

Wenn ein Fehler während einer Abfüllung auftritt, wird diese von der Auswerteelektronik
automatisch abgebrochen.

Wenn die Anzeige Max Fill Time Exceeded leuchtet, konnte die Abfüllung nicht ihren Zielwert
vor der konfigurierten Max Fill Time erreichen. Folgende Möglichkeiten oder Maßnahmen
sind in Betracht zu ziehen:

• Die Durchflussgeschwindigkeit des Prozesses erhöhen.

• Auf Gaseinschlüsse (Schwallströmung) im Prozessmedium prüfen.

• Auf Verstopfungen des Durchflusses prüfen.

• Sicherstellen, dass die Ventile mit der erwarteten Geschwindigkeit schließen.

• Max Fill Time auf einen höheren Wert einstellen.

• Max Fill Time durch eine Einstellung auf 0 deaktivieren.
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8.1.3 Auswirkungen von Pause und Fortfahren bei zweistufigen
diskreten Abfüllungen
Bei zweistufigen diskreten Abfüllungen hängt es davon ab, wo Pause und Fortfahren in
Zusammenhang mit dem Öffnen und Schließen der primären und sekundären Ventile
auftreten.

Zuerst Primär öffnen, zuerst Primär schließen

In den folgenden Abbildungen:

• Das Primärventil öffnet zum Beginn der Abfüllung.

• Das Sekundärventil öffnet während der Abfüllung an dem vom Anwender
konfigurierten Punkt. T stellt die Zeit oder Anzahl dar, die für Sekundär öffnen
konfiguriert ist.

• Das Primärventil schließt, bevor die Abfüllung abgeschlossen ist.

• Das Sekundärventil schließt, wenn die Abfüllung abgeschlossen ist.

Fall AAbbildung 8-1:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Primary

Target 
(AOC adjusted)

Pause Resume

TT

Open Secondary 
not performed

Fall BAbbildung 8-2:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Primary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Secondary
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Fall CAbbildung 8-3:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Primary

Target 
(AOC adjusted)

T T

Secondary valve 
opened early

Pause Resume

Open 
Secondary

Fall DAbbildung 8-4:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Primary

Target 
(AOC adjusted)

T T

Secondary valve 
opened early

Pause Resume

Open 
Secondary

Zuerst Primär öffnen, zuerst Sekundär schließen

In den folgenden Abbildungen:

• Das Primärventil öffnet zum Beginn der Abfüllung.

• Das Sekundärventil öffnet während der Abfüllung an dem vom Anwender
konfigurierten Punkt. T stellt die Zeit oder Anzahl dar, die für Sekundär öffnen
konfiguriert ist.

• Das Sekundärventil schließt, bevor die Abfüllung abgeschlossen ist.

• Das Primärventil schließt, wenn die Abfüllung abgeschlossen ist.
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Fall EAbbildung 8-5:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

Pause Resume

TT

Open Secondary 
not performed

Fall FAbbildung 8-6:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Secondary

Fall GAbbildung 8-7:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

T T

Secondary valve 
not reopened

Pause Resume

Open 
Secondary

Abfüllvorgang mittels Modus

Konfigurations- und Bedienungsanleitung 109



Fall HAbbildung 8-8:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Secondary

Secondary valve 
not reopened

Zuerst Sekundär öffnen, zuerst Primär schließen

In den folgenden Abbildungen:

• Das Sekundärventil öffnet zum Beginn der Abfüllung.

• Das Primärventil öffnet während der Abfüllung an dem vom Anwender
konfigurierten Punkt. T stellt die Zeit oder Anzahl dar, die für Primär öffnen
konfiguriert ist.

• Das Primärventil schließt, bevor die Abfüllung abgeschlossen ist.

• Das Sekundärventil schließt, wenn die Abfüllung abgeschlossen ist.

Fall IAbbildung 8-9:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Primary

Target 
(AOC adjusted)

Pause Resume

TT

Open Primary 
not performed
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Fall JAbbildung 8-10:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Primary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Primary

Fall KAbbildung 8-11:   

Secondary valve

Primary valve

Start Open 
Primary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Primary not 
performed

Close 
Primary

Fall LAbbildung 8-12:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Primary

Target 
(AOC adjusted)

T T

Pause Resume

Open Primary 
not performed

Zuerst Sekundär öffnen, zuerst Sekundär schließen

In den folgenden Abbildungen:

• Das Sekundärventil öffnet zum Beginn der Abfüllung.

• Das Primärventil öffnet während der Abfüllung an dem vom Anwender
konfigurierten Punkt. T stellt die Zeit oder Anzahl dar, die für Primär öffnen
konfiguriert ist.
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• Das Sekundärventil schließt, bevor die Abfüllung abgeschlossen ist.

• Das Primärventil schließt, wenn die Abfüllung abgeschlossen ist.

Fall MAbbildung 8-13:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Secondary

Target 
(AOC adjusted)

Pause Resume

TT

Open Primary 
not performed

Fall NAbbildung 8-14:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Secondary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Primary

Fall OAbbildung 8-15:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Secondary

Target 
(AOC adjusted)

T T

Primary valve 
opened early

Pause Resume

Open 
Primary
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Fall PAbbildung 8-16:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Secondary

Target 
(AOC adjusted)

T T

Primary valve 
opened early

Pause Resume

Open 
Primary

8.2 Durchführen einer manuellen Spülung mittels
Modbus
Die Spülfunktion wird verwendet, um ein Hilfsventil zu steuern, das nicht für die Abfüllung
eingesetzt wird. Beispielsweise kann damit ein Behälter mit Wasser oder Gas aufgefüllt
werden, nachdem der Füllvorgang abgeschlossen ist, oder sie kann als “ Dämpfung
dienen.” Der Durchfluss durch das Hilfsventil wird von der Auswerteelektronik nicht
gemessen.

Vorbereitungsverfahren

Die Spülfunktion muss in Ihrem System implementiert sein.

Die vorhergehende Abfüllung muss beendet worden sein.

Das Hilfsventil muss an das Medium, das Sie verwenden möchten (z. B. Luft, Wasser,
Stickstoff), angeschlossen sein.

Auf dem PC muss das Modbus Interface Tool (MIT) installiert sein.

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Verfahren

1. 1 in Speicher 416 schreiben (Spülung starten).

In Register 2495 werden Spülung läuft Anzeiger (Bit 3) und Spülventil (Bit 7) aktiviert.

2. Lassen Sie das Spülmedium eine angemessene Zeit durch das System laufen.

3. 1 in Speicher 417 schreiben (Spülung beenden).

In Register 2495 werden Spülung läuft Anzeiger (Bit 3) und Spülventil (Bit 7) deaktiviert.

Abfüllvorgang mittels Modus

Konfigurations- und Bedienungsanleitung 113



8.3 Durchführen eines Cleaning-in-Place-
Verfahrens (CIP) mit Modbus
Die Clean-in-Place (CIP) Funktion wird verwendet, um ein Reinigungsmedium durch das
System zu leiten. Mit dem CIP-Verfahren können Sie die Innenflächen von Rohren,
Ventilen, Stutzen usw. reinigen, ohne das Gerät zerlegen zu müssen.

Vorbereitungsverfahren

Hierbei darf kein Abfüllvorgang laufen.

Das Reinigungsmedium muss zum Durchfluss durch das System bereit stehen.

Auf dem PC muss das Modbus Interface Tool (MIT) installiert sein.

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Verfahren

1. Tauschen Sie das Prozessmedium gegen das Reinigungsmedium aus.

2. 1 in Coil 418 schreiben (Reinigung beginnen).

Die Auswerteelektronik öffnet das Primärventil und, falls dieses zum Abfüllen
verwendet wird, das Sekundärventil. Falls die Pumpenfunktion aktiviert ist, wird die
Pumpe gestartet, bevor das Ventil geöffnet wird. Im Register 2495 wird die
Kennzeichnung Reinigung läuft (Bit 4) aktiviert.

3. Lassen Sie das Reinigungsmedium eine angemessene Zeit durch das System laufen.

4. 1 in Coil 419 schreiben (Reinigung beendet).

Die Auswerteelektronik schließt alle offenen Ventile und stoppt die Pumpe (falls
zutreffend). Im Register 2495 wird die Kennzeichnung Reinigung läuft (Bit 4)
deaktiviert.

5. Tauschen Sie das Reinigungsmedium gegen das Prozessmedium aus.

8.4 Überwachen und Analysieren der Abfüll
Leistungsmerkmale mittels Modbus
Für eine Einzelabfüllung können detaillierte Durchflussdaten gesammelt werden und diese
Daten können dann mit denen anderer Abfüllungen verglichen werden.

8.4.1 Sammeln detaillierter Abfülldaten für eine einzelne
Abfüllung mit Modbus
Detaillierte Daten der letzten Abfüllung werden in der Auswerteelektronik gespeichert,
sofern die Abfüllungsprotokollierung aktiviert ist. Die Daten können mittels digitaler
Kommunikation zu Analysezwecken ausgelesen werden. Die detaillierten Daten können
zur Optimierung oder Fehlersuche in der Produktionsumgebung verwendet werden.

Abfüllvorgang mittels Modus

114  Micro Motion® Masse Abfüll-Auswerteelektronik mit Modbus



Vorbereitungsverfahren

Auf dem PC muss das Modbus Interface Tool (MIT) installiert sein.

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Verfahren

1. 1 in Coil 340 schreiben (Abfüllprotokoll aktivieren).

2. Führen Sie einen Abfüllvorgang aus.

3. 0 in Coil 340 schreiben (Abfüllprotokoll aktivieren), wenn die Datensammlung beendet
ist.

4. Lesen Sie das Abfüllprotokoll.

a. Protokollindex in das Register 2498 schreiben.

Die Werte für den Abfüllprotokollindex reichen von 0 bis 1000 und stellen die
letzten 1000 Datensätze dar.

b. Protokolldaten für diesen Index aus den Registern 2499–2500 lesen.

Das Abfüllprotokoll enthält Datensätze von einem einzigen Abfüllvorgang. Die
Aufzeichnung beginnt mit dem Start der Abfüllung und endet 50 Millisekunden nach
Beendigung der Abfüllung oder wenn die maximale Prokotollgröße erreicht wurde.
Datensätze werden alle 10 Millisekunden geschrieben. Jeder Datensatz enthält den
aktuellen Wert für Flow Source (die zum Messen der Abfüllung verwendete Prozessvariable).
Das Abfüllprotokoll ist auf 1000 Datensätze bzw. 10 Sekunden Abfülldauer begrenzt.
Nachdem die maximale Größe erreicht ist, stoppt die Protokollierung zwar, aber die Daten
sind in der Auswerteelektronik verfügbar, bis der nächste Abfüllvorgang beginnt. Das
Abfüllprotokoll wird zu Beginn eines neuen Abfüllvorgangs immer gelöscht.

8.4.2 Analysieren der Abfüll Leistungsmerkmale mittels
Abfüllstatistiken und Modbus
Die Auswerteelektronik zeichnet automatisch eine Vielzahl von Daten über jeden
Abfüllungsvorgang auf. Diese Daten dienen zur Optimierung des Systems.

Vorbereitungsverfahren

Auf dem PC muss das Modbus Interface Tool (MIT) installiert sein.

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Verfahren

1. (Optional) 1 in Speicher 108 schreiben (Abfüllstatistiken zurücksetzen), um die Analyse
mit einem neuen Satz Abfülldaten zu starten

2. Abfüllvoränge durchführen und die Abfülldaten überwachen.
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Abfülldaten Position Abfüllart Beschreibung

Durchschnittliche
Gesamtabfüllung

Register
2519-2520

Einstufige Abfüllungen,
zweistufige Abfüllungen
und zeitgesteuerte Ab-
füllungen

Berechneter Durchschnitt aller
Abfüllsummen seit Zurückset-
zen der Abfüllstatistik.

Abfüllungen mit doppel-
tem Füllkopf und zeit-
gesteuerte Abfüllungen
mit doppeltem Füllkopf

Berechneter Durchschnitt aller
Abfüllsummen durch den Füll-
kopf Nr. 1 seit Zurücksetzen
der Abfüllstatistik.

Abweichung bei Ge-
samtabfüllung

Register
2521-2522

Einstufige Abfüllungen,
zweistufige Abfüllungen
und zeitgesteuerte Ab-
füllungen

Berechnete Abweichung aller
Füllsummen seit Zurücksetzen
der Abfüllstatistik.

Abfüllungen mit doppel-
tem Füllkopf und zeit-
gesteuerte Abfüllungen
mit doppeltem Füllkopf

Berechnete Abweichung aller
Abfüllsummen durch den Füll-
kopf Nr. 1 seit Zurücksetzen
der Abfüllstatistik.

Sekundäre
durchschnittliche Ge-
samtabfüllung

Register
2501

Nur Abfüllungen mit
doppeltem Füllkopf und
zeitgesteuerte Abfüllun-
gen mit doppeltem Füll-
kopf

Berechneter Durchschnitt aller
Abfüllsummen durch den Füll-
kopf Nr. 2 seit Zurücksetzen
der Abfüllstatistik.

Abweichung der se-
kundären Gesamtab-
füllung

Register
2503

Nur Abfüllungen mit
doppeltem Füllkopf und
zeitgesteuerte Abfüllun-
gen mit doppeltem Füll-
kopf

Berechnete Abweichung aller
Abfüllsummen durch den Füll-
kopf Nr. 2 seit Zurücksetzen
der Abfüllstatistik.
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Teil III
Konfigurieren und Durchführen von
Abfüllungen mit externer Ventilsteuerung

In diesem Teil enthaltene Kapitel:

• Konfigurieren und Einrichten einer externen Abfüll-Ventilsteuerung mittels
ProLink II

• Konfigurieren und Einrichten einer externen Abfüll-Ventilsteuerung mittels
Modbus

Konfigurieren und Durchführen von Abfüllungen mit externer Ventilsteuerung
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9 Konfigurieren und Einrichten einer
externen Abfüll-Ventilsteuerung
mittels ProLink II
In diesem Kapitel behandelte Themen:

• Konfigurieren einer mit einem externen Ventil gesteuerten Abfüllung mit
Modbus ProLink II

• Einrichten und Ausführen einer mit einem externen Ventil gesteuerten Abfüllung

9.1 Konfigurieren einer mit einem externen Ventil
gesteuerten Abfüllung mit Modbus ProLink II
Die Konfiguration einer Abfüllung mit externer Ventilsteuerung umfasst eine
Konfiguration des Frequenzausgangs und mehrerer Durchflussparameter. Bei der
Konfiguration der Abfüllung verwendet der Host Durchflussdaten vom Frequenzausgang
der Auswerteelektronik zur Messung der Abfüllung und zum Schließen der Ventile.

Vorbereitungsverfahren

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Wählen Sie ProLink > Configuration (Konfiguration) > Frequency (Frequenz).
2. Setzen Sie die Tertiary Variable auf die Prozessvariable, die der Host zur Messung der

Abfüllung verwenden wird: Mass Flow Rate oder Volume Flow Rate.

3. Stellen Sie die folgenden Parameter gemäß Ihrer Anwendung ein: FO Scaling Method
und relevante Parameter, Frequency Output Polarity und Fault Action.

4. Öffnen Sie das Fenster Flow (Durchfluss).

5. Wenn Sie Tertiary Variable auf Mass Flow Rate setzen:

a. Stellen Sie Mass Flow Units auf die vom Host verwendeten Einheiten für den
Massedurchfluss ein.

b. Stellen Sie Mass Flow Cutoff auf die niedrigste Durchflussrate ein, die gemessen
und dem Host gemeldet wird. Alle Durchflussraten unterhalb dieses
Abschaltungswerts werden als 0 ausgegeben.

6. Wenn Sie Tertiary Variable auf Volume Flow Rate setzen:

a. Stellen Sie Volume Flow Units auf die vom Host verwendeten Einheiten für den
Volumendurchfluss ein.

b. Stellen Sie Volume Flow Cutoff auf die niedrigste Durchflussrate ein, die gemessen
und dem Host gemeldet wird. Alle Durchflussraten unterhalb dieses
Abschaltungswerts werden als 0 ausgegeben.

7. Stellen Sie Flow Damping nach Wunsch ein.
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Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

8. Setzen Sie Flow Direction auf die für Ihre Installation angemessene Option.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar in
die durch den Pfeil auf dem Sensor angegebene Richtung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder andere
Richtung fließen. Der Durchfluss entspricht überwiegend
der auf dem Sensor durch den Pfeil angegebenen Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar in
die entgegengesetzte durch den Pfeil auf dem Sensor ange-
gebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder andere
Richtung fließen. Der Durchfluss entspricht überwiegend
der entgegengesetzten durch den Pfeil auf dem Sensor an-
gegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

Nachbereitungsverfahren

Stellen Sie sicher, dass Ihr Host entsprechend konfiguriert ist. Beispielsweise müssen Sie
sicherstellen, dass Ihr Host die richtige Messeinheit verwendet und falls erforderlich den
Durchfluss in den Gesamtdurchfluss konvertieren kann.

9.2 Einrichten und Ausführen einer mit einem
externen Ventil gesteuerten Abfüllung
Der Host muss Durchflussdaten von der Auswerteelektronik empfangen, erforderliche
Berechnungen durchführen und Ventile öffnen und schließen, um die Abfüllung zu regeln.

1. Sicherstellen, dass der Host die Durchflussdaten vom Frequenzausgang der
Auswerteelektronik empfängt.

2. Sicherstellen, dass der Host die von der Auswerteelektronik empfangenen Daten
richtig interpretiert und verarbeitet.

3. Jede erforderliche Verdrahtung und Konfiguration ausführen, damit der Host die
Ventile zeitgerecht öffnen und schließen kann.

4. Das Programm zum Starten und Regeln der Abfüllung einleiten.

Konfigurieren und Einrichten einer externen Abfüll-Ventilsteuerung mittels ProLink II
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10 Konfigurieren und Einrichten einer
externen Abfüll-Ventilsteuerung
mittels Modbus
In diesem Kapitel behandelte Themen:

• Konfigurieren einer externen Ventilsteuerungs-Abfüllung mitels Modbus

• Einrichten und Ausführen einer mit einem externen Ventil gesteuerten Abfüllung

10.1 Konfigurieren einer externen
Ventilsteuerungs-Abfüllung mitels Modbus
Die Konfiguration einer Abfüllung mit externer Ventilsteuerung umfasst eine
Konfiguration des Frequenzausgangs und mehrerer Durchflussparameter. Bei der
Konfiguration der Abfüllung verwendet der Host Durchflussdaten vom Frequenzausgang
der Auswerteelektronik zur Messung der Abfüllung und zum Schließen der Ventile.

Vorbereitungsverfahren

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Auf dem PC muss das Modbus Interface Tool (MIT) installiert sein.

Verfahren

1. Setzen Sie die Tertiary Variable auf die Prozessvariable, die der Host zur Messung der
Abfüllung verwenden wird: Mass Flow Rate oder Volume Flow Rate.

2. Stellen Sie die folgenden Parameter gemäß Ihrer Anwendung ein: FO Scaling Method
und relevante Parameter, Frequency Output Polarity und Fault Action.

3. Wenn Sie Tertiary Variable auf Mass Flow Rate setzen:

a. Stellen Sie Mass Flow Units auf die vom Host verwendeten Einheiten für den
Massedurchfluss ein.

b. Stellen Sie Mass Flow Cutoff auf die niedrigste Durchflussrate ein, die gemessen
und dem Host gemeldet wird. Alle Durchflussraten unterhalb dieses
Abschaltungswerts werden als 0 ausgegeben.

4. Wenn Sie Tertiary Variable auf Volume Flow Rate setzen:

a. Stellen Sie Volume Flow Units auf die vom Host verwendeten Einheiten für den
Volumendurchfluss ein.

b. Stellen Sie Volume Flow Cutoff auf die niedrigste Durchflussrate ein, die gemessen
und dem Host gemeldet wird. Alle Durchflussraten unterhalb dieses
Abschaltungswerts werden als 0 ausgegeben.

5. Stellen Sie Flow Damping nach Wunsch ein.
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Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

6. Setzen Sie Flow Direction auf die für Ihre Installation angemessene Option.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar in
die durch den Pfeil auf dem Sensor angegebene Richtung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder andere
Richtung fließen. Der Durchfluss entspricht überwiegend
der auf dem Sensor durch den Pfeil angegebenen Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar in
die entgegengesetzte durch den Pfeil auf dem Sensor ange-
gebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder andere
Richtung fließen. Der Durchfluss entspricht überwiegend
der entgegengesetzten durch den Pfeil auf dem Sensor an-
gegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

Beispiel: Konfigurieren einer externen Ventilsteuerungs-Abfüllung

Wichtig
In diesem Beispiel werden standardmäßige oder typische Einstellungen für die erforderlichen
Parameter verwendet. Für Ihre Anwendung sind möglicherweise andere Einstellungen erforderlich.
Weitere Informationen zu Datentypen und Integercodes finden Sie im MIT.

Position Wert Beschreibung

Register 14 0 Setzt die Tetiärvariable auf Massedurchfluss

Register 1108 0 Setzt die FO Skaliermethode auf Frequenz = Durchfluss

Register 1223–
1224

333,33 Setzt den Frequenzfaktor auf 333,33

Register
1225-1226

2000 Setzt den Durchflussfaktor auf 2000

Register 1197 1 Setzt die Frequenzausgangspolarität auf Aktiv hoch

Register 1107 1 Setzt die Störaktion auf Abwärts

Register 39 70 Setzt die Massedurchfluss Einheiten auf g/s

Register 195-196 3 Setzt die Massdurchfluss Abschaltung auf 3 g/s

Register 42 28 Setzt die Volumendurchfluss Einheiten auf m3/s

Register 197-198 0,03 Setzt die Volumendurchfluss Abschaltung) auf 0,03 m3/s
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Position Wert Beschreibung

Register 17 0 Setzt die Durchflussrichtung auf Vorwärts

Nachbereitungsverfahren

Stellen Sie sicher, dass Ihr Host entsprechend konfiguriert ist. Beispielsweise müssen Sie
sicherstellen, dass Ihr Host die richtige Messeinheit verwendet und falls erforderlich den
Durchfluss in den Gesamtdurchfluss konvertieren kann.

10.2 Einrichten und Ausführen einer mit einem
externen Ventil gesteuerten Abfüllung
Der Host muss Durchflussdaten von der Auswerteelektronik empfangen, erforderliche
Berechnungen durchführen und Ventile öffnen und schließen, um die Abfüllung zu regeln.

1. Sicherstellen, dass der Host die Durchflussdaten vom Frequenzausgang der
Auswerteelektronik empfängt.

2. Sicherstellen, dass der Host die von der Auswerteelektronik empfangenen Daten
richtig interpretiert und verarbeitet.

3. Jede erforderliche Verdrahtung und Konfiguration ausführen, damit der Host die
Ventile zeitgerecht öffnen und schließen kann.

4. Das Programm zum Starten und Regeln der Abfüllung einleiten.
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Teil IV
Allgemeine Konfiguration der
Auswerteelektronik

In diesem Teil enthaltene Kapitel:

• Prozessmessung konfigurieren

• Geräteoptionen und Präferenzen konfigurieren

• Integrieren des Messgerätes mit dem Netzwerk
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11 Prozessmessung konfigurieren
In diesem Kapitel behandelte Themen:

• Charakterisieren des Durchfluss-Messsystems (falls erforderlich)

• Massedurchflussmessung konfigurieren

• Konfigurieren von Volumendurchflussmessungen für Flüssigkeitsanwendungen

• Konfigurieren von Durchflussrichtung
• Konfigurieren der Dichtemessung

• Konfigurieren einer Temperaturmessung

• Druckkompensation konfigurieren

11.1 Charakterisieren des Durchfluss-Messsystems
(falls erforderlich)

ProLink II ProLink > Configuration > Device > Sensor Type

ProLink > Configuration > Flow > Flow Cal

ProLink > Configuration > Density > D1

ProLink > Configuration > Density > D2

ProLink > Configuration > Density > Temp Coeff (DT)

ProLink > Configuration > Density > K1

ProLink > Configuration > Density > K2

ProLink > Configuration > Density > FD

ProLink III Device Tools > Calibration Data

Modbus Sensor type: Register 1139

Flow calibration factor (FCF): Registers 407-408

Flow temperature coefficient (FT) : Registers 409-410

D1: Registers 155-156

D2: Registers 157-158

Density temperature coefficient (TC): Registers 163-164

K1: Registers 159-160

K2: Registers 161-162

FD: Registers 303-304

Überblick

Die Charakterisierung des Durchfluss-Messsystems passt die Auswerteelektronik an die
spezifischen Eigenschaften des angeschlossenen Sensors an. Die
Charakterisierungsparameter (auch Kalibrierparameter genannt) stellen die
Sensorempfindlichkeit bezüglich Durchfluss, Dichte und Temperatur dar. Abhängig vom
Sensortyp sind unterschiedliche Parameter erforderlich. Die für den Sensor zutreffenden
Werte von Micro Motion sind auf dem Typenschild des Sensors oder dem Kalibrierzertifikat
abzulesen.
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Hinweis
Wenn das Durchfluss-Messsystem als eine Einheit bestellt wurde, wurde die Charakterisierung
bereits ab Werk vorgenommen. Die Charakterisierungsparameter sollten trotzdem überprüft
werden.

Verfahren

1. Sensor Type spezifizieren.

• Curved-tube (alle Sensoren außer T-Serie)

2. Die Durchfluss Charakterisierungsparameter einstellen. Darauf achten, dass alle
Kommastellen berücksichtigt werden.

• Bei Sensoren mit gebogenem Rohr Flow Cal (Flow Calibration Factor) einstellen.

3. Die Dichte Charakterisierungsparameter einstellen.

• Bei Sensoren mit gebogenem Rohr D1, D2, TC, K1, K2 und FD einstellen. (TC wird
manchmal als DT angezeigt.)

11.1.1 Beispiel Sensor Typenschilder

Typenschild an neueren Sensoren mit gebogenem Messrohr (alle
Sensoren außer T-Serie)

Abbildung 11-1:   

11.1.2 Durchflusskalibrierparameter (FCF, FT)
Zur Beschreibung der Durchflusskalibrierung werden zwei separate Werte verwendet: ein
6 Zeichen langer FCF-Wert und ein 4 Zeichen langer FT-Wert. Diese stehen auf dem
Sensor-Typenschild.

Beide Werte beinhalten Dezimalpunkte. Bei der Charakterisierung können diese als zwei
Werte oder als eine Zahl, bestehend aus 10 Zeichen eingegeben werden. Der 10 Zeichen
lange String wird entweder Flowcal oder FCF genannt.

Wenn die FCF- und FT-Werte separat auf Ihrem Sensor-Typenschild angezeigt werden und
sie einen einzelnen Wert eingeben müssen, verknüpfen Sie die beiden Werte, um den
einzelnen Parameterwert zu bilden.
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Wenn Ihr Sensor-Typenschild einen verknüpften Flowcal- oder FCF-Wert anzeigt und Sie die
FCF- und FT-Werte separat eingeben müssen, trennen Sie den verknüpften Wert:

• FCF = Die ersten 6 Zeichen, einschließlich des Dezimalpunkts

• FT = Die letzten 4 Zeichen, einschließlich des Dezimalpunkts

Beispiel: Verknüpfen von FCF und FT
FCF = x.xxxx
FT = y.yy
Flow calibration parameter: x.xxxxy.yy

Beispiel: Teilen des verknüpften Flowcal- oder FCF-Werts

Flow calibration parameter: x.xxxxy.yy
FCF = x.xxxx
FT = y.yy

11.1.3 Dichtekalibrierparameter (D1, D2, K1, K2, FD, DT, TC)
Dichtekalibrierparameter sind normalerweise auf dem Sensortypenschild und dem
Kalibrierzertifikat zu finden.

Wenn das Typenschild Ihres Sensors keinen D1 oder D2 Wert aufweist:

• Für D1 geben Sie den Dens A oder den D1 Wert vom Kalibrierzertifikat ein. Dieser
Wert ist die Betriebsdichte des Kalibriermediums mit der niedrigen Dichte.
Micro Motion verwendet Luft. Wenn Sie keinen Wert Dens A oder D1 finden, geben
Sie 0,001 g/cm3 ein.

• Für D2 geben Sie den Wert Dens B oder D2 vom Kalibrierzertifikat ein. Dieser Wert ist
die Betriebsdichte des Kalibriermediums mit der höheren Dichte. Micro Motion
verwendet Wasser. Wenn Sie keinen Wert Dens B oder D2 finden, geben Sie
0,998 g/cm3 ein.

Wenn das Typenschild Ihres Sensors keinen Wert K1 oder K2 aufweist:

• Für K1 geben Sie die ersten 5 Ziffern des Dichtekalibrierfaktors ein. Im Beispiel-
Typenschild ist dieser Wert 12500.

• Für K2 geben Sie die zweiten 5 Ziffern des Dichtekalibrierfaktors ein. Im Beispiel-
Typenschild ist dieser Wert 14286.

Wenn das Typenschild Ihres Sensors keinen Wert FD aufweist, nehmen Sie mit dem
Micro Motion Kontakt auf.

Wenn das Typenschild Ihres Sensors keinen Wert DT oder TC aufweist, geben Sie die
letzten 3 Ziffern des Dichtekalibrierfaktors ein. Im Beispiel-Typenschild ist dieser Wert
4,44.

11.2 Massedurchflussmessung konfigurieren
Die Parameter der Massedurchflussmessung steuern, wie Massedurchfluss gemessen und
ausgegeben wird.

Die Parameter der Massedurchflussmessung umfassen:

• Massedurchfluss Messeinheit
• Durchflussdämpfung
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• Massedurchfluss Abschaltung

11.2.1 Massedurchfluss Messeinheit konfigurieren

ProLink II ProLink > Configuration > Flow > Mass Flow Units

ProLink III Device Tools > Configuration > Process Measurement > Flow

Modbus Register 39

Überblick

Massedurchfluss Messeinheit spezifiziert die Messeinheit, die für den Massedurchfluss
verwendet wird. Die für die Masse Summen- und Gesamtzähler verwendet Messeinheit
wird von dieser Einheit abgeleitet.

Verfahren

Setzen Sie Massedurchfluss Messeinheit auf die Einheit, die Sie verwenden möchten.

Die Voreinstellung für Massedurchfluss Messeinheit ist g/s (Gramm pro Sekunde).

Hinweis
Wenn die Messeinheit, die Sie verwenden möchten, nicht verfügbar ist, können Sie eine Spezial-
Messeinheit definieren.

Optionen für Massedurchfluss Messeinheit
Die Auswerteelektronik stellt einen Standardsatz sowie eine anwenderdefinierbare
Messeinheit für die Massedurchfluss Messeinheit zur Verfügung. Verschiedene
Kommunikations-Hilfsmittel verwenden u. U. unterschiedliche Kennzeichnungen für die
Geräte.

Optionen für Massedurchfluss MesseinheitTabelle 11-1:   

Beschreibung der Einheit

Bezeichnung

ProLink II ProLink III

Gramm pro Sekunde g/s g/sec

Gramm pro Minute g/min g/min

Gramm pro Stunde g/h g/hr

Kilogramm pro Sekunde kg/s kg/sec

Kilogramm pro Minute kg/min kg/min

Kilogramm pro Stunde kg/h kg/hr

Kilogramm pro Tag kg/Tag kg/day

Metrische Tonnen pro Minute T/min mTon/min

Metrische Tonnen pro Stunde T/h mTon/hr

Metrische Tonnen pro Tag mT/Tag mTon/day

Pfund pro Sekunde lbs/s lbs/sec

Pfund pro Minute lbs/min lbs/min
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Optionen für Massedurchfluss Messeinheit (Fortsetzung)Tabelle 11-1:   

Beschreibung der Einheit

Bezeichnung

ProLink II ProLink III

Pfund pro Stunde lbs/h lbs/hr

Pfund pro Tag lbs/Tag lbs/day

Short tons (2000 Pfund) pro Minute sTon/min sTon/min

Short tons (2000 Pfund) pro Stunde sTon/h sTon/hr

Short tons (2000 Pfund) pro Tag sTon/Tag sTon/day

Long tons (2240 Pfund) pro Stunde lTon/h lTon/hr

Long tons (2240 Pfund) pro Tag lTon/Tag lTon/day

Spezialeinheit Spezial special

11.2.2 Konfigurieren der Durchflussdämpfung

ProLink II ProLink > Configuration > Flow > Flow Damp

ProLink III Device Tools > Configuration > Process Measurement > Flow

Modbus Registers 189-190

Überblick

Die Dämpfung wird verwendet, um kleine, plötzlich auftretende Schwankungen des
Prozessmesswerts zu glätten. Damping Value gibt die Zeitdauer (in Sekunden) an, über die
die Auswerteelektronik die Änderungen in der ausgegebenen Prozessvariable verteilt. Am
Ende des Intervalls spiegelt die ausgegebene Prozessvariable 63 % der Änderung des
eigentlichen gemessenen Wertes wider.

Verfahren

Flow Damping auf den gewünschten Wert einstellen.

Der Standardwert ist 0,04 Sekunden. Der Bereich liegt bei 0 bis 40,96 Sekunden.

Hinweise

• Ein hoher Dämpfungswert lässt die Prozessvariable regelmäßiger erscheinen, da der
ausgegebene Wert sich langsamer ändert.

• Ein niedriger Dämpfungswert lässt die Prozessvariable unregelmäßiger erscheinen, da der
ausgegebene Wert sich schneller ändert.

• Die Kombination eines hohen Dämpfungswertes und plötzlich auftretenden, großen
Änderungen in der Durchflussrate kann zu erhöhten Messfehlern führen.

• Immer, wenn der Dämpfungswert nicht Null ist, wird der ausgegebene Messwert hinter der
eigentlichen Messung liegen, da der ausgegebene Wert über die Zeit gemittelt wird.

• Allgemein werden niedrigere Dämpfungswerte vorgezogen, da das Risiko von Datenverlusten
und die Verzögerung zwischen dem eigentlichem und dem ausgegebenen Wert geringer ist.

• Micro Motion empfiehlt, den Standardwert von 0,04 Sekunden zu verwenden.
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Der eingegebene Wert wird automatisch auf den nächst gültigen Wert abgerundet. Die
gültigen Werte für Flow Damping sind: 0, 0,04, 0,08, 0,16, ... 40,96.

Auswirkung der Durchflussdämpfung auf die Volumenmessung
Die Durchflussdämpfung wirkt sich auf die Volumenmessung für die
Flüssigkeitsvolumendaten aus. Die Die Auswerteelektronik berechnet die Volumendaten
anhand der gedämpften Massedurchflussdaten.

Wechselwirkung zwischen Durchflussdämpfung und Zusätzlicher
Dämpfung
In einigen Fällen werden sowohl die Durchflussdämpfung als auch die Zusätzliche Dämpfung auf
den ausgegebenen Massedurchfluss angewandt.

Die Durchflussdämpfung regelt die Änderungsrate der Durchfluss-Prozessvariablen. Die
Zusätzliche Dämpfung regelt die Änderungsrate, die über den mA-Ausgang ausgegeben wird.
Wenn die mA-Ausgangs-Prozessvariable auf Massedurchfluss gesetzt ist und sowohl die
Durchflussdämpfung als auch die Zusätzliche Dämpfung auf einen Wert ungleich Null gesetzt
sind, wird zuerst die Durchflussdämpfung angewandt, und die Berechnung der
zusätzlichen Dämpfung wird auf das Ergebnis der ersten Rechnung angewandt

11.2.3 Massedurchfluss Abschaltung für Abfüllanwendungen
konfigurieren

ProLink II ProLink > Configuration > Flow > Mass Flow Cutoff

ProLink III Device Tools > Configuration > Process Measurement > Flow

Modbus Registers 195-196

Überblick

Wenn Sie für eine Abfüllanwendung mit integrierter Ventilregelung die Durchflussquelle auf
Massedurchfluss gesetzt haben, müssen Sie Massedurchfluss Abschaltung auf einen Wert setzen,
der den Einfluss von Vibrationen und anderen Umgebungsbedingungen ausblendet. Dies
ist erforderlich, da die Auswerteelektronik die Abfüllverarbeitung erst dann abschließt,
wenn ein Null Durchfluss erkannt wird.

Wenn die Durchflussquelle auf Volumendurchfluss gesetzt ist, hat die Massedurchfluss Abschaltung
keinen Einfluss auf die Abfüllung.

Vorbereitungsverfahren

Stellen Sie sicher, dass der Nullpunktwert der Auswerteelektronik korrekt ist.

Verfahren

1. Setzen Sie die Massedurchfluss Abschaltung auf 0.

2. Stoppen Sie den Durchfluss durch den Sensor.

3. Schalten Sie die Abfüllanlage und andere Vibrationsquellen ein.

4. Beobachten Sie den ausgegebenen Massedurchfluss.

5. Setzen Sie Massedurchfluss Abschaltung auf einen Wert, der etwas über dem
ausgegebenen Massedurchfluss liegt.
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6. Prüfen Sie, dass der Massedurchfluss als 0 ausgegeben wird.

Nachbereitungsverfahren

Wichtig
An Massedurchfluss Abschaltung vorgenommene Änderungen beeinflussen die automatische
Überfüllkompensation (AOC). Wenn Sie die Standard AOC implementiert haben, müssen Sie die AOC
Kalibrierung bei jeder Änderung des Wertes für Massedurchfluss Abschaltung wiederholen. Diese
Anforderung gilt nicht für rollende AOC oder feste AOC.

11.2.4 Massedurchfluss Abschaltung konfigurieren

ProLink II ProLink > Configuration > Flow > Mass Flow Cutoff

ProLink III Device Tools > Configuration > Process Measurement > Flow

Modbus Registers 195-196

Überblick

Massedurchfluss Abschaltung spezifiziert den niedrigsten Massedurchfluss, der als Messwert
ausgegeben wird. Jeder Massedurchfluss unterhalb dieses Abschaltungswerts wird als 0
ausgegeben.

Anmerkung
Wenn Sie Massedurchfluss Abschaltung für eine Abfüllanwendung mit integrierter Ventilregelung
konfigurieren und Durchflussquelle auf Massedurchfluss gesetzt ist, siehe Abschnitt 11.2.3.

Verfahren

Setzen Sie Massedurchfluss Abschaltung auf den gewünscthen Wert.

Der voreingestellte Wert für Massedurchfluss Abschaltung ist 0,0 g/s oder ein werkseitig
eingestellter, sensorspezifischer Wert. Die empfohlene Einstellung ist 0,05 % des
maximalen Nenndurchflusses des Sensors bzw. ein Wert unter dem höchsten erwarteten
Durchfluss. Setzen Sie Massedurchfluss Abschaltung nicht auf 0,0 g/s.

Auswirkung der Massedurchflussabschaltung auf die
Volumenmessung
Die Massedurchflussabschaltung wirkt sich nicht auf die Volumenmessung aus. Die
Volumendaten werden anhand der tatsächlichen Massendaten errechnet anstelle des
ausgegebenen Werts.

Wechselwirkung zwischen Massedurchflussabschaltung und AO-
Abschaltung
Massedurchflussabschaltung spezifiziert den niedrigsten Massedurchfluss, den die
Auswerteelektronik als Messwert ausgibt. Die AO-Abschaltung definiert die niedrigste
Durchflussrate, die über den mA-Ausgang ausgegeben wird. Wenn die Prozessvariable mA-
Ausgang auf Massedurchfluss eingestellt ist, wird der vom mA-Ausgang ausgegebene
Massedurchfluss vom höheren der beiden Abschaltwerte geregelt.
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Massedurchflussabschaltung wirkt sich auf alle ausgegebenen Werte aus, die in anderen
Auswerteelektronik-Verhalten verwendet werden (z. B. Ereignisse, die für den
Massedurchfluss definiert wurden).

Die AO-Abschaltung wirkt sich nur auf die Massedurchflüsse aus, die über den mA-Ausgang
ausgegeben wurden.

Beispiel: Abschaltwechselwirkung bei AO-Abschaltung kleiner als
Massedurchflussabschaltung

Konfiguration:

• mA-Ausgang-Prozessvariable: Massedurchfluss
• Frequenzausgang-Prozessvariable: Massedurchfluss
• AO-Abschaltung: 10 g/s

• Massedurchflussabschaltung: 15 g/s

Ergebnis: Wenn der Massedurchfluss unter 15 g/s abfällt, wird der Massedurchfluss als 0
ausgegeben und für alle internen Verarbeitungsverfahren verwendet.

Beispiel: Abschaltwechselwirkung bei AO-Abschaltung größer als
Massedurchflussabschaltung

Konfiguration:

• mA-Ausgang-Prozessvariable: Massedurchfluss
• Frequenzausgang-Prozessvariable: Massedurchfluss
• AO-Abschaltung: 15 g/s

• Massedurchflussabschaltung: 10 g/s

Ergebnis:

• Fällt der Massedurchfluss unter 15 g/s aber nicht unter 10 g/s:

- Gibt der mA-Ausgang Nulldurchfluss aus.

- Der Frequenzausgang gibt den Istdurchfluss aus, und der Istdurchfluss wird für
alle internen Verarbeitungsverfahren verwendet.

• Wenn der Massedurchfluss unter 10 g/s abfällt, geben beide Ausgänge
Nulldurchfluss aus, und für alle internen Verarbeitungsverfahren wird 0 verwendet.

11.3 Konfigurieren von
Volumendurchflussmessungen für
Flüssigkeitsanwendungen
Die Parameter für Volumendurchflussmessungen steuern, wie der
Flüssigkeitsvolumenstrom gemessen und gemeldet wird.
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11.3.1 Konfigurieren von Volumendurchfluss-Messeinheit für
Flüssigkeitsanwendungen

ProLink II ProLink > Configuration > Flow > Vol Flow Units

ProLink III Device Tools > Configuration > Process Measurement > Flow

Modbus Register 42

Überblick

Volume Flow Measurement Unit gibt die Messeinheit an, die für die Anzeige des
Volumendurchflusses verwendet wird. Die Einheit, die für den Volumen Summen- und
Gesamtzähler verwendet wird, basiert auf dieser Einheit.

Vorbereitungsverfahren

Stellen Sie vor dem Konfigurieren von Volume Flow Measurement Unit sicherstellen, dass
Volume Flow Type auf Liquid gesetzt ist.

Verfahren

Setzen Sie Volume Flow Measurement Unit auf die gewünschte Einheit.

Die Voreinstellung für Volume Flow Measurement Unit ist l/s (Liter pro Sekunde).

Hinweis
Wenn die Messeinheit, die Sie verwenden möchten, nicht verfügbar ist, können Sie eine Spezial-
Messeinheit definieren.

Optionen für Volume Flow Measurement Unit für
Flüssigkeitsanwendungen
Die Auswerteelektronik bietet ein Standardsatz an Messeinheiten für Volume Flow
Measurement Unit und eine zusätzliche benutzerdefinierbare Messeinheit. Unterschiedliche
Kommunikations-Hilfsmittel verwenden möglicherweise unterschiedliche
Kennzeichnungen für die Einheiten.

Optionen für Volume Flow Measurement UnitTabelle 11-2:   

Beschreibung der Einheit

Kennzeichnung

ProLink II ProLink III

Kubikfuss pro Sekunde ft3/sec ft3/sec

Kubikfuss pro Minute ft3/min ft3/min

Kubikfuss pro Stunde ft3/hr ft3/hr

Kubikfuss pro Tag ft3/day ft3/day

Kubikmeter pro Sekunde m3/sec m3/sec

Kubikmeter pro Minute m3/min m3/min

Kubikmeter pro Stunde m3/hr m3/hr

Kubikmeter pro Tag m3/day m3/day

U.S. Gallonen pro Sekunde US gal/sec US gal/sec
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Optionen für Volume Flow Measurement Unit (Fortsetzung)Tabelle 11-2:   

Beschreibung der Einheit

Kennzeichnung

ProLink II ProLink III

U.S. Gallonen pro Minute US gal/min US gal/min

U.S. Gallonen pro Stunde US gal/hr US gal/hr

U.S. Gallonen pro Tag US gal/Tag US gal/day

Millionen U.S. Gallonen pro Tag mil US gal/day mil US gal/day

Liter pro Sekunde l/sec l/sec

Liter pro Minute l/min l/min

Liter pro Stunde l/hr l/hr

Millionen Liter pro Tag mil l/Tag mil l/day

Imperial Gallonen pro Sekunde Imp gal/s Imp gal/sec

Imperial Gallonen pro Minute Imp gal/min Imp gal/min

Imperial Gallonen pro Stunde Imp gal/h Imp gal/hr

Imperial Gallonen pro Tag Imp gal/Tag Imp gal/day

Barrel pro Sekunde(1) Barrel/s barrels/sec

Barrel pro Minute(1) Barrel/min barrels/min

Barrel pro Stunde(1) Barrel/h barrels/hr

Barrel pro Tag(1) Barrel/Tag barrels/day

Bier Barrel pro Sekunde(2) Bier Barrel/s Beer barrels/sec

Bier Barrel pro Minute(2) Bier Barrel/min Beer barrels/min

Bier Barrel pro Stunde(2) Bier Barrel/h Beer barrels/hr

Bier Barrel pro Tag(2) Bier Barrel/Tag Beer barrels/day

Sondereinheit Spezial special

11.3.2 Konfigurieren der Volumendurchflussabschaltung in
Befüllanwendungen

ProLink II ProLink > Configuration > Flow > Vol Flow Cutoff

ProLink III Device Tools > Configuration > Process Measurement > Flow

Modbus Registers 197-198

Überblick

Bei der Durchführung einer Befüllung mit integrierter Ventilsteuerung und eine auf Volume
Flow Rate eingestellte Flow Source muss Volume Flow Cutoff auf einen Wert gesetzt werden,
der den Einfluss von Vibrationen und anderen Umgebungsbedingungen ausblendet. Dies
ist erforderlich, da die Auswerteelektronik die Befüllung erst dann abschließt, wenn ein
Null Durchfluss erkannt wird.

(1) Einheiten basieren auf Öl Barrels (42 U.S Gallonen).

(2) Einheiten basieren auf Bier Barrels (31 U.S Gallonen).
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Wenn Flow Source auf Mass Flow Rate eingestellt ist, hat Volume Flow Cutoff keinen Einfluss auf
die Befüllung.

Vorbereitungsverfahren

Stellen Sie sicher, dass der Nullpunktwert der Auswerteelektronik korrekt ist.

Verfahren

1. Volume Flow Cutoff (Volumendurchflussabschaltung) auf 0 einstellen.

2. Stoppen Sie den Durchfluss durch den Sensor.

3. Schalten Sie die Befüllanlage und andere Vibrationsquellen ein.

4. Beobachten Sie den ausgegebenen Volumendurchfluss.

5. Setzen Sie Volume Flow Cutoff auf einen Wert, der etwas über dem ausgegebenen
Volumendurchfluss liegt.

6. Prüfen Sie, ob der Volumendurchfluss als 0 ausgegeben wird.

Nachbereitungsverfahren

Wichtig
An Volume Flow Cutoff vorgenommene Änderungen beeinflussen die automatische
Überfüllkompensation (AOC). Wenn Sie die Standard AOC implementiert haben, müssen Sie die AOC
Kalibrierung bei jeder Änderung des Wertes für Volume Flow Cutoff wiederholen. Diese Anforderung
gilt nicht für rollende AOC oder feste AOC.

11.3.3 Konfigurieren der Volumendurchflussabschaltung

ProLink II ProLink > Configuration > Flow > Vol Flow Cutoff

ProLink III Device Tools > Configuration > Process Measurement > Flow

Modbus Registers 197-198

Überblick

Volume Flow Cutoff gibt den niedrigsten Volumendurchfluss an, der als gemessen gemeldet
wird. Jeder Volumendurchfluss unter diesem Grenzwert wird als 0 gemeldet.

Anmerkung
Wenn Volume Flow Cutoff für eine Befüllanwendung mit integrierter Ventilsteuerung konfiguriert wird
und Flow Source auf Volume Flow Rate gesetzt ist, siehe Abschnitt 11.3.2.

Verfahren

Setzen Sie Volume Flow Cutoff auf den gewünschten Wert.

Der Standardwert für Volume Flow Cutoff beträgt 0,0 l/s (Liter pro Sekunde). Der untere
Grenzwert ist 0. Der obere Grenzwert ist der Durchflusskalibrierfaktor des Sensors in
Einheiten von l/sec, multipliziert mit 0.2.
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Wechselwirkung zwischen Volumendurchflussabschaltung und AO-
Abschaltung
Volumendurchflussabschaltung spezifiziert den niedrigsten Flüssigkeitsvolumendurchfluss, den
die Auswerteelektronik als Messwert ausgibt. Die AO-Abschaltung definiert die niedrigste
Durchflussrate, die über den mA-Ausgang ausgegeben wird. Wenn die Prozessvariable mA-
Ausgang auf Volumendurchfluss eingestellt ist, wird der vom mA-Ausgang ausgegebene
Volumendurchfluss vom höheren der beiden Abschaltwerte geregelt.

Die Volumendurchflussabschaltung wirkt sich auf die über die Ausgänge ausgegebenen
Vlumendurchflusswerte und die in anderen Auswerteelektronik-Verhalten (z. B. Ereignisse,
die für den Vvolumendurchfluss definiert wurden) verwendeten Volumendurchflusswerte
aus.

Die AO-Abschaltung wirkt sich nur auf die Durchflüsse aus, die über den mA-Ausgang
ausgegeben wurden.

Beispiel: Abschaltwechselwirkung bei AO-Abschaltung kleiner als
Volumendurchflussabschaltung

Konfiguration:

• mA-Ausgang-Prozessvariable: Volumendurchfluss
• Frequenzausgang-Prozessvariable: Volumendurchfluss
• AO-Abschaltung: 10 l/s

• Volumendurchflussabschaltung: 15 l/s

Ergebnis: Wenn der Volumendurchfluss unter 15 SLPM abfällt, wird der
Volumendurchfluss als 0 ausgegeben und für alle internen Verarbeitungsverfahren
verwendet.

Beispiel: Abschaltwechselwirkung bei AO-Abschaltung größer als
Volumendurchflussabschaltung

Konfiguration:

• mA-Ausgang-Prozessvariable: Volumendurchfluss
• Frequenzausgang-Prozessvariable: Volumendurchfluss
• AO-Abschaltung: 15 l/s

• Volumendurchflussabschaltung: 10 l/s

Ergebnis:

• Fällt der Volumendurchfluss unter 15 l/s aber nicht unter 10 l/s:

- Gibt der mA-Ausgang Nulldurchfluss aus.

- Der Frequenzausgang gibt den Istdurchfluss aus, und der Istdurchfluss wird für
alle internen Verarbeitungsverfahren verwendet.

• Wenn der Volumendurchfluss unter 10 l/s abfällt, geben beide Ausgänge
Nulldurchfluss aus, und für alle internen Verarbeitungsverfahren wird 0 verwendet.

Prozessmessung konfigurieren

Konfigurations- und Bedienungsanleitung 135



11.4 Konfigurieren von Durchflussrichtung
ProLink II ProLink > Configuration > Flow > Flow Direction

ProLink III Device Tools > Configuration > Process Measurement > Flow

Modbus Register 17

Überblick

Mittels Flow Direction steuert, wie sich Vorwärts- und Rückwärtsströmung auf
Durchflussmessungen und deren Anzeige auswirken.

Flow Direction wird entsprechend dem Durchfluss-Richtungspfeil auf dem Sensor definiert:

• Eine Vorwärtsströmung (positiver Durchfluss) bewegt sich in Richtung des
Durchflusspfeils auf dem Sensor.

• Eine Rückwärtsströmung (negativer Durchfluss) bewegt sich entgegengesetzt zu
dem auf dem Sensor angegebenen Durchflusspfeil.

Hinweis
Micro Motion Die Sensoren sind bidirektional. Die Messgenauigkeit wird nicht durch die eigentliche
Durchflussrichtung oder durch die Einstellung des Parameters Durchflussrichtung beeinflusst.

Verfahren

Flow Direction auf den gewünschten Wert einstellen.

11.4.1 Optionen der Durchflussrichtung

Optionen der DurchflussrichtungTabelle 11-3:   

Einstellung der Durchflussrichtung Beziehung zum Durchflussrichtungspfeil auf
dem Sensor

ProLink II ProLink III

Vorwärts Forward Korrekt, wenn der Durchflussrichtungspfeil in die-
selbe Richtung wie der Großteil des Durchflusses
weist.

Bidirektional Bidirectional Korrekt, wenn beide Strömungen (vorwärts, rück-
wärts) zu erwarten sind, der Vorwärtsfluss domi-
niert und der Rückwärtsfluss jedoch beachtlich ist.

Vorwärts negieren Negate Forward Korrekt, wenn der Durchflussrichtungspfeil in die
entgegengesetzte Richtung wie der Großteil des
Durchflusses weist.

Bidirektional negieren Negate Bidirectional Korrekt, wenn beide Strömungen (vorwärts, rück-
wärts) zu erwarten sind, der Rückwärtsfluss domi-
niert und der Vorwärtsfluss jedoch beachtlich ist.
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Auswirkungen der Durchflussrichtung auf die mA-Ausgänge
Die Durchflussrichtung beeinflusst die Art, in der die Auswerteelektronik Durchflusswerte
über die mA-Ausgänge ausgibt. Die mA-Ausgänge werden nur dann von der
Durchflussrichtung beeinflusst, wenn die Prozessvariable mA-Ausgang auf eine
Durchflussvariable eingestellt ist.

Beispiel:  Durchflussrichtung = Vorwärts und Messanfang = 0

Konfiguration:

• Durchflussrichtung = Vorwärts
• Messanfang = 0 g/s

• Messende = 100 g/s

Ergebnis:

• Bei Rückwärts- oder Nulldurchfluss hat der mA-Ausgang 4 mA.

• Bei Vorwärtsdurchfluss bis zu einem Durchfluss von 100 g/s liegt der mA-Ausgang
zwischen 4 mA und 20 mA, proportional zum Durchfluss.

• Bei Vorwärtsdurchfluss, wenn der Durchfluss gleich oder höher als 100 g/s ist, ist der
mA-Ausgang bis 20,5 mA proportional zum Durchfluss und wird bei höherem
Durchfluss auf 20,5 mA begrenzt.

Beispiel:  Durchflussrichtung = Vorwärts und Messanfang < 0

Konfiguration:

• Durchflussrichtung = Vorwärts
• Messanfang = -100 g/s

• Messende = +100 g/s

Ergebnis:

• Bei Nulldurchfluss hat der mA Ausgang 12 mA.

• Bei Vorwärtsdurchfluss bis zu einem Durchfluss zwischen 0 und +100 g/s liegt der
mA-Ausgang zwischen 12 mA und 20 mA, proportional zum Durchfluss (absoluter
Wert).

• Bei Vorwärtsdurchfluss, wenn der Durchfluss (absoluter Wert) gleich oder höher als
100 g/s ist, ist der mA-Ausgang bis 20,5 mA proportional zum Durchfluss und wird
bei höherem Durchfluss auf 20,5 mA begrenzt.

• Bei Rückwärtsdurchfluss bis zu einem Durchfluss zwischen 0 und -100 g/s liegt der
mA-Ausgang zwischen 4 mA und 12 mA umgekehrt proportional zum absoluten
Wert des Durchflusses.

• Bei Rückwärtsdurchfluss, wenn der absolute Wert des Durchflusses gleich oder
höher als 100 g/s ist, ist der mA-Ausgang bis 3,8 mA umgekehrt proportional und
wird bei höheren Absolutwerten auf 3,8 mA begrenzt.

Auswirkungen der Durchflussrichtung auf die Frequenzausgänge
Die Durchflussrichtung beeinflusst die Art, in der die Auswerteelektronik Durchflusswerte
über die Frequenzausgänge ausgibt. Frequenzausgänge werden nur dann von der
Durchflussrichtung beeinflusst, wenn die Prozessvariable Frequenzausgang auf eine
Durchflussvariable eingestellt ist.
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Auswirkung des Parameters Durchflussrichtung und der tatsächlichen
Durchflussrichtung auf die Frequenzausgänge

Tabelle 11-4:   

Einstellung der Durchfluss-
richtung

Tatsächliche Durchflussrichtung

Vorwärts Nulldurchfluss Rückwärts

Vorwärts Hz > 0 0 Hz 0 Hz

Bidirektional Hz > 0 0 Hz Hz > 0

Vorwärts negieren 0 Hz 0 Hz Hz > 0

Bidirektional negieren Hz > 0 0 Hz Hz > 0

Auswirkungen der Durchflussrichtung auf die Binärausgänge
Die Durchflussrichtung wirkt sich nur dann auf das Verhalten der Binärausgänge aus, wenn die
Binärausgangsquelle auf Durchflussrichtung eingestellt ist.

Auswirkung des Parameters Durchflussrichtung und der tatsächlichen
Durchflussrichtung auf die Binärausgänge

Tabelle 11-5:   

Einstellung der Durchfluss-
richtung

Tatsächliche Durchflussrichtung

Vorwärts Nulldurchfluss Rückwärts

Vorwärts OFF OFF ON

Rückwärts OFF OFF ON

Bidirektional OFF OFF ON

Absolutwert OFF OFF OFF

Vorwärts negieren ON OFF OFF

Bidirektional negieren ON OFF OFF

Auswirkungen der Durchflussrichtung auf die digitale
Kommunikation
Die Durchflussrichtung wirkt sich auf die Ausgabe von Durchflusswerten über die digitale
Kommunikation aus.

Auswirkung des Parameters Durchflussrichtung und der tatsächlichen
Durchflussrichtung auf die über die digitale Kommunikation
ausgegebenen Durchflusswerte

Tabelle 11-6:   

Einstellung der Durchfluss-
richtung

Tatsächliche Durchflussrichtung

Vorwärts Nulldurchfluss Rückwärts

Vorwärts Positiv 0 Negativ

Bidirektional Positiv 0 Negativ

Vorwärts negieren Negativ 0 Positiv

Bidirektional negieren Negativ 0 Positiv
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Auswirkung der Durchflussrichtung auf Durchflusswerte
Die Durchflussrichtung wirkt sich auf die Berechnung von Summen- und Gesamtzählern aus.

Auswirkung des Parameters Durchflussrichtung und der tatsächlichen
Durchflussrichtung auf die Summen- und Gesamtzähler

Tabelle 11-7:   

Einstellung der Durch-
flussrichtung

Tatsächliche Durchflussrichtung

Vorwärts Nulldurchfluss Rückwärts

Vorwärts Zähler steigen Zähler ändern sich nicht Zähler ändern sich
nicht

Bidirektional Zähler steigen Zähler ändern sich nicht Zähler fallen

Vorwärts negieren Zähler ändern sich
nicht

Zähler ändern sich nicht Zähler steigen

Bidirektional negieren Zähler fallen Zähler ändern sich nicht Zähler steigen

Auswirkung der Durchflussrichtung auf die Gesamtbefüllung
Die Durchflussrichtung wirkt sich darauf aus, wie die Auswerteelektronik Befüllungen misst
und bestimmt, wann die Befüllung abgeschlossen ist (die Gesamtmenge wurde erreicht).

Auswirkung des Parameters Durchflussrichtung und der tatsächlichen
Durchflussrichtung auf die Gesamtbefüllung

Tabelle 11-8:   

Einstellung der Durch-
flussrichtung

Tatsächliche Durchflussrichtung

Vorwärts Nulldurchfluss Rückwärts

Vorwärts Befüllzähler steigt Befüllzähler ändert sich
nicht

Befüllzähler ändert
sich nicht

Bidirektional Befüllzähler steigt Befüllzähler ändert sich
nicht

Befüllzähler fällt

Vorwärts negieren Befüllzähler ändert
sich nicht

Befüllzähler ändert sich
nicht

Befüllzähler steigt

Bidirektional negieren Befüllzähler fällt Befüllzähler ändert sich
nicht

Befüllzähler steigt

Vorwärtsdurchfluss Prozessmedium strömt in Richtung des Pfeils auf dem Sensor

Rückwärtsdurchfluss Prozessmedium strömt in entgegengesetzter Richtung des Pfeils
auf dem Sensor

Hinweis
Wenn ein Rückwärtsdurchfluss in Ihrem Prozess auftreten und Konsistenzprobleme verursachen
könnte, empfiehlt Micro Motion die Einstellung der Durchflussrichtung auf Bidirektional oder Bidirektional
negieren.
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Anmerkung
Die Durchflussrichtung wirkt sich außerdem auf die Befüllungsprotokollierung über den mA-Ausgang,
den Frequenzausgang und die digitale Kommunikation aus und wirkt sich auf die
Durchflussprotokollierung über den mA-Ausgang, den Frequenzausgang und die digitale
Kommunikation aus.

11.5 Konfigurieren der Dichtemessung
Die Dichtemessparameter steuern, wie die Dichte gemessen und ausgegeben wird. Die
Dichtemessung (zusammen mit der Massemessung) wird verwendet, um den
Volumendurchfluss für Flüssigkeiten zu bestimmen.

Die Dichtemessparameter beinhalten:

• Dichte Messeinheit
• Schwallstromparameter
• Dichtedämpfung
• Dichteabschaltung

11.5.1 Konfigurieren der Dichte Messeinheit

ProLink II ProLink > Configuration > Density > Density Units

ProLink III Device Tools > Configuration > Process Measurement > Density

Modbus Register 40

Überblick

Die Density Measurement Unit gibt die Messeinheiten an, die als Dichtemessung angezeigt
werden.

Verfahren

Die Density Measurement Unit auf die gewünschte Option einstellen.

Die Standardeinstellung für die Density Measurement Unit ist g/cm3 (Gramm pro
Kubikzentimeter).

Optionen für die Dichtemesseinheit
Die Auswerteelektronik bietet einen Standardsatz an Messeinheiten für die
Dichtemesseinheit. Verschiedene Kommunikations-Hilfsmittel verwenden u. U.
unterschiedliche Kennzeichnungen.

Optionen für die DichtemesseinheitTabelle 11-9:   

Beschreibung der Einheit

Bezeichnung

ProLink II ProLink III

Spezifische Dichteeinheit (nicht Temp. korrigiert) SGU SGU

Gramm pro Kubikzentimeter g/cm3 g/cm3
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Optionen für die Dichtemesseinheit (Fortsetzung)Tabelle 11-9:   

Beschreibung der Einheit

Bezeichnung

ProLink II ProLink III

Gramm pro Liter g/l g/l

Gramm pro Milliliter g/ml g/ml

Kilogramm pro Liter kg/l kg/l

Kilogramm pro Kubikmeter kg/m3 kg/m3

Pfund pro U.S. Gallone lbs/Usgal lbs/Usgal

Pfund pro Kubikfuß lbs/ft3 lbs/ft3

Pfund pro Kubikzoll lbs/in3 lbs/in3

API Dichte degAPI degAPI

Short ton pro Kubikyard sT/yd3 sT/yd3

11.5.2 Schwallstrom Parameter konfigurieren

ProLink II ProLink > Configuration > Density > Slug High Limit

ProLink > Configuration > Density > Slug Low Limit

ProLink > Configuration > Density > Slug Duration

ProLink III Device Tools > Configuration > Process Measurement > Density

Modbus Slug Low Limit: Registers 201-202

Slug High Limit: Registers 199-200

Slug Duration: Registers 141-142

Überblick

Die Schwallstrom Parameter steuern, wie die Auswerteelektronik eine
Zweiphasenströmung (Gas in einem Flüssigkeitsprozess oder Flüssigkeit in einem
Gasprozess) erkennt und ausgibt.

Verfahren

1. Setzen Sie Unterer Schwallstrom Grenzwert auf den niedrigsten Dichtewert, der in Ihrem
Prozess als normal betrachtet wird.

Werte unter diesem Grenzwert führen dazu, dass die Auswerteelektronik die für
Schwallstrom konfigurierte Aktion ausführt. Üblicherweise ist dieser Wert die
niedrigste Dichte im normalen Bereich Ihres Prozesses.

Hinweis
Gaseinschlüsse können dazu führen, dass die Prozessdichte kurzzeitig abfällt. Um das
Auftreten von Schwallstrom Alarmen, die für den Prozess nicht von Bedeutung sind, zu
reduzieren, setzen Sie Unterer Schwallstrom Grenzwert etwas unterhalb der niedrigsten
erwarteten Prozessdichte.

Sie müssen Unterer Schwallstrom Grenzwert in g/cm3 auch dann eingeben, wenn Sie eine
andere Einheit für die Dichtemessung konfiguriert haben.
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Der voreingestellte Wert für Unterer Schwallstrom Grenzwert ist 0,0 g/cm3. Der Bereich
ist 0,0 bis 10,0 g/cm3.

2. Setzen Sie Oberer Schwallstrom Grenzwert auf den höchsten Dichtewert, der in Ihrem
Prozess als normal betrachtet wird.

Werte über diesem Grenzwert führen dazu, dass die Auswerteelektronik die für
Schwallstrom konfigurierte Aktion ausführt. Üblicherweise ist dieser Wert die
höchste Dichte im normalen Bereich Ihres Prozesses.

Hinweis
Um das Auftreten von Schwallstrom Alarmen, die für den Prozess nicht von Bedeutung sind,
zu reduzieren, setzen Sie Oberer Schwallstrom Grenzwert etwas oberhalb der höchsten erwarteten
Prozessdichte.

Sie müssen Oberer Schwallstrom Grenzwert in g/cm3 auch dann eingeben, wenn Sie eine
andere Einheit für die Dichtemessung konfiguriert haben.

Der voreingestellte Wert für Oberer Schwallstrom Grenzwert ist 5,0 g/cm3. Der Bereich
ist 0,0 bis 10,0 g/cm3.

3. Setzen Sie Schwallstromdauer auf die Anzahl der Sekunden, die die Auswerteelektronik
auf die Beseitigung einer Schwallstrombedingung wartet, bevor die für
Schwallstrom konfigurierte Aktion ausgeführt wird.

Der voreingestellte Wert für Schwallstromdauer ist 0,0 s. Der Bereich ist 0,0 bis 60,0 s.

Hinweis
Füe Abfüllanwendungen empfiehlt Micro Motion, den für Schwallstromdauer voreingestellten
Wert nicht zu verändern.

Schwallstromerkennung und -ausgabe
Die Schwallströmung wird üblicherweise als Indikator eines Zweiphasenstroms (Gas in
einem Flüssigkeitsprozess oder Flüssigkeit in einem Gasprozess) verwendet. Der
Zweiphasenstrom kann verschiedene Probleme bei der Prozessregelung verursachen.
Durch die richtige Konfiguration der Schwallstromparameter für Ihre Anwendung können
Sie Prozessbedingungen erkennen, die korrigiert werden müssen.

Hinweis
Um das Auftreten von Schwallstromalarmen zu reduzieren, senken Sie den Unteren Schwallstrom-
Grenzwert oder erhöhen den Oberen Schwallstrom-Grenzwert.

Eine Schwallströmung tritt auf, wenn die gemessene Dichte unter den Unteren Schwallstrom-
Grenzwert fällt oder über den Oberen Schwallstrom-Grenzwert steigt. In diesem Fall:

• Wird ein Schwallstromalarm in der aktiven Alarmliste gesetzt.

• Alle Ausgänge, die auf Durchfluss konfiguriert sind, halten den letzten gemessenen
Durchflusswert vor der Schwallströmung bis zum Ende der konfigurierten
Schwallstromdauer.

Wenn der Schwallstromzustand verschwindet, bevor die Schwallstromdauer abgelaufen ist:

• Ausgänge, die auf Durchfluss konfiguriert sind, kehren zur aktuellen
Durchflussanzeige zurück.
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• Der Schwallstromalarm wird deaktiviert, verbleibt aber in der Alarmliste bis er
bestätigt ist.

Wenn der Schwallstromzustand nicht verschwindet, bevor die Schwallstromdauer abgelaufen
ist, zeigen die Ausgänge die auf Durchfluss konfiguriert sind, Nulldurchfluss an.

Wenn die Schwallstromdauer auf 0,0 Sekunden eingestellt ist, zeigen die Ausgänge, die auf
Durchfluss konfiguriert sind, Nulldurchfluss an, sobald ein Schwallstromzustand erkannt
wird.

11.5.3 Konfigurieren der Dichtedämpfung

ProLink II ProLink > Configuration > Density > Density Damping

ProLink III Device Tools > Configuration > Process Measurement > Density

Modbus Registers 193-194

Überblick

Die Dämpfung wird verwendet, um kleine, plötzlich auftretende Schwankungen des
Prozessmesswerts zu glätten. Damping Value gibt die Zeitdauer (in Sekunden) an, über die
die Auswerteelektronik die Änderungen in der ausgegebenen Prozessvariable verteilt. Am
Ende des Intervalls spiegelt die ausgegebene Prozessvariable 63 % der Änderung des
eigentlichen gemessenen Wertes wider.

Verfahren

Density Damping auf den gewünschten Wert einstellen.

Der Standardwert ist 1,28 Sekunden. Der Bereich liegt bei 0 bis 40,96 Sekunden.

Hinweise

• Ein hoher Dämpfungswert lässt die Prozessvariable regelmäßiger erscheinen, da der
ausgegebene Wert sich langsamer ändert.

• Ein niedriger Dämpfungswert lässt die Prozessvariable unregelmäßiger erscheinen, da der
ausgegebene Wert sich schneller ändert.

• Immer, wenn der Dämpfungswert nicht Null ist, wird der ausgegebene Messwert hinter der
eigentlichen Messung liegen, da der ausgegebene Wert über die Zeit gemittelt wird.

• Allgemein werden niedrigere Dämpfungswerte vorgezogen, da das Risiko von Datenverlusten
und die Verzögerung zwischen dem eigentlichem und dem ausgegebenen Wert geringer ist.

Der eingegebene Wert wird automatisch auf den nächst gültigen Wert abgerundet. Die
gültigen Werte für Density Damping sind: 0, 0,04, 0,08, 0,16, ... 40,96.

Effekt der Dichtedämpfung auf die Volumenmessung
Die Dichtedämpfung wirkt sich auf die Flüssigkeitsvolumenmessung aus. Die Werte des
Flüssigkeitsvolumens werden mittels des gedämpften Dichtewerts anstatt des
gemessenen Dichtewerts errechnet. Die
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Interaktion zwischen Dichtedämpfung und Zusätzlicher Dämpfung
In einigen Fällen werden sowohl die Dichtedämpfung als auch die Zusätzliche Dämpfung auf den
ausgegebenen Dichtewert angewandt.

Die Dichtedämpfung regelt die Änderungsrate der Dichte-Prozessvariablen. Die Zusätzliche
Dämpfung regelt die Änderungsrate, die über den mA-Ausgang ausgegeben wird. Wenn die
mA-Ausgangs-Prozessvariable auf Dichte gesetzt ist und sowohl die Dichtedämpfung als auch die
Zusätzliche Dämpfung auf einen Wert ungleich Null gesetzt sind, wird zuerst die
Dichtedämpfung angewandt, und die Berechnung der zusätzlichen Dämpfung wird auf
das Ergebnis der ersten Rechnung angewandt

11.5.4 Konfigurieren der Dichteabschaltung

ProLink II ProLink > Configuration > Density > Low Density Cutoff

ProLink III Device Tools > Configuration > Process Measurement > Density

Modbus Registers 149-150

Überblick

Density Cutoff gibt den niedrigsten Dichtewert an, der als gemessen ausgegeben wird. Alle
Dichtewerte unter dieser Abschaltung werden als 0 ausgegeben.

Verfahren

Density Cutoff auf den gewünschten Wert einstellen.

Der Standardwert für Density Cutoff ist 0,2 g/cm3. Der Bereich liegt bei 0,0 g/cm3 bis
0,5 g/cm3.

Auswirkung der Dichteabschaltung auf die Volumenmessung
Dichteabschaltung beeinflusst die Volumenmessung von Flüssigkeiten. Wenn der Dichtewert
die Dichteabschaltung unterschreitet, wird die Volumendurchflussrate als 0 wiedergegeben.

11.6 Konfigurieren einer Temperaturmessung
Die Parameter der Temperaturmessung steuern, wie die Temperaturdaten vom Sensor
ausgegeben werden. Die Temperaturdaten werden verwendet, um die Auswirkungen zu
kompensieren, die die Temperatur auf Messrohre während Durchflussmessungen hat.

Die Parameter der Temperaturmessung umfassen:

• Temperature Measurement Unit
• Temperature Damping
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11.6.1 Konfigurieren einer Temperatur Messeinheit

ProLink II ProLink > Configuration > Temperature > Temp Units

ProLink III Device Tools > Configuration > Process Measurement > Temperature

Modbus Register 41

Überblick

Temperature Measurement Unit gibt die Einheit an, die für die Temperaturmessung verwendet
wird.

Verfahren

Setzen Sie Temperature Measurement Unit auf die gewünschte Option.

Die Standardeinstellung ist Degrees Celsius.

Optionen für die Temperatur Messeinheit
Die Auswerteelektronik bietet einen Standardsatz an Messeinheiten für Temperature
Measurement Unit. Unterschiedliche Kommunikations-Hilfsmittel verwenden
möglicherweise unterschiedliche Kennzeichnungen für die Einheiten.

Optionen für Temperature Measurement UnitTabelle 11-10:   

Beschreibung der Einheit

Kennzeichnung

ProLink II ProLink III

Grad Celsius GradC °C

Grad Fahrenheit °F °F

Grad Rankine °R °R

Kelvin degK °K

11.6.2 Konfigurieren der Temperaturdämpfung

ProLink II ProLink > Configuration > Temperature > Temp Damping

ProLink III Device Tools > Configuration > Temperature

Modbus Registers 191-192

Überblick

Die Dämpfung wird verwendet, um kleine, plötzlich auftretende Schwankungen des
Prozessmesswerts zu glätten. Damping Value gibt die Zeitdauer (in Sekunden) an, über die
die Auswerteelektronik die Änderungen in der ausgegebenen Prozessvariable verteilt. Am
Ende des Intervalls spiegelt die ausgegebene Prozessvariable 63 % der Änderung des
eigentlichen gemessenen Wertes wider.
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Verfahren

Geben Sie den Wert ein, der für Temperature Damping verwendet werden soll.

Der Standardwert beträgt 4,8 Sekunden. Der Bereich liegt zwischen 0,0 und
38,4 Sekunden.

Hinweise

• Ein hoher Dämpfungswert lässt die Prozessvariable regelmäßiger erscheinen, da der
ausgegebene Wert sich langsamer ändert.

• Ein niedriger Dämpfungswert lässt die Prozessvariable unregelmäßiger erscheinen, da der
ausgegebene Wert sich schneller ändert.

• Immer, wenn der Dämpfungswert nicht Null ist, wird der ausgegebene Messwert hinter der
eigentlichen Messung liegen, da der ausgegebene Wert über die Zeit gemittelt wird.

• Allgemein werden niedrigere Dämpfungswerte vorgezogen, da das Risiko von Datenverlusten
und die Verzögerung zwischen dem eigentlichem und dem ausgegebenen Wert geringer ist.

Der eingegebene Wert wird automatisch auf den nächsten gültigen Wert abgerundet.
Gültige Werte für Temperature Damping sind 0, 0,6, 1,2, 2,4, 4,8, … 38,4.

Auswirkung der Temperaturdämpfung auf die Prozessmessung
Die Temperaturdämpfung beeinflusst die Reaktionsgeschwindigkeit der
Temperaturkompensation bei schwankenden Temperaturen. Die
Temperaturkompensation passt die Prozessmessung an, um den Temperatureinfluss auf
das Messrohr zu kompensieren.

11.7 Druckkompensation konfigurieren
Die Druckkompensation nimmt Anpassungen an der Prozessmessung vor, um den Einfluss
des Drucks auf den Sensor zu kompensieren. Der Einfluss des Drucks ist die Änderung der
Empfindlichkeit des Sensors bezüglich Durchfluss und Dichte, die durch die Differenz
zwischen dem Kalibrierdruck und dem Prozessdruck verursacht wird.

Hinweis
Verwenden Sie die Druckkompensation nur dann für Abfüllanwendungen, wenn dies ausdrücklich
von Micro Motion empfohlen wurde. Wenn Sie Fragen zum Einfluss des Drucks auf eine
Abfüllungsmessung haben, wenden Sie sich an den Micro Motion Kundenservice.

11.7.1 Druckkompensation konfigurieren mittels ProLink II
Vorbereitungsverfahren

Sie benötigen den Durchflussfaktor, den Dichtefaktor und die Kalibrierdruckwerte für den
Sensor.

• Durchflussfaktor und Dichtefaktor sind im Produktdatenblatt des Sensors
angegeben.

• Der Kalibrierdruck ist im Kalibrierdatenblatt des Sensors zu finden. Sind die Daten
nicht verfügbar, verwenden Sie 20 psi.
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Verfahren

1. Wählen Sie View > Preferences und stellen Sie sicher, dass das Kontrollfeld Externe
Druckkompensation aktivieren markiert ist.

2. Wählen Sie ProLink > Configuration > Pressure.

3. Geben Sie den Flow Factor für Ihren Sensor ein.

Der Durchflussfaktor ist die prozentuale Änderung des Durchflusses pro psi. Bei der
Eingabe des Wertes verwenden Sie das umgekehrte Vorzeichen.

Beispiel: 

Wenn der Durchflussfaktor 0,000004 % pro psi ist, geben Sie −0,000004 %  pro  psi ein.

4. Geben Sie den Density Factor für Ihren Sensor ein.

Der Dichtefaktor ist die Änderung der Dichte des Prozessmediums in g/cm3/psi. Bei
der Eingabe des Wertes verwenden Sie das umgekehrte Vorzeichen.

Beispiel: 

Wenn der Dichtefaktor 0,000006 g/cm3/psi ist, geben Sie −0,000006 g/cm3/psi ein.

5. Geben Sie den Cal Pressure für Ihren Sensor ein.

Der Kalibrierdruck ist der Druck, bei dem der Sensor kalibriert wurde. Dies entspricht
dem Druck, bei dem kein Einfluss des Drucks vorhanden ist. Sind die Daten nicht
verfügbar, geben Sie 20 psi ein.

6. Ermitteln Sie, wie die Auswerteelektronik die Druckdaten empfängt, und führen Sie
die entsprechende Einrichtung durch.

Option Einrichtung

Ein vom Anwender
konfigurierter, sta-
tischer Druckwert

a. Setzen Sie Pressure Units auf die gewünschte Einheit.
b. Setzen Sie External Pressure auf den gewünschten Wert.

Abfragen von
Druck(3)

a. Stellen Sie sicher, dass der primäre mA Ausgang gemäß HART
Abfrage verdrahtet wurde.

b. Wählen Sie ProLink > Configuration > Polled Variables.
c. Wählen Sie einen freien Abfrage Slot.
d. Setzen Sie Polling Control auf Poll As Primary oder Poll as Secondary

und klicken Sie dann auf Apply.
e. Setzen Sie External Tag auf die HART Kennzeichnung des externen

Druckmessgeräts.
f. Setzen Sie Variable Type auf Pressure.

Hinweis
• Als Primär abfragen: Auf dem Netzwerk ist kein anderer HART Mas-

ter vorhanden.
• Als Sekundär abfragen: Auf dem Netzwerk sind andere HART Mas-

ter vorhanden. Das Handterminal ist kein HART Master.

(3) Nicht bei allen Auswerteelektroniken verfügbar.
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Option Einrichtung

Ein von der digital-
en Kommunikation
bereitgestellter
Wert

a. Setzen Sie Pressure Units auf die gewünschte Einheit.
b. Führen Sie die erforderlichen Schritte zur Programmierung des

Hostsystems und zur Einrichtung der Kommunikation durch, um
die Druckdaten in entsprechenden Intervallen auf die Auswer-
teelektronik zu schreiben.

Nachbereitungsverfahren

Wenn Sie ein externes Druckmessgerät verwenden, überprüfen Sie die Einstellung, indem
Sie ProLink > Process Variables wählen und den in External Pressure angezeigten Wert prüfen.

11.7.2 Druckkompensation konfigurieren mittels ProLink III
Vorbereitungsverfahren

Sie benötigen den Durchflussfaktor, den Dichtefaktor und die Kalibrierdruckwerte für den
Sensor.

• Durchflussfaktor und Dichtefaktor sind im Produktdatenblatt des Sensors
angegeben.

• Der Kalibrierdruck ist im Kalibrierdatenblatt des Sensors zu finden. Sind die Daten
nicht verfügbar, verwenden Sie 20 psi.

Verfahren

1. Wählen Sie Device Tools > Configuration > Process Measurement > Pressure Compensation.

2. Setzen Sie Pressure Compensation Status to Enabled.

3. Geben Sie den Flow Calibration Pressure für Ihren Sensor ein.

Der Kalibrierdruck ist der Druck, bei dem der Sensor kalibriert wurde. Dies entspricht
dem Druck, bei dem kein Einfluss des Drucks vorhanden ist. Sind die Daten nicht
verfügbar, geben Sie 20 psi ein.

4. Geben Sie den Flow Factor für Ihren Sensor ein.

Der Durchflussfaktor ist die prozentuale Änderung des Durchflusses pro psi. Bei der
Eingabe des Wertes verwenden Sie das umgekehrte Vorzeichen.

Beispiel: 

Wenn der Durchflussfaktor 0,000004 % pro psi ist, geben Sie −0,000004 %  pro  psi ein.

5. Geben Sie den Density Factor für Ihren Sensor ein.

Der Dichtefaktor ist die Änderung der Dichte des Prozessmediums in g/cm3/psi. Bei
der Eingabe des Wertes verwenden Sie das umgekehrte Vorzeichen.

Beispiel: 

Wenn der Dichtefaktor 0,000006 g/cm3/psi ist, geben Sie −0,000006 g/cm3/psi ein.

6. Setzen Sie Pressure Source auf die Methode, die die Auswerteelektronik für den
Empfang der Druckdaten verwendet.
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Option Beschreibung

Externen Wert abfragen(4) Die Auswerteelektronik fragt ein externes Druckmessgerät
ab. Sie verwendet hierfür das HART Protokoll über den pri-
mären mA Ausgang.

Statische oder digitale Kommuni-
kation

Die Auswerteelektronik verwendet den aus dem Speicher
gelesenen Druckwert.
• Statisch: Der konfigurierte Wert wird verwendet.
• Digitale Kommunikation: Ein Host schreibt Daten in den

Speicher der Auswerteelektronik.

7. Wenn Sie die Abfrage von Druckdaten wählen:

a. Wählen Sie den zu verwendenden Abfrage Slot.
b. Setzen Sie Polling Control auf Poll as Primary oder auf Poll as Secondary und klicken Sie

dann auf Apply.

Hinweis

• Als Primär abfragen: Auf dem Netzwerk ist kein anderer HART Master vorhanden.

• Als Sekundär abfragen: Auf dem Netzwerk sind andere HART Master vorhanden. Das
Handterminal ist kein HART Master.

c. Setzen Sie External Device Tag auf die HART Kennzeichnung des externen
Druckmessgeräts und klicken Sie dann auf Apply.

8. Wenn Sie einen statischen Druckwert verwenden:

a. Setzen Sie Pressure Unit auf die gewünschte Einheit.

b. Setzen Sie Static or Current Pressure auf den Wert, den Sie verwenden möchten,
und klicken Sie auf Apply.

9. Wenn Sie digitale Kommunikation verwenden möchten, klicken Sie auf Apply und
führen Sie dann die erforderlichen Schritte zur Programmierung des Hostsystems
und zur Einrichtung der Kommunikation durch, um Druckdaten in entsprechenden
Intervallen auf die Auswerteelektronik zu schreiben.

Nachbereitungsverfahren

Wenn Sie einen externen Druckwert verwenden, überprüfen Sie die Einstellung, indem Sie
den Wert External Pressure prüfen, der im Bereich Inputs des Hauptfensters angezeigt wird.

11.7.3 Optionen für Druckmesseinheit
Die Auswerteelektronik bietet ein Standardsatz an Messeinheiten für Pressure Measurement
Unit. Unterschiedliche Kommunikations-Hilfsmittel verwenden möglicherweise
unterschiedliche Kennzeichnungen für die Einheiten. In den meisten Anwendungen sollte
Pressure Measurement Unit so eingestellt sein, dass sie mit dem vom externen Gerät
verwendeten Druckmesseinheit übereinstimmt.

(4) Nicht bei allen Auswerteelektroniken verfügbar.
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Optionen für Pressure Measurement UnitTabelle 11-11:   

Beschreibung der Einheit

Kennzeichnung

ProLink II ProLink III

Feet Wasser bei 68 °F Ft Wasser bei 68 °F Ft Water @ 68°F

In. Wasser bei 4 °C In. Wasser bei 4 °C In Water @ 4°C

In. Wasser bei 60 °F In. Wasser bei 60 °F In Water @ 60°F

In. Wasser bei 68 °F In. Wasser bei 68 °F In Water @ 68°F

Millimeter Wasser bei 4 °C mm Wasser bei 4 °C mm Water @ 4°C

Millimeter Wasser bei 68 °F mm Wasser bei 68 °F mm Water @ 68°F

Millimeter Quecksilber bei 0 °C mm Quecksilber bei 0 °C mm Mercury @ 0°C

In. Quecksilber bei 0 °C In. Quecksilber bei 0 °C In Mercury @ 0°C

Pounds pro Quadratinch PSI PSI

bar bar bar

mbar mbar millibar

Gramm pro Quadratzentimeter g/cm2 g/cm2

Kilogramm pro Quadratzentimeter kg/cm2 kg/cm2

Pascal Pa pascals

kPa kPa Kilopascals

Megapascal MPa Megapascals

Torr bei 0 °C Torr bei 0 °C Torr @ 0°C

Atmosphären at atms
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12 Geräteoptionen und Präferenzen
konfigurieren
In diesem Kapitel behandelte Themen:

• Konfigurieren der Alarmverwaltung

• Informationsparameter konfigurieren

12.1 Konfigurieren der Alarmverwaltung
Die Alarmverwaltungsparameter steuern die Reaktion der Auswerteelektronik auf Prozess-
und Gerätebedingungen.

Die Alarmverwaltungsparameter umfassen:

• Fehler-Timeout
• Status Alarmstufe

12.1.1 Konfigurieren von Störung-Timeout

ProLink II ProLink > Configuration > Frequency > Last Measured Value Timeout

ProLink III Device Tools > Configuration > Fault Processing

Modbus Register 314

Überblick

Fault Timeout steuert die Verzögerung, bevor Störaktionen eingeleitet werden.

Einschränkung
Fault Timeout findet nur auf die folgenden Alarme Anwendung (aufgelistet nach Statusalarmcode):
A003, A004, A005, A008, A016, A017, A033. Bei allen anderen Alarmen werden Störaktionen
durchgeführt, sobald ein Alarm erkannt wird.

Verfahren

Fault Timeout wie gewünscht einstellen.

Der Standardwert ist 0 Sekunden. Der Bereich liegt bei 0 bis 60 Sekunden.

Wenn Fault Timeout auf 0 eingestellt wird, werden Störaktionen durchgeführt, sobald eine
Alarmbedingung erkannt wird.

Die Zeitspanne Störung-Timeout beginnt, sobald die Auswerteelektronik eine
Alarmbedingung erkennt. Während der Zeitspanne Störung-Timeouts gibt die
Auswerteelektronik weiterhin die zuletzt gültigen Messwerte aus.

Wenn Störung-Timeout abläuft und der Alarm noch aktiv ist, werden die Störaktionen
durchgeführt. Wenn die Alarmbedingung nicht mehr aktiv ist, bevor Störung-Timeout
abläuft, wird keine Störaktionen durchgeführt.
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Hinweis
ProLink IIermöglicht die Einstellung von Fault Timeout in zwei Bereichen. Allerdings gibt es nur einen
Parameter und dieselbe Einstellung gilt für alle Ausgänge.

12.1.2 Konfigurieren von Status Alarmstufe

ProLink II ProLink > Configuration > Alarm > Alarm

ProLink > Configuration > Alarm > Severity

ProLink III Device Tools > Configuration > Alert Severity

Modbus Alarm index: Register 1237

Alarm x severity: Register 1238

Überblick

Verwenden Sie Status Alarm Severity, um Störaktionen zu steuern, die die
Auswerteelektronik ausführt, wenn eine Alarmbedingung erkannt wird.

Einschränkungen

• Für einige Alarme ist Status Alarm Severity nicht konfigurierbar.

• Für einige Alarme kann Status Alarm Severity nur auf zwei der drei Optionen eingestellt werden.

Hinweis
Micro Motion empfiehlt, die Standardeinstellungen für Status Alarm Severity zu verwenden, es sei
denn, es bestehen spezielle Anforderungen, diese zu ändern.

Verfahren

1. Wählen Sie einen Statusalarm aus.

2. Setzen Sie Status Alarm Severity wie gewünscht für den ausgewählten Statusalarm.
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Op-
tion Beschreibung

Fault Maßnahmen bei Erkennung einer Störung:
• Der Alarm wird in der Alarmliste angezeigt.
• Die Befüllung wird beendet.(1)

• Die Ausgänge werden auf die konfigurierte Störaktion gesetzt (nach Ablauf
von Fault Timeout, falls zutreffend).

• Die digitale Kommunikation wird auf die konfigurierte Störaktion gesetzt
(nach Ablauf von Fault Timeout, falls zutreffend).

• Die Farbe der Status-LED (falls vorhanden) wechselt auf rot oder gelb (abhän-
gig von der Alarmstufe).

Maßnahmen, wenn der Alarm gelöscht wird:
• Die Ausgänge kehren zu ihrem normalen Verhalten zurück.
• Die digitale Kommunikation kehrt zu ihrem normalen Verhalten zurück.
• Die Farbe der Status-LED (falls vorhanden) wechselt zu grün und die LED kann

ggf. blinken.
• Die Befüllung wird nicht fortgesetzt.(1)

Informa-
tional

Maßnahmen bei Erkennung einer Störung:
• Der Alarm wird in der Alarmliste angezeigt.
• Die Farbe der Status-LED (falls vorhanden) wechselt auf rot oder gelb (abhän-

gig von der Alarmstufe).
• Nur bei Alarm A105 (Schwallströmung) wird die Befüllung beendet, wenn Slug

Duration abläuft.(1)

Maßnahmen, wenn der Alarm gelöscht wird:
• Die Farbe der Status-LED (falls vorhanden) wechselt zu grün und die LED kann

ggf. blinken.
• Nur bei Alarm A105 (Schwallströmung) wird die Befüllung nicht fortgesetzt.(1)

Ignore • Nur bei Alarm A105 (Schwallströmung) wird die Befüllung beendet, wenn Slug
Duration abläuft und wird nicht fortgesetzt, wenn der Alarm gelöscht wird.(1)

• Bei allen anderen Alarmen: Keine Aktion.

Statusalarme und Optionen für Status-Alarmstufe

Statusalarme und Status-AlarmstufeTabelle 12-1:   

Alarm Code
Statusmeldung Voreingestellte

Alarmstufe Hinweise
Konfigurier-
bar?

A001 EEPROM-Fehler (Core-Pro-
zessor)

Störung Nein

A002 RAM-Fehler (Core-Prozes-
sor)

Störung Nein

A003 Keine Antwort vom Sensor Störung Ja

A004 Messbereichsüberschrei-
tung für Temperatur

Störung Nein

A005 Messbereichsüberschrei-
tung für Massedurchfluss

Störung Ja

(1) Nur bei Befüllungen mit integrierter Ventilsteuerung. Bei Befüllungen mit externer Ventilsteuerung wird die Verarbeitung durch das Host-
programm gesteuert.
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Statusalarme und Status-Alarmstufe (Fortsetzung)Tabelle 12-1:   

Alarm Code
Statusmeldung Voreingestellte

Alarmstufe Hinweise
Konfigurier-
bar?

A006 Charakterisierung erfor-
derlich

Störung Ja

A008 Dichte Bereichsüberschrei-
tung

Störung Ja

A009 Auswerteelektronik Initiali-
sierung/Aufwärmphase

Störung Ja

A010 Kalibrierfehler Störung Nein

A011 Nullpunktkalibrierung fehl-
geschlagen: Tief

Störung Ja

A012 Nullpunktkalibrierung fehl-
geschlagen: Hoch

Störung Ja

A013 Nullpunktkalibrierung fehl-
geschlagen: Instabil

Störung Ja

A014 Auswerteelektronikfehler Störung Nein

A016 Sensor-RTD-Fehler Störung Ja

A017 T-Serien-RTD-Fehler Störung Ja

A020 K.wrt f. k. Drchflss Störung Ja

A021 Falscher Sensortyp (K1) Störung Nein

A029 PIC/Tochterboard-Kom-
munikationsfehler

Störung Nein

A030 Falscher Platinentyp Störung Nein

A031 Spannung zu niedrig Störung Nein

A033 Unzureichendes Signal von
rechter/linker Aufnehmer-
spule

Störung Ja

A102 Antrieb Bereichsübers-
chreitung

Informativ Ja

A104 Kalibrierung läuft Informativ Kann entweder auf Informativ oder
Ignorieren gesetzt werden, aber
nicht auf Störung.

Ja

A105 Schwallströmung Informativ Ja

A107 Spannungsunterbrechung
eingetreten

Informativ Normales Verhalten der Auswer-
teelektronik; tritt nach jedem Aus-/
Einschalten der Stromversorgung
auf.

Ja

A110 Frequenzausgang gesät-
tigt

Informativ Kann entweder auf Informativ oder
Ignorieren gesetzt werden, aber
nicht auf Störung.

Ja

A111 Frequenzausgang fixiert Informativ Kann entweder auf Informativ oder
Ignorieren gesetzt werden, aber
nicht auf Störung.

Ja

A113 mA-Ausgang 2 gesättigt Informativ Kann entweder auf Informativ oder
Ignorieren gesetzt werden, aber
nicht auf Störung.

Ja
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Statusalarme und Status-Alarmstufe (Fortsetzung)Tabelle 12-1:   

Alarm Code
Statusmeldung Voreingestellte

Alarmstufe Hinweise
Konfigurier-
bar?

A114 mA-Ausgang 2 fest Informativ Kann entweder auf Informativ oder
Ignorieren gesetzt werden, aber
nicht auf Störung.

Ja

A118 Binärer mA Ausgang 1 fix Informativ Kann entweder auf Informativ oder
Ignorieren gesetzt werden, aber
nicht auf Störung.

Ja

12.2 Informationsparameter konfigurieren
Die Informationsparameter können verwendet werden, um das Durchflussmessgerät zu
identifizieren oder zu beschrieben. Sie werden jedoch nicht für die Verarbeitung in der
Auswerteelektronik benötigt und sind auch nicht erforderlich.

Die Informationsparameter umfassen:

• Geräteparameter

- Beschreibung
- Nachricht
- Datum

• Sensorparameter

- Sensor Seriennummer
- Sensor Werkstoff
- Sensor Auskleidungswerkstoff
- Sensor Flanschtyp

12.2.1 Konfigurieren der Beschreibung

ProLink II ProLink > Configuration > Device > Descriptor

ProLink III Device Tools > Configuration > Informational Parameters > Transmitter

Modbus Registers 96-103

Überblick

Mit Descriptor kann eine Beschreibung im Speicher der Auswerteelektronik gespeichert
werden. Die Beschreibung wird nicht für die Verarbeitung benötigt und ist nicht
erforderlich.

Verfahren

Eine Beschreibung für die Auswerteelektronik eingeben.

Es können bis zu 16 Zeichen als Beschreibung eingegeben werden.
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12.2.2 Nachricht konfigurieren

ProLink II ProLink > Configuration > Device > Message

ProLink III Device Tools > Configuration > Informational Parameters > Transmitter

Modbus Registers 104-119

Überblick

Nachricht ermöglicht das Speichern einer kurzen Nachricht im Speicher der
Auswerteelektronik. Dieser Parameter wird nicht für die Verarbeitung in der
Auswerteelektronik benötigt und ist auch nicht erforderlich.

Verfahren

Geben Sie eine kurze Nachricht für die Auswerteelektronik ein.

Die Nachricht kann bis zu 32 Zeichen lang sein.

12.2.3 Konfigurieren des Datums

ProLink II ProLink > Configuration > Device > Date

ProLink III Device Tools > Configuration > Informational Parameters > Transmitter

Modbus Register 51

Überblick

Mittels Date kann eine statisches Datum (wird nicht durch die Auswerteelektronik
aktualisiert) im Speicher der Auswerteelektronik gespeichert werden. Dieser Parameter
wird nicht für die Verarbeitung benötigt und ist nicht erforderlich.

Verfahren

Das Datum im Format MM/TT/JJJJ eingeben.

Hinweis
ProLink II und ProLink III bietet einen Kalender, der die Auswahl des Datums erleichtert.

12.2.4 Sensor Seriennummer konfigurieren

ProLink II ProLink > Configuration > Sensor > Sensor s/n

ProLink III Device Tools > Configuration > Informational Parameters > Sensor

Modbus Registers 127-128
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Überblick

Sensor Seriennummer ermöglicht Ihnen das Speichern der Seriennummer der Sensor-
Komponente des Durchflussmessgeräts im Speicher der Auswerteelektronik. Dieser
Parameter wird nicht für die Verarbeitung in der Auswerteelektronik benötigt und ist auch
nicht erforderlich.

Verfahren

1. Sie finden die Seriennummer des Sensors in der Sensor Kennzeichnung.

2. Geben Sie die Seriennummer in das Feld Sensor Seriennummer ein.

12.2.5 Sensor Werkstoff konfigurieren

ProLink II ProLink > Configuration > Sensor > Sensor Matl

ProLink III Device Tools > Configuration > Informational Parameters > Sensor
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Überblick

Sensor Werkstoff ermöglicht Ihnen das Speichern der Art des Werkstoffs, die für die
mediumberührten Teile des Sensors verwendet werden, im Speicher der
Auswerteelektronik. Dieser Parameter wird nicht für die Verarbeitung in der
Auswerteelektronik benötigt und ist auch nicht erforderlich.

Verfahren

1. Der für die mediumberührten Teile des Sensors verwendete Werkstoff ist in den
Dokumenten aufgeführt, die im Lieferumfang des Sensors enthalten sind, bzw. aus
einem Code in der Modellnummer des Sensor ersichtlich.

Eine Aufschlüsselung der Modellnummer ist im Produktdatenblatt des jeweiligen
Sensors zu finden.

2. Setzen Sie Sensor Werkstoff auf die entsprechende Option.

12.2.6 Sensor Auskleidungswerkstoff konfigurieren

ProLink II ProLink > Configuration > Sensor > Liner Matl

ProLink III Device Tools > Configuration > Informational Parameters > Sensor
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Überblick

Sensor Auskleidungswerkstoff ermöglicht Ihnen das Speichern der Art des Werkstoffs, die für
die Auskleidung des Sensors verwendet wird, im Speicher der Auswerteelektronik. Dieser
Parameter wird nicht für die Verarbeitung in der Auswerteelektronik benötigt und ist auch
nicht erforderlich.

Geräteoptionen und Präferenzen konfigurieren

Konfigurations- und Bedienungsanleitung 157



Verfahren

1. Der Auskleidungswerkstoff des Sensors ist in den Dokumenten aufgeführt, die im
Lieferumfang des Sensors enthalten sind, bzw. aus einem Code in der
Modellnummer des Sensors ersichtlich.

Eine Aufschlüsselung der Modellnummer ist im Produktdatenblatt des jeweiligen
Sensors zu finden.

2. Setzen Sie Sensor Auskleidungswerkstoff auf die entsprechende Option.

12.2.7 Sensor Flanschtyp konfigurieren

ProLink II ProLink > Configuration > Sensor > Flange

ProLink III Device Tools > Configuration > Informational Parameters > Sensor
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Überblick

Sensor Flanschtyp ermöglicht Ihnen das Speichern des Flanschtyps Ihres Sensors im Speicher
der Auswerteelektronik. Dieser Parameter wird nicht für die Verarbeitung in der
Auswerteelektronik benötigt und ist auch nicht erforderlich.

Verfahren

1. Der Flanschtyp des Sensors ist in den Dokumenten aufgeführt, die im Lieferumfang
des Sensors enthalten sind, bzw. aus einem Code in der Modellnummer des Sensors
ersichtlich.

Eine Aufschlüsselung der Modellnummer ist im Produktdatenblatt des jeweiligen
Sensors zu finden.

2. Setzen Sie Sensor Flanschtyp auf die entsprechende Option.
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13 Integrieren des Messgerätes mit dem
Netzwerk
In diesem Kapitel behandelte Themen:

• Konfigurieren der Auswerteelektronikkanäle

• mA Ausgang konfigurieren

• Frequenzausgang konfigurieren

• Konfigurieren des Binärausgangs

• Binäreingang konfigurieren

• Konfigurieren eines erweiterten Ereignisses

• Konfigurieren der digitalen Kommunikation

13.1 Konfigurieren der Auswerteelektronikkanäle

ProLink II ProLink > Configuration > Channel > Channel B > Type Assignment

ProLink III Device Tools > Configuration > I/O > Channels

Modbus Register 1167

Überblick

Kanal B der Auswerteelektronik kann so konfiguriert werden, dass er als Binärausgang oder
als Binäreingang fungiert. Die Kanalkonfiguration muss der Verdrahtung an den
Anschlussklemmen der Auswerteelektronik entsprechen.

Vorbereitungsverfahren

Vermeiden von Prozessstörungen:

• Konfigurieren Sie die Kanäle, bevor Sie die Ausgänge konfigurieren.

• Vor dem Ändern der Kanalkonfiguration sicherstellen, dass alle durch diesen Kanal
betroffenen Regelkreise manuell gesteuert werden.

VORSICHT!

Bevor Sie einen Kanal als Binäreingang konfigurieren, prüfen Sie den Status des externen
Eingangsgerätes und die Aktionen, die dem Binäreingang zugeordnet sind. Wenn der
Binäreingang EIN ist, werden alle dem Binäreingang zugeordneten Aktionen ausgeführt, wenn
die neue Kanalkonfiguration implementiert wird. Ist dies nicht akzeptabel, ändern Sie den
Status des externen Gerätes oder warten mit der Konfiguration des Kanals als Binäreingang auf
einen geeigneten Zeitpunkt.

Verfahren

Kanal B wie gewünscht einstellen.
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Option Beschreibung

Binärausgang Kanal B fungiert als Binärausgang.

Binäreingang Kanal B arbeitet als Binärausgang.

Nachbereitungsverfahren

Für jeden konfigurierten Kanal die entsprechende Eingangs- oder Ausgangskonfiguration
durchführen bzw. überprüfen. Wenn die Konfiguration eines Kanals sich ändert, wird das
Verhalten des Kanals durch die Konfiguration geregelt, die für den ausgewählten
Eingangs- oder Ausgangstyp gespeichert ist. Die gespeicherte Konfiguration ist für den
bestimmten Prozess möglicherweise nicht geeignet.

Nach dem Überprüfen der Kanal- und Ausgangskonfiguration die automatische Steuerung
des Regelkreises wieder aktivieren.

13.2 mA Ausgang konfigurieren
Der mA Ausgang wird zum Ausgeben der konfigurierten Prozessvariablen verwendet. Die
mA Ausgangsparameter steuern, wie die Prozessvariable ausgegeben wird. Ihre
Auswerteelektronik hat einen mA Ausgang.

Die Parameter des mA Ausgangs umfassen:

• mA Ausgang Prozessvariable
• Lower Range Value (LRV) und Upper Range Value (URV)

• Analogausgang Abschaltung
• Zusätzliche Dämpfung
• AO Fault Action und AO Fault Value

Wichtig
Immer wenn Sie einen Parameter des mA Ausgangs ändern, prüfen Sie alle anderen Parameter des
mA Ausgangs, bevor Sie das Durchfluss-Messsystem wieder in Betrieb nehmen. In einigen
Situationen lädt die Auswerteelektronik automatisch einige gespeicherte Werte und es kann sein,
dass diese Werte nicht passend für Ihre Anwendung sind.

13.2.1 mA Ausgang Prozessvariable konfigurieren

ProLink II ProLink > Configuration > Analog Output > Secondary Variable

ProLink III Device Tools > Configuration > I/O > Outputs > mA Output

Modbus Register 13

Überblick

Verwenden Sie mA Ausgang Prozessvariable, um die Variable auszuwählen, die über den mA
Ausgang ausgegeben wird.

Verfahren

Setzen Sie die mA Ausgang Prozessvariable wie gewünscht.
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Die Voreinstellung ist Massedurchfluss.

Optionen für mA Ausgang Prozessvariable
Die Auswerteelektronik liefert einen Grundoptionssatz für Ausgang Prozessvariable,
einschließlich mehrerer anwendungsspezifischer Optionen. Verschiedene
Kommunikations-Hilfsmittel verwenden u. U. unterschiedliche Kennzeichnungen für die
Optionen.

Optionen für mA Ausgang ProzessvariableTabelle 13-1:   

Prozessvariable

Bezeichnung

ProLink II ProLink III

Massedurchflussrate Massendurchflussrate Massendurchflussrate

Volumendurchflussrate Volumendurchflussrate Volumendurchflussrate

Temperatur Temperatur Temperatur

Dichte Dichte Dichte

Gelieferter Prozentsatz der Abfüllung Binärbatch: Prozent Abfüllung Binärbatch: Prozent Abfüllung

13.2.2 Messanfang (LRV) und Messende (URV) konfigurieren

ProLink II ProLink > Configuration > Analog Output > Lower Range Value

ProLink > Configuration > Analog Output > Upper Range Value

ProLink III Device Tools > Configuration > I/O > Outputs > mA Output

Modbus LRV: Registers 221-222

URV: Registers 219-220

Überblick

Der Messanfang (LRV) und das Messende (URV) werden verwendet, um den mA Ausgang zu
skalieren, d. h. das Verhältnis zwischen der mA Ausgang Prozessvariablen und dem mA
Ausgangswert zu definieren.

Anmerkung
Wenn Sie LRV und URV von den werkseitig voreingestellten Werten ändern und Sie später die mA
Ausgang Prozessvariable ändern, werden LRV und URV nicht auf die voreingestellten Werte
zurückgesetzt. Wenn Sie beispielsweise die mA Ausgang Prozessvariable als Massedurchfluss
konfigurieren und LRV und URV ändern, dann die mA Ausgang Prozessvariable auf Dichte setzen und
schließlich die mA Ausgang Prozessvariable zurück auf Massedurchfluss ändern, werden LRV und URV für
Massedurchfluss auf die konfigurierten Werte zurückgesetzt.

Verfahren

Setzen Sie LRV und URV wie gewünscht.

• LRV ist der Wert der mA Ausgang Prozessvariablen, der durch einen Ausgang von 4 mA
repräsentiert wird. Der voreingestellte Wert für LRV ist von der Einstellung der mA
Ausgang Prozessvariablen abhängig. Wenn mA Ausgang Prozessvariable auf Batch: Prozent der
Befüllung gesetzt ist, geben Sie LRV in % ein.
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• URV ist der Wert der mA Ausgang Prozessvariablen, der durch einen Ausgang von 20 mA
repräsentiert wird. Der voreingestellte Wert für URV ist von der Einstellung der mA
Ausgang Prozessvariablen abhängig. Wenn mA Ausgang Prozessvariable auf Batch: Prozent der
Befüllung gesetzt ist, geben Sie URV in % ein.

Hinweise
Für optimale Leistungsmerkmale:

• Setzen Sie LRV ≥ LSL (untere Sensorgrenze).

• Setzen Sie URV ≤ USL (obere Sensorgrenze).

• Setzen Sie diese Werte so, dass die Differenz zwischen URV und LRV ≥ Min Spanne
(Mindestmessspanne) ist.

Die Festlegung von URV und LRV innerhalb der empfohlenen Werte für Min Spanne, LSL und USL sorgt
dafür, dass die Auflösung des mA Ausgang Signals innerhalb des Bereichs der Bitgenauigkeit des
D/A-Wandlers liegt.

Anmerkung
Sie können URV unterhalb von LRV setzen. Zum Beispiel können Sie URV auf 50 und LRV auf 100
setzen.

Der mA Ausgang verwendet einen Bereich von 4–20 mA zur Darstellung der mA Ausgang
Prozessvariablen. Zwischen LRV und URV ist der mA Ausgang linear zur Prozessvariablen.
Fällt die Prozessvariable unter LRV oder steigt über URV, setzt die Auswerteelektronik
einen Sättigungsalarm.

Voreingestelle Werte für Messanfang (LRV) und Messende (URV)
Jede Option für die mA Ausgang Prozessvariable hat ihre eigenen LRV und URV. Wenn Sie die
Konfiguration der mA Ausgang Prozessvariable ändern, werden die korrospondierenden LRV
und URV geladen und verwendet.

Voreingestelle Werte für Messanfang (LRV) und Messende (URV)Tabelle 13-2:   

Prozessvariable Messanfang Messende

Alle Massedurchfluss-Variablen -200,000 g/s 200,000 g/s

Alle Flüssigkeits-Volumen-
durchfluss-Variablen

-0,200 l/s 0,200 l/s

Alle Dichtevariablen 0,000 g/cm3 10,000 g/cm3

Alle Temperaturvariablen -240,000 ℃ 450,000 ℃

Abfüllung in Prozent 0 % 100 %

13.2.3 Analogausgang Abschaltung konfigurieren

ProLink II ProLink > Configuration > Analog Output > AO Cutoff

ProLink III Device Tools > Configuration > I/O > Outputs > mA Output

Modbus Registers 217-218
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Überblick

AO Cutoff (Analogausgang Abschaltung) spezifiziert den niedrigsten Massedurchfluss oder
Volumendurchfluss, der durch den mA Ausgang ausgegeben wird. Jeder Durchfluss
unterhalb der Analogausgang Abschaltung wird als 0 ausgegeben.

Einschränkung
Die Analogausgang Abschaltung wird nur angewandt, wenn die mA Ausgang Prozessvariable auf
Massedurchfluss oder Volumendurchfluss gesetzt ist. Ist die mA Ausgang Prozessvariable auf eine andere
Prozessvariable gesetzt, ist die Analogausgang Abschaltung nicht konfigurierbar und die
Auswerteelektronik implementiert die Funktion der Analogausgang Abschaltung nicht.

Verfahren

Setzen Sie die Analogausgang Abschaltung wie gewünscht.

Der voreingestellte Wert für Analogausgang Abschaltung ist 0,0 g/s.

Hinweis
Für die meisten Anwendungen sollte der voreingestellte Wert der Analogausgang Abschaltung
verwendet werden. Setzen Sie sich mit dem Micro Motion Kundenservice in Verbindung, bevor Sie
die Analogausgang Abschaltung ändern.

Wechselwirkung zwischen AO-Abschaltung und
Prozessvariablen-Abschaltungen
Wenn die mA-Ausgang-Prozessvariable auf eine Durchflussvariable (beispielsweise
Massendurchfluss oder Volumendurchfluss) gesetzt ist, dann hat die AO-Abschaltung
Wechselwirkungen mit der Massendurchfluss-Abschaltung oder der Volumendurchfluss-
Abschaltung. Die Auswerteelektronik setzt die Abschaltung beim höchsten Durchfluss ein,
bei dem diese anwendbar ist.

Beispiel: Wechselwirkung bei Abschaltung

Konfiguration:

• mA-Ausgang-Prozessvariable = Massedurchfluss
• AO-Abschaltung = 10 g/s

• Massedurchfluss-Abschaltung = 15 g/s

Ergebnis: Fällt der Massedurchfluss unter 15 g/s, gibt der mA-Ausgang null Durchfluss aus.

13.2.4 Zusätzliche Dämpfung konfigurieren

ProLink II ProLink > Configuration > Analog Output > AO Added Damp

ProLink III Device Tools > Configuration > I/O > Outputs > mA Output

Modbus Registers 215-216
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Überblick

Die Dämpfung wird verwendet, um kleine, plötzlich auftretende Schwankungen des
Prozessmesswerts zu glätten. Damping Value gibt die Zeitdauer (in Sekunden) an, über die
die Auswerteelektronik die Änderungen in der ausgegebenen Prozessvariable verteilt. Am
Ende des Intervalls spiegelt die ausgegebene Prozessvariable 63 % der Änderung des
eigentlichen gemessenen Wertes wider. Zusätzliche Dämpfung steuert den Wert der
Dämpfung, die für den mA Ausgang angewandt werden soll. Sie beeinflusst nur die
Ausgabe der mA Ausgang Prozessvariablen durch den mA Ausgang. Sie beeinflusst nicht die
Ausgabe der Prozessvariablen mittels einer anderen Methode (z. B. dem Frequenzausgang
oder der digitalen Kommunikation) oder den Wert der Prozessvariablen, der für
Berechnungen verwendet wird.

Anmerkung
Zusätzliche Dämpfung wird nicht auf den mA Ausgang angewandt, wenn dieser fixiert ist (z. B. während
des Messkreistests) oder wenn der mA Ausgang eine Störung ausgibt. Zusätzliche Dämpfung wird
angewandt, während die Sensor Simulation aktiv ist.

Verfahren

Setzen Sie Zusätzliche Dämpfung auf den gewünschten Wert.

Der voreingestellte Wert ist 0,0 Sekunden.

Wenn Sie einen Wert für Added Damping setzen, rundet die Auswerteelektronik den Wert
automatisch auf den nächsten Wert nach unten ab.

Gültige Werte für Zusätzliche DämpfungTabelle 13-3:   

Gültige Werte für Zusätzliche Dämpfung

0,0, 0,1, 0,3, 0,75, 1,6, 3,3, 6,5, 13,5, 27,5, 55, 110, 220, 440

Interaktion zwischen Zusatzdämpfung und
Prozessvariablendämpfung
Wenn die mA-Ausgang-Prozessvariable auf eine Durchflussvariable, Dichte oder Temperatur
gesetzt ist, dann hat die Zusätzliche Dämpfung Wechselwirkungen mit der Durchflussdämpfung,
Dichtedämpfung oder Temperaturdämpfung. Wenn mehrere Dämpfungsparameter verwendet
werden, wird zuerst der Effekt der Dämpfung der Prozessvariablen berechnet, und die
zusätzliche Dämpfung wird auf das Ergebnis dieser Berechnung angewandt.

Beispiel: Wechselwirkung bei Dämpfung

Konfiguration:

• Durchflussdämpfung = 1 Sekunde

• mA-Ausgang-Prozessvariable = Massedurchfluss
• Zusätzliche Dämpfung = 2 Sekunden

Ergebnis: Eine Änderung des Massedurchflusses wirkt sich am mA-Ausgang nach mehr als
3 Sekunden aus. Die genaue Zeit wird durch die Auswerteelektronik berechnet, gemäß
einem internen Algorithmus, der nicht konfiguriert werden kann.
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13.2.5 mA Ausgang Störaktion und mA Ausgang Störwert
konfigurieren

ProLink II ProLink > Configuration > Analog Output > AO Fault Action

ProLink > Configuration > Analog Output > AO Fault Level

ProLink III Device Tools > Configuration > Fault Processing

Modbus AO fault action: Register 1114

AO fault level: Registers 1111-1112

Überblick

Die mA Ausgang Störaktion steuert das Verhalten des mA Ausgangs, wenn die
Auswerteelektronik eine interne Störbedingung erkennt.

Anmerkung
Nur für manche Fehler: Wenn Zuletzt gemessener Wert – Zeitüberschreitung auf einen Wert ungleich null
gesetzt ist, wird die Auswerteelektronik die Störaktion erst nach Ablauf der Zeitüberschreitung
implementieren.

Verfahren

1. Setzen Sie die mA Ausgang Störaktion auf den gewünschten Wert.

Die Voreinstellung ist Abwärts.

2. Wenn Sie mA Ausgang Störaktion auf Aufwärts oder Abwärts setzen, setzen Sie den mA
Ausgang Störwert wie gewünscht.

Optionen für mA Ausgang Störaktion und mA Ausgang Störwert

Optionen für mA Ausgang Störaktion und mA Ausgang StörwertTabelle 13-4:   

Option mA Ausgang Verhalten mA Ausgang Störwert

Aufwärts Geht auf den konfigurierten Störwert Default: 22,0 mA

Bereich: 21 bis 24 mA

Abwärts (Voreinstellung) Geht auf den konfigurierten Störwert Voreinstellung: 2,0 mA

Bereich: 1,0 bis 3,6 mA

Interner Nullpunkt Geht auf den mA-Ausgangswert, der
dem Wert der Prozessvariablen von 0
(Null) zugeordnet ist, wie durch die Mes-
sanfang und Messende Werte Einstellun-
gen.

Nicht zutreffend

Keine Übertragungsdaten für die zugeordnete
Prozessvariable, keine Störaktion

Nicht zutreffend
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VORSICHT!

Wenn Sie die mA-Ausgang-Störaktion oder Frequenzausgang-Störaktion auf Keine setzen, stellen Sie
sicher, dass auch Digitale Kommunikations-Störaktion auf Keine gesetzt ist. Andernfalls gibt der
Ausgang nicht die aktuellen Prozessdaten aus und dies kann Messfehler erzeugen oder
ungewollte Konsequenzen für Ihren Prozess haben.

Einschränkung
Wenn Sie die Digitale Kommunikations-Störaktion auf NAN setzen, können Sie die mA-Ausgang-Störaktion
oder Frequenzausgang-Störaktion nicht auf Keine setzen. Wenn Sie dies versuchen, akzeptiert die
Auswerteelektronik die Konfiguration nicht.

13.3 Frequenzausgang konfigurieren
Der Frequenzausgang wird zum Ausgeben einer Prozessvariablen verwendet. Die
Parameter für den Frequenzausgang steuern, wie die Prozessvariable ausgegeben wird.
Wenn Sie eine Auswerteelektronik für Abfüllanwendungen mit externer Ventilsteuerung
erworben haben, hat die Auswerteelektronik einen Frequenzausgang. Wenn Sie eine
Auswerteelektronik für Abfüllanwendungen mit integrierter Ventilregelung erworben
haben, hat die Auswerteelektronik keinen Frequenzausgang.

Die Parameter Frequenzausgang umfassen:

• Frequenzausgang Polarität
• Frequenzausgang Skaliermethode
• Frequenzausgang max. Impulsbreite
• Frequency Output Fault Action und Frequency Output Fault Value

Anmerkung
Die Frequency Output Process Variable wurde während der Konfiguration der Abfüllanwendung mit
externer Ventilregelung konfiguriert. Wenn Sie diesen Frequenzausgang ändern, ändern Sie die
Prozessvariable, die der Host zum Messen und Steuern der Abfüllanwendung verwendet.

Wichtig
Immer wenn Sie einen Parameter des Frequenzausgangs ändern, prüfen Sie alle anderen Parameter
des Frequenzausgangs, bevor Sie das Durchfluss-Messsystem wieder in Betrieb nehmen. In einigen
Situationen lädt die Auswerteelektronik automatisch einige gespeicherte Werte und es kann sein,
dass diese Werte nicht passend für Ihre Anwendung sind.

13.3.1 Frequenzausgang Polarität konfigurieren

ProLink II ProLink > Configuration > Frequency > Freq Output Polarity

ProLink III Device Tools > Configuration > I/O > Outputs > Frequency Output

Modbus Register 1197
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Überblick

Die Frequenzausgang Polarität steuert, wie der Ausgang einen Status EIN (aktiv) anzeigt. Der
voreingestellte Wert Aktiv Hoch ist für die meisten Anwendungen anwendbar. Es kann sein,
dass Aktiv Niedrig für Anwendungen mit niederfrequentem Signal benötigt wird.

Verfahren

Setzen Sie die Frequenzausgang Polarität wie gewünscht.

Die vorgegebene Einstellung ist Aktiv Hoch.

Optionen für Frequenzausgang Polarität

Optionen für Frequenzausgang PolaritätTabelle 13-5:   

Polarität Referenzspannung (AUS) Impulsspannung (ON)

Aktiv hoch 0 Bestimmt durch Spannungs-
versorgung, Pull-up-Wider-
stand und Bürde (siehe Installa-
tionsanleitung Ihrer Auswer-
teelektronik)

Aktiv niedrig Bestimmt durch Spannungs-
versorgung, Pull-up-Wider-
stand und Bürde (siehe Installa-
tionsanleitung Ihrer Auswer-
teelektronik)

0

13.3.2 Frequenzausgang Skaliermethode konfigurieren

ProLink II ProLink > Configuration > Frequency > Scaling Method

ProLink III Device Tools > Configuration > I/O > Outputs > Frequency Output

Modbus Register 1108

Überblick

Die Frequenzausgang Skaliermethode definiert das Verhältnis zwischen Ausgangsimpulsen und
Durchflusseinheiten. Setzen Sie die Frequenzausgang Skaliermethode entsprechend den
Anforderungen Ihres frequenzempfangenden Gerätes.

Verfahren

1. Setzen Sie die Frequenzausgang Skaliermethode.

Option Beschreibung

Frequenz = Durchfluss (Vor-
einstellung)

Frequenz berechnet vom Durchfluss

Impulse/Einheit Eine durch den Anwender spezifizierte Impulszahl repräsentiert
eine Durchflusseinheit
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Option Beschreibung

Einheiten/Impulse Ein Impuls repräsentiert eine durch den Anwender spezifizierte
Anzahl an Durchflusseinheiten

2. Setzen Sie zusätzlich erforderlicher Parameter.

• Wenn Sie die Frequency Output Scaling Method auf Frequency=Flow setzen, setzen Sie
den Rate Factor und Frequency Factor.

• Wenn Sie die Frequency Output Scaling Method auf Pulses/Unit setzen, definieren Sie
die Anzahl der Impulse, die eine Durchflusseinheit repräsentieren soll.

• Wenn Sie die Frequency Output Scaling Method auf Units/Pulse setzen, definieren Sie
die Einheiten, die jeder Impuls anzeigen soll.

Frequenz anhand des Durchflusses berechnen
Die Option Frequenz = Durchfluss wird verwendet, um den Frequenzausgang Ihrer
Anwendung kundenspezifisch anzupassen, wenn Sie die entsprechenden Werte für
Einheiten/Impuls oder Impulse/Einheit nicht kennen.

Wenn Sie Frequenz = Durchfluss wählen, müssen Sie die Werte für Durchflussfaktor und
Frequenzfaktor angeben:

Durchflussfaktor Der max. Durchfluss, den der Frequenzausgang ausgeben soll. Oberhalb
dieses Durchflusses gibt die Auswerteelektronik A110: Frequenzausgang
gesättigt aus.

Frequenzfaktor Ein Wert wird wie folgt berechnet:

FrequencyFactor = x NRateFactor
T

wobei:

T Faktor zum Umrechnen der gewählten Zeitbasis in Sekunden

N Anzahl der Impulse pro Durchflusseinheit gemäß Konfiguration am
empfangenden Gerät

Der resultierende Frequenzfaktor muss innerhalb des Frequenzbereichs des Ausgangs liegen
(von 0 bis 10 000 Hz).

• Ist der Frequenzfaktor kleiner als 1 Hz, konfigurieren Sie das empfangende Gerät auf
einen höheren Wert für Impulse/Einheit.

• Ist der Frequenzfaktor größer als 10.000 Hz, konfigurieren Sie das empfangende Gerät
auf einen niedrigeren Wert für Impulse/Einheit.

Hinweis
Ist die Frequenzausgang-Skaliermethode auf Frequenz = Durchfluss gesetzt und Max. Impulsbreite für
Frequenzausgang auf einen Wert ungleich Null gesetzt, empfiehlt MicroMotion die Einstellung des
Frequenzfaktors auf einen Wert kleiner als 200 Hz.

Beispiel: Frequenz = Durchfluss konfigurieren

Wenn Sie möchten, dass der Frequenzausgang alle Durchflüsse bis 2000 kg/min ausgeben
soll.

Das frequenzempfangende Gerät ist auf 10 Impulse/kg konfiguriert.
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Lösung:

FrequencyFactor = x 102000
60

333.33FrequencyFactor =

FrequencyFactor = x NRateFactor
T

Setzen Sie die Parameter wie folgt.

• Durchflussfaktor: 2000
• Frequenzfaktor: 333,33

13.3.3 Frequenzausgang max. Impulsbreite konfigurieren

ProLink II ProLink > Configuration > Frequency > Freq Pulse Width

ProLink III Device Tools > Configuration > I/O > Outputs > Frequency Output

Modbus Registers 227-228

Überblick

Die Frequenzausgang max. Impulsbreite stellt sicher, dass die Dauer des EIN Signals lang genug
ist, damit das Frequenz empfangende Gerät es erkennt.

Das EIN Signal kann die hohe Spannung sein oder 0,0 V, abhängig von der Frequenzausgang
Polarität.

Wechselwirkung von Frequenzausgang max. Impulsbreite und Frequenzausgang
Polarität

Tabelle 13-6:   

Polarität Impulsbreite

Aktiv hoch

Aktiv niedrig

Verfahren

Setzen Sie die Frequenzausgang max. Impulsbreite wie gewünscht.

Der voreingestellte Wert ist 277 ms. Sie können den Frequenzausgang max. Impulsbreite auf
0 ms oder einen Wert zwischen 0,5 ms und 277,5 ms einstellen. Die Auswerteelektronik
setzt den eingegebenen Wert automatisch auf den nächsten gültigen Wert.
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Hinweis
Micro Motion empfiehlt, den voreingestellten Wert für die Frequenzausgang max. Impulsbreite nicht zu
ändern. Wenden Sie sich an den Micro Motion Kundendienst, wenn Sie die Frequenzausgang max.
Impulsbreite ändern möchten.

13.3.4 Frequenzausgang Störaktion und Frequenzausgang Störwert
konfigurieren

ProLink II ProLink > Configuration > Frequency > Freq Fault Action

ProLink III Device Tools > Configuration > Fault Processing

Modbus Register 1107

Überblick

Frequenzausgang Störaktion steuert das Verhalten des Frequenzausgangs, wenn die
Auswerteelektronik eine interne Störbedingung erkennt.

Anmerkung
Nur für manche Fehler: Wenn Zuletzt gemessener Wert – Zeitüberschreitung auf einen Wert ungleich null
gesetzt ist, wird die Auswerteelektronik die Störaktion erst nach Ablauf der Zeitüberschreitung
implementieren.

Verfahren

1. Setzen Sie die Frequenzausgang Störaktion wie gewünscht.

Der voreingestellte Wert ist Abwärts (0 Hz).

2. Wenn Sie die Frequenzausgang Störaktion auf Aufwärts setzen, setzen Sie den
Frequenzausgang Störwert auf den gewünschten Wert.

Der voreingestellte Wert ist 15000 Hz. Der Bereich ist 10 bis 15000 Hz.

Optionen für Frequenzausgang Störaktion

Optionen für Frequenzausgang StöraktionTabelle 13-7:   

Bezeichnung Frequenzausgang Verhalten

Upscale Geht zum konfigurierten Aufwärts Wert:
• Bereich: 10 Hz bis 15000 Hz
• Standardwert: 15000 Hz

Downscale 0 Hz

Interner Nullpunkt 0 Hz

Keine (Voreinstellung) Übertragungsdaten für die zugeordnete Prozessvariable, keine
Störaktion
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VORSICHT!

Wenn Sie die mA-Ausgang-Störaktion oder Frequenzausgang-Störaktion auf Keine setzen, stellen Sie
sicher, dass auch Digitale Kommunikations-Störaktion auf Keine gesetzt ist. Andernfalls gibt der
Ausgang nicht die aktuellen Prozessdaten aus und dies kann Messfehler erzeugen oder
ungewollte Konsequenzen für Ihren Prozess haben.

Einschränkung
Wenn Sie die Digitale Kommunikations-Störaktion auf NAN setzen, können Sie die mA-Ausgang-Störaktion
oder Frequenzausgang-Störaktion nicht auf Keine setzen. Wenn Sie dies versuchen, akzeptiert die
Auswerteelektronik die Konfiguration nicht.

13.4 Konfigurieren des Binärausgangs
Der Binärausgang wird verwendet, um spezifische Durchfluss-Messsystem oder
Prozessbedingungen auszugeben. Die Parameter des Binärausgangs steuern welche
Bedingung ausgegeben wird und wie.
Je nach Kaufoption und der Konfiguration von Channel B verfügt die Auswerteelektronik
entweder über gar keinen bzw. über einen Binärausgang.

Die Parameter Binärausgang enthält:

• Binärausgang Quelle
• Binärausgang Polarität
• Binärausgang Störaktion

Anmerkung
Die präzisen Binärausgänge wurden während der Abfüllungskonfiguration konfiguriert.

Wichtig
Immer wenn Sie einen Parameter des Binärausgangs ändern, prüfen Sie alle anderen Parameter des
Binärausgangs bevor Sie das Durchfluss-Messsystem wieder in Betrieb nehmen. In einigen
Situationen lädt die Auswerteelektronik automatisch einige gespeicherte Werte und es kann sein,
dass diese Werte nicht passend für Ihre Anwendung sind.

13.4.1 Konfigurieren der Binärausgangsquelle

ProLink II ProLink > Configuration > Discrete Output > DO1 Assignment

ProLink III Device Tools > Configuration > I/O > Outputs > Discrete Output

Modbus Register 1151

Überblick

Die Discrete Output Source steuert welche Bedingung oder Prozessvariable des Durchfluss-
Messsystems über den Binärausgang ausgegeben wird.

Verfahren

Discrete Output Source auf die gewünschte Option einstellen.
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Optionen für Binärausgang Quelle

Optionen für Binärausgang QuelleTabelle 13-8:   

Option Bezeichnung ProLink II Zustand Binärausgang Spannung

Abfüllung läuft Batching/Filling in Progress Abfüllung läuft (eins-
chließlich unterbrochener
Abfüllungen)

0  V

Abfüllung beendet Anwenderspezifisch

Spülventil Discrete Batch: Purge Valve Spülventil offen Anwenderspezifisch

Spülventil geschlossen 0  V

Störung Fault Condition Indication Mindestens eine aktive Stör-
ung

Anwenderspezifisch

Keine aktiven Störungen 0  V

Wichtig
In dieser Tabelle wird davon ausgegangen, dass Binärausgang Polarität auf Aktiv Hoch eingestellt ist. Ist
die Binärausgang Polarität auf Aktiv Niedrig gesetzt, Spannungswerte umkehren.

13.4.2 Konfigurieren derPolarität des Binärausgangs

ProLink II ProLink > Configuration > Discrete Output > DO1 Polarity

ProLink III Device Tools > Configuration > I/O > Outputs > Discrete Output

Modbus Register 1152

Überblick

Binärausgänge haben zwei Zustände: EIN (aktiv) und AUS (inaktiv). Zwei unterschiedliche
Spannungswerte werden verwendet, um diese Zustände zu repräsentieren. Die Discrete
Output Polarity steuert welcher Spannungswert welchen Zustand repräsentiert.

Verfahren

Discrete Output Polarity wie gewünscht einstellen.

Die Standardeinstellung ist Active High.

Optionen für Binärausgang Polarität

Optionen für Binärausgang PolaritätTabelle 13-9:   

Polarität Beschreibung

Aktiv hoch • Wenn die festgelegte Bedingung für den
Binärausgang zutrifft, erzeugt der Pull-up
24 V.

• Wenn die festgelegte Bedingung für den
Binärausgang nicht zutrifft, erzeugt die
Schaltung 0 V.
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Optionen für Binärausgang Polarität (Fortsetzung)Tabelle 13-9:   

Polarität Beschreibung

Aktiv niedrig • Wenn die festgelegte Bedingung für den
Binärausgang zutrifft, erzeugt die Schal-
tung 0 V.

• Wenn die festgelegte Bedingung für den
Binärausgang nicht zutrifft, erzeugt der
Pull-up 24 V.

13.4.3 Konfigurieren von Binärausgang Störaktion

ProLink II ProLink > Configuration > Discrete Output > DO1 Fault Action

ProLink III Device Tools > Configuration > Fault Processing

Modbus Register 2615

Überblick

Discrete Output Fault Action steuert das Verhalten des Binärausgangs, wenn die
Auswerteelektronik eine interne Störbedingung erkennt.

Anmerkung
Nur für manche Fehler: Wenn Zuletzt gemessener Wert – Zeitüberschreitung auf einen Wert ungleich null
gesetzt ist, wird die Auswerteelektronik die Störaktion erst nach Ablauf der Zeitüberschreitung
implementieren.

VORSICHT!

Verwenden Sie Discrete Output Fault Action nicht als Störanzeige. Möglicherweise lässt sich eine
Störbedingung nicht von einem normalen Betriebszustand unterscheiden.
SieheStöranzeige mit dem Binärausgang, wenn der Binärausgang als Störindikator verwendet
werden soll.

Verfahren

Discrete Output Fault Action wie gewünscht einstellen.

Die Standardeinstellung ist None.
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Optionen für Binärausgang Störaktion

Optionen für Binärausgang Störaktion Tabelle 13-10:   

Bezeichnung

Binärausgang Verhalten

Polarität = Aktiv Hoch Polarität = Aktiv Niedrig

Upscale • Störung: Binärausgang ist EIN
(anwenderspezifische Span-
nung)

• Keine Störung: Binärausgang
wird durch seine Zuweisung
gesteuert

• Störung: Binärausgang ist AUS
(0 V)

• Keine Störung: Binärausgang
wird durch seine Zuweisung
gesteuert

Downscale • Störung: Binärausgang ist AUS
(0 V)

• Keine Störung: Binärausgang
wird durch seine Zuweisung
gesteuert

• Störung: Binärausgang ist EIN
(anwenderspezifische Span-
nung)

• Keine Störung: Binärausgang
wird durch seine Zuweisung
gesteuert

Keine (Voreinstellung) Binärausgang wird durch seine Zuweisung gesteuert

Störanzeige mit dem Binärausgang

Um Störungen über den Binärausgang anzuzeigen, setzen Sie die Parameter wie folgt:

• Binärausgang-Quelle = Störung
• Binärausgang-Störaktion = Keine

Anmerkung
Wenn Binärausgang-Quelle auf Störung gesetzt ist und eine Störung eintritt, ist der Binärausgang immer
EIN. Die Einstellung Binärausgang-Störaktion wird ignoriert.

13.5 Binäreingang konfigurieren
Der Binäreingang wird verwendet, um eine oder mehrere Aktionen der Auswerteelektronik
von einem externen Gerät aus zu veranlassen. Je nach Kaufoption und der Konfiguration
von Kanal B verfügt die Auswerteelektronik entweder über keinen oder einen
Binäreingang.

Der Parameter Binäreingang enthält:

• Binäreingang Aktion
• Polarität Binäreingang

Wichtig
Immer wenn Sie einen Parameter des Binäreingangs ändern, prüfen Sie alle anderen Parameter des
Binäreingangs bevor Sie das Durchfluss-Messsystem wieder in Betrieb nehmen. In einigen
Situationen lädt die Auswerteelektronik automatisch einige gespeicherte Werte und es kann sein,
dass diese Werte nicht passend für Ihre Anwendung sind.
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13.5.1 Binäreingang Aktion konfigurieren

ProLink II ProLink > Configuration > Discrete Input > Assignment > Reset Mass Total

ProLink > Configuration > Discrete Input > Assignment > Reset Volume Total

ProLink > Configuration > Discrete Input > Assignment > Reset All Totals

ProLink > Configuration > Discrete Input > Assignment > Begin Fill

ProLink > Configuration > Discrete Input > Assignment > End Fill

ProLink > Configuration > Discrete Input > Assignment > Pause Fill

ProLink > Configuration > Discrete Input > Assignment > Resume Fill

ProLink III Device Tools > Configuration > I/O > Action Assignment

Modbus Reset mass total: Register 1316

Reset volume total: Register 1317

Reset all totals: Register 1322

Begin filling: Register 1329

End filling: Register 1324

Pause filling: Register 1330

Resume filling: Register 1328

Überblick

Die Binäreingang Aktion steuert die Aktion oder Aktionen, die die Auswerteelektronik
ausführt wenn der Binäreingang von AUS auf EIN wechselt.

VORSICHT!

Bevor Sie Aktionen einem erweitertem Ereignis oder einem Binäreingang zuordnen, prüfen Sie
den Status des Ereignisses oder des externen Eingangsgerätes. Ist es auf EIN, werden alle
Aktionen ausgeführt, wenn die neue Kanalkonfiguration implementiert wird. Ist dies nicht
akzeptabel, warten Sie auf einen geeigneten Zeitpunkt, um Aktionen dem Ereignis oder
Binäreingang zuzuordnen.

Verfahren

1. Wählen Sie eine Aktion.

2. Wählen Sie den Binäreingang, der die ausgewählte Aktion durchführen soll.

3. Wiederholen Sie diesen Vorgang, bis alle vom Binäreingang auszuführenden
Aktionen zugeordnet sind.

Optionen für Binäreingang Aktion

Optionen für Binäreingang-Aktion oder Erweiterte EreignisaktionTabelle 13-11:   

Aktion

Kennzeichnung

ProLink II ProLink III

Keine (Voreinstellung) Keine Keine

Masse-Summenzähler zurücksetzen Reset Mass Total Reset Mass Total

Volumenzähler zurücksetzen Reset Volume Total Reset Volume Total
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Optionen für Binäreingang-Aktion oder Erweiterte Ereignisaktion (Fortsetzung)Tabelle 13-11:   

Aktion

Kennzeichnung

ProLink II ProLink III

Alle Zähler zurücksetzen Reset All Totals Reset All Totals

Befüllung beginnen Begin Fill Befüllung beginnen

Befüllung beenden End Fill Befüllung beenden

Befüllung fortsetzen Resume Fill Befüllung fortsetzen

Befüllung unterbrechen Pause Fill Befüllung unterbrechen

VORSICHT!

Bevor Sie Aktionen einem erweitertem Ereignis oder einem Binäreingang zuordnen, prüfen Sie
den Status des Ereignisses oder des externen Eingangsgerätes. Ist es auf EIN, werden alle
Aktionen ausgeführt, wenn die neue Kanalkonfiguration implementiert wird. Ist dies nicht
akzeptabel, warten Sie auf einen geeigneten Zeitpunkt, um Aktionen dem Ereignis oder
Binäreingang zuzuordnen.

13.5.2 Binäreingang Polarität konfigurieren

ProLink II ProLink > Configuration > Discrete Input > Polarity

ProLink III Device Tools > Configuration > I/O > Inputs > Discrete Input

Modbus Register 1178

Überblick

Der Binäreingang hat zwei Zustände: EIN und AUS. Die Binäreingang Polarität steuert wie die
Auswerteelektronik die eingehenden Spannungswerte dem EIN und AUS Status zuordnet.

Verfahren

Polarität Binäreingang wie gewünscht einstellen.

Die Standardeinstellung ist Aktiv Niedrig.

Optionen für Binäreingang Polarität

Optionen für Binäreingang PolaritätTabelle 13-12:   

Polarität Spannung Status Binäreingin-
gang an der Auswer-
teelektronik

Aktiv hoch Angelegte Spannung zwischen Anschluss-
klemmen ist 3–30 VDC

EIN

Angelegte Spannung zwischen Anschluss-
klemmen ist <0,8 VDC

AUS

Aktiv niedrig Angelegte Spannung zwischen Anschluss-
klemmen ist <0,8 VDC

EIN
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Optionen für Binäreingang Polarität (Fortsetzung)Tabelle 13-12:   

Polarität Spannung Status Binäreingin-
gang an der Auswer-
teelektronik

Angelegte Spannung zwischen Anschluss-
klemmen ist 3–30 VDC

AUS

13.6 Konfigurieren eines erweiterten Ereignisses

ProLink II ProLink > Configuration > Discrete Events > Event Name

ProLink > Configuration > Discrete Events > Event Type

ProLink > Configuration > Discrete Events > Process Variable

ProLink > Configuration > Discrete Events > Low Setpoint

ProLink > Configuration > Discrete Events > High Setpoint

ProLink III Device Tools > Configuration > Events > Enhanced Events

Modbus Event x (x = 0, 1, 2, 3, 4): Register 609

Event type: Register 610

Event process variable: Register 615

Event setpoint A: Registers 611-612

Event setpoint B: Registers 613-614

Überblick

Ein erweitertes Ereignis wird verwendet, um Meldungen zu Prozessänderungen zu liefern
und um spezielle Auswerteelektronik Aktionen auszuführen wenn ein Ereignis eintritt. Das
Erweiterte Ereignis tritt ein (ist EIN), wenn der Real-Time Wert einer
anwenderspezifizierten Prozessvariablen den anwenderspezifizierten Sollwert (HI)
überschreitet oder (LO) unterschreitet oder im Bereich (IN) oder ausserhalb des Bereichs
(OUT) liegt, unter Berücksichtigung zweier anwenderspezifizierten Sollwerte. Sie können
bis zu fünf Erweiterte Ereignisse konfigurieren. Für jedes Erweiterte Ereigniss können Sie
eine oder mehrere Aktionen zuordnen, die die Auswerteelektronik ausführt, wenn das
Erweiterte Ereigniss eintritt.

Verfahren

1. Das Ereignis auswählen, das konfiguriert werden soll.

2. Spezifizieren Sie die Ereignisart.

Options Description

HI x > A

Das Ereignis tritt ein, wenn der Wert der zugeordneten Prozessvariable
(x) größer als der Sollwert (Sollwert A) ist (Endpunkt nicht eingeschlossen).

LO x < A

Das Ereignis tritt ein, wenn der Wert der zugeordneten Prozessvariable
(x) kleiner als der Sollwert (Sollwert A) ist (Endpunkt nicht eingeschlossen).
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Options Description

IN A ≤ x ≤ B

Das Ereignis tritt ein, wenn der Wert der zugeordneten Prozessvariable
(x) sich innerhalb “des Bereichs befindet,” d. h. zwischen Sollwert A und
Sollwert B (Endpunkte eingeschlossen).

AUS x ≤ A oder x ≥ B

Das Ereignis tritt ein, wenn der Wert der zugeordneten Prozessvariable
(x) sich “außerhalb des Bereichs befindet,” d. h. kleiner als Sollwert A oder
größer als Sollwert B ist (Endpunkte eingeschlossen).

3. Prozessvariable dem Ereignis zuordnen.

4. Setzen Sie die Werte für die erforderlichen Sollwerte.

• Bei HI- und LO-Ereignissen Sollwert A festlegen.

• Bei IN- und OUT-Ereignissen Sollwert A und Sollwert B festlegen.

5. (Optional) Einen Binärausgang konfigurieren, um den Status entsprechend dem
Ereignisstatus zu wechseln.

6. (Optional) Spezifizieren Sie die Aktion oder Aktionen die die Auswerteelektronik
ausführen soll, wenn das Ereignis eintritt.

• Mit ProLink II: ProLink > Configuration > Discrete Input
• Mit ProLink III:Device Tools > Configuration > I/O > Action Assignment
• Mit Modbus: Register 609, 1316, 1317, 1322, 1324 und 1328–1330.

13.6.1 Optionen für Erweitertes Ereignisaktion

Optionen für Binäreingang-Aktion oder Erweiterte EreignisaktionTabelle 13-13:   

Aktion

Kennzeichnung

ProLink II ProLink III

Keine (Voreinstellung) Keine Keine

Masse-Summenzähler zurücksetzen Reset Mass Total Reset Mass Total

Volumenzähler zurücksetzen Reset Volume Total Reset Volume Total

Alle Zähler zurücksetzen Reset All Totals Reset All Totals

Befüllung beginnen Begin Fill Befüllung beginnen

Befüllung beenden End Fill Befüllung beenden

Befüllung fortsetzen Resume Fill Befüllung fortsetzen

Befüllung unterbrechen Pause Fill Befüllung unterbrechen

VORSICHT!

Bevor Sie Aktionen einem erweitertem Ereignis oder einem Binäreingang zuordnen, prüfen Sie
den Status des Ereignisses oder des externen Eingangsgerätes. Ist es auf EIN, werden alle
Aktionen ausgeführt, wenn die neue Kanalkonfiguration implementiert wird. Ist dies nicht
akzeptabel, warten Sie auf einen geeigneten Zeitpunkt, um Aktionen dem Ereignis oder
Binäreingang zuzuordnen.
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13.7 Konfigurieren der digitalen Kommunikation
Die Parameter der digitalen Kommunikation steuern die digitale Kommunikation der
Auswerteelektronik.

Die Auswerteelektronik unterstützt die folgenden Typen digitaler Kommunikation:

• Modbus/RS-485 über die RS-485 Anschlussklemmen

• Modbus RTU über Service Port

Anmerkung
Der Service Port reagiert automatisch auf eine Vielzahl von Anschlussanfragen. Er ist nicht
konfigurierbar.

13.7.1 Modbus/RS-485 Kommunikation konfigurieren

ProLink II ProLink > Configuration > Digital Comm Settings > Modbus Address

ProLink > Configuration > Device > Floating Pt Ordering

ProLink > Configuration > Device > Add Comm Resp Delay

ProLink III Device Tools > Configuration > Communications > RS-485 Terminals

Modbus Modbus address: Register 313

Floating-point byte order: Register 521

Additional communications response delay: Register 522

Überblick

Die Modbus/RS-485 Kommunikationsparameter steuern die Modbus Kommunikation
mittels der RS-485 Anschlussklemmen der Auswerteelektronik.

Modbus/RS-485 Kommunikationsparameters umfassen:

• Modbus Adresse (Slave Adresse)

• Fließkomma Byte Befehl
• Zusätzliche Kommunikations-Antwortverzögerung

Einschränkung
Um den Fließkomma Byte Befehl oder die Zusätzliche Kommunikations-Antwortverzögerung zu konfigurieren,
müssen Sie ProLink II verwenden.

Verfahren

1. Setzen Sie Modbus Adresse auf einen Wert, der auf dem Netzwerk eindeutig ist.

2. Setzen Sie den Fließkomma Byte Befehl entsprechend dem Byte Befehl den Ihr Modbus
Host verwendet.

Code Byte Reihenfolge

0 1–2    3–4

1 3–4    1–2

2 2–1    4–3
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Code Byte Reihenfolge

3 4–3    2–1

Die Bit Struktur der Bytes 1, 2, 3 und 4 ist in Tabelle 13-14 dargestellt.

Bit Struktur der Fließkomma BytesTabelle 13-14:   

Byte Bits Definition

1 SEEEEEEE S = Vorzeichen

E = Exponent

2 EMMMMMMM E = Exponent

M = Mantisse

3 MMMMMMMM M = Mantisse

4 MMMMMMMM M = Mantisse

3. (Optional) Setzen Sie die Zusätzliche Kommunikations-Antwortverzögerung in den
“Verzögerungseinheiten.”

Eine Verzögerungseinheit ist 2/3 der Zeit, die erforderlich ist, um ein Zeichen zu
übertragen, wie für den aktuell verwendeten Port berechnet und der Zeichen
Übertragungsparameter. Gültiger Wertebereich von 1 bis 255.

Die Zusätzliche Kommunikations-Antwortverzögerung wird dazu verwendet, um die Modbus
Kommunikation mit dem Host zu synchronisieren, wenn dieser langsamer arbeitet
als die Auswerteelektronik. Der hier spezifizierte Wert wird jeder Antwort
hinzuaddiert, die die Auswerteelektronik an den Host sendet.

Hinweis
Setzen Sie die Zusätzliche Kommunikations-Antwortverzögerung nicht, wenn dies nicht durch Ihren
Modbus Host erforderlich ist.

13.7.2 Digitale Kommunikation Störaktion konfigurieren

ProLink II ProLink > Configuration > Digital Comm Settings > Digital Comm Fault Setting

ProLink III Device Tools > Configuration > Fault Processing

Modbus Register 124

Überblick

Die Digital Communications Fault Action spezifiziert den Wert der mittels digitaler
Kommunikation ausgegeben wird, wenn die Auswerteelektronik eine interne
Störbedingung erkennt.

Verfahren

Digital Communications Fault Action wie gewünscht einstellen.

Die Standardeinstellung ist Keine.
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Optionen für Digitale Kommunikation Störaktion

Optionen für Digitale Kommunikation StöraktionTabelle 13-15:   

Bezeichnung

BeschreibungProLink II ProLink III

Upscale • Die Prozessvariablenwerte zeigen, dass der Wert höher
als der obere Sensorgrenzwert ist.

• Zählerfortschaltung stoppen.

Downscale • Die Prozessvariablenwerte zeigen, dass der Wert höher
als der obere Sensorgrenzwert ist.

• Zählerfortschaltung stoppen.

Nullpunkt • Durchflussvariablen gehen auf einen Wert, der einen
Durchfluss von 0 darstellt.

• Dichte wird als 0 ausgegeben.
• Temperatur wird als 0 °C ausgegeben oder aquivalent,

wenn andere Einheiten verwendet werden (z. B. 32 °F).
• Antriebsverstärkung wird wie gemessen ausgegeben.
• Zählerfortschaltung stoppen.

Not-A-Number (NAN) • Prozessvariablen werden als IEEE NAN ausgegeben.
• Antriebsverstärkung wird wie gemessen ausgegeben.
• Modbus skalierte Integer werden als Max Int ausgege-

ben.
• Zählerfortschaltung stoppen.

Durchfluss auf Null • Durchflüsse werden als 0 ausgegeben.
• Andere Prozessvariablen werden wie gemessen ausge-

geben.
• Zählerfortschaltung stoppen.

Keine (Voreinstellung) • Alle Prozessvariablen werden wie gemessen ausgege-
ben.

• Zählerfortschaltung wenn sie laufen.

VORSICHT!

Wenn Sie die mA-Ausgang-Störaktion oder Frequenzausgang-Störaktion auf Keine setzen, stellen Sie
sicher, dass auch Digitale Kommunikations-Störaktion auf Keine gesetzt ist. Andernfalls gibt der
Ausgang nicht die aktuellen Prozessdaten aus und dies kann Messfehler erzeugen oder
ungewollte Konsequenzen für Ihren Prozess haben.

Einschränkung
Wenn Sie die Digitale Kommunikations-Störaktion auf NAN setzen, können Sie die mA-Ausgang-Störaktion
oder Frequenzausgang-Störaktion nicht auf Keine setzen. Wenn Sie dies versuchen, akzeptiert die
Auswerteelektronik die Konfiguration nicht.

Integrieren des Messgerätes mit dem Netzwerk
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Teil V
Geschäftstätigkeit, Wartung sowie
Fehlersuche und -beseitigung

In diesem Teil enthaltene Kapitel:

• Auswerteelektronikbetrieb

• Messunterstützung

• Störungsanalyse und -behebung

Geschäftstätigkeit, Wartung sowie Fehlersuche und -beseitigung
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14 Auswerteelektronikbetrieb
In diesem Kapitel behandelte Themen:

• Notieren der Prozessvariablen

• Anzeigen von Prozessvariablen

• Anzeigen und Bestätigen von Statusalarmen

• Lesen von Gesamt- und Summenzählerwerten

• Starten und Stoppen von Gesamt- und Summenzählern

• Zähler zurücksetzen

• Gesamtzähler zurücksetzen

14.1 Notieren der Prozessvariablen
Micro Motion empfiehlt die Aufzeichnung von speziellen Messungen von Prozessvariablen
einschließlich des akzeptablen Messbereiches unter normalen Betriebsbedingungen. Mit
diesen Daten können Sie leichter erkennen, wann Prozessvariablenwerte ungewöhnlich
hoch oder niedrig sind, und sie können Ihnen dabei helfen, Anwendungsprobleme besser
zu diagnostizieren und zu lösen.

Verfahren

Notieren Sie die folgenden Prozessvariablen unter normalen Betriebsbedingungen:

Prozessvariable

Messung

Typischer Durchschnitt Typisch hoch Typisch niedrig

Durchfluss

Dichte

Temperatur

Messrohrfrequenz

Aufnehmerspannung

Antriebsverstärkung

Auswerteelektronikbetrieb
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14.2 Anzeigen von Prozessvariablen

ProLink II ProLink > Process Variables

ProLink III Die gewünschte Variable kann auf dem Hauptbildschirm unter Process Variables ange-

zeigt werden. Weitere Informationen finden Sie in Abschnitt 14.2.1.

Modbus Mass flow rate: Registers 247-248

Volume flow rate: Registers 253-254

Density: Registers 249-250

Temperature: Registers 251-252

Tube frequency: Registers 285-286

Left pickoff voltage: Registers 287-288

Right pickoff voltage: Registers 289-290

Drive gain: Registers 291-292

Überblick

Prozessvariablen liefern Informationen über den Zustand des Prozessmediums, wie
Strömungsgeschwindigkeit, Dichte und Temperatur sowie über aktuelle Summen.
Prozessvariablen können außerdem Daten über den Betrieb des Durchflussmessgeräts
bereitstellen, wie Antriebsverstärkung und Aufnehmerspannung. Diese Informationen
können zum besseren Verständnis des Prozesses und zur Störungssuche und -beseitigung
verwendet werden.

14.2.1 Anzeigen von Prozessvariablen mittels ProLink III
Sobald eine Verbindung zu einem Gerät hergestellt ist, werden die Prozessvariablen auf
dem Hauptbildschirm von ProLink III angezeigt.

Verfahren

Zeigen Sie die gewünschte(n) Prozessvariable(n) an.

Hinweis
ProLink III ermöglicht Ihnen das Auswählen der Prozessvariablen, die auf dem Hauptbildschirm
angezeigt werden sollen. Außerdem können Sie wählen, ob die Daten in der Ansicht Analog Gauge
oder als Digitalanzeige angezeigt werden sollen, und Sie können die Anzeigeeinstellungen anpassen.
Weitere Informationen finden Sie in der ProLink III Betriebsanleitung.

14.3 Anzeigen und Bestätigen von Statusalarmen
Die Auswerteelektronik gibt einen Statusalarm aus, sobald eine Prozessvariable die
definierten Grenzen überschreitet oder die Auswerteelektronik eine Störung erkennt.
Aktive Alarme können angezeigt und Alarme bestätigt werden.

14.3.1 Anzeigen und Bestätigen von Alarmen mittels ProLink II
Sie können eine Liste mit allen aktiven oder inaktiven aber unbestätigten Alarmen
anzeigen.

Auswerteelektronikbetrieb
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1. Wählen Sie ProLink > Alarm Log.

2. Wählen Sie den Bereich High Priority oder Low Priority.

Anmerkung
Das Gruppieren von Alarmen in diese beiden Kategorien ist fest programmiert und wird durch
Status Alarm Severity nicht beeinflusst.

Alle aktiven oder nicht bestätigten Alarme sind aufgeführt:

• Rote Anzeige: Alarm ist derzeit aktiv.

• Grüne Anzeige: Alarm ist nicht aktiv, aber nicht bestätigt.

Anmerkung
Es werden nur Störungs- und informative Alarme aufgeführt. Alarme mit Status Alarmstufe
Ignorieren werden von der Auswerteelektronik automatisch herausgefiltert.

3. Markieren Sie das Kontrollkästchen Ack, um einen Alarm zu bestätigen.

Nachbereitungsverfahren

• Um die folgenden Alarme zu löschen, müssen Sie das Problem beheben, den Alarm
bestätigen und anschließend die Auswerteelektronik aus- und wieder einschalten:
A001, A002, A010, A011, A012, A013, A018, A019, A022, A023, A024, A025, A028,
A029, A031.

• Für alle anderen Alarme:

- War der Alarm bei der Bestätigung inaktiv, wird er aus der Liste gelöscht.

- War der Alarm bei der Bestätigung aktiv, wird er von der Liste entfernt, sobald
die Alarmbedingung gelöscht ist.

14.3.2 Anzeigen und Bestätigen von Alarmen mittels ProLink III
Sie können eine Liste mit allen aktiven, inaktiven oder unbestätigten Alarmen anzeigen.
Bestimmte Alarme können in der Liste bestätigt oder alle Alarme als bestätigt ausgewählt
werden.

1. Alle Alarme können im ProLink III Hauptbildschirm unter Alerts angezeigt werden.

Alle aktiven oder unbestätigten Alarme werden aufgeführt und entsprechend den
folgenden Kategorien angezeigt:

Kategorie Beschreibung

Failed: Fix Now Ein Messgerätefehler ist aufgetreten und erfordert unverzügliche
Maßnahmen.

Maintenance: Fix Soon Ein Zustand ist aufgetreten, der zu einem späteren Zeitpunkt beho-
ben werden kann.

Advisory: Informational Ein Zustand ist aufgetreten, der kein Eingreifen erfordert.

Anmerkungen

• Alle Fehleralarme werden in der Kategorie Failed: Fix Now angezeigt.

• Alle Informationsalarme werden entweder in der Kategorie Maintenance: Fix Soon oder
Advisory: Informational angezeigt. Die Kategoriezuweisung ist fest programmiert.

Auswerteelektronikbetrieb
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• Alarme mit Alert Severity Ignore werden von der Auswerteelektronik automatisch
herausgefiltert.

2. Markieren Sie das Kontrollkästchen Ack für einen bestimmten Alarm, um diesen zu
bestätigen. Klicken Sie auf Ack All, um alle Alarme auf einmal zu bestätigen.

Nachbereitungsverfahren

• Um die folgenden Alarme zu löschen, müssen Sie das Problem beheben, den Alarm
bestätigen und anschließend die Auswerteelektronik aus- und wieder einschalten:
A001, A002, A010, A011, A012, A013, A018, A019, A022, A023, A024, A025, A028,
A029, A031.

• Für alle anderen Alarme:

- War der Alarm bei der Bestätigung inaktiv, wird er aus der Liste gelöscht.

- War der Alarm bei der Bestätigung aktiv, wird er von der Liste entfernt, sobald
die Alarmbedingung gelöscht ist.

14.3.3 Prüfen des Alarmstatus und Bestätigen von Alarmen
mittels Modbus
Sie können den Status eines einzelnen Alarms überprüfen und den jeweiligen Alarm
bestätigen. Sie können auch alle aktiven Alarme bestätigen und weitere detaillierte
Informationen über diese abrufen.

Vorbereitungsverfahren

Auf dem PC muss das Modbus Interface Tool (MIT) installiert sein.

Verfahren

• So prüfen Sie den Status eines einzelnen Alarms:

1. Den Alarmindex in Register 1237 schreiben.

2. Die gewünschten Alarmstatusregister lesen: 1239, 1241-1242, 1243-1244,
1247-1248, 1249-1250, 1240, 1245, 1246.

• So bestätigen Sie einen einzelnen Alarm:

1. Den Alarmindex in Register 1237 schreiben.

2. 0 in Bit Nr. 1 von Register 1239 schreiben.

• 1 in Spule 241 schreiben, um alle Alarme zu bestätigen.

• Die Diagnosespulen und Register lesen, um weitere detaillierte Alarminformationen
zu erhalten.

14.3.4 Alarmdaten im Auswerteelektronik-Speicher
Die Auswerteelektronik speichert drei Datensets für jeden Alarm.

Für jedes Alarmvorkommen werden die folgenden drei Datensets im Auswerteelektronik-
Speicher gepflegt:

• Alarmliste

• Alarmstatistik

Auswerteelektronikbetrieb
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• Neueste Alarme

Alarmdaten im Auswerteelektronik-SpeicherTabelle 14-1:   

Alarmdatenstruktur

Auswerteelektronik-Aktion bei Eintreten der Bedingung

Inhalt Löschen

Alarmliste Je nach Bestimmung durch die Alarmstatus-
bits; eine Liste mit:
• Allen derzeit aktiven Alarmen
• Allen zuvor aktiven Alarmen, die noch

nicht bestätigt wurden

Bei jedem Aus-/Einschalten der Spannungsver-
sorgung zur Auswerteelektronik gelöscht und
neu generiert

Alarmstatistik Ein Datensatz für jeden Alarm (nach Alarm-
nummer), der seit der letzten Hauptrückset-
zung gesetzt wurde. Jeder Eintrag enthält:
• Eine Zählung der Vorkommen
• Zeitstempel für die neuesten gesetzten

und gelöschten Alarme

Nicht gelöscht; gespeichert auch nach Aus-/
Einschalten der Auswerteelektronik

Neueste Alarme 50 zuletzt gesetzte oder gelöschte Alarme Nicht gelöscht; gespeichert auch nach Aus-/
Einschalten der Auswerteelektronik

14.4 Lesen von Gesamt- und Summenzählerwerten

ProLink II ProLink > Totalizer Control

Modbus Mass totalizer: Register 8

Volume totalizer: Register 9

Mass inventory: Register 10

Volume inventory: Register 11

Überblick

Gesamtzähler erfassen die von der Auswerteelektronik seit der letzten
Gesamtzählerrücksetzung gemessene Masse und das Volumen. Summenzähler erfassen
die von der Auswerteelektronik seit der letzten Summenzählerrücksetzung gemessene
Masse und das Volumen.

Hinweis
Die Summenzähler können als laufende Summe von Masse und Volumen über mehrere
Gesamtzählerrücksetzungen verwendet werden.

Auswerteelektronikbetrieb
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14.5 Starten und Stoppen von Gesamt- und
Summenzählern

ProLink II ProLink > Totalizer Control > Start

ProLink > Totalizer Control > Stop

Modbus Coil 2

Überblick

Durch Starten eines Gesamtzählers werden Prozessmessungen überwacht. In einer
typischen Anwendung erhöht sich der Wert mit dem Durchfluss. Durch Stoppen eines
Gesamtzählers wird die Überwachung der Prozessmessungen gestoppt und sein Wert wird
nicht mehr durch den Durchfluss beeinflusst. Summenzähler werden durch Starten und
Stoppen der Gesamtzähler automatisch gestartet und gestoppt.

Wichtig
Gesamt- und Summenzähler werden stets als Gruppe gestartet oder gestoppt. Wenn ein
Gesamtzähler gestartet wird, werden gleichzeitig auch alle anderen Gesamt- und Summenzähler
gestartet. Wenn ein Gesamtzähler gestoppt wird, werden gleichzeitig auch alle anderen Gesamt-
und Summenzähler gestoppt. Summenzähler können nicht direkt gestartet oder gestoppt werden.

14.6 Zähler zurücksetzen

ProLink II ProLink > Totalizer Control > Reset Mass Total

ProLink > Totalizer Control > Reset Volume Total

ProLink > Totalizer Control > Reset All Totals

Modbus Reset mass totalizer: Coil 56

Reset volume totalizer: Coil 57

Reset all totalizers: Coil 3

Überblick

Wenn der Zähler zurückgesetzt wird, setzt die Auswerteelektronik seinen Wert auf 0.
Hierbei spielt es keine Rolle, ob der Zähler gestartet oder gestoppt wurde. Wenn der
Zähler gestartet wurde, wird die Überwachung der Prozessmessung fortgeführt.

Hinweis
Wenn ein einzelner Zähler zurückgesetzt wird, werden die Werte der anderen Zähler nicht
zurückgesetzt. Gesamtzählerwerte werden nicht zurückgesetzt.

Auswerteelektronikbetrieb
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14.7 Gesamtzähler zurücksetzen

ProLink II ProLink > Totalizer Control > Reset Inventories

ProLink > Totalizer Control > Reset Mass Inventory

ProLink > Totalizer Control > Reset Volume Inventory

ProLink III Device Tools > Totalizer Control > Totalizer and Inventories > Reset Mass Inventory

Device Tools > Totalizer Control > Totalizer and Inventories > Reset Volume Inventory

Device Tools > Totalizer Control > Totalizer and Inventories > Reset Gas Inventory

Device Tools > Totalizer Control > Totalizer and Inventories > Reset All Inventories

Modbus Reset mass inventory: Coil 192

Reset volume inventory: Coil 193

Reset all inventories: Coil 4

Überblick

Wenn Sie einen Gesamtzähler zurücksetzen, setzt die Auswerteelektronik den Wert auf 0.
Dabei spielt es keine Rolle, ob der Gesamtzähler gestartet oder gestoppt wurde. Wenn der
Gesamtzähler gestartet wurde, wird die Verfolgung der Prozessmessung fortgesetzt.

Hinweis
Wenn Sie einen einzelnen Gesamtzähler zurücksetzen, werden die Werte der anderen Gesamtzähler
nicht zurückgesetzt. Die Werte der Summenzähler werden nicht zurückgesetzt.

Vorbereitungsverfahren

Wenn Sie ProLink II oder ProLink III zum Zurücksetzen der Gesamtzähler verwenden
möchten, muss diese Funktion aktiviert sein.

• So aktivieren Sie das Zurücksetzen von Gesamtzählern in ProLink II:

1. Klicken Sie auf View > Preferences.

2. Markieren Sie das Kontrollfeld Enable Inventory Totals Reset.
3. Klicken Sie auf Apply.

• So aktivieren Sie das Zurücksetzen von Gesamtzählern in ProLink III:

1. Wählen Sie Tools > Options.

2. Wählen Sie Reset Inventories from ProLink III.

Auswerteelektronikbetrieb
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15 Messunterstützung
In diesem Kapitel behandelte Themen:

• Nullpunktkalibrierung des Durchflussmesssystems

• Messsystem validieren

• (Standard) D1 und D2 Dichtekalibrierung durchführen

• Durchführen einer Temperaturkalibrierung

15.1 Nullpunktkalibrierung des
Durchflussmesssystems
Die Nullpunktkalibrierung des Durchflussmesssystems etabliert einen Basiswert für die
Prozessmessung, indem der Sensorausgang analysiert wird, wenn kein Durchfluss im
Messrohr vorhanden ist.

Wichtig
In den meisten Fällen ist die werksseitige Nullpunktkalibrierung genauer als die im Feld. Kalibrieren
Sie den Nullpunkt des Durchflussmesssystems nicht, es sei denn:

• Anlagenverfahren erfordern eine Nullpunktkalibrierung.

• Der gespeicherte Nullpunktwert besteht das Nullpunktverifizierungsverfahren nicht.

15.1.1 Nullpunktkalibrierung des Durchflussmesssystems
mittels ProLink II
Die Nullpunktkalibrierung des Durchflussmesssystems etabliert einen Basiswert für die
Prozessmessung, indem der Sensorausgang analysiert wird, wenn kein Durchfluss im
Messrohr vorhanden ist.

Vorbereitungsverfahren

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Vorbereiten des Durchflussmesssystems:

a. Lassen Sie das Durchflussmesssystem nach dem Einschalten mindestens
20 Minuten aufwärmen.

b. Lassen Sie das Prozessmedium durch den Sensor strömen, bis die
Sensortemperatur ungefähr die normale Betriebstemperatur erreicht hat.

c. Stoppen Sie den Durchfluss durch den Sensor, indem Sie das in Flussrichtung
abwärts liegende Ventil und danach das in Flussrichtung aufwärts liegende Ventil
schließen (falls verfügbar).

d. Stellen Sie sicher, dass der Sensor abgesperrt ist, kein Durchfluss mehr
vorhanden ist und der Sensor vollständig mit dem Prozessmedium gefüllt ist.

Messunterstützung
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e. Beobachten Sie die Werte für Antriebsverstärkung, Temperatur und Dichte. Sind
diese stabil, prüfen Sie den Wert Live Zero oder Field Verification Zero. Wenn der
Mittelwert nahe bei 0 liegt, muss der Nullpunkt des Durchflussmesssystems
nicht kalibriert werden.

2. Wählen Sie ProLink > Calibration > Zero Verification and Calibration.

3. Klicken Sie auf Calibrate Zero.

4. Ändern Sie Zero Time falls gewünscht.

Unter Zero Time versteht man die Zeit, die der Auswerteelektronik vorgegeben wird,
um den Referenzpunkt bei einem Durchfluss von Null zu bestimmen. Die
voreingestellte Zero Time beträgt 20 Sekunden. Für die meisten Anwendungen ist die
voreingestellte Zero Time ausreichend.

5. Klicken Sie auf Perform Auto Zero.

Die Anzeige Calibration in Progress leuchtet während der Nullpunktkalibrierung rot.
Am Ende des Verfahrens:

• Wenn die Nullpunktkalibrierung erfolgreich war, leuchtet die Anzeige Calibration
in Progress wieder grün und ein neuer Nullpunktwert wird angezeigt.

• Wenn die Kalibrierung fehlgeschlagen ist, leuchtet die Anzeige Calibration Failure
rot.

Nachbereitungsverfahren

Öffnen Sie die Ventile, um den normalen Durchfluss durch den Sensor wieder herzustellen.

Benötigen Sie Hilfe?  Wenn die Nullpunktkalibrierung fehlschlägt:

• Stellen Sie sicher, dass kein Durchfluss durch den Sensor erfolgt und wiederholen Sie das
Verfahren.

• Entfernen oder reduzieren Sie elektromagnetisches Rauschen und wiederholen Sie das
Verfahren.

• Setzen Sie Zero Time auf einen niedrigeren Wert und wiederholen Sie das Verfahren.

• Sollte eine Nullpunktkalibrierung weiterhin nicht möglich sein, wenden Sie sich an
Micro Motion.

• Wenn das Durchflussmesssystem mit einem zuvor verwendeten Nullpunktwert wieder in
Betrieb genommen werden soll:

- Wiederherstellen des werksseitig eingestellten Nullpunktwertes: ProLink > Zero Verification
and Calibration > Calibrate Zero > Restore Factory Zero .

- Wiederherstellen des zuletzt gültigen Nullpunktwertes vom Speicher der
Auswerteelektronik: ProLink > Zero Verification and Calibration > Calibrate Zero > Restore Prior
Zero . Restore Prior Zero ist nur dann verfügbar, wenn das Fenster Flow Calibration angezeigt
wird. Wenn das Fenster Flow Calibration geschlossen wird, kann der vorige Nullpunktwert
nicht mehr wiederhergestellt werden.

Einschränkung
Den werksseitigen Nullpunkt nur dann wiederherstellen, wenn das Durchflussmesssystem als eine
Einheit erworben wurde, der Nullpunkt im Werk kalibriert wurde und die Originalteile verwendet
werden.
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15.1.2 Nullpunktkalibrierung des Durchflussmesssystems
mittels ProLink III
Die Nullpunktkalibrierung des Durchflussmesssystems etabliert einen Basiswert für die
Prozessmessung, indem der Sensorausgang analysiert wird, wenn kein Durchfluss im
Messrohr vorhanden ist.

Vorbereitungsverfahren

ProLink III muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Vorbereiten des Durchflussmesssystems:

a. Lassen Sie das Durchflussmesssystem nach dem Einschalten mindestens
20 Minuten aufwärmen.

b. Lassen Sie das Prozessmedium durch den Sensor strömen, bis die
Sensortemperatur ungefähr die normale Betriebstemperatur erreicht hat.

c. Stoppen Sie den Durchfluss durch den Sensor, indem Sie das in Flussrichtung
abwärts liegende Ventil und danach das in Flussrichtung aufwärts liegende Ventil
schließen (falls verfügbar).

d. Stellen Sie sicher, dass der Sensor abgesperrt ist, kein Durchfluss mehr
vorhanden ist und der Sensor vollständig mit dem Prozessmedium gefüllt ist.

e. Beobachten Sie die Werte für Antriebsverstärkung, Temperatur und Dichte. Sind
diese stabil, prüfen Sie den Wert Live Zero oder Field Verification Zero. Wenn der
Mittelwert nahe bei 0 liegt, muss der Nullpunkt des Durchflussmesssystems
nicht kalibriert werden.

2. Wählen Sie Device Tools > Calibration > Zero Verification and Calibration.

3. Klicken Sie auf Calibrate Zero.

4. Ändern Sie Zero Time falls gewünscht.

Unter Zero Time versteht man die Zeit, die der Auswerteelektronik vorgegeben wird,
um den Referenzpunkt bei einem Durchfluss von Null zu bestimmen. Die
voreingestellte Zero Time beträgt 20 Sekunden. Für die meisten Anwendungen ist die
voreingestellte Zero Time ausreichend.

5. Klicken Sie auf Calibrate Zero.

Die Meldung Calibration in Progress wird angezeigt. Wenn die Kalibrierung
abgeschlossen ist:

• Wenn die Nullpunktkalibrierung erfolgreich war, wird die Meldung Calibration
Success angezeigt und ein neuer Nullpunktwert wird angezeigt.

• Wenn die Nullpunktkalibrierung fehlgeschlagen ist, wird die Meldung Calibration
Failed angezeigt.

Nachbereitungsverfahren

Öffnen Sie die Ventile, um den normalen Durchfluss durch den Sensor wieder herzustellen.

Benötigen Sie Hilfe?  Wenn die Nullpunktkalibrierung fehlschlägt:

• Stellen Sie sicher, dass kein Durchfluss durch den Sensor erfolgt und wiederholen Sie das
Verfahren.
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• Entfernen oder reduzieren Sie elektromagnetisches Rauschen und wiederholen Sie das
Verfahren.

• Setzen Sie Zero Time auf einen niedrigeren Wert und wiederholen Sie das Verfahren.

• Sollte eine Nullpunktkalibrierung weiterhin nicht möglich sein, wenden Sie sich an
Micro Motion.

• Wenn das Durchflussmesssystem mit einem zuvor verwendeten Nullpunktwert wieder in
Betrieb genommen werden soll:

- Wiederherstellen des werksseitig eingestellten Nullpunktwertes: Device Tools > Zero
Verification and Calibration > Calibrate Zero > Restore Factory Zero .

- Wiederherstellen des zuletzt gültigen Nullpunktwertes vom Speicher der
Auswerteelektronik: Device Tools > Zero Verification and Calibration > Calibrate Zero > Restore Prior
Zero . Restore Prior Zero ist nur dann verfügbar, wenn das Fenster Flow Calibration angezeigt
wird. Wenn das Fenster Flow Calibration geschlossen wird, kann der vorige Nullpunktwert
nicht mehr wiederhergestellt werden.

Einschränkung
Den werksseitigen Nullpunkt nur dann wiederherstellen, wenn das Durchflussmesssystem als eine
Einheit erworben wurde, der Nullpunkt im Werk kalibriert wurde und die Originalteile verwendet
werden.

15.1.3 Nullpunktkalibrierung des Durchflussmesssystems
mittels Modbus
Die Nullpunktkalibrierung des Durchflussmesssystems etabliert einen Basiswert für die
Prozessmessung, indem der Sensorausgang analysiert wird, wenn kein Durchfluss im
Messrohr vorhanden ist.

Vorbereitungsverfahren

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Wichtig
In vielen Fällen wurde der Nullpunkt des Durchflussmesssystems bereits im Werk kalibriert und
erfordert deshalb keine erneute Kalibrierung vor Ort.

Anmerkung
Verifizieren bzw. kalibrieren Sie den Nullpunkt nicht, wenn ein Alarm mit hoher Priorität aktiv ist. Das
Problem muss erst behoben werden, bevor der Nullpunkt des Durchflussmesssystems verifiziert
bzw. kalibriert wird. Sie können den Nullpunkt verifizieren bzw. kalibrieren, wenn ein Alarm mit
niedriger Priorität aktiv ist.

Verfahren

1. Vorbereiten des Durchflussmesssystems:

a. Lassen Sie das Durchflussmesssystem nach dem Einschalten mindestens
20 Minuten aufwärmen.

b. Lassen Sie das Prozessmedium durch den Sensor strömen, bis die
Sensortemperatur ungefähr die normale Betriebstemperatur erreicht hat.
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c. Stoppen Sie den Durchfluss durch den Sensor, indem Sie das in Flussrichtung
abwärts liegende Ventil und danach das in Flussrichtung aufwärts liegende Ventil
schließen (falls verfügbar).

d. Stellen Sie sicher, dass der Sensor abgesperrt ist, kein Durchfluss mehr
vorhanden ist und der Sensor vollständig mit dem Prozessmedium gefüllt ist.

e. Beobachten Sie die Werte für Antriebsverstärkung, Temperatur und Dichte. Sind
diese stabil, prüfen Sie den Wert Live Zero oder Field Verification Zero. Wenn der
Mittelwert nahe bei 0 liegt, muss der Nullpunkt des Durchflussmesssystems
nicht kalibriert werden.

2. Die gewünschte Zero Time in Register 136 schreiben.

Unter Zero Time versteht man die Zeit, die der Auswerteelektronik vorgegeben wird,
um den Referenzpunkt bei einem Durchfluss von Null zu bestimmen. Die
voreingestellte Zero Time beträgt 20 Sekunden. Für die meisten Anwendungen ist die
voreingestellte Zero Time ausreichend.

3. 1 in Spule 5 schreiben.

4. Spule 68 lesen, um die Nullpunktkalibrierung zu überwachen.

Wert Beschreibung

0 Nullpunktkalibrierung abgeschlossen

1 Nullpunktkalibrierung läuft

5. Spule 26 für Ergebnis der Nullpunktkalibrierung lesen.

Wert Beschreibung

0 Nullpunktkalibrierung erfolgreich

1 Nullpunktkalibrierung fehlgeschlagen

Nachbereitungsverfahren

Öffnen Sie die Ventile, um den normalen Durchfluss durch den Sensor wieder herzustellen.

Benötigen Sie Hilfe?  Wenn die Nullpunktkalibrierung fehlschlägt:

• Stellen Sie sicher, dass kein Durchfluss durch den Sensor erfolgt und wiederholen Sie das
Verfahren.

• Entfernen oder reduzieren Sie elektromagnetisches Rauschen und wiederholen Sie das
Verfahren.

• Setzen Sie Zero Time auf einen niedrigeren Wert und wiederholen Sie das Verfahren.

• Sollte eine Nullpunktkalibrierung weiterhin nicht möglich sein, wenden Sie sich an
Micro Motion.

• Wenn das Durchflussmesssystem mit einem zuvor verwendeten Nullpunktwert wieder in
Betrieb genommen werden soll:

- Wiederherstellen des werksseitig eingestellten Nullpunktwertes: 1 in Spule 243
schreiben.
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15.2 Messsystem validieren

ProLink II ProLink > Configuration > Flow

ProLink III Device Tools > Configuration > Process Measurement > Flow

Device Tools > Configuration > Process Measurement > Density

Modbus Massefaktor: Register 279-280

Volumenfaktor: Register 281-282

Dichtefaktor: Register 283-284

Überblick

Die Systemvalidierung vergleicht die von der Auswerteelektronik ausgegebenen
Messwerte des Durchflussmessgeräts mit einem externen Messnormal. Weicht der von
der Auswerteelektronik ausgegebene Massdurchfluss-, Volumendurchfluss- oder
Dichtemesswert signifikant vom externen Messnormal ab, sollte der entsprechende
Gerätefaktor gesetzt werden. Der tatsächliche Messwert des Durchflussmessgeräts wird
mit dem Gerätefaktor multipliziert und der resultierende Wert wird ausgegeben und für
die weitere Verarbeitung verwendet.

Vorbereitungsverfahren

Identifizieren Sie den/die Gerätefaktor(en), den/die Sie berechnen und setzen werden. Sie
können jede Kombination der drei Gerätefaktoren setzen: Massedurchfluss,
Volumendurchfluss und Dichte. Beachten Sie, dass alle drei Gerätefaktoren unabhängig
sind:

• Der Gerätefaktor für Massedurchfluss beeinflusst nur den ausgegebenen Wert des
Massedurchflusses.

• Der Gerätefaktor für Dichte beeinflusst nur den ausgegebenen Wert der Dichte.

• Der Gerätefaktor für Volumendurchfluss beeinflusst nur den ausgegebenen Wert
des Volumendurchflusses.

Wichtig
Zum Justieren des Volumendurchflusses ist der Gerätefaktor für Volumendurchfluss zu setzen. Das
Setzen des Gerätefaktors für Massedurchfluss und des Gerätefaktors für Dichte erzeugt nicht das
gewünschte Ergebnis. Die Berechnung des Volumendurchflusses basiert auf den originalen
Massedurchfluss- und Dichtewerten, bevor der entsprechende Gerätefaktor angewendet wird.

Wenn Sie vorhaben, den Gerätefaktor des Volumendurchflusses zu berechnen, sollten Sie
beachten, dass das Validieren des Volumens in der Anlage kostspielig sein kann. Dieser
Vorgang kann bei manchen Prozessmedien außerdem gefährlich sein. Da das Volumen
umgekehrt proportional zur Dichte ist, ist die Berechnung des Gerätefaktors für
Volumendurchfluss von dem Gerätefaktor für Dichte eine alternative zur direkten
Messung. Anweisungen für diese Methode finden Sie in Abschnitt Abschnitt 15.2.1.

Stellen Sie ein Referenzgerät (ein externes Messgerät) für die entsprechende
Prozessvariable bereit.

Wichtig
Das Referenzgerät muss äußerst genau sein, um zuverlässige Ergebnisse zu erzielen.
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Verfahren

1. Bestimmen Sie den Gerätefaktor wie folgt:

a. Nehmen Sie eine Probemessung mit dem Durchflussmessgerät vor.

b. Messen Sie die gleiche Probe mit dem Referenzgerät.

c. Berechnen Sie den Gerätefaktor mit folgender Formel:

NeuerGerätefaktor Konfigurierter
Gerätefaktor

Referenzmessung
Durchfluss-MesssystemMessung

= x

2. Stellen Sie sicher, dass der berechnete Gerätefaktor zwischen 0,8 und 1,2 liegt
(inklusive). Wenn der Gerätefaktor außerhalb dieser Grenzen liegt, setzen Sie sich
mit dem Micro Motion Kundenservice in Verbindung.

3. Konfigurieren Sie den Gerätefaktor in der Auswerteelektronik.

Beispiel: Gerätefaktor für Massedurchfluss berechnen

Das Durchflussmesssystem wird zum ersten Mal installiert und verifiziert. Der von der
Auswerteelektronik gemessene Massedurchfluss beträgt 250,27 lb. Der vom
Referenzgerät gemessene Massedurchfluss beträgt 250 lb. Der Gerätefaktor für
Massedurchfluss wird wie folgt berechnet:

Gerätefaktor
Massedurchfluss

1
250

250,27
= x = 0,9989

Der erste Gerätefaktor für Massedurchfluss ist 0,9989.

Ein Jahr später wird das Durchflussmesssystem erneut validiert. Der von der
Auswerteelektronik gemessene Massedurchfluss beträgt 250,07 lb. Der vom
Referenzgerät gemessene Massedurchfluss beträgt 250,25 lb. Der neue Gerätefaktor für
Massedurchfluss wird wie folgt berechnet:

Gerätefaktor
Massedurchfluss

0,9989 250,25
250,07

= x = 0,9996

Der neue Gerätefaktor für Massedurchfluss ist 0.9996.

15.2.1 Alternative Methode für die Berechnung des
Gerätefaktors für Volumendurchfluss
Die alternative Methode für die Berechnung des Gerätefaktors für Volumendurchfluss wird
verwendet, um die Schwierigkeiten zu vermeiden, die bei Verwendung der
Standardmethode auftreten können.

Diese alternative Methode basiert auf der Tatsache, dass das Volumen umgekehrt
proportional zur Dichte ist. Sie bietet eine Teilkorrektur der Volumendurchflussmessung
durch Justierung des Anteils des Gesamt Offsets, der durch den Offset der Dichtemessung
begründet ist. Verwenden Sie diese Methode nur dann, wenn keine Referenz für den
Volumendurchfluss verfügbar ist, jedoch eine Referenz für die Dichte.
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Verfahren

1. Berechnen Sie den Gerätefaktor für Dichte unter Verwendung der
Standardmethode (siehe Abschnitt 15.2).

2. Berechnen Sie den Gerätefaktor für Volumendurchfluss vom Gerätefaktor für die
Dichte:

GerätefaktorVolumen
1

GerätefaktorDichte
=

Anmerkung
Die folgende Gleichung ist mathematisch äquivalent zur ersten Gleichung. Sie können die
Gleichung verwenden, die Sie bevorzugen.

Gerätefaktor
Volumen

KonfigurierterGerätefaktorDichte
DichteDurchfluss-Messsystem

DichteReferenzgerät
= x

3. Stellen Sie sicher, dass der berechnete Gerätefaktor zwischen 0,8 und 1,2 liegt
(inklusive). Wenn der Gerätefaktor außerhalb dieser Grenzen liegt, setzen Sie sich
mit dem Micro Motion Kundenservice in Verbindung.

4. Konfigurieren Sie den Gerätefaktor für Volumendurchfluss in der
Auswerteelektronik.

15.3 (Standard) D1 und D2 Dichtekalibrierung
durchführen
Mittels der Dichtekalibrierung wird das Verhältnis zwischen der Mediumsdichte bei
Dichtekalibrierung und dem vom Sensor erzeugten Signal ermittelt. Die
Dichtekalibrierung umfasst das Kalibrieren der Kalibrierpunkte D1 (niedrige Dichte) und
D2 (hohe Dichte).

Wichtig
Micro Motion Auswerteelektroniken werden werksseitig kalibriert und müssen normalerweise nicht
vor Ort kalibriert werden. Führen Sie eine Kalibrierung des Durchflussmessers nur dann durch, wenn
dies durch gesetzliche Bestimmungen gefordert wird. Wenden Sie sich an Micro Motion, bevor Sie
den Durchflussmesser kalibrieren.

Hinweis
Micro Motion empfiehlt eine Systemvalidierung und die Verwendung von Gerätefaktoren anstatt
einer Kalibrierung, um den Durchflussmesser auf ein geeichtes Messnormal abzugleichen oder einen
Messfehler zu korrigieren.
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15.3.1 Durchführen einer D1- und D2-Dichtekalibrierung
mittels ProLink II
Vorbereitungsverfahren

• Während der Dichtekalibrierung muss der Sensor komplett mit dem
Kalibriermedium gefüllt sein und der Durchfluss durch den Sensor muss so klein
sein, wie es Ihre Anwendung ermöglicht. Dies wird normalerweise durch Schließen
des auslaufseitig vom Sensor befindlichen Absperrventils erreicht. Anschließend
füllen Sie den Sensor mit dem entsprechenden Medium.

• Die D1 und D2 Dichtekalibrierung erfordert ein D1 Medium (niedrige Dichte) und
ein D2 Medium (hohe Dichte). Hierfür können Sie Luft und Wasser nehmen.

• Die Kalibrierverfahren müssen ohne Unterbrechung in der gezeigten Reihenfolge
durchgeführt werden. Stellen Sie sicher, dass Sie das Verfahren ohne
Unterbrechungen abschließen können.

• Bevor Sie die Kalibrierung durchführen, notieren Sie die aktuellen
Kalibrierparameter. Sie können dies tun, in dem Sie die aktuelle Konfiguration als
Datei auf dem PC speichern. Sollte die Kalibrierung fehlschlagen, können die alten
Werte zurückgespeichert werden.

Verfahren

Siehe Abbildung 15-1.

D1- und D2-Dichtekalibrierung mittels ProLink IIAbbildung 15-1:   

Dichte des D1 Mediums 
eingeben

Calibration in Progress LED 
wechselt auf grün

 Calibration in Progress 
LED wechselt auf rot

D1 
Kalibrierung

Absperrventil schliessen, 
auslaufseitig vom Sensor

Sensor mit D1 Medium 
füllen

Sensor mit D2 Medium 
füllen

Schliessen

Dichte des D2 Mediums 
eingeben

Calibration in Progress LED 
wechselt auf grün

 Calibration in Progress 
LED wechselt auf rot

D2 
Kalibrierung

Schliessen

Fertig

Kalibrierung ausführen Kalibrierung ausführen

ProLink Menü >
 Calibration >
 Density cal – Point 1

ProLink Menü >
 Calibration >
 Density cal – Point 2
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15.3.2 Durchführen einer D1- und D2-Dichtekalibrierung
mittels ProLink III
Vorbereitungsverfahren

• Während der Dichtekalibrierung muss der Sensor komplett mit dem
Kalibriermedium gefüllt sein und der Durchfluss durch den Sensor muss so klein
sein, wie es Ihre Anwendung ermöglicht. Dies wird normalerweise durch Schließen
des auslaufseitig vom Sensor befindlichen Absperrventils erreicht. Anschließend
füllen Sie den Sensor mit dem entsprechenden Medium.

• Die D1 und D2 Dichtekalibrierung erfordert ein D1 Medium (niedrige Dichte) und
ein D2 Medium (hohe Dichte). Hierfür können Sie Luft und Wasser nehmen.

• Die Kalibrierverfahren müssen ohne Unterbrechung in der gezeigten Reihenfolge
durchgeführt werden. Stellen Sie sicher, dass Sie das Verfahren ohne
Unterbrechungen abschließen können.

• Bevor Sie die Kalibrierung durchführen, notieren Sie die aktuellen
Kalibrierparameter. Sie können dies tun, in dem Sie die aktuelle Konfiguration als
Datei auf dem PC speichern. Sollte die Kalibrierung fehlschlagen, können die alten
Werte zurückgespeichert werden.

Verfahren

Siehe Abbildung 15-2.

D1- und D2-Dichtekalibrierung mittels ProLink IIIAbbildung 15-2:   

D1 
Kalibrierung

Fertig

Device Tools >
 Calibration >
 Density Calibration >
 Density Calibration – Point 1 (Air)

Schliessen

Kalibrierung starten

D2 
Kalibrierung

Device Tools >
 Calibration >
 Density Calibration >
 Density Calibration – Point 2 (Water)

Schliessen

Kalibrierung starten

Absperrventil schliessen, 
auslaufseitig vom Sensor

Sensor mit D1 Medium 
füllen

Dichte des D1 Mediums 
eingeben

Dichte des D2 Mediums 
eingeben

Sensor mit D2 Medium 
füllen
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15.3.3 Durchführen einer D1- und D2-Dichtekalibrierung
mittels Modbus
Vorbereitungsverfahren

• Während der Dichtekalibrierung muss der Sensor komplett mit dem
Kalibriermedium gefüllt sein und der Durchfluss durch den Sensor muss so klein
sein, wie es Ihre Anwendung ermöglicht. Dies wird normalerweise durch Schließen
des auslaufseitig vom Sensor befindlichen Absperrventils erreicht. Anschließend
füllen Sie den Sensor mit dem entsprechenden Medium.

• Die D1 und D2 Dichtekalibrierung erfordert ein D1 Medium (niedrige Dichte) und
ein D2 Medium (hohe Dichte). Hierfür können Sie Luft und Wasser nehmen.

• Die Kalibrierverfahren müssen ohne Unterbrechung in der gezeigten Reihenfolge
durchgeführt werden. Stellen Sie sicher, dass Sie das Verfahren ohne
Unterbrechungen abschließen können.

• Bevor Sie die Kalibrierung durchführen, notieren Sie sich die aktuellen
Kalibrierparameter. Sollte die Kalibrierung fehlschlagen, können die alten Werte
zurückgespeichert werden.

Verfahren

Siehe Abbildung 15-3.

Durchführen einer D1- und D2-Dichtekalibrierung mittels ModbusAbbildung 15-3:   

Dichte des D1 Mediums 
eingeben

Status überwachen

D1 
Kalibrierung

Absperrventil schliessen, 
auslaufseitig vom Sensor

Sensor mit D1 Medium 
füllen

Coil 13D1 Kalibrierung starten

Register 155-156

Register 423, Bit 14

Bit 14 aus?Nein

Dichte des D2 Mediums 
eingeben

Status überwachen

D2 
KalibrierungSensor mit D2 Medium 

füllen

Coil 14D2 Kalibrierung starten

Register 157-158

Register 423, Bit 13

Bit 13 aus?Nein

K1 Wert prüfen Register 159-160

Ja

K2 Wert prüfen Register 161-162

Ja

Fertig Fertig

15.4 Durchführen einer Temperaturkalibrierung
Die Temperaturkalibrierung stellt die Beziehung zwischen der Temperatur der
Kalibriermedien und dem vom Sensor erzeugten Signal her.
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15.4.1 Durchführen einer Temperaturkalibrierung mit ProLink II
Die Temperaturkalibrierung stellt die Beziehung zwischen der Temperatur der
Kalibriermedien und dem vom Sensor erzeugten Signal her.

Vorbereitungsverfahren

Die Temperaturkalibrierung ist ein zweiteiliges Verfahren: die Kalibrierung des
Temperatur-Offsets und die Kalibrierung der Temperatursteigung Die beiden
Kalibrierverfahren müssen ohne Unterbrechung in der gezeigten Reihenfolge
durchgeführt werden. Stellen Sie sicher, dass Sie das Verfahren ohne Unterbrechungen
abschließen können.

Wichtig
Wenden Sie sich an Micro Motion, bevor Sie eine Temperaturkalibrierung durchführen. Unter
normalen Umständen ist der Temperaturkreis stabil und sollte nicht eingestellt werden müssen.

Verfahren

Siehe Abbildung 15-4.

Temperaturkalibrierung mit ProLink IIAbbildung 15-4:   

Temperatur des Mediums 
mit niedriger Temperatur 

eingeben

Temperatur Offset Kalibrierung

Kalibrierung ausführen

Warten, bis der 
Temperaturausgleich mit 

dem Sensor erfolgt ist

Sensor mit Medium niedriger 
Temperatur füllen

Calibration in Progress LED 
wechselt auf grün

 Calibration in Progress 
LED wechselt auf rot

Schliessen

Temperatur des Mediums mit 
hoher Temperatur eingeben

Temperatur Steigung 
Kalibrierung

Kalibrierung ausführen

Warten, bis der 
Temperaturausgleich mit 

dem Sensor erfolgt ist

Sensor mit Medium hoher 
Temperatur füllen

Calibration in Progress LED 
wechselt auf grün

 Calibration in Progress 
LED wechselt auf rot

Schliessen

Fertig

ProLink Menü >
 Calibration >
 Temp offset cal

ProLink Menü >
 Calibration >
 Temp slope cal
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15.4.2 Durchführen einer Temperaturkalibrierung mit
ProLink III
Die Temperaturkalibrierung stellt die Beziehung zwischen der Temperatur der
Kalibriermedien und dem vom Sensor erzeugten Signal her.

Vorbereitungsverfahren

Die Temperaturkalibrierung ist ein zweiteiliges Verfahren: die Kalibrierung des
Temperatur-Offsets und die Kalibrierung der Temperatursteigung Die beiden
Kalibrierverfahren müssen ohne Unterbrechung in der gezeigten Reihenfolge
durchgeführt werden. Stellen Sie sicher, dass Sie das Verfahren ohne Unterbrechungen
abschließen können.

Wichtig
Wenden Sie sich an Micro Motion, bevor Sie eine Temperaturkalibrierung durchführen. Unter
normalen Umständen ist der Temperaturkreis stabil und sollte nicht eingestellt werden müssen.

Verfahren

Siehe Abbildung 15-5.

Temperaturkalibrierung mit ProLink IIIAbbildung 15-5:   

Temperatur des Mediums 
mit niedriger Temperatur 

eingeben

Temperatur Offset Kalibrierung

Sensor mit Medium niedriger 
Temperatur füllen

Temperatur des Mediums mit 
hoher Temperatur eingeben

Temperatur Steigung 
Kalibrierung

Kalibrierung starten

Sensor mit Medium hoher 
Temperatur füllen

Fertig

Device Tools >
 Calibration >
 Temperature Calibration >
 Temperature Calibration - Offset

Kalibrierung starten

Device Tools >
 Calibration >
 Temperature Calibration >
 Temperature Calibration - Slope

Warten, bis der 
Temperaturausgleich mit 

dem Sensor erfolgt ist

Warten, bis der 
Temperaturausgleich mit 

dem Sensor erfolgt ist
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16 Störungsanalyse und -behebung
In diesem Kapitel behandelte Themen:

• Status Alarme

• Probleme bei Durchflussmessungen

• Probleme bei Dichtemessungen

• Probleme bei der Temperaturmessung

• Probleme bei mA-Ausgängen

• Probleme beim Frequenzausgang

• Verwenden der Sensorsimulation zur Störungsanalyse und -beseitigung

• Verdrahtung der Spannungsversorgung prüfen

• Erdung überprüfen

• Messkreistests durchführen

• mA Ausgänge abgleichen

• Prüfen von Messanfang und Messende
• mA Ausgang Störaktion prüfen

• Prüfung auf hochfrequente Störungen (RFI)

• Frequenzausgang max. Impulsbreite prüfen

• Frequenzausgang Skaliermethode prüfen

• Frequenzausgang Störaktion prüfen

• Prüfen der Durchflussrichtung
• Prüfen der Abschaltungen

• Prüfen auf Schwallströmung (Zweiphasenströmung)

• Antriebsverstärkung prüfen

• Aufnehmerspannung prüfen

• Prüfen auf elektrische Kurzschlüsse

16.1 Status Alarme

Statusalarme und empfohlene MaßnahmenTabelle 16-1:   

Alarm Code Beschreibung Ursache Empfohlene Maßnahmen

A001 EEPROM-Fehler (Core-
Prozessor)

Ein nicht korrigierbarer
Prüfsummenfehler
wurde festgestellt.

• Die Spannungsversorgung zum Messsystem
aus-/einschalten.

• Wenden Sie sich an Micro Motion.

A002 RAM-Fehler (Core-Pro-
zessor)

ROM Prüfsummenfeh-
ler oder ein RAM Be-
reich kann nicht bes-
chrieben werden.

• Die Spannungsversorgung zum Messsystem
aus-/einschalten.

• Wenden Sie sich an Micro Motion.

Störungsanalyse und -behebung
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Statusalarme und empfohlene Maßnahmen (Fortsetzung)Tabelle 16-1:   

Alarm Code Beschreibung Ursache Empfohlene Maßnahmen

A003 Keine Antwort vom
Sensor

Durchgangsfehler des
Antriebskreises, LPO
oder RPO oder LPO-
RPO Fehler während
des Antriebs.

• Antriebsverstärkung und Aufnehmerspannung
prüfen. Siehe Abschnitt 16.21 und 
Abschnitt 16.22.

• Auf elektrische Kurzschlüsse prüfen. Siehe 
Abschnitt 16.23.

• Die Unversehrtheit der Sensormessrohre prü-
fen.

A004 Messbereichsübers-
chreitung für Tempera-
tur

Kombination von A016
und A017.

• Die Temperatur-Charakterisierungsparameter
(Temperaturkalibrierfaktor) prüfen.

• Überprüfen Sie Ihre Prozessbedingungen an-
hand der vom Durchflussmesser gemeldeten
Werte.

• Wenden Sie sich an Micro Motion.

A005 Messbereichsübers-
chreitung für Masse-
durchfluss

Der gemessene Durch-
fluss hat die maximale
Durchflussmenge des
Sensors überschritten
(ΔT größer als 200 µs).

• Sind andere Alarme vorhanden, diese Alarm-
bedingungen zuerst beheben. Besteht der ak-
tuelle Alarm weiterhin, fahren Sie mit den
Empfehlungen hier fort.

• Überprüfen Sie Ihre Prozessbedingungen an-
hand der vom Durchflussmesser gemeldeten
Werte.

• Auf Schwallströmung prüfen. Siehe 
Abschnitt 16.20.

• Antriebsverstärkung und Aufnehmerspannung
prüfen. Siehe Abschnitt 16.21 und 
Abschnitt 16.22.

• Auf elektrische Kurzschlüsse prüfen. Siehe 
Abschnitt 16.23.

• Die Unversehrtheit der Sensormessrohre prü-
fen.

• Wenden Sie sich an Micro Motion.

A006 Charakterisierung erfor-
derlich

Kalibrierfaktoren wur-
den nicht eingegeben
und der Sensortyp ist
falsch.

• Prüfen Sie, ob alle Charakterisierungsparame-
ter den Daten auf dem Sensor-Tag entspre-
chen.

• Wenden Sie sich an Micro Motion.
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Statusalarme und empfohlene Maßnahmen (Fortsetzung)Tabelle 16-1:   

Alarm Code Beschreibung Ursache Empfohlene Maßnahmen

A008 Dichte Bereichsübers-
chreitung

Die gemessene Dichte
hat 10 g/cm3 übers-
chritten

• Sind andere Alarme vorhanden, diese Alarm-
bedingungen zuerst beheben. Besteht der ak-
tuelle Alarm weiterhin, fahren Sie mit den
Empfehlungen hier fort.

• Die Prozessbedingungen prüfen, insbeson-
dere, ob Luft in den Messrohren vorhanden ist,
ob die Messrohre nicht gefüllt sind oder ob
sich Fremdkörper oder Ablagerungen in den
Messrohren befinden.

• Auf Schwallströmung prüfen. Siehe 
Abschnitt 16.20.

• Bei gleichzeitigem A003-Alarm auf elektrische
Kurzschlüsse prüfen. Siehe Abschnitt 16.23.

• Prüfen Sie, ob alle Charakterisierungsparame-
ter den Daten auf dem Sensor-Tag entspre-
chen.

• Antriebsverstärkung und Aufnehmerspannung
prüfen. Siehe Abschnitt 16.21 und 
Abschnitt 16.22.

• Dichtekalibrierung durchführen.
• Wenden Sie sich an Micro Motion.

A009 Auswerteelektronik Ini-
tialisierung/Aufwärm-
phase

Auswerteelektronik im
Einschaltmodus.

• Lassen Sie das Messsystem warmlaufen.
• Überprüfen Sie, ob die Messrohre voll mit Pro-

zessmedium gefüllt.

A010 Kalibrierfehler Viele mögliche Ursa-
chen, wie beispielswe-
ise zu großer Durch-
fluss durch den Sensor
während eines Kali-
brierverfahrens.

• Erscheint während der Nullpunktkalibrierung
dieser Alarm, überprüfen Sie, ob kein Durch-
fluss durch den Sensor erfolgt, und versuchen
Sie es erneut.

• Spannungsversorgung aus-/einschalten und
erneut versuchen.

A011 Nullpunktkalibrierung
fehlgeschlagen: Tief

Viele mögliche Ursa-
chen, wie beispielswe-
ise zu großer Durch-
fluss – insbesondere
Rückwärtsdurchfluss –
durch den Sensor wäh-
rend eines Kalibrierver-
fahrens.

• Überprüfen Sie, ob kein Durchfluss durch den
Sensor erfolgt, und versuchen Sie es erneut.

• Spannungsversorgung aus-/einschalten und
erneut versuchen.

A012 Nullpunktkalibrierung
fehlgeschlagen: Hoch

Viele mögliche Ursa-
chen, wie beispielswe-
ise zu großer Durch-
fluss – insbesondere
Vorwärtsdurchfluss –
durch den Sensor wäh-
rend eines Kalibrierver-
fahrens.

• Überprüfen Sie, ob kein Durchfluss durch den
Sensor erfolgt, und versuchen Sie es erneut.

• Spannungsversorgung aus-/einschalten und
erneut versuchen.
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Statusalarme und empfohlene Maßnahmen (Fortsetzung)Tabelle 16-1:   

Alarm Code Beschreibung Ursache Empfohlene Maßnahmen

A013 Nullpunktkalibrierung
fehlgeschlagen: Instabil

Der Prozessbedingun-
gen während des Kali-
brierverfahrens waren
zu instabil.

• Entfernen oder reduzieren Sie die Quellen für
elektromagnetisches Rauschen (z. B. Pumpen,
Vibration, Rohrspannungen) und versuchen
Sie es erneut.

• Spannungsversorgung aus-/einschalten und
erneut versuchen.

A014 Auswerteelektronikfeh-
ler

Viele mögliche Ursa-
chen.

• Die Spannungsversorgung zum Messsystem
aus-/einschalten.

• Wenden Sie sich an Micro Motion.

A016 Sensor-RTD-Fehler Der berechnete Wider-
standswert des Lei-
tungs-RTDs liegt außer-
halb des Bereichs.

• Überprüfen Sie Ihre Prozessbedingungen an-
hand der vom Durchflussmesser gemeldeten
Werte.

• Wenden Sie sich an Micro Motion.

A017 T-Serien-RTD-Fehler Der berechnete Wider-
standswert für das RTD-
Messgerät/-Gehäuse
liegt außerhalb der
Grenzwerte.

• Überprüfen Sie Ihre Prozessbedingungen an-
hand der vom Durchflussmesser gemeldeten
Werte. Die Temperatur sollte zwischen -200 °F
und +400 °F liegen.

• Prüfen Sie, ob alle Charakterisierungsparame-
ter den Daten auf dem Sensor-Tag entspre-
chen.

• Wenden Sie sich an Micro Motion.

A020 K.wrt f. k. Drchflss Der Durchflusskalibrier-
faktor und/oder K1
wurden seit der letzten
Hauptrücksetzung
nicht eingegeben.

• Prüfen Sie, ob alle Charakterisierungsparame-
ter den Daten auf dem Sensor-Tag entspre-
chen.

A021 Falscher Sensortyp (K1) Der Sensor wird als Ger-
adrohr erkannt, aber
der K1-Wert deutet auf
einen Sensor mit gebo-
genem Messrohr hin
oder umgekehrt.

• Prüfen Sie, ob alle Charakterisierungsparame-
ter den Daten auf dem Sensor-Tag entspre-
chen.

A029 PIC/Tochterboard-Kom-
munikationsfehler

In einer Hardware-Zwi-
schenbaugruppe ist
eine Kommunikations-
störung aufgetreten.

• Wenden Sie sich an Micro Motion.

A030 Falscher Platinentyp • Wenden Sie sich an Micro Motion.

A031 Spannung zu niedrig Die Auswerteelektronik
erhält zu wenig Span-
nungsversorgung.

• Die Spannungsversorgung und deren Verdrah-
tung prüfen. Siehe Abschnitt 16.8.

A033 Unzureichendes Signal
von rechter/linker Auf-
nehmerspule

Kein Signal von LPO
oder RPO, vermutlich
schwingen die Sensor-
Messrohre nicht.

• Die Prozessbedingungen prüfen, insbeson-
dere, ob Luft in den Messrohren vorhanden ist,
ob die Messrohre nicht gefüllt sind oder ob
sich Fremdkörper oder Ablagerungen in den
Messrohren befinden.
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Statusalarme und empfohlene Maßnahmen (Fortsetzung)Tabelle 16-1:   

Alarm Code Beschreibung Ursache Empfohlene Maßnahmen

A102 Antrieb Bereichsübers-
chreitung

Die Antriebsleistung
(Spannung) hat die
Maximalleistung er-
reicht.

• Antriebsverstärkung und Aufnehmerspannung
prüfen. Siehe Abschnitt 16.21 und 
Abschnitt 16.22.

• Auf elektrische Kurzschlüsse prüfen. Siehe 
Abschnitt 16.23.

A104 Kalibrierung läuft Ein Kalibrierverfahren
läuft.

• Das Verfahren beenden lassen.
• Bei einer Nullpunktkalibrierung kann die Kali-

brierung abgebrochen, der Nullzeitparameter
auf einen niedrigeren Wert eingestellt und die
Kalibrierung erneut gestartet werden.

A105 Schwallströmung Die Dichte hat die be-
nutzerdefinierten
Schwallstromgrenzen
(Dichte) überschritten.

• Auf Schwallströmung prüfen. Siehe 
Abschnitt 16.20.

A107 Spannungsunterbre-
chung eingetreten

Die Auswerteelektronik
wurde neu gestartet.

• Keine Maßnahme erforderlich.
• Falls erforderlich, können Sie die Alarmstufe

auf Ignorieren neu konfigurieren.

A110 Frequenzausgang ge-
sättigt

Der berechnete Fre-
quenzausgangswert
liegt außerhalb des lin-
earen Bereichs.

• Die Skalierung des Frequenzausgangs über-
prüfen. Siehe Abschnitt 16.16.

• Prozessbedingungen überprüfen. Die aktuell-
en Bedingungen können jenseits der normalen
Bedingungen liegen, für die der Ausgang kon-
figuriert ist.

• Die Prozessbedingungen prüfen, insbeson-
dere, ob Luft in den Messrohren vorhanden ist,
ob die Messrohre nicht gefüllt sind oder ob
sich Fremdkörper oder Ablagerungen in den
Messrohren befinden.

• Prüfen Sie, ob die Messeinheiten für Ihre An-
wendung korrekt konfiguriert sind.

• Messrohre spülen.

A111 Frequenzausgang fixiert Der Frequenzausgang
wurde zum Senden
eines Direktwerts konfi-
guriert.

• Prüfen Sie, ob der Ausgang im Messkreistest-
Modus ist. Sollte das der Fall sein, den Aus-
gang lösen.

• Prüfen Sie, ob der Ausgang über die digitale
Kommunikation auf einen konstanten Wert
eingestellt wurde.
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Statusalarme und empfohlene Maßnahmen (Fortsetzung)Tabelle 16-1:   

Alarm Code Beschreibung Ursache Empfohlene Maßnahmen

A113 mA-Ausgang 2 gesät-
tigt

• Prozessbedingungen überprüfen. Die aktuell-
en Bedingungen können jenseits der normalen
Bedingungen liegen, für die der Ausgang kon-
figuriert ist.

• Die Prozessbedingungen prüfen, insbeson-
dere, ob Luft in den Messrohren vorhanden ist,
ob die Messrohre nicht gefüllt sind oder ob
sich Fremdkörper oder Ablagerungen in den
Messrohren befinden.

• Prüfen Sie, ob die Messeinheiten für Ihre An-
wendung korrekt konfiguriert sind.

• Messrohre spülen.
• Die Einstellungen für Messende (URV) und Mes-

sanfang (LRV) überprüfen. Siehe 
Abschnitt 16.12.

A114 mA-Ausgang 2 fest • Prüfen Sie, ob der Ausgang im Messkreistest-
Modus ist. Sollte das der Fall sein, den Aus-
gang lösen.

• Abgleich des mA-Ausgangs gegebenenfalls
beenden.

• Prüfen Sie, ob der Ausgang über die digitale
Kommunikation auf einen konstanten Wert
eingestellt wurde.

A118 Binärer mA Ausgang 1
fix

Der Binärausgang
wurde zum Senden
eines Direktwerts konfi-
guriert.

• Prüfen Sie, ob der Ausgang im Messkreistest-
Modus ist. Sollte das der Fall sein, den Aus-
gang lösen.

A132 Sensorsimulation aktiv Simulationsmodus ist
aktiviert.

• Keine Maßnahme erforderlich.
• Sensor-Simulation deaktivieren.

16.2 Probleme bei Durchflussmessungen

Probleme bei Durchflussmessungen und AbhilfemaßnahmenTabelle 16-2:   

Problem Mögliche Ursachen Empfohlene Maßnahmen

Durchflussrichtung-
sanzeige bei Null-
durchfluss oder Null-
punktverschiebung

• Nicht fluchtende Rohrleitung (speziell
bei neuen Installationen)

• Offenes oder undichtes Ventil
• Falscher Sensor-Nullpunkt

• Prüfen Sie, ob alle Charakterisierungspara-
meter den Daten auf dem Sensor-Tag en-
tsprechen.

• Ist der gemessene Durchfluss nicht besond-
ers hoch, die Echtzeit-Nullpunktkalibrierung
prüfen. Sie müssen die Werkseinstellung für
die Nullpunktkalibrierung wiederherstellen.

• Auf offene oder undichte Ventile oder Dich-
tungen prüfen.

• Den Sensor auf Montagespannungen prüfen
(z. B. Sensor zur Abstützung von Rohrleitun-
gen, nicht fluchtende Rohrleitungen).

• Wenden Sie sich an Micro Motion.
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Probleme bei Durchflussmessungen und Abhilfemaßnahmen (Fortsetzung)Tabelle 16-2:   

Problem Mögliche Ursachen Empfohlene Maßnahmen

Sprunghafter Durch-
fluss bei Nulldurch-
flussbedingungen

• Leckage an Ventil oder Abdichtung
• Slug flow
• Messrohr verstopft oder beschichtet
• Falsche Sensor-Einbaulage
• Verdrahtungsproblem
• Vibrationen der Rohrleitung nahe der

Sensor Messrohrfrequenz
• Dämpfungswert zu niedrig
• Montagespannungen auf dem Sensor

• Prüfen, ob die Sensor-Einbaulage zu Ihrer An-
wendung passt (siehe Sensor-Installationsan-
leitung).

• Antriebsverstärkung und Aufnehmerspan-
nung prüfen. Siehe Antriebsverstärkung prüfen
und Aufnehmerspannung prüfen.

• Messrohre spülen.
• Auf offene oder undichte Ventile oder Dich-

tungen prüfen.
• Die Ursache der Vibration prüfen.
• Die Dämpfungskonfiguration prüfen.
• Prüfen Sie, ob die Messeinheiten für Ihre An-

wendung korrekt konfiguriert sind.
• Auf Schwallströmung prüfen. Siehe 

Prüfen auf Schwallströmung (Zweiphasenströ-
mung).

• Auf HF-Störungen prüfen. Siehe 
Prüfung auf hochfrequente Störungen (RFI).

• Wenden Sie sich an Micro Motion.

Sprunghafter Durch-
fluss bei stabilem
Durchfluss

• Slug flow
• Dämpfungswert zu niedrig
• Messrohr verstopft oder beschichtet
• Problem mit der Ausgangsverdrahtung
• Problem mit dem empfangenden Gerät
• Verdrahtungsproblem

• Prüfen, ob die Sensor-Einbaulage zu Ihrer An-
wendung passt (siehe Sensor-Installationsan-
leitung).

• Antriebsverstärkung und Aufnehmerspan-
nung prüfen. Siehe Antriebsverstärkung prüfen
und Aufnehmerspannung prüfen.

• Auf Luftanteile, Verschmutzung, Dampfbil-
dung oder Beschädigung des Messrohres
prüfen.

• Messrohre spülen.
• Auf offene oder undichte Ventile oder Dich-

tungen prüfen.
• Die Ursache der Vibration prüfen.
• Die Dämpfungskonfiguration prüfen.
• Prüfen Sie, ob die Messeinheiten für Ihre An-

wendung korrekt konfiguriert sind.
• Auf Schwallströmung prüfen. Siehe 

Prüfen auf Schwallströmung (Zweiphasenströ-
mung).

• Auf HF-Störungen prüfen. Siehe 
Prüfung auf hochfrequente Störungen (RFI).

• Wenden Sie sich an Micro Motion.
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Probleme bei Durchflussmessungen und Abhilfemaßnahmen (Fortsetzung)Tabelle 16-2:   

Problem Mögliche Ursachen Empfohlene Maßnahmen

Ungenauer Durchfluss
oder Batchmenge

• Verdrahtungsproblem
• Ungeeignete Maßeinheit
• Falscher Durchflusskalibrierfaktor
• Falscher Gerätefaktor
• Falsche Dichtekalibrierfaktoren
• Falsche Erdung des Durchflussmessers
• Slug flow
• Problem mit dem empfangenden Gerät

• Prüfen Sie, ob die Messeinheiten für Ihre An-
wendung korrekt konfiguriert sind.

• Prüfen Sie, ob alle Charakterisierungspara-
meter den Daten auf dem Sensor-Tag en-
tsprechen.

• Mit einem Eimertest die Gesamtcharge über-
prüfen.

• Nullpunktkalibrierung des Messsystems.
• Erdung prüfen. Siehe Erdung überprüfen.
• Auf Schwallströmung prüfen. Siehe 

Prüfen auf Schwallströmung (Zweiphasenströ-
mung).

• Das empfangende Gerät sowie die Verdrah-
tung zwischen Auswerteelektronik und Core-
Prozessor prüfen.

• Den Widerstand der Sensorspule und auf
Kurzschlüsse am Gehäuse prüfen. Siehe 
Prüfen der Sensorspulen.

• Kern-Prozessor oder Auswerteelektronik aus-
tauschen.

16.3 Probleme bei Dichtemessungen

Probleme bei Dichtemessungen und AbhilfemaßnahmenTabelle 16-3:   

Problem Mögliche Ursachen Empfohlene Maßnahmen

Ungenauer Dichte-
wert

• Problem mit dem Prozessmedium
• Falsche Dichtekalibrierfaktoren
• Verdrahtungsproblem
• Falsche Erdung des Durchflussmessers
• Slug flow
• Messrohr verstopft oder beschichtet
• Falsche Sensor-Einbaulage
• Fehlerhafter Widerstandsthermometer
• Physikalische Charakteristik des Sensors

hat sich geändert

• Erdung prüfen. Siehe Erdung überprüfen.
• Überprüfen Sie Ihre Prozessbedingungen an-

hand der vom Durchflussmesser gemeldeten
Werte.

• Prüfen Sie, ob alle Charakterisierungspara-
meter den Daten auf dem Sensor-Tag en-
tsprechen.

• Auf Schwallströmung prüfen. Siehe 
Prüfen auf Schwallströmung (Zweiphasenströ-
mung).

• Zwei Sensoren mit ähnlicher Frequenz tren-
nen, wenn sie sich zu nahe nebeneinander
befinden.

• Messrohre spülen.
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Probleme bei Dichtemessungen und Abhilfemaßnahmen (Fortsetzung)Tabelle 16-3:   

Problem Mögliche Ursachen Empfohlene Maßnahmen

Ungewöhnlich hoher
Dichtewert

• Messrohr verstopft oder beschichtet
• Falscher K2-Wert
• Falsche Temperaturmessung
• Widerstandsthermometerproblem
• In Hochfrequenzmessgeräten kann dies

ein Anzeichen für Erosion oder Korrosion
sein

• In Niederfrequenzmessgeräten kann
dies auf Rohrablagerungen hindeuten

• Prüfen Sie, ob alle Charakterisierungspara-
meter den Daten auf dem Sensor-Tag en-
tsprechen.

• Messrohre spülen.
• Auf Ablagerungen in den Messrohren prüfen.

Ungewöhnlich nie-
driger Dichtewert

• Slug flow
• Falscher K2-Wert
• In Niederfrequenzmessgeräten kann

dies ein Anzeichen für Erosion oder Kor-
rosion sein

• Überprüfen Sie Ihre Prozessbedingungen an-
hand der vom Durchflussmesser gemeldeten
Werte.

• Prüfen Sie, ob alle Charakterisierungspara-
meter den Daten auf dem Sensor-Tag en-
tsprechen.

• Die Messrohre auf Erosion prüfen, insbeson-
dere, wenn das Prozessmedium abrasiv ist.

16.4 Probleme bei der Temperaturmessung

Probleme bei der Temperaturmessung und AbhilfemaßnahmenTabelle 16-4:   

Problem Mögliche Ursachen Empfohlene Maßnahmen

Temperaturwert
weicht signifikant von
der Prozesstempera-
tur ab

• Fehlerhafter Widerstandsthermometer
• Verdrahtungsproblem

• Die Anschlussdose auf Feuchtigkeit und
Grünspan prüfen.

• Am Widerstandsthermometer Wider-
standsprüfungen durchführen und auf
Kurzschlüsse zum Gehäuse prüfen (siehe 
Prüfen der Sensorspulen).

• Bestätigen, dass der Temperaturkalibrier-
faktor mit dem Wert auf dem Typenschild
des Sensors übereinstimmt.

• Siehe Status-Alarme (insbesondere RTD-
Fehleralarme).

• Externe Temperaturkompensation deakti-
vieren.

• Temperaturkalibrierung prüfen.

Störungsanalyse und -behebung
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Probleme bei der Temperaturmessung und Abhilfemaßnahmen (Fortsetzung)Tabelle 16-4:   

Problem Mögliche Ursachen Empfohlene Maßnahmen

Temperaturwert
weicht gering von der
Prozesstemperatur ab

• Sensortemperatur noch nicht angeglichen
• Sensor Wärmeverlust

• Das Widerstandsthermometer hat eine
Spezifikation von ±1 °C. Wenn sich der Feh-
ler in diesem Bereich bewegt, liegt kein
Problem vor. Wenn sich die Temperatur-
messung außerhalb der Spezifikation des
Sensors befindet, Micro Motion kontaktie-
ren.

• Die Temperatur des Mediums ändert sich
möglicherweise schnell. Dem Sensor aus-
reichend Zeit geben, sich an das Prozess-
medium anzupassen.

• Den Sensor falls erforderlich isolieren.
• Am Widerstandsthermometer Wider-

standsprüfungen durchführen und auf
Kurzschlüsse zum Gehäuse prüfen (siehe 
Prüfen der Sensorspulen).

• Das Widerstandsthermometer hat mögli-
cherweise keinen guten Kontakt mit dem
Sensor. Der Sensor muss möglicherweise
ausgetauscht werden.

16.5 Probleme bei mA-Ausgängen

Probleme bei mA-Ausgängen und empfohlene MaßnahmenTabelle 16-5:   

Problem Mögliche Ursachen Empfohlene Maßnahmen

Kein mA-Ausgang • Verdrahtungsproblem
• Störung im Schaltkreis

• Die Spannungsversorgung und deren Ver-
drahtung prüfen. Siehe 
Verdrahtung der Spannungsversorgung prü-
fen.

• Die mA-Ausgangsverdrahtung überprüfen.
• Die Einstellungen für Störaktion prüfen.

Siehe mA Ausgang Störaktion prüfen.
• Gleichspannung an den Ausgangsklem-

men messen, um zu prüfen, ob der Aus-
gang aktiv ist.

• Wenden Sie sich an Micro Motion.

Messkreistest fehler-
haft

• Problem mit der Spannungsversorgung
• Verdrahtungsproblem
• Störung im Schaltkreis
• Falsche Konfiguration der internen/exter-

nen Spannungsversorgung

• Die Spannungsversorgung und deren Ver-
drahtung prüfen. Siehe 
Verdrahtung der Spannungsversorgung prü-
fen.

• Die mA-Ausgangsverdrahtung überprüfen.
• Die Einstellungen für Störaktion prüfen.

Siehe mA Ausgang Störaktion prüfen.
• Wenden Sie sich an Micro Motion.
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Probleme bei mA-Ausgängen und empfohlene Maßnahmen (Fortsetzung)Tabelle 16-5:   

Problem Mögliche Ursachen Empfohlene Maßnahmen

mA-Ausgang unter 4
mA

• Offene Verdrahtung
• Schlechter Ausgangskreis
• Prozessbedingungen unterhalb LRV
• LRV und URV sind nicht korrekt gesetzt
• Störbedingungen liegen vor, wenn die

Störaktion auf intern Null oder abwärts ste-
hen

• Schlechtes, empfangendes mA Gerät

• Überprüfen Sie Ihre Prozessbedingungen
anhand der vom Durchflussmesser gemel-
deten Werte.

• Das empfangende Gerät sowie die Ver-
drahtung zwischen Auswerteelektronik
und Core-Prozessor prüfen.

• Die Einstellungen für Messende (URV) und
Messanfang (LRV) überprüfen. Siehe 
Prüfen von Messanfang und Messende.

• Die Einstellungen für Störaktion prüfen.
Siehe mA Ausgang Störaktion prüfen.

Konstanter mA-Aus-
gang

• Falsche dem Ausgang zugewiesene Pro-
zessvariable

• Störung besteht
• Eine HART-Adresse ungleich Null (mA-Aus-

gang 1)
• Ausgang ist für den Messkreistestmodus

konfiguriert.
• Fehlerhafte Nullpunktkalibrierung

• Ausgangsvariablen-Zuordnung prüfen.
• Bestehende Alarmzustände anzeigen und

beheben.
• Überprüfen Sie, ob ein Messkreistest läuft

(der Ausgang ist fixiert).
• Bei einer fehlerhaften Nullpunktkalibrier-

ung die Spannungsversorgung zum Mess-
system aus-/einschalten und die Null-
punktkalibrierung zu wiederholen versu-
chen.

mA-Ausgang dauer-
haft außerhalb des
Bereichs

• Falsche dem Ausgang zugewiesene Pro-
zessvariable oder Einheiten

• Störbedingungen liegen vor, wenn die
Störmaßnahme auf aufwärts oder abwärts
steht

• LRV und URV sind nicht korrekt gesetzt

• Ausgangsvariablen-Zuordnung prüfen.
• Die für den Ausgang konfigurierten Mes-

seinheiten überprüfen.
• Die Einstellungen für Störaktion prüfen.

Siehe mA Ausgang Störaktion prüfen.
• Die Einstellungen für Messende (URV) und

Messanfang (LRV) überprüfen. Siehe 
Prüfen von Messanfang und Messende.

• Abgleich des mA-Ausgangs überprüfen.
Siehe mA Ausgänge abgleichen.

Konstant ungenaue
mA-Messung

• Problem im Messkreis
• Ausgang nicht richtig abgeglichen
• Falsche Durchfluss Messeinheit konfigur-

iert
• Falsche Prozessvariable konfiguriert
• LRV und URV sind nicht korrekt gesetzt

• Abgleich des mA-Ausgangs überprüfen.
Siehe mA Ausgänge abgleichen.

• Prüfen Sie, ob die Messeinheiten für Ihre
Anwendung korrekt konfiguriert sind.

• Zuordnung der Prozessvariablen zum mA-
Ausgang prüfen.

• Die Einstellungen für Messende (URV) und
Messanfang (LRV) überprüfen. Siehe 
Prüfen von Messanfang und Messende.

Korrekter mA-Aus-
gang bei niedriger
Spannung, jedoch ink-
orrekt bei höherer
Spannung

• mA-Messkreiswiderstand kann zu hoch
eingestellt sein

• Prüfen, ob die Last am mA-Ausgang 1 un-
terhalb der max. Last liegt (siehe Installa-
tionsanleitung Ihrer Auswerteelektronik).
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16.6 Probleme beim Frequenzausgang

Probleme beim Frequenzausgang und empfohlene MaßnahmenTabelle 16-6:   

Problem Mögliche Ursachen Empfohlene Maßnahmen

Kein Frequenzaus-
gang

• Zähler stoppen
• Prozessbedingungen unterhalb Abschal-

tung
• Störbedingungen liegen vor, wenn die

Störaktion auf intern Null oder abwärts
stehen

• Slug flow
• Durchfluss in umgekehrter Richtung

zum konfigurierten Parameter der
Durchflussrichtung

• Schlechtes, empfangendes Frequenz
Gerät

• Ausgangspegel nicht kompatibel zum
empfangenden Gerät

• Schlechter Ausgangskreis
• Falsche Konfiguration der internen/ex-

ternen Spannungsversorgung
• Falsche Konfiguration der Impulsbreite
• Ausgang hat keine Spannungsversor-

gung
• Verdrahtungsproblem

• Prüfen Sie, ob die Prozessbedingungen un-
terhalb der Schleichmengenabschaltung
liegen. Konfigurieren Sie die Schleichmenge-
nabschaltung gegebenenfalls neu.

• Die Einstellungen für Störaktion prüfen. Siehe 
mA Ausgang Störaktion prüfen.

• Prüfen Sie, ob die Zähler nicht gestoppt wur-
den. Durch einen gestoppten Zähler wird der
Frequenzausgang gesperrt.

• Auf Schwallströmung prüfen. Siehe 
Prüfen auf Schwallströmung (Zweiphasenströ-
mung).

• Durchflussrichtung prüfen. Siehe 
Prüfen der Durchflussrichtung.

• Das empfangende Gerät sowie die Verdrah-
tung zwischen Auswerteelektronik und Core-
Prozessor prüfen.

• Überprüfen Sie, ob der Kanal verdrahtet und
als Frequenzausgang konfiguriert ist.

• Überprüfen Sie die Spannungsversorgung für
den Frequenzausgang (intern und extern).

• Impulsbreite prüfen. Siehe 
Frequenzausgang max. Impulsbreite prüfen.

• Messkreistest durchführen Siehe 
Messkreistests durchführen.

Konstant ungenaue
Frequenzmessung

• Ausgang nicht richtig skaliert
• Falsche Durchfluss Messeinheit konfi-

guriert

• Die Skalierung des Frequenzausgangs über-
prüfen. Siehe 
Frequenzausgang Skaliermethode prüfen.

• Prüfen Sie, ob die Messeinheiten für Ihre An-
wendung korrekt konfiguriert sind.

Ungleichmäßiger Fre-
quenzausgang

• Hochfrequenzstörungen • Auf HF-Störungen prüfen. Siehe 
Prüfung auf hochfrequente Störungen (RFI).

16.7 Verwenden der Sensorsimulation zur
Störungsanalyse und -beseitigung
Bei aktivierter Sensorsimulation gibt die Auswerteelektronik benutzerdefinierte Werte für
Massedurchfluss, Temperatur und Dichte aus. Hiermit können unterschiedliche
Prozessbedingungen reproduziert bzw. das System geprüft werden.

Mit der Sensorsimulation kann zwischen tatsächlichem Prozessrauschen und extern
verursachten Varianten unterschieden werden. Sie haben beispielsweise ein
empfangendes Gerät, das einen unerwartet ungleichmäßigen Durchflusswert ausgibt.
Wenn die Sensorsimulation aktiviert ist und die gemessene Durchflussrate nicht mit dem
simulierten Wert übereinstimmt, so liegt die Ursache des Problems wahrscheinlich
zwischen Auswerteelektronik und empfangendem Gerät.
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Wichtig
Wenn die Sensorsimulation aktiviert ist, wird der simulierte Wert bei allen Ausgängen und
Berechnungen der Auswerteelektronik, einschließlich Zähler und Summen, Volumendurchfluss- und
Konzentrationsberechnungen, verwendet. Alle mit den Ausgängen der Auswerteelektronik in
Verbindung stehenden automatischen Funktionen deaktivieren und den Messkreis auf Handbetrieb
setzen. Den Simulationsmodus nur aktivieren, wenn die Anwendung diese Auswirkungen toleriert.
Sicherstellen, dass der Simulationsmodus nach den Tests wieder deaktiviert wird.

Siehe Abschnitt 2.4.1 bzgl. weiterer Informationen zur Verwendung der Sensorsimulation.

16.8 Verdrahtung der Spannungsversorgung prüfen
Wenn die Verdrahtung der Spannungsversorgung beschädigt oder falsch angeschlossen
ist, wird die Auswerteelektronik möglicherweise nicht ausreichend mit Spannung versorgt.

Vorbereitungsverfahren

Weitere Informationen sind in der Installationsanleitung der Auswerteelektronik zu finden.

Verfahren

1. Die Spannungsversorgung trennen, bevor deren Verdrahtung überprüft wird.

VORSICHT!

Befindet sich die Auswerteelektronik in einer explosionsgefährdeten Umgebung, nach
dem Trennen der Spannungsversorgung fünf Minuten warten.

2. Prüfen, ob die richtige externe Sicherung verwendet wird.

Eine falsche Sicherung kann den Strom zur Auswerteelektronik begrenzen und so
das Hochfahren verhindern.

3. Stellen Sie sicher, dass die Adern der Spannungsversorgung an den richtigen
Anschlussklemmen angeschlossen sind.

4. Prüfen Sie, ob die Adern der Spannungsversorgung guten Kontakt haben und nicht
über die Isolierung angeklemmt sind.

5. Erneut Spannung an der Auswerteelektronik anlegen.

VORSICHT!

Wenn die Auswerteelektronik in einer explosionsgefährdeten Umgebung installiert ist,
nicht erneut Spannung bei entferntem Gehäuse anlegen. Das Anlegen von Spannung an
die Auswerteelektronik bei entferntem Gehäusedeckel kann zu einer Explosion führen.

6. Prüfen Sie mit einem Spannungsmessgerät die Spannung an den
Anschlussklemmen der Auswerteelektronik.

Die Spannung muss sich innerhalb der festgelegten Grenzwerte befinden. Bei einer
DC Spannung kann eine Kabelauslegung erforderlich sein.
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16.9 Erdung überprüfen
Sensor und Auswerteelektronik müssen geerdet sein.

Vorbereitungsverfahren

Sie benötigen:

• Installationsanleitung für Ihren Sensor

• Installationsanleitung für Ihre Auswerteelektronik

Verfahren

Anforderungen und Hinweise zur Erdung finden Sie in der Installationsanleitung des
Sensors und der Auswerteelektronik.

16.10 Messkreistests durchführen
Ein Messkreistest ermöglicht die Überprüfung, ob Auswerteelektronik und externes Gerät
ordnungsgemäß kommunizieren. Ein Messkreistest hilft Ihnen ebenso bei der
Entscheidung, ob die mA Ausgänge abgeglichen werden müssen.

16.10.1 Messkreistests durchführen mittels ProLink II
Ein Messkreistest ermöglicht die Überprüfung, ob Auswerteelektronik und externes Gerät
ordnungsgemäß kommunizieren. Ein Messkreistest hilft Ihnen ebenso bei der
Entscheidung, ob die mA Ausgänge abgeglichen werden müssen.

Vorbereitungsverfahren

Bevor Sie den Messkreistest durchführen, konfigurieren Sie die Kanäle der Ein-/Ausgänge
der Auswerteelektronik, die für Ihre Anwendung konfiguriert sind.

Folgen Sie den entsprechenden Vorgehensweisen, um sicherzustellen, dass die
Messkreistests existierende Mess- und Regelkreise nicht beeinträchtigen.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Testen Sie den oder die mA Ausgänge.

a. Wählen Sie ProLink > Test > Fix Milliamp 2.

b. Geben Sie 4 mA in Set Output To ein.

c. Klicken Sie auf Fix mA.

d. Lesen Sie den mA Wert am empfangenden Gerät ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.

Die Werte müssen nicht exakt übereinstimmen. Weichen die Werte nur
geringfügig voneinander ab, können Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

e. Klicken Sie auf UnFix mA.

f. Geben Sie 20 mA in Set Output To ein.
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g. Klicken Sie auf Fix mA.

h. Lesen Sie den mA Wert am empfangenden Gerät ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.

Die Werte müssen nicht exakt übereinstimmen. Weichen die Werte nur
geringfügig voneinander ab, können Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

i. Klicken Sie auf UnFix mA.

2. Testen Sie den oder die Frequenzausgänge.

a. Wählen Sie ProLink > Test > Fix Freq Out.
b. Geben Sie den Frequenzausgangswert in Set Output To ein.

c. Klicken Sie auf Fix Frequency.

d. Lesen Sie das Frequenzsignal am empfangenden Gerät ab und vergleichen dieses
mit dem Ausgang der Auswerteelektronik.

e. Klicken Sie auf UnFix Freq.

3. Testen Sie den oder die Binärausgänge.

a. Wählen Sie ProLink > Test > Fix Discrete Output.
b. Wählen Sie On.

c. Prüfen Sie das Signal am empfangenden Gerät.

d. Wählen Sie Off.
e. Prüfen Sie das Signal am empfangenden Gerät.

f. Klicken Sie auf UnFix.

Nachbereitungsverfahren

• Weicht der mA Ausgangswert am empfangenden Gerät geringfügig vom Wert an
der Auswerteelektronik ab, können Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

• Weicht der mA Ausgangswert am empfangenden Gerät signifikant ab oder war der
Messwert bei einem Schritt fehlerhaft, prüfen Sie die Verdrahtung zwischen der
Auswerteelektronik und dem externen Gerät und wiederholen Sie den Test.

• Wird der Messwert des Binärausgangs umgekehrt angezeigt, prüfen Sie die
Einstellung der Discrete Output Polarity.

16.10.2 Messkreistests durchführen mittels ProLink III
Ein Messkreistest ermöglicht die Überprüfung, ob Auswerteelektronik und externes Gerät
ordnungsgemäß kommunizieren. Ein Messkreistest hilft Ihnen ebenso bei der
Entscheidung, ob die mA Ausgänge abgeglichen werden müssen.

Vorbereitungsverfahren

Bevor Sie den Messkreistest durchführen, konfigurieren Sie die Kanäle der Ein-/Ausgänge
der Auswerteelektronik, die für Ihre Anwendung konfiguriert sind.

Folgen Sie den entsprechenden Vorgehensweisen, um sicherzustellen, dass die
Messkreistests existierende Mess- und Regelkreise nicht beeinträchtigen.
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ProLink III muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Testen Sie den oder die mA Ausgänge.

a. Wählen Sie Device Tools > Diagnostics > Testing > mA Output 2 Test.
b. Geben Sie 4 in Fix to: ein.

c. Klicken Sie auf Fix mA.

d. Lesen Sie den mA Wert am empfangenden Gerät ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.

Die Werte müssen nicht exakt übereinstimmen. Weichen die Werte nur
geringfügig voneinander ab, können Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

e. Klicken Sie auf UnFix mA.

f. Geben Sie 20 in Fix to: ein.

g. Klicken Sie auf Fix mA.

h. Lesen Sie den mA Wert am empfangenden Gerät ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.

Die Werte müssen nicht exakt übereinstimmen. Weichen die Werte nur
geringfügig voneinander ab, können Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

i. Klicken Sie auf UnFix mA.

2. Testen Sie den oder die Frequenzausgänge.

a. Wählen Sie Device Tools > Diagnostics > Testing > Frequency Output Test.
b. Geben Sie den Frequenzausgangswert in Fix to ein.

c. Klicken Sie auf Fix FO.

d. Lesen Sie das Frequenzsignal am empfangenden Gerät ab und vergleichen dieses
mit dem Ausgang der Auswerteelektronik.

e. Klicken Sie auf UnFix FO.

3. Testen Sie den oder die Binärausgänge.

a. Wählen Sie Device Tools > Diagnostics > Testing > Discrete Output Test.
b. Setzen Sie Fix To: auf ON.

c. Prüfen Sie das Signal am empfangenden Gerät.

d. Setzen Sie Fix To: auf OFF.

e. Prüfen Sie das Signal am empfangenden Gerät.

f. Klicken Sie auf UnFix.

4. Testen Sie den Binäreingang.

a. Setzen Sie das externe Eingangsgerät auf EIN.

b. Wählen Sie Device Tools > Diagnostics > Testing > Discrete Input Test.
c. Prüfen Sie das Signal an der Auswerteelektronik.

d. Setzen Sie das externe Eingangsgerät auf AUS.
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e. Prüfen Sie das Signal an der Auswerteelektronik.

Nachbereitungsverfahren

• Weicht der mA Ausgangswert am empfangenden Gerät geringfügig vom Wert an
der Auswerteelektronik ab, können Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

• Weicht der mA Ausgangswert am empfangenden Gerät signifikant ab oder war der
Messwert bei einem Schritt fehlerhaft, prüfen Sie die Verdrahtung zwischen der
Auswerteelektronik und dem externen Gerät und wiederholen Sie den Test.

• Wird der Messwert des Binärausgangs umgekehrt angezeigt, prüfen Sie die
Einstellung der Discrete Output Polarity.

16.10.3 Messkreistests mittels Modus durchführen
Ein Messkreistest ermöglicht die Überprüfung, ob Auswerteelektronik und externes Gerät
ordnungsgemäß kommunizieren. Ein Messkreistest hilft Ihnen ebenso bei der
Entscheidung, ob die mA Ausgänge abgeglichen werden müssen.

Vorbereitungsverfahren

Bevor Sie den Messkreistest durchführen, konfigurieren Sie die Kanäle der Ein-/Ausgänge
der Auswerteelektronik, die für Ihre Anwendung konfiguriert sind.

Folgen Sie den entsprechenden Vorgehensweisen, um sicherzustellen, dass die
Messkreistests existierende Mess- und Regelkreise nicht beeinträchtigen.

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Verfahren

1. Testen des mA Ausgangs 2.

a. 4 in die Register 145-146 schreiben.

b. 1 in Spule 11 schreiben.

c. Lesen Sie den mA Wert am empfangenden Gerät ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.

Die Werte müssen nicht exakt übereinstimmen. Weichen die Werte nur
geringfügig voneinander ab, können Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

d. 20 in die Register 145-146 schreiben.

e. 1 in Spule 11 schreiben.

f. Lesen Sie den mA Wert am empfangenden Gerät ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.

Die Werte müssen nicht exakt übereinstimmen. Weichen die Werte nur
geringfügig voneinander ab, können Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

g. 0 in die Register 145-146 schreiben.

h. 1 in Spule 11 schreiben.
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2. Testen Sie den oder die Frequenzausgänge.

a. Testwert in die Register 147-148 schreiben.

b. 1 in Spule 12 schreiben.

c. Lesen Sie das Frequenzsignal am empfangenden Gerät ab und vergleichen dieses
mit dem Ausgang der Auswerteelektronik.

d. 0 in die Register 147-148 schreiben.

e. 1 in Spule 12 schreiben.

f. Register 423, Bit 2 lesen (Wert sollte 0 sein), um sicherzustellen, dass der mA
Ausgang nicht fixiert ist.

3. Testen des Binärausgangs 1.

a. 1 in Register 1182 schreiben.

b. 1 in Spule 46 schreiben.

c. Prüfen Sie das Signal am empfangenden Gerät.

Der Binärausgang ist EIN. Die tatsächliche Spannung wird durch das Setzen der
Binärausgang Polarität bestimmt.

d. 0 in Register 1182 schreiben.

e. 1 in Spule 46 schreiben.

f. Prüfen Sie das Signal am empfangenden Gerät.

Der Binärausgang ist AUS. Die tatsächliche Spannung wird durch das Setzen der
Binärausgang Polarität bestimmt.

g. 255 in Register 1182 schreiben.

h. 1 in Spule 46 schreiben.

4. Testen des Binärausgangs 1 mit hoher Genauigkeit.

a. 1 in Register 2487 schreiben.

b. 1 in Spule 405 schreiben.

c. Prüfen Sie das Signal am empfangenden Gerät.

Der Binärausgang ist EIN. Die tatsächliche Spannung wird durch das Setzen der
Polarität des Binärausgangs 1 mit hoher Genauigkeit bestimmt.

d. 0 in Register 2487 schreiben.

e. 1 in Spule 405 schreiben.

f. Prüfen Sie das Signal am empfangenden Gerät.

Der Binärausgang ist AUS. Die tatsächliche Spannung wird durch das Setzen der
Polarität des Binärausgangs 1 mit hoher Genauigkeit bestimmt.

g. 255 in Register 2487 schreiben.

h. 1 in Spule 405 schreiben.

5. Testen des Binärausgangs 2 mit hoher Genauigkeit.

a. 1 in Register 2488 schreiben.

b. 1 in Spule 406 schreiben.

c. Prüfen Sie das Signal am empfangenden Gerät.
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Der Binärausgang ist EIN. Die tatsächliche Spannung wird durch das Setzen der
Polarität des Binärausgangs 2 mit hoher Genauigkeit bestimmt.

d. 0 in Register 2488 schreiben.

e. 1 in Spule 406 schreiben.

f. Prüfen Sie das Signal am empfangenden Gerät.

Der Binärausgang ist AUS. Die tatsächliche Spannung wird durch das Setzen der
Polarität des Binärausgangs 2 mit hoher Genauigkeit bestimmt.

g. 255 in Register 2488 schreiben.

h. 1 in Spule 406 schreiben.

6. Testen des Binäreingangs 1.

a. Setzen Sie das externe Eingangsgerät auf EIN.

b. Register 424, Bit 0 lesen.

c. Setzen Sie das externe Eingangsgerät auf AUS.

d. Register 424, Bit 0 lesen.

Nachbereitungsverfahren

• Weicht der mA Ausgangswert am empfangenden Gerät geringfügig vom Wert an
der Auswerteelektronik ab, können Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

• Weicht der mA Ausgangswert am empfangenden Gerät signifikant ab oder war der
Messwert bei einem Schritt fehlerhaft, prüfen Sie die Verdrahtung zwischen der
Auswerteelektronik und dem externen Gerät und wiederholen Sie den Test.

• Wird der Messwert des Binärausgangs umgekehrt angezeigt, prüfen Sie die
Einstellung der Discrete Output Polarity.

16.11 mA Ausgänge abgleichen
Beim Abgleich eines mA Ausgangs wird der mA Ausgang der Auswerteelektronik
entsprechend des empfangenden Geräts kalibriert. Wenn die aktuellen Abgleichswerte
nicht richtig sind, wird der Ausgang durch die Auswerteelektronik über- oder
unterkompensiert.

16.11.1 Abgleichen der mA Ausgänge mittels ProLink II
Der Abgleich des mA Ausgangs erzeugt einen gemeinsamen Messkreis zwischen der
Auswerteelektronik und dem Gerät, das den mA Ausgang empfängt.

Wichtig
Der Abgleich des Ausgangs muss an beiden Punkten (4 mA und 20 mA) durchgeführt werden, um
sicherzustellen, dass eine entsprechende Kompensation über den gesamten Ausgangsbereich
erfolgt.

Vorbereitungsverfahren

Stellen Sie sicher, dass der mA Ausgang mit dem empfangenden Gerät verdrahtet ist, das
bei der Produktion verwendet wird.
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Verfahren

1. Wählen Sie ProLink > Calibration > Milliamp 2 Trim .

2. Folgen Sie den Anweisungen der geführten Methode.

3. Prüfen Sie die Abgleichswerte und wenden Sie sich an den Micro Motion
Kundenservice, wenn ein Wert kleiner als −200 Mikroampere oder größer als
+200 Mikroampere ist.

16.11.2 Abgleichen der mA Ausgänge mittels ProLink III
Der Abgleich des mA Ausgangs erzeugt einen gemeinsamen Messkreis zwischen der
Auswerteelektronik und dem Gerät, das den mA Ausgang empfängt.

Wichtig
Der Abgleich des Ausgangs muss an beiden Punkten (4 mA und 20 mA) durchgeführt werden, um
sicherzustellen, dass eine entsprechende Kompensation über den gesamten Ausgangsbereich
erfolgt.

Vorbereitungsverfahren

Stellen Sie sicher, dass der mA Ausgang mit dem empfangenden Gerät verdrahtet ist, das
bei der Produktion verwendet wird.

Verfahren

1. Wählen Sie Device Tools > Calibration > MA Output Trim > mA Output 2 Trim.

2. Folgen Sie den Anweisungen der geführten Methode.

3. Prüfen Sie die Abgleichswerte und wenden Sie sich an den Micro Motion
Kundenservice, wenn ein Wert kleiner als −200 Mikroampere oder größer als
+200 Mikroampere ist.

16.11.3 Abgleichen der mA Ausgänge mittels Modbus
Der Abgleich des mA Ausgangs erzeugt einen gemeinsamen Messkreis zwischen der
Auswerteelektronik und dem Gerät, das den mA Ausgang empfängt.

Wichtig
Der Abgleich des Ausgangs muss an beiden Punkten (4 mA und 20 mA) durchgeführt werden, um
sicherzustellen, dass eine entsprechende Kompensation über den gesamten Ausgangsbereich
erfolgt.

Vorbereitungsverfahren

Stellen Sie sicher, dass der mA Ausgang mit dem empfangenden Gerät verdrahtet ist, das
bei der Produktion verwendet wird.

Sie benötigen ein Modbus Hilfsprogramm oder Tool, mit dem Sie die Auswerteelektronik
lesen bzw. beschreiben können, und eine aktive Modbus Verbindung.

Verfahren

1. mA Ausgang 2 bei 4 mA abgleichen.
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a. 4 in die Register 145-146 schreiben.

b. 1 in Spule 11 schreiben.

c. Ausgangspegel am externen Gerät ablesen.

d. Den Ausgangspegel des vorigen Schritts in die Register 145-146 schreiben.

e. 1 in Spule 8 schreiben.

f. Ausgangspegel am externen Gerät ablesen.

g. Wenn der Ausgang der Auswerteelektronik dicht genug am Ausgang des
externen Gerätes liegt, 0 in die Register 145-146 und danach 1 in Spule 11
schreiben. Mit dem Abgleich bei 20 mA fortfahren.

h. Wenn der Ausgang der Auswerteelektronik nicht dicht genug am Ausgang des
externen Gerätes liegt, Teilschritte c bis f ausführen.

2. mA Ausgang 2 bei 20 mA abgleichen.

a. 1 in Spule 11 schreiben.

b. Ausgangspegel am externen Gerät ablesen.

c. Den Ausgangspegel des vorigen Schritts in die Register 145-146 schreiben.

d. 1 in Spule 9 schreiben.

e. Ausgangspegel am externen Gerät ablesen.

f. Wenn der Ausgang der Auswerteelektronik dicht genug am Ausgang des
externen Gerätes liegt, 0 in die Register 145-146 und danach 1 in Spule 11
schreiben. Der Abgleich ist abgeschlossen.

g. Wenn der Ausgang der Auswerteelektronik nicht dicht genug am Ausgang des
externen Gerätes liegt, Teilschritte c bis f ausführen.

3. Die Abgleichswerte prüfen.

mA Ausgang Abgleich durchgeführt bei
Zu lesende Modbus Regis-
ter

mA Ausgang 2 Messanfang (4 mA) 1193-1194

Messende (20 mA) 1195-1196

4. Wenn ein Abgleichswert niedriger als −200 Mikroampere oder höher als
+200 Mikroampere liegt, Kontakt mit dem Kundenservice von Micro Motion
aufnehmen.

16.12 Prüfen von Messanfang und Messende
Wenn die Prozessbedingungen unter den konfigurierten Lower Range Value (LRV) fallen oder
über den konfigurierten Upper Range Value (URV) steigen, können unerwartete Werte über
die Ausgänge der Auswertelektronik ausgegeben werden.

1. Bewerten Sie die aktuellen Prozessbedingungen.

2. Prüfen Sie die Konfiguration von LRV und URV.
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16.13 mA Ausgang Störaktion prüfen
Die mA Ausgang Störaktion steuert das Verhalten des mA Ausgangs, wenn die
Auswerteelektronik eine interne Störbedingung erkennt. Wenn der mA Ausgang einen
konstanten Wert unter 4 mA oder über 20 mA ausgibt, weist die Auswerteelektronik
möglicherweise eine Störbedingung auf.

1. In diesem Fall die Statusalarme auf aktive Störbedingungen prüfen.

2. Wenn keine aktiven Störbedingungen vorhanden sind, funktioniert die
Auswerteelektronik ordnungsgemäß. Wenn Sie das Verhalten des
Frequenzausgangs ändern möchten, haben Sie folgende Möglichkeiten:

• Ändern Sie die Einstellung der mA Ausgang Störaktion.

• Ändern Sie für die relevanten Statusalarme die Einstellung Alarmstufe auf Ignorieren.

3. Wenn keine aktiven Störbedingungen vorhanden sind, setzen Sie die
Störungsanalyse und -beseitigung fort.

16.14 Prüfung auf hochfrequente Störungen (RFI)
Der Frequenzausgang bzw. der Binärausgang der Auswerteelektronik kann durch
hochfrequente Störungen (RFI) beeinflusst werden. Mögliche RFI-Quellen sind Sender von
Funkemissionen bzw. große Transformatoren, Pumpen oder Motoren, die ein starkes
elektromagnetisches Feld erzeugen können. Es gibt mehrere Methoden zur Reduzierung
hochfrequenter Störungen. Verwenden Sie eine oder mehrere der folgenden
Empfehlungen entsprechend der jeweiligen Installation.

Verfahren

• Hochfrequente Störquelle eliminieren.

• Auswerteelektronik versetzen.

• Abgeschirmte Kabel für den Frequenz- bzw. Binärausgang verwenden.

- Kabelschirm am Ausgangsgerät auflegen. Ist dies nicht möglich, den Schirm an
der Kabelverschraubung oder der Kabelschutzrohrverschraubung auflegen.

- Den Schirm nicht im Inneren des Anschlussraumes auflegen.

- Ein 360° Schirmabschluss ist nicht erforderlich.

16.15 Frequenzausgang max. Impulsbreite prüfen
Wenn die Frequenzausgang max. Impulsbreite falsch eingestellt ist, kann der Frequenzausgang
einen falschen Wert ausgeben.

Prüfen Sie die Konfiguration der Frequenzausgang max. Impulsbreite.

Für die meisten Anwendungen ist der für Frequenzausgang max. Impulsbreite voreingestellte
Wert geeignet. Dieser Wert entspricht einem Impuls/Pause-Verhältnis von 50 %.

Störungsanalyse und -behebung
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16.16 Frequenzausgang Skaliermethode prüfen
Wenn die Frequenzausgang Skaliermethode falsch eingestellt ist, kann der Frequenzausgang
einen falschen Wert ausgeben.

1. Prüfen Sie die Konfiguration von Frequenzausgang Skaliermethode.

2. Wenn Sie die Einstellung für Frequenzausgang Skaliermethode geändert haben, prüfen
Sie alle anderen Parameter des Frequenzausgangs.

16.17 Frequenzausgang Störaktion prüfen
Die Frequenzausgang Störaktion steuert das Verhalten des Frequenzausgangs, wenn die
Auswerteelektronik eine interne Störbedingung erkennt. Wenn der Frequenzausgang
einen konstanten Wert ausgibt, liegt möglicherweise eine Störbedingung der
Auswerteelektronik vor.

1. In diesem Fall die Statusalarme auf aktive Störbedingungen prüfen.

2. Wenn keine aktiven Störbedingungen vorhanden sind, funktioniert die
Auswerteelektronik ordnungsgemäß. Wenn Sie das Verhalten des
Frequenzausgangs ändern möchten, haben Sie folgende Möglichkeiten:

• Ändern der Einstellung Frequenzausgang Störaktion.

• Ändern Sie für die relevanten Statusalarme die Einstellung Alarmstufe auf Ignorieren.

3. Wenn keine aktiven Störbedingungen vorhanden sind, setzen Sie die
Störungsanalyse und -beseitigung fort.

16.18 Prüfen der Durchflussrichtung
Wenn die Durchflussrichtung für Ihren Prozess nicht korrekt eingestellt ist, zeigt die
Auswerteelektronik möglicherweise unerwartete Durchflusswerte oder Zähler an.
Der Parameter Durchflussrichtung interagiert mit der eigentlichen Durchflussrichtung und
hat somit Auswirkungen auf Durchflusswerte, Durchflusszähler und -summen und das
Ausgangsverhalten. Der einfachste Betrieb wird erreicht, indem der eigentliche
Prozessfluss mit dem Richtungspfeil für den Durchfluss auf der Seite des Sensorgehäuses
übereinstimmt.

Verfahren

1. Die eigentliche Durchflussrichtung des Prozessflusses durch den Sensor überprüfen.

2. Die Konfiguration der Durchflussrichtung prüfen.

16.19 Prüfen der Abschaltungen
Wenn die Abschaltungen der Auswerteelektronik falsch konfiguriert sind, kann die
Auswerteelektronik bei vorhandenem Durchfluss oder bei sehr geringen
Durchflussmengen einen Null Durchfluss ausgeben.

Störungsanalyse und -behebung
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Es gibt separate Abschaltparameter für Massedurchfluss, Volumendurchfluss, Standard-
Gasvolumen-Durchfluss (falls zutreffend) und Dichte. Für jeden mA-Ausgang an der
Auswerteelektronik gibt es eine separate Abschaltung. Die Wechselwirkung zwischen den
Abschaltungen kann zu unerwarteten Ergebnissen führen.

Verfahren

Die Konfiguration der Abschaltungen überprüfen.

Hinweis
Bei typischen Anwendungen empfiehlt Micro Motion, Mass Flow Cutoff auf den
Nullpunktstabilitätswert des Sensors multipliziert mit 10 einzustellen. Nullpunktstabilitätswerte sind
im Produktdatenblatt des Sensors zu finden.

16.20 Prüfen auf Schwallströmung
(Zweiphasenströmung)
Schwallströmung (Zweiphasenströmung, Gaseinschlüsse) kann zu Spitzenwerten bei der
Antriebsverstärkung führen. Dies kann dazu führen, dass die Auswerteelektronik Null
Durchfluss oder mehrere unterschiedliche Alarme meldet.

1. Auf durch Schwallströmung ausgelöste Alarme prüfen.

Wenn die Auswerteelektronik keine Schwallstromalarme erzeugt, ist
Schwallströmung nicht die Ursache des Problems.

2. Prozess auf Kavitation, Dampfbildung oder Leckagen prüfen.

3. Die Dichte des Prozessmediumausgangs unter normalen Prozessbedingungen
überwachen.

4. Die Einstellungen für Slug Low Limit, Slug High Limit und Slug Duration prüfen.

Hinweis
Das Auftreten von Schwallstromalarmen kann durch die Einstellung von Slug Low Limit auf
einen niedrigeren Wert, Slug High Limit auf einen höheren oder Slug Duration auf einen höheren
Wert reduziert werden.

16.21 Antriebsverstärkung prüfen
Übermäßige oder fehlerhafte Antriebsverstärkung kann auf vielfältige
Prozessbedingungen, Sensor- oder Konfigurationsprobleme hindeuten.

Um herauszufinden, ob die Antriebsverstärkung zu hoch oder fehlerhaft ist, müssen Daten
in der Problemsituation gesammelt und mit den Daten der Antriebsverstärkung unter
normalen Betriebsbedingungen verglichen werden.

Störungsanalyse und -behebung

226  Micro Motion® Masse Abfüll-Auswerteelektronik mit Modbus



Übermäßige (gesättigte) Antriebsverstärkung

Mögliche Ursachen und Abhilfemaßnahmen bei übermäßiger
(gesättigter) Antriebsverstärkung

Tabelle 16-7:   

Mögliche Ursache Empfohlene Maßnahmen

Schwallströmung Auf Schwallströmung prüfen. Siehe Abschnitt 16.20.

Teilweise gefülltes Durch-
flussrohr

Prozessbedingungen so korrigieren, dass die Durchflussrohre ge-
füllt sind.

Verstopfte Messrohre Aufnehmerspannungen prüfen (siehe Abschnitt 16.22). Ist eine der
Spannungen fast null (aber keine null), können verstopfte Rohre
die Ursache des Problems sein. Rohre spülen. In Extremfällen kann
es sein, dass der Sensor ersetzt werden muss.

Kavitation, Dampfbildung
oder Lufteinschluss; Abschei-
den von Zwei- oder Dreis-
tromflüssigkeiten

• Den einlaufseitigen oder auslaufseitigen Druck am Sensor er-
höhen.

• Befindet sich einlaufseitig vor dem Sensor eine Pumpe, den Ab-
stand zwischen Pumpe und Sensor vergrößern.

• Der Sensor muss möglicherweise neu ausgerichtet werden.
Weitere Informationen bzgl. der Sensorausrichtung sind im In-
stallationshandbuch zu finden.

Störung in Antriebsplatine
oder Modul

Kontaktieren Sie .

Messrohr verbogen Aufnehmerspannungen prüfen (siehe Abschnitt 16.20). Ist eine der
Spannungen fast null (aber keine null), sind die Messrohre mögli-
cherweise verbogen. Der Sensor muss ausgetauscht werden.

Messrohr gerissen Sensor austauschen.

Sensorunwucht Kontaktieren Sie Micro Motion.

Mechanische Verbindung am
Sensor

Stellen Sie sicher, dass der Sensor frei schwingen kann.

Offene Antriebs- oder Auf-
nehmerspule links

Kontaktieren Sie Micro Motion.

Durchfluss außerhalb des Be-
reichs

Stellen Sie sicher, dass der Durchfluss innerhalb der Sensorgrenzen
liegt.

Falsche Sensor-Charakteri-
sierung

Charakterisierungsparameter prüfen.

Sprunghafte Antriebsverstärkung

Mögliche Ursachen und Abhilfemaßnahmen bei fehlerhafter
Antriebsverstärkung

Tabelle 16-8:   

Mögliche Ursache Empfohlene Maßnahmen

Falsche K1-Charakterisierungskonstante für
den Sensor

Charakterisierungsparameter K1 prüfen.

Polarität der Aufnehmer- oder Antriebsspule
vertauscht

Kontaktieren Sie Micro Motion.

Schwallströmung Auf Schwallströmung prüfen. Siehe 
Abschnitt 16.20.
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Mögliche Ursachen und Abhilfemaßnahmen bei fehlerhafter
Antriebsverstärkung (Fortsetzung)

Tabelle 16-8:   

Mögliche Ursache Empfohlene Maßnahmen

Fremdkörper in den Messrohren • Messrohre spülen.
• Sensor austauschen.

16.21.1 Daten der Antriebsverstärkung sammeln

ProLink II ProLink > Diagnostic Information

ProLink III Device Tools > Diagnostics > Core Processor Diagnostics

Modbus Registers 291-292

Überblick

Daten der Antriebsverstärkung können für die Diagnose einer Reihe von Prozess- und
Gerätebedingungen verwendet werden. Die Daten der Antriebsverstärkung können für
eine Zeitspanne während des normalen Betriebs gesammelt und als Referenz zur
Störungsanalyse/-beseitigung verwendet werden.

Verfahren

1. Zu den Daten der Antriebsverstärkung navigieren.

2. Die Daten der Antriebsverstärkung über eine bestimmte Zeitspanne und unter
verschiedenen Prozessbedingungen beobachten und aufzeichnen.

16.22 Aufnehmerspannung prüfen
Wenn die Aufnehmerspannungswerte ungewöhnlich niedrig sind, ist es möglich, dass eine
von vielen möglichen Störungen im Prozess oder bei der Ausrüstung aufgetreten sind.

Um zu erfahren, ob die Aufnehmerspannung ungewöhnlich niedrig ist, müssen
Aufnehmerspannungsdaten gesammelt werden, während die Störung vorherrscht, und
diese Daten dann mit Daten der Aufnehmerspannung während des normalen Betriebs
verglichen werden.

Mögliche Ursachen und empfohlene Maßnahmen für eine niedrige
Aufnehmerspannung

Tabelle 16-9:   

Mögliche Ursache Empfohlene Maßnahmen

Lufteinschlüsse • Den einlaufseitigen oder auslaufseitigen Druck am Sensor
erhöhen.

• Befindet sich einlaufseitig vor dem Sensor eine Pumpe, den
Abstand zwischen Pumpe und Sensor vergrößern.

• Der Sensor muss möglicherweise neu ausgerichtet werden.
Weitere Informationen bzgl. der Sensorausrichtung sind im
Installationshandbuch zu finden.

Störungsanalyse und -behebung
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Mögliche Ursachen und empfohlene Maßnahmen für eine niedrige
Aufnehmerspannung (Fortsetzung)

Tabelle 16-9:   

Mögliche Ursache Empfohlene Maßnahmen

Fehlerhafte Verdrahtung zwi-
schen Sensor und Auswerteelek-
tronik

Verdrahtung zwischen Sensor und Auswerteelektronik prüfen.

Der Durchfluss befindet sich
außerhalb der Sensorgrenz-
werte.

Stellen Sie sicher, dass der Durchfluss nicht außerhalb des Sen-
sor-Messbereichs liegt.

Schwallströmung Auf Schwallströmung prüfen. Siehe Abschnitt 16.20.

Keine Schwingung der Sensor
Messrohre

• Auf verstopfte Messrohre prüfen.
• Stellen Sie sicher, dass der Sensor frei schwingen kann

(keine mechanische Verbindungen).
• Verdrahtung prüfen.

Feuchtigkeit in der Sensorelek-
tronik

Beseitigen Sie die Feuchtigkeit in der Sensorelektronik.

Der Sensor ist beschädigt oder
die Sensormagnete haben sich
entmagnetisiert.

Sensor austauschen.

16.22.1 Aufnehmer Spannungsdaten sammeln

ProLink II ProLink > Diagnostic Information

ProLink III Device Tools > Diagnostics > Core Processor Diagnostics

Modbus Left pickoff voltage: Registers 287-288

Right pickoff voltage: Registers 289-290

Überblick

Die Aufnehmer Spannungsdaten können zur Diagnose einer Vielzahl von Prozess- und
Gerätebedingungen verwendet werden. Die Aufnehmer Spannungsdaten können für eine
Zeitspanne während des normalen Betriebs gesammelt und als Referenz zur
Störungsanalyse/-beseitigung verwendet werden.

Verfahren

1. Die Aufnehmer Spannungsdaten aufrufen.

2. Die Daten für den linken und für den rechten Aufnehmer für einen bestimmte
Zeitspanne und unter verschiedenen Prozessbedingungen beobachten und
aufzeichnen.

16.23 Prüfen auf elektrische Kurzschlüsse
Kurzschlüsse zwischen Sensor Anschlussklemmen oder Sensor Anschlussklemmen und
dem Sensorgehäuse können einen Ausfall des Sensors bewirken.

Störungsanalyse und -behebung
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Mögliche Ursachen und empfohlene Maßnahmen bei elektrischen
Kurzschlüssen

Tabelle 16-10:   

Mögliche Ursache Empfohlene Maßnahme

Feuchtigkeit im Innern der Ans-
chlussdose

Sicherstellen, dass die Anschlussdose trocken und ohne Kor-
rosion ist.

Flüssigkeit oder Feuchtigkeit im
Sensorgehäuse

Micro Motion kontaktieren.

Kurzschluss in interner Durchfüh-
rung

Micro Motion kontaktieren.

Fehlerhaftes Kabel Das Kabel austauschen.

Unsachgemäße Kabelanschlüsse Kabelanschlüsse in der Sensor Anschlussdose prüfen. Das
Micro Motion Dokument mit dem Titel Kabelvorbereitung und
Installationsanleitung für 9-adrige Durchfluss-Messsysteme kann
hierbei möglicherweise hilfreich sein.

Störungsanalyse und -behebung
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Anhang A
Voreingestellte Werte und Bereiche

A.1 Voreingestellte Werte und Bereiche
Die Standardwerte und -bereiche repräsentieren die typische Auswerteelektronik-
Konfiguration. Je nach Bestellung der Auswerteelektronik sind bestimmte Werte vom
Hersteller konfiguriert und entsprechen nicht den Standardwerten und -bereichen. Diese
Werte gelten auch für Abfüllanwendungen mit externer Ventilsteuerung. Siehe 
Abschnitt 4.2.1 bzgl. Standardwerte für Abfüllungen mit integrierter Ventilsteuerung

Voreingestellte Werte und Bereiche der AuswerteelektronikTabelle A-1:   

Typ Parameter Standard Bereich Bemerkungen

Durchfluss Fließrichtung Vorwärts

Durchflussdämpfung 0,04 s 0,0 – 40,96 s Vom Anwender eingegebener
Wert, korrigiert auf den nächst
niedrigeren vorkonfigurierten
Wert in der Liste. Micro Motion
empfiehlt für Abfüllanwendun-
gen den Standardwert.

Massedurchfluss-Messeinheiten g/s

Massedurchflussabschaltung 0,0 g/s Empfohlene Einstellung ist 5 %
des max. Durchflusses vom Sen-
sor.

Volumendurchfluss-Messein-
heiten

l/s

Volumendurchflussabschaltung 0/0 l/s 0,0 – x L/s x erhalten Sie durch die Multipli-
kation des Durchflusskalibrier-
faktors mit 0,2, bei Verwendung
der Einheit L/s.

Messgeräte-
faktoren

Massefaktor 1

Dichtefaktor 1

Volumenfaktor 1

Dichte Dichtedämpfung 1,28 s 0,0 – 40,96 s Vom Anwender eingegebener
Wert, korrigiert auf den nächs-
ten vorkonfigurierten Wert in
der Liste.

Dichteeinheiten g/cm3

Dichteabschaltung 0,2 g/cm3 0,0 – 0,5
g/cm3

D1 0

D2 1

Voreingestellte Werte und Bereiche
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Voreingestellte Werte und Bereiche der Auswerteelektronik (Fortsetzung)Tabelle A-1:   

Typ Parameter Standard Bereich Bemerkungen

K1 1000

K2 50.000,00

FD 0

Temp.-koeffizient 4,44

Schwallströ-
mung

Unterer Schwallstrom-Grenz-
wert

0,0 g/cm3 0,0 – 10,0
g/cm3

Oberer Schwallstrom-Grenzwert 5,0 g/cm3 0,0 – 10,0
g/cm3

Schwallstromdauer 0,0 s 0,0 – 60,0 s

Temperatur Temperaturdämpfung 4,8 s 0,0 – 38,4 s Vom Anwender eingegebener
Wert, korrigiert auf den nächst
niedrigeren vorkonfigurierten
Wert in der Liste.

Temperatureinheiten Grad C

Temperaturkalibrierfaktor 1.00000T0.00
00

Druck Druckeinheiten PSI

Durchflussfaktor 0

Dichtefaktor 0

Kalibrierter Druck 0

Spezialeinheit-
en (1)

Basis-Masseeinheit g

Basis Massezeit s

Massedurchfluss-Umrechnungs-
faktor

1

Basis-Volumeneinheit l

Basis-Volumenzeit s

Volumendurchfluss-Umrech-
nungsfaktor

1

mA-Ausgang Sekundärvariable Massedurch-
fluss

Messanfang -200,00000 g/s

Messende 200,00000 g/s

Analogausgangsabschaltung 0,00000 g/s

AO (Analogausgang) zusätzliche
Dämpfung

0,00000 s

USG -200 g/s Schreibgeschützt.

USG und OSG werden auf Basis
der Sensorgröße und Charakteri-
sierungsparameter berechnet.

OSG 200 g/s

Min. Spanne 0,3 g/s Schreibgeschützt

(1) Von PROFIBUS-DP nicht unterstützt.
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Voreingestellte Werte und Bereiche der Auswerteelektronik (Fortsetzung)Tabelle A-1:   

Typ Parameter Standard Bereich Bemerkungen

Fehlermaßnahme Herunterskalie-
ren

Analogausgang-Störpegel – Her-
unterskalieren

2,0 mA 0,0 – 3,6 mA

Analogausgang-Störpegel – Her-
aufskalieren

22 mA 21,0 – 24,0 mA

Zuletzt gemessener Wert vor
Timeout

0,00 s

Messanfang Massedurchflussrate -200,000 g/s

Volumendurchflussrate -0,200 L/s

Dichte 0,000 g/cm3

Temperatur -240,000 ℃

Antriebsverstärkung 0,000 %

Standard-Gas-Volumendurch-
fluss

-423,78 SCFM

Externe Temperatur -240,000 ℃

Externer Druck 0,000 psi

Messende Massedurchflussrate 200,000 g/s

Volumendurchflussrate 0,200 l/s

Dichte 10,000 g/cm3

Temperatur 450,000 ℃

Antriebsverstärkung 100,000 %

Standard-Gas-Volumendurch-
fluss

423,78 SCFM

Externe Temperatur 450,000 ℃

Externer Druck 100,000 psi

Frequenzaus-
gang

Tertiärvariable Massedurch-
fluss

Frequenzfaktor 1.000,00 Hz 0,00091 –
10.000,00 Hz

Durchflussfaktor 16.666,66992
g/s

Frequenz-Impulsbreite 0 (50 % Puls/
Pause-Verhält-
nis)

0,01 – 655,35
ms

Skaliermethode Frequenz =
Durchfluss

Frequenz-Fehlermaßnahme Herunterskalie-
ren

Frequenz-Störpegel – Herauf-
skalieren

15.000 Hz 10,0 – 15.000
Hz

Frequenzausgangs-Polarität Active high
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Voreingestellte Werte und Bereiche der Auswerteelektronik (Fortsetzung)Tabelle A-1:   

Typ Parameter Standard Bereich Bemerkungen

Zuletzt gemessener Wert vor
Timeout

0,0 s 0,0 – 60,0 s

Binärausgang Zuweisung Störung

Fehleranzeige Keine

Spannungsversorgung Intern

Polarität Aktiv hoch

Binäreingang Zuweisung Keine

Polarität Aktiv niedrig

Voreingestellte Werte und Bereiche
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Anhang B
Verwendung mit der Auswerteelektronik

In diesem Anhang behandelte Themen:

• Grundlegende Informationen über das ProLink II

• Menüstruktur für ProLink II

B.1 Grundlegende Informationen über das
ProLink II
ProLink II ist ein Softwaretool von Micro Motion. Es läuft auf Windows und ermöglicht den
Zugriff auf alle Daten und Funktionen der Auswerteelektronik.

ProLink II Anforderungen

Die Auswerteelektronik erfordert mindestens ProLink II v2.91.

Zur Installation von ProLink II brauchen Sie:

• Das ProLink II Installationsmedium

• Das ProLink II Installationskit für Ihre Anschlussart

ProLink II sowie das passende Installationskit erhalten Sie von Micro Motion.

ProLink II Dokumentation

Die meisten Anweisungen in dieser Betriebsanleitung setzen voraus, dass Sie bereits mit
ProLink II vertraut sind oder sich mit Windows-Programmen auskennen. Wenn Sie mehr
Informationen brauchen, als Sie in dieser Betriebsanweisung finden, schlagen Sie im
Handbuch ProLink II (ProLink® II Software für Micro Motion® Auswerteelektroniken:
Installations- und Betriebsanleitung) nach.

Für die meisten ProLink II Installationen wird die Betriebsanleitung zusammen mit dem
ProLink II Programm installiert. Darüber hinaus finden die Betriebsanleitung für ProLink II
auf der Micro Motion Dokumentations-CD oder der Micro Motion Website
(www.micromotion.com).

ProLink II Merkmale und Funktionen

ProLink II bietet alle Funktionen zur Konfiguration und zum Betrieb der
Auswerteelektronik. ProLink II bietet außerdem eine Reihe zusätzlicher Merkmale und
Funktionen, einschließlich:

• Der Möglichkeit, die Auswerteelektronik-Konfigurationsdaten auf einer Datei auf
dem PC zu speichern und sie auf andere Auswerteelektroniken zu laden oder zu
kopieren

• Die Möglichkeit, spezifische Datentypen in einer Datei auf dem PC zu protokollieren

• Ein Inbetriebnahme-Wizard

• Ein Prüfungs-Wizard

• Ein Gas-Wizard

Verwendung mit der Auswerteelektronik
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Diese Funktionen werden in der ProLink II Betriebsanleitung beschrieben. Sie werden nicht
im aktuellen Handbuch beschrieben.

ProLink II Meldungen

Wenn Sie ProLink II mit einer Micro Motion Auswerteelektronik verwenden, sehen Sie eine
Reihe von Meldungen und Hinweisen. Diese Betriebsanleitung beschreibt nicht alle dieser
Meldungen und Hinweise.

Wichtig
Der Benutzer ist für die Reaktion auf Meldungen und Hinweise und die Befolgung aller
Sicherheitshinweise verantwortlich.

B.2 Menüstruktur für ProLink II

HauptmenüAbbildung B-1:   

File

Preferences
· Use External Temperature
· Enable Inventory Totals Reset
· Enable External Pressure Compensation
· Copper RTD

Installed options

Data LoggingLoad from Xmtr to File
Send to Xmtr from File

License

Connect to Device
Connect to Densitometer/ Viscometer
Disconnect

View Connection

Options
· ProLink II Language
· Error Log On

Tools Plug-insProLink

Configuration
Output Levels
Process Variables
Status
Alarm Log
Diagnostic Information
Calibration
Test
Totalizer Control
Core Processor Diagnostics
Batcher Control
Run Filler

Calibration
· Zero Calibration
· Milliamp 2 Trim
· Density Cal – Point 1
· Density Cal – Point 2
· Density Cal – Flowing Density
· Density Cal – Point 3
· Density Cal – Point 4
· Temp Offset Cal

Test
· Fix Freq Output
· Fix Milliamp 2
· Fix Discrete Output
· Read Discrete Input

See Fill Operation menu map.
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Abfüll KonfigurationsmenüAbbildung B-2:   

Filling

Flow Source

Filling Control Options
· Enable Filling Option
· Count Up
· Enable Dual Fill
· Enable AOC
· Enable Purge
· Enable Timed Fill
· Enable Fill Logging
· AOC Change Limit
· AOC Convergence Rate
· Fill Type
· Configure By
· Fill Target
· Max Fill Time
· Purge Mode
· Target Time
· Measured Fill Time
· Pump to Valve Delay
· Purge Delay
· Purge Time
· AOC Algorithm
· AOC Window Length
· Fixed Overshoot Comp

Discrete Valves for 2 Stage Filling
· Open Primary
· Open Secondary
· Close Primary
· Close Secondary

Discrete Output

Discrete Output 1
· DO1 Assignment
· DO1 Polarity
· DO1 Fault Action

Precision Discrete Outputs
· Precision DO1
· Precision DO2
· Precision DO1 Polarity 
· Precision DO2 Polarity

Configuration

ProLink Menu

Verwendung mit der Auswerteelektronik
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Abfüll BetriebsmenüAbbildung B-3:   

Filling

Fill Setup
· Current Total
· Percent Fill
· Current Target
· Reset Fill Total
· AOC Coeff
· Secondary AOC Coeff
· Target Time

Fill Control
· Begin Filling
· Pause Filling
· Resume Filling
· End Filling
· Begin Purge
· End Purge
· Begin Cleaning
· End Cleaning

AOC Calibration
· Start AOC Cal
· Save AOC Cal
· Override Blocked Start
· Reset AOC Flow Rate
· Start Sec AOC Cal
· Save Sec AOC Cal

Fill Statistics

Fill Data

Fill Status

ProLink

Configuration
Output Levels
Process Variables
Status
Alarm Log
Diagnostic Information
Calibration
Test
Totalizer Control
Core Processor Diagnostics
Batcher Control
Run Filler

· Fill Total Average
· Fill Total Variance
· Secondary Fill Total Average
· Secondary Fill Total Variance
· Reset Fill Statistics

· Max Fill Time Exceeded
· Filling In Progress
· Secondary Fill In Progress
· Cleaning In Progress
· Purge In Progress
· Purge Delay Phase
· Primary Valve
· Secondary Valve
· Pump
· Purge Valve
· AOC Flow Rate Too High
· AOC Calibration Active
· Start Not Okay

· Fill Time
· Fill Count
· Reset Fill Count

Verwendung mit der Auswerteelektronik
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KonfigurationsmenüAbbildung B-4:   

Configuration

ProLink Menu

Flow

· Flow Direction
· Flow Damp
· Flow Cal
· Mass Flow Cutoff
· Mass Flow Units
· Vol Flow Cutoff
· Vol Flow Units
· Mass Factor
· Dens Factor
· Vol Factor

Density

· Density Units
· Density Damping
· Slug High Limit
· Slug Low Limit
· Slug Duration
· Low Density Cutoff
· K1
· K2
· FD
· D1
· D2
· Temp Coeff (DT)

Temperature

· Temp Units
· Temp Cal Factor
· Temp Damping
· External Temperature

Pressure

· Flow Factor
· Dens Factor
· Cal Pressure
· Pressure Units
· External Pressure

Sensor

· Sensor s/n
· Sensor Model
· Sensor Matl
· Liner Matl
· Flange

Special Units

· Base Mass Unit
· Base Mass Time
· Mass Flow Conv Fact
· Mass Flow Text
· Mass Total Text
· Base Vol Unit
· Base Vol Time
· Vol Flow Conv Fact
· Vol Flow Text
· Vol Total Text

T Series

· FTG
· FFQ
· DTG
· DFQ1
· DFQ2
· K3
· D3
· D4
· K4

Analog Output

· Secondary Variable 
is

· Lower Range Value
· Upper Range Value
· AO Cutoff
· AO Added Damp
· Lower Sensor Limit
· Upper Sensor Limit
· Min Span
· AO Fault Action
· AO Fault Level
· Last Measured 

Value Timeout

Verwendung mit der Auswerteelektronik
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Konfigurationsmenü (Fortsetzung)Abbildung B-5:   

Device

· Model 
· Hardware Rev
· Software Rev
· Option Board
· Manufacturer
· Distributor
· ETO
· Tag
· Date
· Descriptor
· Message
· Sensor Type
· Transmitter Serial
· Floating Pt Ordering
· Add Comm Resp Delay

Digital Comm Settings
· Digital Comm Fault Setting
· Device ID
· Modbus Address
· Response Time

Discrete Events

· Event Name
· Event Type
· Process Variable 
· Low Setpoint
· High Setpoint

Channel

Channel B
· Type Assignment

Alarm

· Alarm 
· Severity

Sensor Simulation

· Enable Simulation 
Mode

· Mass Flow
· Density
· Temperature

Discrete Input

Assignment
· Reset Mass Total
· Reset Volume Total
· Reset All Totals
· Begin Fill
· End Fill
· Resume Fill
· Pause Fill

Polarity

Frequency

· Tertiary Variable
· Freq Factor
· Rate Factor
· Freq Pulse Width
· Last Measured Value 

Timeout
· Scaling Method
· Freq Fault Action
· Freq Output Polarity

Configuration

ProLink Menu

Verwendung mit der Auswerteelektronik
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Standard
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mit ProLink II   38
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B
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Konfigurieren
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mittels ProLink II   51
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unter Verwendung von Modbus   219

unter Verwendung von ProLink II   216

unter Verwendung von ProLink III   217
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Charakterisierung
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mittels ProLink II   63
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discrete inputs   174
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enhanced   177
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D
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interaction between Added Damping and process
variable damping   164

on mA outputs   163

Datum   156

Deskriptor   155
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Messkreistest

unter Verwendung von Modbus   219

unter Verwendung von ProLink II   216

unter Verwendung von ProLink III   217

Sensorsimulation   9
Dichtefaktor, siehe Druckkompensation
Dichtekalibrierung, siehe Kalibrierung, Dichte
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Konfiguration   144

Dämpfung
Wechselwirkung mit zusätzlicher

Dämpfung   144
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Konfiguration   140
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Konfiguration   140
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Konfiguration   141
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Verhalten der Auswerteelektronik   142

Störungsanalyse und -beseitigung   210

Systemfaktor   195
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Digital Communications Fault Action
configuring   180

options   181

Digitale Kommunikation Störaktion   180

discrete inputs
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configuring   175

options   175

configuring   174
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configuring   176

options   176

discrete outputs
configuring   171

Fault Action
configuring   173

options   174

fault indication   174

polarity
configuring   172

source
configuring   171

options   172

Druckkompensation
Druckmesseinheiten

Optionen   149

Konfiguration
mit ProLink II   146

mit ProLink III   148

Übersicht   146

duale Füllhöhen
Konfigurieren

unter Verwendung von Modbus   79

unter Verwendung von ProLink II   32

Durchflussdämpfung
Konfiguration   128

Wechselwirkung mit zusätzlicher Dämpfung   129

Wirkung auf Volumendurchflussmessung   129

Durchflussfaktor   146, 168, siehe Druckkompensation
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Auswirkung auf Gesamtbefüllung (Befüllungen mit
integrierter Ventilregelung)   139

Konfiguration   136
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Störungsanalyse und -beseitigung   225
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Konfigurieren
unter Verwendung von Modbus   66

unter Verwendung von ProLink II   21

einstufige diskrete Abfüllungen
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enhanced events, siehe events
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Störungsanalyse und -beseitigung   216

Ereignisse
Konfigurieren der Abfüllsteuerung

mittels Modbus   96

mittels ProLink II   47

events
configuring enhanced events   177

Enhanced Event Action
configuring   177

options   178

F
Fault Action

digital communications   180

discrete outputs   173

frequency outputs   170

mA outputs   165
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Fehler-Zeitüberschreitung
Auswirkung auf Störaktion   151

Konfigurieren   151

feste AOC, siehe Automatische Überfüllkompensation
(AOC)

Fliesskomma Byte Befehl   179

frequency outputs
configuring   166

Fault Action
configuring   170

options   170

maximum pulse width   169

polarity
configuring   166

options   167

scaling method
configuring   167
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Ventilregelung
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unter Verwendung von ProLink II   118

Messkreistest
unter Verwendung von Modbus   219

unter Verwendung von ProLink II   216

unter Verwendung von ProLink III   217

Störungsanalyse und -beseitigung   214, 224, 225

Frequenzfaktor   168

H
Hochfrequenzstörungen (HFS)   224
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Informationsparameter   155

K
Kalibrierdruck, siehe Druckkompensation
Kalibrierparameter, siehe Charakterisierung
Kalibrierung

Dichte D1 und D2
Übersicht   197

unter Verwendung von Modbus   200

unter Verwendung von ProLink II   198

unter Verwendung von ProLink III   199

mA-Ausgänge, siehe mA-Ausgänge, abgleichen
Temperatur

unter Verwendung von ProLink II   201

unter Verwendung von ProLink III   202

Konfiguration
Siehe auch Befüllungskonfiguration
Dichtemessung   140

Druckkompensation, siehe Druckkompensation
Informationsparameter   155

Massedurchflussmessung   126

Sichern   10

Standardwerte
Befüllungen mit integrierter Ventilsteuerung   20

Standard-Auswerteelektronik-Parameter   231

Temperaturmessung   144

Volumendurchflussmessung   131

Werkseinstellungen wiederherstellen
unter Verwendung von Modbus   16

unter Verwendung von ProLink II   11

unter Verwendung von ProLink III   11

Konfiguriert von
Auswirkungen auf zweistufige Befüllungen   29, 76
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Kontakt   ii

Kurzschlüsse
Störungsanalyse und -beseitigung   229

L
laufende AOC-Kalibrierung, siehe AOC-Kalibrierung
Letzter Messwert - Zeitüberschreitung, siehe Fehler-

Zeitüberschreitung
Lower Range Value (LRV)   161

Luftkalibrierung, siehe Kalibrierung, Dichte

M
mA outputs

Added Damping
configuring   163

interaction with flow damping   129

AO cutoff
configuring   162

configuring   160

Fault Action
configuring   165

options   165

Lower Range Value and Upper Range Value
configuring   161

default values   162

process variable
configuring   160

options   161

scaling   161

mA-Ausgänge
Abgleichen

unter Verwendung von Modbus   222

unter Verwendung von ProLink II   221

unter Verwendung von ProLink III   222

AO-Abschaltung
Wechselwirkung mit
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Konfigurieren der Abfüllungsberichte
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Messkreistest
unter Verwendung von Modbus   219

unter Verwendung von ProLink II   216

unter Verwendung von ProLink III   217

Störungsanalyse und -beseitigung   212, 223, 224

Zusätzliche Dämpfung
Wechselwirkung mit Dichtedämpfung   144

Massedurchflussmessung
Abschaltung

Konfiguration   130

Konfiguration für Anwendung Füllungen   129

Wechselwirkung mit AO-Abschaltung   130

Wirkung auf Volumendurchflussmessung   130

Durchflussdämpfung   128

Konfiguration   126

Messeinheiten
Konfiguration   127

Optionen   127

Störungsanalyse und -beseitigung   208

Massendurchflussmessung
Systemfaktor   195

Maximum Pulse Width   169

Meldung   156

Menüstruktur
ProLink II   236

Messeinheiten
Dichte

Konfiguration   140, 143

Optionen   140

Druck, siehe Druckkompensation
Massedurchfluss

Konfiguration   127

Optionen   127

Temperatur
Konfiguration   145

Optionen   145

Volumendurchfluss
Konfiguration   132

Optionen   132

Messkreistest
unter Verwendung von Modbus   219

unter Verwendung von ProLink II   216

unter Verwendung von ProLink III   217

MIT, siehe Modbus Interface Tool
Mitgeführtes Gas, siehe Dichtemessung,

Schwallströmung
Modbus

Additional Communications Response Delay   179

address   179

Auswerteelektronik-Modellcode   4
configuring Modbus/RS-485 digital

communications   179

Floating-Point Byte Order   179

ProLink-II-Verbindungen   7
Verbindung mit der Auswerteelektronik   13

Modbus Interface Tool (MIT)   13

Modellcodes, siehe Auswerteelektronik-Modellcodes

N
Null

Null-Werkseinstellung wiederherstellen
unter Verwendung von Modbus   193

unter Verwendung von ProLink II   190

unter Verwendung von ProLink III   192

Prozedur
unter Verwendung von Modbus   193

unter Verwendung von ProLink II   190

unter Verwendung von ProLink III   192

Vorherige Null wiederherstellen
unter Verwendung von ProLink II   190

unter Verwendung von ProLink III   192

P
Pause und Fortfahren

Auswirkungen auf zweistufige diskrete
Abfüllungen   56, 57, 59, 60, 107, 108, 110, 111

polarity
discrete inputs   176

discrete outputs   172

frequency outputs   166

PROFIBUS-DP
Auswerteelektonik-Modellcodes   4

ProLink II
Anforderungen   235

Menüstruktur   236

Übersicht   235, 236

Verbinden
Modbus/RS-485   7
Service Port   7

Protokolle
unterstützte Benutzerschnittstellen   4
von der Auswerteelektronik unterstützte   4

Protokollierung
Siehe auch Abfüllungsprotokollierung

Prozessvariablen
Siehe auch Dichtemessung
Siehe auch Massedurchflussmessung
Siehe auch Temperaturmessung
Siehe auch Volumendurchflussmessung
Werte anzeigen   184

Werte aufzeichnen   183

Prüfen, siehe Systemvalidierung
pulse width   169

Pumpfunktion
Definition   3
konfigurieren

mit Modbus   93

mit ProLink II   44
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S
scaling

frequency outputs   167

mA outputs   161

Schwallströmung, siehe Dichtemessung,
Schwallströmung

Sensor Material   157

Sensor Serial Number   156

Sensor-Auskleidungswerkstoff   157

Sensor-Flanschtyp   158

Sensor-Simulationsmodus
unter Verwendung von ProLink II   9
unter Verwendung von ProLink III   9

Sensorsimulation
Störungsanalyse und -beseitigung   214

Übersicht   10, 16

unter Verwendung von Modbus   15

Sensorspulen
Störungsanalyse und -beseitigung   229

Service Port
ProLink-II-Verbindungen   7

Sicherungen   10

Simulation
Sensorsimulation

unter Verwendung von Modbus   15

unter Verwendung von ProLink II   9
unter Verwendung von ProLink III   9

slave address, siehe Modbus address
Spülfunktion

Definition   3
konfigurieren

mit Modbus   91

mit ProLink II   42

Spülvorgang durchführen
mittels Modbus   113

mittels ProLink II   62

Standard-AOC-Kalibrierung, siehe AOC-Kalibrierung
Standardwerte

Befüllungen mit integrierter Ventilsteuerung   20

Standard-Auswerteelektronik-Parameter   231

Statusalarme, siehe Alarme
Störaktion

beeinflusst von Fehler-Zeitüberschreitung   151

Störungsanalyse und -beseitigung
Abfüllung kann nicht abgeschlossen werden

mittels Modbus   106

mittels ProLink II   55

Abfüllung startet nicht
mittels Modbus   105

mittels ProLink II   55

Alarme   203

Antriebsverstärkung   226, 227

Aufnehmerspannung   228

Binärausgänge   224, 225

Dichtemessung   225, 226

Erdung   216

Frequenzausgänge   214, 224, 225

Hochfrequenzstörungen (HFS)   224

Kurzschlüsse   229

mA-Ausgänge   212, 223–225

Massendurchflussmessung   208, 225

Schwallströmung (Zweiphasenströmung)   226

Systemtest   214

Temperaturmessung   211

Verdrahtung   215

Volumenstrommessung   208, 225

Werkseinstellungen wiederherstellen
unter Verwendung von Modbus   16

unter Verwendung von ProLink II   11

unter Verwendung von ProLink III   11

Stromversorgung
Einschalten   6, 12

Summenzähler
Starten und Stoppen

Aktion ausführen   188

Zurücksetzen
Aktion ausführen   188

Systemfaktoren, siehe Systemvalidierung
Systemvalidierung

alternative Methode für Volumenstrom   196

Standardmethode   195

T
Temperaturkalibrierung, siehe Kalibrierung, Temperatur
Temperaturmessung

Dämpfung
Konfiguration   145

Wirkung auf Prozessmessung   146

Konfiguration   144

Messeinheiten
Konfiguration   145

Optionen   145

Störungsanalyse und -beseitigung   211
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Messkreistest

unter Verwendung von Modbus   219

unter Verwendung von ProLink II   216

unter Verwendung von ProLink III   217

Systemtest   9

U
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V
Ventilöffnungs- und -schließsequenzen

Auswirkungen auf Pause und Fortfahren   56, 57, 59,

60, 107, 108, 110, 111

Ventilöffnungs- und Ventilschließsequenzen
Normalbetrieb   28, 75
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Verbindung
Modbus   13

ProLink II
Modbus/RS-485   7
Service Port   7

Verdrahtung
Erdung

Störungsanalyse und -beseitigung   216

Verdrahtung der Stromversorgung
Störungsanalyse und -beseitigung   215

Verdrahtung der Stromversorgung
Störungsanalyse und -beseitigung   215

Volumendurchflussmessung
Abschaltung

Konfiguration   134

Konfiguration für Anwendung Füllungen   133

Wechselwirkung mit AO-Abschaltung   135

Konfiguration   131

Messeinheiten
Konfiguration   132

Optionen   132

Wirkung der Dichtedämpfung auf   143

Wirkung der Durchflussdämpfung auf   129

Wirkung der Massedurchflussmessung auf   130

Volumenstrommessung
Störungsanalyse und -beseitigung   208

Systemfaktor   195, 196

W
Wasserkalibrierung, siehe Kalibrierung, Dichte

Z
zeitgesteuerte Abfüllungen

Definition   2
zeitgesteuerte Befüllungen

Konfigurieren
unter Verwendung von Modbus   77

unter Verwendung von ProLink II   30

zeitgesteuerte Befüllungen mit zwei Füllhöhen
Konfigurieren

unter Verwendung von Modbus   83

unter Verwendung von ProLink II   35

Zusätzliche Dämpfung   163

Zusätzliche Kommunikations-Antwortverzögerung   179

Zwei-Phasen-Durchfluss, siehe Dichtemessung,
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